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COPYRIGHT

Copyright © 2009 - 2025Spectra Logic Corporation. All rights reserved. This item and the information contained
herein are the property of Spectra Logic Corporation.

NOTICES

Except as expressly stated herein, Spectra Logic Corporation makes its products and associated documentation
on an “AS IS” BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE, BOTH OF WHICH ARE EXPRESSLY DISCLAIMED. In no event shall Spectra Logic
be liable for any loss of profits, loss of business, loss of use or data, interruption of business, or for indirect,
special, incidental or consequential damages of any kind, even if Spectra Logic has been advised of the
possibility of such damages arising from any defect or error.

Information furnished in this manual is believed to be accurate and reliable. However, no responsibility is
assumed by Spectra Logic for its use. Due to continuing research and development, Spectra Logic may revise
this publication from time to time without notice, and reserves the right to change any product specification at
any time without notice.

TRADEMARKS

Attack Hardened, BlackPearl, BlueScale, RioBroker, Spectra, SpectraGuard, Spectra Logic, Spectra Vail,
StorCycle, TeraPack, TFinity, and TranScale are registered trademarks of Spectra Logic Corporation. All rights
reserved worldwide. All other trademarks and registered trademarks are the property of their respective owners.

PART NUMBER

90940043 Revision AB
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Notes: l To make sure you have the most current version of this guide check the Spectra Logic
Technical Support portal at support.spectralogic.com/documentation/user-guides/.

l To make sure you have the release notes for the most current version of the BlueScale
software, check the Spectra Logic Technical Support portal at
support.spectralogic.com/documentation/release-notes/.

l You must sign into the portal before viewing Release Notes. The release notes contain
updates to the User Guide since the last time it was revised.
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END USER LICENSE AGREEMENT
1. READ CAREFULLY
YOU SHOULD READ THE FOLLOWING TERMS AND CONDITIONS BEFORE ACCEPTING THIS END-USER
LICENSE AGREEMENT ("EULA"). THIS EULA IS A LEGAL AGREEMENT BETWEEN YOUR ORGANIZATION,
THE END USER, AND SPECTRA LOGIC CORPORATION ("SPECTRA") FOR THE SPECTRA SOFTWARE
PRODUCT WHICH INCLUDES COMPUTER SOFTWARE AND MAY INCLUDE ASSOCIATED MEDIA,
PRINTED MEDIA, AND "ONLINE" OR ELECTRONIC DOCUMENTATION (COLLECTIVELY, "SOFTWARE
PRODUCT"). BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE
TO BE BOUND BY THE TERMS OF THIS EULA. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA,
YOU MAY NOT INSTALL, COPY, DOWNLOAD OR USE THE SOFTWARE PRODUCT. YOU AGREE THAT
YOUR USE OF THE SOFTWARE ACKNOWLEDGES THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.

2. OWNERSHIP
It is understood and agreed that Spectra Logic Corporation, a Delaware corporation with offices at 6285 Lookout
Road, Boulder, CO 80301 ("Licensor") is the owner of all right, title and interest to the Software Product,
regardless of the media or form of the original download, whether by the World Wide Web, disk or otherwise.
You, as licensee ("Licensee") through your downloading, installing, copying or use of this product do not acquire
any ownership rights to the Software Product.

3. GENERAL
The Software Product is licensed, not sold, to you by Spectra for use only under the terms of this EULA. The
Software Product is protected by copyright laws and international copyright treaties, as well as other intellectual
property laws and treaties. The rights granted herein are limited to Spectra's and its licensors' intellectual
property rights in the Software Product and do not include any other patents or intellectual property rights. The
terms of this EULA will govern any software upgrades provided by Spectra that replace and/or supplement the
original Software Product, unless such upgrade is accompanied by a separate license in which case the terms of
that license will govern.

4. SOFTWARE PRODUCT
The Software Product, as used in this EULA, means, collectively and/or as applicable:

• The Software Product package;

• Any and all contents, components, attachments, software, media, and code with which this Agreement is
provided and delivered;

• Any and all images, photographs, art, art work, clip art, fonts or other artistic works (the "Art Work");

• Related explanatory written materials and instructions, and any other possible documentation related
thereto ("Documentation"); and

• Upgrades, modified versions, updates, additions and copies of the Software Product (the "Upgrades"), if
any, licensed to by Spectra under this EULA.

5. GRANT OF LICENSE AND RESTRICTIONS
A. Spectra grants you a non-exclusive, non-transferable End-User license right to install the Software Product

solely for the purpose for which it was created.
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B. Unless provided otherwise in the Documentation or by prior express written consent of Spectra, you shall
not display, modify, reproduce and distribute any Art Work, or portion(s) thereof, included with or
relating to the Software Product, if any. Any such authorized display, modification, reproduction and
distribution shall be in full accord with this EULA. Under no circumstances will your use, display,
modification, reproduction and distribution of the Art Work give you any Intellectual Property or
Proprietary Rights of the Art Work. All rights, title, and interest belong solely to Spectra.

C. Except for the initial loading of the Software Product, you shall not, without Spectra's express written
consent:

• Copy or reproduce the Software Product; or

• Modify, adapt, or create derivative works based on the Software Product or any accompanying materials.

6. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
A. Spectra will provide you with support services related to the Software Product ("Support"). Such Support

will be provided in accordance with the Spectra Master Support Agreement, available for download and
viewing on the Spectra Corporate Web site. Use of Support is governed by this EULA and Spectra's
Master Support Agreement.

B. Any supplemental software, code, content, or media provided to you in the course of Support shall be
considered part of the Software Product and subject to the terms and conditions of this EULA.

C. Spectra retains all right, title, and interest in and to the Software Product, and any rights not granted to
you herein are reserved by Spectra. You hereby expressly agree not to extract information, reverse
engineer, disassemble, decompile, or translate the Software Product, or otherwise attempt to derive the
source code of the Software, except to the extent allowed under any applicable law. In the event that such
activities are permitted by applicable law, any information you, or your authorized agent, discover shall
be promptly disclosed to Spectra and shall be deemed the confidential information of Spectra.

D. You shall not modify, sublicense, assign, or transfer the Software Product or any rights under this EULA,
except as expressly provided in this EULA. Any attempt to sublicense, assign, or transfer any of the
rights, duties, or obligations will be void.

E. You may permanently transfer all of your rights under this EULA, provided you retain no copies. The
other party must agree to accept the terms and conditions of the EULA.

7. ALL RESERVED
All rights not expressly granted herein are reserved by Spectra.

8. TERM
A. This License is effective until terminated. Licensee may terminate it at any time by destroying the

Software Product with all copies, full or partial, and removing all of its component parts.

B. Your rights under this EULA will terminate automatically without notice from Spectra if you fail to
comply with any term(s) or condition(s) of this EULA. In such event, no notice shall be required by
Spectra to effect such termination.

C. Upon termination of this EULA, you shall cease all use of the Software Product and destroy all copies, full
or partial, together with all backup copies, modifications, printed or written materials, and merged
portions in any form and remove all component parts of the Software Product.

JUNE 2025 15 SPECTRA TFINITY LIBRARY - USER GUIDE



9. INTELLECTUAL PROPERTY RIGHTS
A. Spectra shall retain all right, title, and interest in the Software Product and to any modifications or

improvements made thereto, and any upgrades, updates or Documentation provided to End User. End
User will not obtain any rights in the Software Product, its updates, upgrades, and Documentation, as a
result of its responsibilities hereunder.

B. End User acknowledges Spectra's exclusive rights in the Software Product and that the Software Product
is unique and original to Spectra and that Spectra is owner thereof. Unless otherwise permitted by law,
End User shall not, at any time during or after the effective Term of the Agreement, dispute or contest,
directly or indirectly, Spectra's exclusive right and title to the Software Product or the validity thereof.

10. U.S. GOVERNMENT END USERS
The Software Product and related documentation are "Commercial Items," as that term is defined at 48 C.F.R.
§2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation," as
such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable. The
Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other
End Users pursuant to the terms and conditions herein. Unpublished rights reserved under the copyright laws of
the United States.

11. EXPORT LAW ASSURANCES
You may not use or otherwise export or re-export the Software Product except as authorized by United States
law and the laws of the jurisdiction in which the Software Product was obtained. In particular, but without
limitation, the Software Product may not be exported or re-exported (a) into (or to a nation or resident of) any
U.S. embargoed countries or (b) to anyone on the U.S. Treasury Department's list of Specially Designated
Nationals or the U.S. Department of Commerce Denied Persons List or Entity List. By installing or using any
component of the Software Product, you represent and warrant that you are not located in, under control of, or a
national or resident of any such country or on any such list.

12. DISCLAIMER OF WARRANTIES
YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE PRODUCT IS AT YOUR
SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY
AND EFFORT IS WITH YOU. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, AND
EXCEPT AS MAY BE STATED IN THE SPECTRA MASTER SERVICE AGREEMENT, THE SOFTWARE
PRODUCT IS PROVIDED "AS IS," WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND
SPECTRA AND SPECTRA'S AFFILIATES (COLLECTIVELY REFERRED TO AS "SPECTRA" FOR THE
PURPOSES OF SECTIONS 12 AND 13) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH
RESPECT TO THE SOFTWARE PRODUCT, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF
SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET
ENJOYMENT, AND NON-INFRINGEMENT OF THIRD-PARTY RIGHTS. SPECTRA DOES NOT WARRANT
AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE SOFTWARE PRODUCT THAT THE
FUNCTIONS CONTAINED IN THE SOFTWARE PRODUCT WILL MEET YOUR REQUIREMENTS, THAT THE
OPERATION OF THE SOFTWARE PRODUCT WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT
DEFECTS IN THE SOFTWARE PRODUCT WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION
OR ADVICE GIVEN BY SPECTRA OR A SPECTRA AUTHORIZED REPRESENTATIVE SHALL CREATE A
WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR
LIMITATION ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND
LIMITATIONS MAY NOT APPLY TO YOU.
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13. LIMITATION OF LIABILITY
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SPECTRA, ITS
AFFILIATES OR LICENSEES, BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS
OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCT OR
THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF SPECTRA HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, SPECTRA'S ENTIRE LIABILITY UNDER
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
THE SOFTWARE PRODUCT; PROVIDED HOWEVER, IF YOU HAVE ENTERED INTO A MASTER SUPPORT
AGREEMENT, SPECTRA'S ENTIRE LIABILITY REGARDING SUPPORT SERVICES SHALL BE GOVERNED BY
THE TERMS OF THAT AGREEMENT. BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF LIABILITY, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

14. CONTROLLING LAW AND SEVERABILITY
This EULA will be governed by and construed in accordance with the laws of the State of Colorado, as applied
to agreements entered into and to be performed entirely within Colorado between Colorado residents. This
EULA shall not be governed by the United Nations Convention on Contracts for the International Sale of Goods,
the application of which is expressly excluded. If for any reason a court of competent jurisdiction finds any
provision, or portion thereof, to be unenforceable, the remainder of this EULA shall continue in full force and
effect.
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Contacting Spectra Logic

To Obtain General Information

Spectra Logic Website: spectralogic.com

United States Headquarters European Office

Spectra Logic Corporation
6285 Lookout Road
Boulder, CO 80301
USA

Phone:1.800.833.1132 or 1.303.449.6400
International:1.303.449.6400
Fax:1.303.939.8844

Spectra Logic Europe Ltd.
329 Doncastle Road
Bracknell
Berks, RG12 8PE
United Kingdom

Phone:44 (0) 870.112.2150

Fax:44 (0) 870.112.2175

Spectra Logic Technical Support

Technical Support Portal: support.spectralogic.com

United States and Canada
Phone:

Toll free US and Canada:1.800.227.4637

International:1.303.449.0160

Europe, Middle East, Africa
Phone:44 (0) 870.112.2185

Deutsch Sprechende Kunden
Phone:49 (0) 6028.9796.507

Email:spectralogic@stortrec.de
Mexico, Central and South America, Asia, Australia, and New Zealand
Phone: 1.303.449.0160

Spectra Logic Sales

Website: shop.spectralogic.com

United States and Canada
Phone:1.800.833.1132 or 1.303.449.6400

Fax:1.303.939.8844
Email:sales@spectralogic.com

Europe
Phone:44 (0) 870.112.2150

Fax:44 (0) 870.112.2175

Email:eurosales@spectralogic.com

To Obtain Documentation

Spectra Logic Website: support.spectralogic.com/documentations

JUNE 2025 18 SPECTRA TFINITY LIBRARY - USER GUIDE

http://www.spectralogic.com/
http://support.spectralogic.com/
https://shop.spectralogic.com/
https://support.spectralogic.com/documentations


ABOUT THIS GUIDE
This guide describes how to configure, use, maintain, and troubleshoot the Spectra® TFinity
library. It also provides specifications for the library.

INTENDED AUDIENCE

This guide is intended for data center administrators and operators who maintain and operate
backup systems. The information in this guide assumes a familiarity with SCSI and Fibre
Channel command protocols, as well as with network connectivity protocols such as Fibre
Channel and Ethernet. It also assumes a knowledge of technical tasks such as configuring
operating systems and installing drivers.

PRODUCT STATUS

The Spectra Logic® Technical Support portal provides information about which products are
currently supported and which are considered discontinued. To view information about
discontinued products, log into the portal (see Accessing the Technical Support Portal on
page 534), and navigate to Documentation > Product Life Cycle Information.
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RELATED INFORMATION

This section contains information about this document and other documents related to the
TFinity library.

BlueScale User Interface Screens

The BlueScale® interface changes as new features are added or other modifications are made
between software revisions. Therefore, the screens on your library may differ from those
shown in this document.

Additional Publications

For additional information about the Spectra TFinity library and its drives, refer to the
publications listed in this section.

Spectra TFinity Library

This guide and the following documents related to the Spectra TFinity library are available as
PDF files on the Spectra Logic website at
support.spectralogic.com/documentation.

• The Spectra TFinity Library Quick Reference Guide provides a quick reference for the user
interface and instructions for performing day-to-day library operations such as powering
on and off, and preparing, importing, and exporting media.

• The Spectra TFinity Library Site Preparation Guide provides information about preparing your
site for the installation of the TFinity library.

• The Spectra BlueScale Vision Camera User Guide provides detailed information about
installing and using the white BlueScale Vision Camera and software.

• The Vivotek FD8361 Fixed Dome Network Camera User’s Manual provides detailed information
about installing and using the black BlueScale Vision Camera and software.

• The Spectra Tape Libraries Encryption User Guide provides detailed information about using
BlueScale Encryption Standard and Professional Edition and the Spectra SKLM Encryption
key management system. It also provides useful information about encryption best
practices and recycling encrypted media.

• The Spectra Tape Libraries SCSI Developer’s Guide provides detailed information about the
SCSI and Fibre Channel commands used in the library.

• The Spectra Tape Libraries XML Command Reference provides detailed information about
using the XML interface with the TFinity library.

• The Spectra Tape Libraries Warnings document provides all of the warnings found in Spectra
tape libraries documentation, in English and 27 other languages.
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• The Using StorageTek T10K Drives in a Spectra TFinity Library document provides detailed
information about using T10K drives in a TFinity library partition.

The following document is available after logging into your Support portal account
at:support.spectralogic.com.

• The Spectra TFinity Library Release Notes and Documentation Updates provides the most up-to-
date information about the TFinity library, drives, and media.

LTO Ultrium Tape Drives

The following documents provide information that is applicable to all IBM LTO tape drives.

• IBM Tape Device Drivers Installation and User’s Guide

Note: This guide also provides information about using the IBM Tape Diagnostic Tool (ITDT) to
troubleshoot drive problems.

• IBM TotalStorage LTO Ultrium Tape Drive: SCSI Reference (LTO-1 through LTO-4)

• IBM TotalStorage LTO Ultrium Tape Drive: SCSI Reference (LTO-5 and later)

For drive-specific information, search for the product name (for example, LTO 5) on the
documentation page on the IBM website. You can also search the IBM Support Portal at:
ibm.com/support/knowledgecenter/.

TS11xx Technology Drives

The following documents provide information that is applicable to TS11xx technology drives.

• IBM System Storage Tape Drive 3592 SCSI Reference

• IBM Tape Device Drivers Installation and User's Guide

Note: This guide also provides information about using the IBM Tape Diagnostic Tool (ITDT) to
troubleshoot drive problems.

StorageTek T10000 Drives

The following documents provide information that is applicable to StorageTek T10000 drives,
which are referred to as T10K drives in this book.

• StorageTek T10000 Tape Drive Operator's Guide

• Using StorageTek T10K Drives in a Spectra TFinity Library

Spectra SKLM Server

For additional information that can assist you during the installation and configuration of
your server, see the following website:

• IBM Security Key Lifecycle Manager welcome page

KMIP

See the documentation specific to your server.
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Typographical Conventions

This document uses the following conventions to highlight important information:

WARNING Read text marked by the “Warning” icon for information you must know to avoid
personal injury.

CAUTION Read text marked by the “Caution” icon for information you must know to
avoid damaging the library, the tape drives, or losing data.

IMPORTANT Read text marked by the “Important” icon for information that helps you
complete a procedure or avoid extra steps.

Note: Read text marked with “Note” for additional information or suggestions about the current
topic.
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CHAPTER 1 - LIBRARY OVERVIEW

The Spectra TFinity Library is an enterprise-class, highly scalable library. It provides fast,
affordable storage that meets the stringent requirements for data integrity, data security, and
high reliability in the enterprise environment.

This chapter provides an overview of the TFinity library features and components.
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LIBRARY FEATURES

This section provides an overview of the features that make the TFinity library a highly
versatile enterprise storage solution. The library’s unique modular design lets you tailor the
library to suit your current data requirements and easily expand it in the future. Keep up with
data growth and technology changes by adding storage capacity and incorporating new drive
technologies as they become available.

BlueScale Software

The library’s BlueScale software lets you set configuration options, view library and drive
information and metrics, manage cartridges, and monitor library operations. You can access
the BlueScale interface using either of the following methods:

• The BlueScale operator panel interface — via the touch screen on the library’s operator
panel.

• The BlueScale web interface — via the Remote Library Controller (RLC) using a standard
web browser.

See Introducing the BlueScale User Interface on page 85, for detailed information about the
features and controls provided by the BlueScale user interface.

IMPORTANT

Many of the features described in this user guide require your library to be
running the most current version of the BlueScale software. Spectra Logic
recommends that you keep your library’s BlueScale software and component
firmware up-to-date at all times. If you are using a previously released BlueScale
package, upgrading to the current release is strongly recommended. See
Updating the BlueScale Software and Library Firmware on page 471 for detailed
information.

The BlueScale software includes the following features (listed in alphabetical order).

Auto Configuration Save

The Auto Configuration Save feature automatically generates a weekly backup file and
replaces the previous backup file on the memory card in the LCM. The backup file contains
the library configuration and the MLM and DLM databases, as well as the encryption
configuration and any BlueScale encryption keys. A backup file is also automatically generated
and saved whenever a partition is created or modified. See Use Automatic Backup of the
Library Configuration on page 149 for more information.
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If desired, the library can email the automatically generated backup file each time it is created.
Having an external copy of the backup file ensures that you can recover the library
configuration, as well as the MLM and DLM databases, in the event of a disaster and is highly
recommended.

Auto Drive Clean

Auto Drive Clean provides library-based cleaning of drives without user intervention.
Automated drive cleaning results in fewer failed tape read/write operations and is the
recommended method for cleaning drives.

The Auto Drive Clean feature uses a dedicated cleaning partition for storing cleaning
cartridges. The cleaning partition can be shared by multiple storage partitions and is used by
the library to automatically clean drives whenever necessary. See Cleaning Partitions and Auto
Drive Clean on page 65.

AutoSupport

AutoSupport configures the library to automatically contact configured users with messages
when specific events occur. It can also be used to open or update a support ticket and send it
to a specified email recipient or to Spectra Logic Technical Support. See Configuring and
Using AutoSupport on page 362 for detailed information.

Complex Passwords

The library can be configured to require complex passwords. See Enable Complex Passwords
on page 123 for more information.

Controller Failover

Controller failover configures two Robotics Interface Modules (RIMs), in the library as a
failover pair. One member of the pair (the primary controller) provides the robotic control
path in the partition. The other controller (the secondary) is designated as the spare. In the
event that the secondary controller detects an internal problem with the primary controller, it
automatically takes over all robotics control operations to provide uninterrupted operation.
See Controller Failover on page 80 for more information.

Diagnostics and Utilities

Diagnostics and utilities are available through the BlueScale interface. Selecting a diagnostic or
utility displays additional information, including whether or not it can be run while the
library is operating.
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IMPORTANT In general, the library diagnostics and advanced utilities are only for use
under the direction of Spectra Logic Technical Support.

Drive Lifecycle Management

BlueScale Drive Lifecycle Management (DLM) helps you identify drives that are experiencing
high error rates or other problems. DLM is automatically enabled when Media Lifecycle
Management (MLM) is enabled. See Using Drive Lifecycle Management on page 352 for
detailed information.

Encryption Key Management

The Spectra TFinity library can encrypt data and manage encryption keys, using BlueScale key
management, the Spectra SKLM key management system, or KMIP encryption key
management.

Spectra SKLM and KMIP encryption run on a stand alone server and provide centralized
encryption key management. BlueScale encryption key management is tightly integrated into
the BlueScale environment. Encryption is performed through encryption-enabled drives. See
the Spectra Tape Libraries Encryption User Guide for detailed information.

EnergyAudit Reporting

The BlueScale EnergyAudit feature lets you display actual power consumption. See View
Power Consumption Statistics on page 172 for information.

EtherLib

Beginning with BlueScale12.4.0, TFinity libraries can take advantage of the BlueScale EtherLib
feature to reduce the time for some library tasks. After installing Ethernet cables, and a switch,
if necessary, tasks such as firmware updates and trace gathering complete much faster. See
Spectra Library Control Modules (LCM, RCM, and LCR) on page 48 for information about the
dedicated EtherLib port.
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Global Spare

The Global Spare feature provides a way to remotely replace a failed drive in the library. You
simply configure an installed drive as a designated spare for other drives in the library. This
drive can then be substituted for a failed drive in any partition that is configured to use the
Global Spare drive. When a drive fails, you simply log into the BlueScale web interface from
any location, select the Global Spare option for the failed drive, and continue normal
operations. You can then physically replace the failed drive at your convenience. See Assign
Global Spare Drives on page 206 and Using a Global Spare Drive on page 433 for more
information.

Hardware Health Monitoring

BlueScale Hardware Health Monitoring (HHM) tracks maintenance thresholds for key robotic
components and notifies you when a maintenance threshold is reached. You can click the
maintenance icon on the status bar to send the AutoSupport Log (ASL) file to Spectra Logic
Technical Support so they can review the log file and determine if any maintenance tasks are
needed. See Using BlueScale Hardware Health Monitoring on page 395 for more information.

MediaIQ

Configuring multiple controllers to export a partition allows the data storage software to send
multiple moves to the partition, which are stored in a move queue. The library’s MediaIQ
software analyzes the move queue and processes the moves in the most efficient way. For
more information on using multiple controllers to export a partition, see Configuring and
Managing Partitions on page 188.

Media Lifecycle Management

BlueScale Media Lifecycle Management (MLM) helps you manage your tape media by giving
you tools to proactively determine potential media errors before they happen. See Configuring
and Managing Partitions on page 188 and Configuring and Using Media Lifecycle
Management on page 301 for detailed information about configuring and using the MLM
features.
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Mixed Media Support

Certain configurations of TFinity libraries using the High Performance Transporter and
BlueScale12.7.04, or later, support mixed media and drive types. LTO, TS11xx technology, and
T10K drives and media must be in separate partitions and an LTO drive cannot be installed in
Drive Bay Assembly position 1 if there is a TS11xx technology or T10K drive in Drive Bay
Assembly position 2, or in Drive Bay Assembly position 3 if there is a TS11xx technology or
T10K drive in Drive Bay Assembly position 4.

Remote Support

The remote support feature uses a remote web access application, WebEx™, to facilitate
remote problem diagnosis. Remote support preserves your organization’s site and data
security, giving Spectra Logic Technical Support limited access to your library. With WebEx,
Technical Support can “drive” the library, taking enough control to gather the data required to
speed understanding of the problem. See Remote Support Icon on page 93 for more
information.

Robotic Load Balancing

When used with host software that is limited to one exporter per partition, such as IBM
Spectrum Protect™, the Robotic Load Balancing advanced partition setting improves library
performance for a two TeraPorter library. SeeEnable Robotic Load Balancing on page 230 for
more information.

Shared Library Services (SLS) Partitioning

The library uses Shared Library Services (SLS) virtualization technology to partition the library
into virtual libraries. SLS partitioning is an option you can add to the library by purchasing an
activation key from Spectra Logic. See Library Partitions on page 63 for detailed information
about how partitions function in the library. See Configuring and Managing Partitions on
page 188 for detailed information about configuring and using partitions.

SlotIQ

SlotIQ optimizes robotics performance by allowing the library to virtualize slot locations and
optimize the order of moves in a queue to reduce the amount of robotic movement required
for any set of moves.
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Soft Load

The Soft Load feature uses the drives soft load (or auto load) functionality to improve library
performance. Soft Load requires that the library have high performance transporters and that
the partition use TS11xx technology or LTO-5 or later generation drives. See Enable Soft Load
on page 226 for more information.

Soft Power Control

The Soft Power option disables the front panel power button and instead enables a “soft
power” button on the General Status screen of the BlueScale user interface. Enabling the Soft
Power option prevents unauthorized users from powering the library off using the front panel
power switch. See Use the Soft Power Feature on page 164 for more information.

Spectra Swarm

The Spectra Swarm bridge is a high-performance storage controller that adds 40-Gigabit
Ethernet connectivity to SAS tape drives. See the Spectra Swarm Bridge Installation &
Configuration Guide for more information.

Time-based Access Order System (TAOS)

Time-based Access Order System (TAOS) is a way to reduce the time it takes to read several
data segments from a single tape. The intent of TAOS is to minimize the re-positioning the
drive must do between reads of multiple locations, to improve the overall read time and
reduce drive and media wear by limiting the total travel amount of the media within the
drive. This feature is supported for LTO-7 and later generation drives. See Enable Time-based
Access Order System (TAOS) on page 228 for more information.

Thin Provisioning

The Thin Provisioning option allows automatic library partition resizing as a partition requires
greater slot count, without reconfiguring the library or host software. Using Thin Provisioning,
it is possible for the combined number of storage slots configured in all library partitions to
exceed the licensed or physically available number of slots. Empty slots are included in, but
inaccessible to, all partitions until you import a TeraPack magazine into one partition. At that
time, the library makes the slots accessible to only the partition into which the magazine was
imported. You can import additional magazines into any of the thin provisioned partitions
until the inventory reaches the licensed capacity. Thin Provisioning is enabled with a
purchased activation key.
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XML Command Interface

The XML command interface provides a set of commands for use in customer-generated
programs used for viewing the library’s status, inventory, and configuration information, and
performing BlueScale package updates and other operations without using the BlueScale user
interface. See the Spectra Tape Libraries XML Command Reference for detailed information.

Library Components

The following sections show the locations of and briefly describe the major front panel,
internal, and rear panel components of the library’s main, service, bulk TeraPack® Access Port
(TAP) service, and drive expansion frames.

Front Panel Components

Figure 1 shows the front components of a five frame library. It also shows the relative
locations of the main frame, the expansion frames, and the service frames. The expansion
frames and bulk TAP are optional.

Figure 1 Front panel components.

The following table describes each of the components shown in Figure 1 on page 30.
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Component Description

Access Panels The access panels on the outer side of the library let you view the inside
of the library and provide access to the interior components. The access
panels are equipped with safety interlocks that power down the library
robotics when removed.

Service Frames The service frames at each end of the library allow a malfunctioning
TeraPorter in a two TeraPorter library to be serviced without interrupting
library operations. See Service Frame Rear Panel Components on page 42
for additional information.

Note: Starting with BlueScale12.8.04, a non-isolating service frame
configuration is available that replaces the right and left service frame with
media expansion frames. This provides more storage slots at a lower cost, but
means that some slots may be inaccessible if a TeraPorter is in the service
position.

Status LED Bar A multi-colored LED bar along the top front edge of each frame shows the
status of the library and the location of the TeraPorter(s). See Interpreting
External Lights on page 394 for details.

Expansion Frames Expansion frames make it possible to increase media storage capacity or
the number of drives in the library. See Drive, Media, and Service Frames
on page 68 for more information.

TeraPack Access
Ports (TAPs)

The TeraPack Access Ports (TAPs) act as entry/exit ports that let you
import media into or remove media from the library. The library has two
types of TAPs:

• The center TAP lets you import or export a single magazine. The two
TAP chambers alternate to provide increased throughput.

• The optional bulk TAP lets you import or export up to 14 TeraPack
magazines in a single operation.

To learn more about the TAP, see TeraPack Access Ports (TAPs) on page 46.

Operator Panel The operator panel on the main frame includes a color LCD touch screen
and library power button. To learn more, see Operator Panel and Touch
Screen on page 45. A stylus for making selections and typing entries on
the touch screen can be conveniently stored near the screen.

Air Filters and
Fans

The air filters on the front of the main frame, drive frames, and service
frames prevent particulate contaminants from being pulled into the library
by the air circulation system. Redundant fans in the main and drive
frames ensure positive pressure inside the library, keeping dust out, and
circulate clean air for climate control inside the library.
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Component Description

Main Frame The main frame houses the library control module (LCM), the main
robotics control module (RCM), the operator panel, the TeraPack access
port (TAP), robotics interface modules (RIMs), power supplies, the
EtherLib switch, and drives. It also provides cartridge storage.

Doors (not
shown)

Lockable doors on the back of the main, drive expansion, and service
frames enclose the drives and cable connections to prevent unauthorized
access.

Interior Components

Figure 2 shows the interior components of the library.

Note: The interior components are shown for reference only. They are not accessible during normal
operation.

Figure 2 Library interior components (viewed through the right-hand service frame with the access
panel removed).

The following table describes each of the components shown in Figure 2.
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Component Description

LED panels The LED panels mounted on the top of the main frame and each
expansion frame illuminate the interior of the library.

TeraPorters A standard library includes two TeraPorters. You can optionally order a
single TeraPorter library.

The TeraPorter and the transporter make up the robotic mechanism used
to move a TeraPack magazine from one location to another in the library.
The TeraPorter moves along the horizontal axis and the transporter
moves up and down the vertical axis (VAX) to perform all media
movement within the library.

During normal operation each TeraPorter operates independently. The
library’s BlueScale software manages the TeraPorter(s) to ensure that they
perform as efficiently as possible and do not interfere with each other. In
the event that one TeraPorter in a dual TeraPorter library experiences a
problem, the other TeraPorter automatically pushes it to the service
position and takes over all move operations for the library.

Transporters and
High Performance
Transporters

Transporters and optional High Performance Transporters (HPT) are
mounted on the TeraPorter(s); they retrieve the magazine from the source
chamber and hold it while the TeraPorter moves to its destination. The
cartridge picker then removes the requested individual cartridge from the
magazine and inserts it into a drive. When the drive is finished using the
cartridge and ejects it, the cartridge picker retrieves the cartridge and
returns it to a magazine. The TeraPorter then moves the transporter to
return the magazine to a chamber.

The barcode reader, mounted on the cartridge picker, reads the barcode
labels on TeraPack magazines and individual cartridges. The library uses
the barcode label information to maintain an inventory of the media
currently stored inside the library.

High Performance Transporters are designed for reduced cycle and tape
mount time to provide increased performance, and with increased mean
time to repair and new sensors for enhanced reliability.

Notes:

• Unless otherwise specified, the features of both the HPT and legacy
transporter are the same and “transporter” is used to refer to both.

• You can mix legacy and high performance transporters in a library.

Media Storage All of the media in the library is stored in TeraPack magazines. Each
magazine contains nine slots for TS11xx technology or T10K cartridges or
ten slots for LTO cartridges. The magazines are placed in TBAs or on
shelves divided into chambers. Each chamber provides storage for one
TeraPack magazine.
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Component Description

The number of slots in a frame depends on the type and configuration of
the frame and magazines (see Drive, Media, and Service Frames on
page 68). The maximum media storage capacity of the library depends on
the number of drives installed and the number of drive and media
expansion frames installed (see Data Storage Capacity on page 570).

Service Frame or
Bulk TAP Service
Frame

In isolating service frame libraries, service frames are located at each end
of the library. Each service frame includes media storage and a service bay
that lets you isolate and service one TeraPorter without interrupting
library operations in a dual TeraPorter library. See Service Frame Rear
Panel Components on page 42 and Bulk TAP Service Frame Front Panel
Components on page 44 for additional information.

Note: In non-isolating service frame configurations, the service frames are
replaced by right and left media expansion frames.

Main and Drive Expansion Frame Rear Components

The components on the library’s rear panel depend on the type of frame. Figure 3 shows the
rear panel components of the library’s main frame. Except where noted in the following
descriptions, the same components are present in each drive expansion frame.

Note: Any bays that do not contain components must have covers installed to maintain proper air
circulation throughout the library and to protect the internal components.
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Figure 3 Library main frame rear components (doors removed).

The following table describes each of the components shown in Figure 3 on page 35.

Component Description

EtherLib Switch
(not shown)

An EtherLib switch is installed in a controller bay to use the BlueScale
EtherLib feature which reduces the time for some library tasks such as
firmware updates and trace gathering.
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Component Description

Doors (not
shown)

Doors on the back of each frame protect the cabling connections. The
doors are equipped with safety interlocks that cause the library robotics to
operate at a reduced speed while the doors are open.

Tool Storage The compartment above the media storage area in the main frame
provides space for storing the tool kit and documentation that
accompanies the library.

BlueScale Vision
Camera
Connector

The dedicated Ethernet port for the BlueScale Vision camera lets you
connect the camera to an Ethernet network and use the web-based
BlueScale Vision software to monitor the interior of the library. Each
frame that contains a camera has an Ethernet connector. See BlueScale
Vision Camera on page 57 for information about the BlueScale Vision
camera.

Notes:

• The BlueScale Vision camera connector is not present if a frame does not
have a BlueScale Vision camera installed.

• In media expansion frames, the connector is in a similar location.

Media Storage
Chambers

All of the media in the library is stored in TeraPack magazines, each of
which contains ten slots for LTO media or nine slots for TS11xx
technology or T10K media. The magazines are placed on shelves divided
into chambers. The number of chambers at the back of a frame depends on
the type of frame and its configuration (see Drive, Media, and Service
Frames on page 68).

Flex Bays (for
DBAs or TBAs)

In LTO main and drive frames, three flex bays make it possible to
configure the frame to increase media storage capacity or data throughput.
The flex bays accommodate either three Drive Bay Assemblies (DBAs) or
three TeraPack Bay Assemblies (TBAs).

Note: TS11xx technology, T10K, or mixed media main and drive frames always
include DBAs or shelves in place of the flex bays.

TeraPack Bay
Assemblies (TBAs)

Each TBA contains four chambers, each of which accommodates a single
magazine. If the frame has only three DBAs installed, TBAs occupy the flex
bays.

Note: TBAs are not supported by TS11xx technology, T10K, or mixed media
main and drive frames. They are replaced by DBAs or shelves.

Drive Bay
Assemblies
(DBAs)

A main or drive frame can have either three or six DBAs installed.

Each DBA provides the electrical and internal interface connections for up
to four full-height drives. See Tape Drives on page 55 for information
about the drives used in the library. Each DBA also includes a controller
bay for a RIM or EtherLib switch to the right of the drives.
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Component Description

Notes:

• Any drive or controller bays that do not contain components must have
covers installed to maintain proper air circulation throughout the library
and to protect internal components.

• The library does not support placing an LTO drive in Drive Bay
Assembly position 1 if there is a TS11xx technology or T10K drive in
Drive Bay Assembly position 2, or in Drive Bay Assembly position 3 if
there is a TS11xx technology or T10K drive in Drive Bay Assembly
position 4.

LCM and RCM Dedicated on-board library control modules run the BlueScale software
that controls all aspects of library operation. Depending on where the
module is installed, it functions as the Library Control Module (LCM) or
the Robotics Control Module (RCM). To learn more, see Spectra Library
Control Modules (LCM, RCM, and LCR) on page 48.

Note: Drive expansion frames only have an RCM, they do not include an LCM. A
cover over the opening maintains proper air circulation throughout the frame.
Media frames do not have either module.

24 VDC Robotics
Power Supply
Modules

Two 24 VDC power supply modules in the main frame provide redundant
power for the library robotics and motors, the fans, and the interior LED light
bars.

Each 24 VDC power supply module has two indicator LEDs, one for DC
power status and one for AC power status. The color of the LED indicates
the power supply status:

• Green — The power is on and functioning normally.
• Orange — The power supply has a fault condition.
• Off — The power is not on or the power supply module is not
functioning normally.

Notes:

• Drive expansion frames do not include 24 VDC power supply modules.
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Component Description

• If the second 24 VDC power supply module is not installed, a cover
over the opening maintains proper air circulation throughout the frame.

• 24 V Power supplies are labeled A and B from top to bottom.

Robotics Interface
Module (RIM)

One RIM can be installed in each of the vertical controller bays to the
right of the drives in the main frame DBA (see Figure 3 on page 35). A
RIM or LTO-6 or later generation drive, or a TS1155, TS1160, or TS1170
tape technology drive is required to provide the Fibre Channel interface to
the library’s TeraPorter(s). One additional RIM is required for controller
failover, if enabled. To learn more, see Exporting Controllers on page 53.

Note: Unless otherwise specified, the features of both RIM and RIM2 are the
same and “RIM” is used to refer to both.

Drives The library accommodates multiple generations of high-performance,
high-capacity, full-height and half-height LTO drives, TS11xx technology
drives, or T10K drives. The drives are installed in DBAs, with each DBA
accommodating up to four drives. Drives are hot-swappable to provide
uninterrupted operation. To learn more, see Tape Drives on page 55.

Notes:

• Any drive bays that do not have drives installed must have covers
installed to maintain proper air circulation throughout the frame and to
protect internal library components.

• The library does not support placing an LTO drive in Drive Bay
Assembly position 1 if there is a TS11xx technology or T10K drive in
Drive Bay Assembly position 2, or in Drive Bay Assembly position 3 if
there is a TS11xx technology or T10K drive in Drive Bay Assembly
position 4.

Power Control
Module (PCM)

The PCM supplies power to the power supplies when you press the power
button on the front panel of the main frame. It monitors the power supply
modules in the frame for output voltage, output current, power supply
fan operational status, and power supply operational temperature. The
PCM uses the voltage and current data to calculate the library power
usage that is displayed through the BlueScale user interface.

5/12 VDC Power
Supply Modules

The 5/12 VDC power supply modules convert AC input to provide the
5 VDC and 12 VDC power used by the drives in the frame. In the main
frame, these power supplies also provide power to the controller bays, the
LCM, the RCM, and the LCD operator panel. With the exception of its
voltage rating, the 5/12 VDC power supply module closely resembles the
24 VDC robotics power supply module shown on on the previous page.
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Component Description

There are two different power supplies available depending on the age
and configuration of the library. The number of supplies required by a
library is calculated by Spectra Logic based on the number and type of
drives in the library. Extra supplies provide redundancy and failover
protection. The new and old supplies can be mixed in a power control
module and older supplies can always be replaced by a newer supply.
However, newer supplies cannot always be replaced by an older supply.
Contact Spectra Logic Technical Support (see Contacting Spectra Logic on
page 18) for more information.

5/12 VDC Power
Supply Modules
(continued)

Power Supply 1
Each power supply module has two indicator LEDs, one for AC power
status and one for DC power status. The color of the LED indicates the
status.

• Green — The power is on and functioning normally.
• Orange — The power supply has a fault condition.
• Off — The power is not on or the power supply module is not
functioning normally.

Note: Any bays that do not have power supply modules installed must have
covers installed to maintain proper air circulation throughout the frame.
Note: Power supplies are numbered 1-7 starting from the left.

Power Supply 2
Each power supply module has three indicator LEDs, one for AC power
status, one for 5-volt power status, and one for 12-volt power status. The
color of the LED indicates the status.

• Green — The power is on and functioning normally.
• Amber — The supply is operating with a Current/Temperature Limit.
• Red — There is a fault that prevents the supply from operating.
• Off — The power is not on or the power supply module is not
functioning normally.
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Component Description

Note: Any bays that do not have power supply modules installed must have
covers installed to maintain proper air circulation throughout the frame.
Note: Power supplies are numbered 1-7 starting from the left.

Dual AC Power
Module

The dual AC power module provides surge protection for the library
power system and monitors the primary AC input power to determine
whether it is present and of adequate voltage. If the primary AC input
fails or drops too low, the dual AC power module checks the voltage on
the secondary input, and if it is adequate, handles the failover to the
redundant, secondary AC input until the primary input is restored.
Each dual AC power module includes both primary and secondary AC
power connectors and two breaker switches. There are four types of dual
AC power modules: dual AC, dual AC with convenience outlet, dual AC 2
(13 A), and dual AC 2 (16 A). Dual AC with convenience outlet and dual
AC 2 power modules include a fused 200-240 VAC convenience outlet.
The dual AC convenience outlet is rated at 5 A. The dual AC 2
convenience outlet is rated at 2 A.
Dual AC Power Module and Dual AC Power Module with Convenience
Outlet
LEDs indicate the status of the primary and secondary AC inputs.

• Primary and Secondary Input Power LED States:
• Green - Good/Active
• Orange - Under Voltage

CAUTION If the power sources for the AC inputs for a frame using the dual AC
or dual AC with convenience outlets are not on the same phase, damage
to the library could result.

Dual AC Power
Module
(continued)

Dual AC 2 Power Module
LEDs indicate the status of the primary and secondary AC inputs and the
overall dual AC 2 module.
• Primary and Secondary Input Power LED States:
• Green - Good/Active
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Component Description

• Blue - Good/Not Active
• Orange - Bad/Active, cannot switch to secondary source
• Red - Under Voltage Lockout
• Off - Not Present

• Dual AC 2 Status LED States:
• Blinking Green - Good Status
• Solid Red - Over Temperature, > 100C

Notes:

• The dual AC 2 does not require the power sources for the AC inputs for
a frame to be on the same phase.

• The convenience outlet is powered by the primary AC input. If the
primary input fails, the convenience outlet does not function.

• The dual AC 2 (16A) can be distinguished from the dual AC 2 (13A) by
the book and triangle with exclamation graphics below the outlet fuse
on the back of the 16A dual AC

Service Frames

The standard TFinity library includes two service frames, one for each TeraPorter in a
standard two TeraPorter library. The service frame is the last frame on each end of the library.

Note: Starting with BlueScale12.8.04, a non-isolating service frame configuration is available that
replaces the right and left service frame with media expansion frames (see Bulk TAP Service
Frame Front Panel Components on page 44). This provides more storage slots at a lower cost,
but means that some slots may be inaccessible if the library has two TeraPorters and one of
the TeraPorters is in the sce position. The chambers that could be blocked by the TeraPorter
are called the exclusion zone, which are the two outermost columns of the library on each
side. They are the last chambers filled when importing magazines. For maximum availability,
Spectra Logic recommends not licensing/using the chambers in the exclusion zone. In an LTO
library, each non-isolating service frame has 78 chambers that are always accessible by both
robots and 52 chambers in the exclusion zone. In a TS11xx technology library, each non-
isolating service frame has 66 chambers that are always accessible by both robots and 44
chambers in the exclusion zone.
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Figure 4 A dual-robot, non-isolating service frame example.

Service Frame Rear Panel Components

Figure 5 Service frame components (left-hand service frame shown).

The following table describes each of the components shown in Figure 5.

Component Description

Service Bay The service bay, located on the outer end of each service frame, lets you
isolate a malfunctioning TeraPorter in a two TeraPorter library for
maintenance without interrupting library operations. After a TeraPorter is
in the service bay, a manually operated safety door can be closed and
locked to isolate the TeraPorter for service.

Safety Door and
Handle

The safety door is manually opened and closed using a latching handle
located on the door. A solenoid locks the safety door open or closed. The
BlueScale user interface and the LEDs on the SCM indicate whether the
door is open or closed and if it is safe to perform service.
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Component Description

The BlueScale user interface also provides controls for preparing the
TeraPorter in the service bay for maintenance and for locking or unlocking
the safety door. When the safety door is unlocked and enabled, the handle
can be lowered to manually slide the safety bay door into the service
frame to isolate the TeraPorter in the service bay.

Transporter
Service Access

After the TeraPorter is moved into the service bay and the safety door is
closed, the transporter can be accessed and serviced through the service
access opening at the back of the service frame. A safety interlock on the
door covering the access opening automatically turns off all 24 VDC
power to the library robotics if it is opened without first closing the
service bay safety door.

Expansion Power
Module (EPM)

The expansion power module provides power to the service frame and
includes the following:

• Power Supply Modules — Two 24 VDC power supply modules in each
service frame provide redundant power for the library robotics and the
safety door controls. See 24 VDC Robotics Power Supply Modules on
page 37 for a description of the 24 VDC power supply modules.

Note: The right service bay only has one 24 VDC supply in a single TeraPorter
library.

• AC input and breaker switches — Two AC power connectors and two
breaker switches, one for each 24 VDC power supply module, provide
power to the service frame components and the TeraPorter when it is in
the service frame.

Service Expansion
Module (SEM)
(optional)

Some libraries shipped with a control module in a service frame, called a
Service Expansion Module (SEM). The library no longer uses the SEM. If
your library has one, it can be used as a spare for the LCM or RCM.

Media Storage
Chambers

All of the media in the library is stored in TeraPack magazines, each of
which contains nine slots for TS11xx technology or T10K cartridges or ten
slots for LTO cartridges. The magazines are placed on shelves divided into
chambers. The chambers are located along the side of the frame where it
attaches to the preceding frame (see Drive, Media, and Service Frames on
page 68).

Service Control
Module (SCM)

The service control module provides the control logic for the safety door
and power interlock system.

Doors and Access
Panels (not
shown)

Doors on the back of each service frame prevent accidental contact with
the interior components of the frame, including the TeraPorter, and
protect the cabling connections. A safety interlock on the door over the
transporter service access opening (see Figure 5 on page 42) automatically
turns off all 24 VDC power to the library robotics if the door is opened
without first closing the service frame safety door.
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Component Description

The access panels on the side of the service frame (see Figure 1 on
page 30) let you view the interior of the library and provide access to the
entire TeraPorter assembly, which includes the VAX column and the
transporter. A safety interlock on the access panel automatically turns off
all 24 VDC power to the library robotics if the panel is removed without
first closing the safety door.

Note: When the safety door is closed, opening the door or removing the access
panel on the service frame only turns off the 24 VDC power to the TeraPorter in
the service bay.

Bulk TAP Service Frame Front Panel Components

The bulk TeraPack Access Port (TAP) service frame can replace the left or right (as viewed
from the front of the library) service frame. It includes the components of the standard service
frame (see Service Frame Rear Panel Components on page 42) and a bulk TAP carousel used
to import or export up to 14 magazines in a single operation. See TeraPack Access Ports
(TAPs) on page 46 for detailed information about how the bulk TAP operates.

Figure 6 The front of the bulk TAP service frame.
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The following table describes each of the components shown in Figure 6.

Component Description

TAP Carousel The TAP carousel accommodates up to 14 TeraPack magazines.

Door Release
Button

An LED in the button indicates the current state of the TAP carousel. Pressing
the button, when the carousel is ready to be loaded or unloaded, opens the
door.

• Solid green — The carousel is ready to be loaded or unloaded.
• Flashing green — An import or export operation is in progress.
• Red — The carousel is in an error state.
• Off — The carousel is empty and there are no unprocessed import or
export requests.

Door The door locks to prevent unauthorized access to the carousel.

Media Storage The bulk TAP frame has 50 LTO media storage chambers or 42 TS11xx
media storage chambers. Each chamber accommodates a single TeraPack
magazine. See Drive, Media, and Service Frames on page 68 for additional
information.

Bulk TAP Service
Control Module
(SCM) (on rear)

The bulk TAP service control module provides the control logic for the
bulk TAP carousel and door.

Media Expansion Frames

Media expansion frames are for media storage only and do not include any active front or rear
panel components or a door. See Data Storage Capacity on page 570 for more information.

Starting with BlueScale12.8.04, a non-isolating service frame configuration is available that
replaces the right and left service frame with media expansion frames. This provides more
storage slots at a lower cost, but means that some slots may be inaccessible if a TeraPorter is in
the service position. The chambers that could be blocked by the TeraPorter are called the
exclusion zone. They are the last chambers filled when importing magazines. See Service
Frames on page 41 for more information.

Operator Panel and Touch Screen

The operator panel touch screen on the main frame provides local access to the BlueScale user
interface through the Library Control (LC) server. You can select options and enter
information by touching the appropriate location on the screen. For detailed information about
using the BlueScale user interface through the touch screen, see Introducing the BlueScale User
Interface on page 85.
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Figure 7 The library operator panel displaying the General Status screen of
the BlueScale user interface.

The operator panel includes the following features:

Component Description

LCD touch screen The LCD touch screen lets you monitor library operations and select
configuration options using the BlueScale user interface.

Power Button The power button provides front panel on/off control of the library.

Stylus A stylus for making selections and typing entries on the touch screen is
conveniently stored near the screen.

USB Port The USB port can be used to connect a USB device to the library for
transferring BlueScale encryption keys, saving configurations, and
uploading software packages. You can also connect a USB keyboard to the
USB port.

TeraPack Access Ports (TAPs)

The TeraPack Access Ports (TAPs) act as entry/exit ports that let you import magazines into or
export magazines from the library. A magazine can contain one or more cartridges or it can be
empty.

Notes: l To import or export individual cartridges, they must be placed in a magazine.

l All import and export requests are issued through the Import/Export screen of the
BlueScale front panel user interface or by using the XML command interface.

The library features two types of TAPs:
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• The center TAP lets you move TeraPack magazines into or out of the library one at a time.
During import or export operations involving multiple magazines, the TAP doors alternate
so that the operation completes more quickly.

• The carousel in the bulk TAP media frame lets you move up to 14 magazines into or out of
the library in a single operation.

Using the TAP to move cartridges into and out of the library provides these key advantages:

• Data Security — Media is never stored in the TAP. A newly inserted TeraPack magazine is
automatically moved into the library and placed in a storage chamber. A magazine already
in the library is only moved to the TAP when you request an export operation through the
user interface. Data security and backup integrity are enhanced because the media stored
in the library can only be accessed using the password-protected BlueScale user interface or
XML interface.

• Convenience — Instead of individually importing or exporting single cartridges as you
would with a traditional entry/exit port, using a TAP lets you handle multiple cartridges in
a single operation, thus reducing the time spent on import and export tasks.

Center TAP

The center TAP lets you move a single TeraPack magazine into and out of the library. When
you use the center TAP, one of the two TAP doors opens so that you can insert or remove a
magazine. During import or export operations involving multiple magazines, the TAP doors
alternate so that the operation completes more quickly.

Figure 8 The center TAP with a TeraPack magazine loaded.
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See Importing and Exporting Cartridges on page 238 for details on how the center TAP is used
to import and export TeraPack magazines.

Bulk TAP

The optional bulk TAP service frame lets you import or export up to 14 TeraPack magazines in
a single operation.

Figure 9 The bulk TAP carousel.S

See Importing and Exporting Cartridges on page 238 for details on how the bulk TAP is used
to import and export TeraPack magazines.

Spectra Library Control Modules (LCM, RCM, and LCR)

The library uses multiple control modules called the Spectra Library Server (Spectra LS). These
dedicated computers run the library’s BlueScale software, which controls and manages all
aspects of the library operation. Depending on where the module is installed in the library, it
functions as either the Library Control Module (LCM) or the Robotics Control Module (RCM).
The Library CAN Repeater (LCR) is used in drive expansion frames to process robotic
commands.

Note: Some libraries shipped with a control module in a service frame, called a Service Expansion
Module (SEM). The library no longer uses the SEM. If your library has one, it can be used as a
spare for the LCM or RCM.
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Spectra LS Overview

Figure 10 shows the external components on a Spectra LS module.

Notes: l When the control module is functioning as an RCM, the connectors are only used for
troubleshooting and diagnostic purposes under the direction of Spectra Logic
Technical Support.

l The Spectra LS also contains a hard drive that is used for storing the CAN logs used for
troubleshooting the library.

Figure 10 The connectors and components on a Spectra LS Gen 4.

The following table describes the components shown in Figure 10.

Component Description

USB Ports (4) The USB ports on the LCM can be used to connect a USB device for
transferring BlueScale encryption keys, saving configurations, and
uploading BlueScale software packages. You can also connect a USB
keyboard and mouse to the USB ports on the LCM and use them when
interacting with the BlueScale user interface. This connection provides
access to all of the options available from the library’s front panel touch
screen.

Note: Use the USB port(s) on the RCM to update the firmware on the RCM
during BlueScale package update or under the direction of Technical Support
for capturing motion traces that are used for troubleshooting.

Monitor
Connector

You can connect a monitor to the LCM and use it to view the BlueScale
user interface instead of using the library front panel.

Note: The monitor connector on an RCM is only used by service personnel.
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Component Description

Ethernet Port • The Ethernet port on the LCM connects the library to an Ethernet
network and is used to access the library through the BlueScale web
interface using the Remote Library Controller (RLC). The BlueScale web
interface provides access to all of the options available from the library’s
operator panel except those that require physical interaction with the
library (for example, importing or exporting media). The Spectra LS has
a 10/100/1000BaseT connection.

Notes:

• Beginning with BlueScale12.4.1, the right-most Ethernet port on a
Spectra LS is dedicated for EtherLib. See Dedicated EtherLib Port below.

• When the module is functioning as the RCM or SCM, the left-most
Ethernet port is only used for troubleshooting by service personnel.

Dedicated
EtherLib Port

With BlueScale12.4.1 and later, the right-most Ethernet port on the Spectra
LS is configured as a dedicated EtherLib port. EtherLib uses this port to
speed communication between components in the library.
Note: This port cannot be used to access the BlueScale web interface.

Memory Card
(behind cover)

The memory card in each module stores information related to its
functional role in the library. When the library control module is installed
in the library and powered on for the first time, the library determines the
location and then activates either the LCM or RCM code on the memory
card. Once this is done, the module performs only the functions defined
by the activated code on the memory card. In addition to the code that
determines the module’s role in the library, the memory card is used to
store the following:
• In the LCM it stores the library’s configuration information, activation
keys, system settings, and partition settings. It also stores the MLM and
DLM databases and information related to the current system status.

• In the RCM it stores the library’s configuration information, system logs,
and inventory.

Notes:

• Two extra memory cards come standard with new libraries for error
recovery.

• Before replacing a memory card, it is important to backup the
information it contains, if possible. See the Spectra T950 or TFinity
Memory Card Replacement guide for more information.

CAN Connector This connector is only used for troubleshooting by service personnel.
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LCM and RCM Functionality

The functionality provided by a Spectra LS module is determined by where the module is
installed and the information on the memory card installed in the module.

Figure 11 Identifying the LCM and the RCM.

• When installed in the top bay of the main frame, the module functions as the Library
Control Module (LCM).

Note: Drive expansion frames do not have an LCM. A cover over the opening where the LCM would
be installed maintains proper air circulation throughout the frame.

• When installed in the bottom bay of the main frame or in a drive expansion frame, the
module functions as the Robotics Control Module (RCM).

Note: Starting with BlueScale 12.8.08.02, LCR modules can be used in drive expansion frames
instead of RCM modules.

The following table describes each Spectra LS control module:

When functioning
as the... The Spectra LS control module...

Library Control
Module (LCM)

Runs the BlueScale software, which provides the BlueScale user interface
that is used to perform all configuration, import/export, and management
functions for the library. The BlueScale user interface is accessed locally
through the library’s touch screen. In addition, an embedded web server
provides remote access to the BlueScale web interface and to the XML
command interface using a standard web browser.
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When functioning
as the... The Spectra LS control module...

In addition to providing the user interface, the BlueScale software running on
the LCM generates and maintains the MLM database, BlueScale encryption
keys, system logs, and other information related to the current system status.
It also handles email operations such as sending a backup file and
AutoSupport logs to preconfigured recipients.

Robotics Control
Module (RCM)

Processes media changer commands from the hosts and storage
management software to control the operation of the TeraPorter(s). The
RCM also stores all of the information about the location and status of
each element in the library, as well as the raw media inventory in its non-
volatile memory. This functionality allows the library to continue
performing backup/restore operations, even when the user interface
provided through the LCM is unavailable.

LCR Functionality

The Library Can Repeater (LCR) module is installed in drive expansion frames in place of an
RCM module. When the library control module issues a command, the LCR duplicates that
signal across all frames.

Figure 12 Identifying the LCR in the back of a library.
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Exporting Controllers

Either a RIM or direct-attached LTO-6 or later generation drive, or TS1155, TS1160, or TS1170
tape technology drive is required to provide the control path for the library’s robotics. When
configuring a storage partition, the device you select to provide the robotic control path is
referred to as the “exporting controller” for the partition.

Note: Unless otherwise specified, the features of both RIM and RIM2 are the same and “RIM” is used
to refer to both.

The controller is the bridge between an external Fibre Channel or SAS connection from the
host and the internal interface used by the library. It provides the control path for the media
changer commands sent from the host to the library. The controller relays the commands to
the RCM, which processes the commands and uses them to control the robotics in the library.

A minimum of one controller is required to connect the library’s TeraPorter(s) to the Fibre
Channel network. To learn more about the role the controller plays in the library, see
TeraPorter Connectivity on page 73.

Spectra Logic recommends using a direct-attached drive as the exporting controller for a
partition unless you need to configure the partition for media zoning, which is used by
software packages such as High Performance Storage System (HPSS) and HPE Data
Management Framework (DMF).

Notes: l A tape drive can only provide the control path for one partition. A RIM can provide the
robotic control path for up to eight partitions. A RIM2 can provide the robotic control
path for up to 16 partitions.

l For BlueScale12.7.03 through BlueScale12.8.01.04, the maximum number of exporting
controllers (RIMs) supported by the library is six.

l For BlueScale12.8.07 and later, the library supports 12 RIM exporters and 48 drive
exporters.

l You can select multiple exporting controllers (RIMs) for a partition and use your host
software to either export the same changer interface over the controllers to provide
redundancy, or send multiple moves to the partition which are analyzed by MediaIQ so
that the moves are processed in the most efficient way. See Partition Types and
Requirements on page 190 for more information.

l Two RIMs or two RIM2s can be configured for controller failover. Two tape drives
cannot be configured for controller failover.

RIMs are mounted in the vertical controller bay located along the right side of each DBA.
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Figure 13 The Robotics
Interface Module 2 (RIM2).

Figure 14 The Robotics
Interface Module (RIM).

The following table describes the controllers supported by the library.

Controller Description

RIM2 The RIM2 has two dual-channel 8-Gbps Fibre Channel ports (Port A and
Port B), which can be used to provide connections to two separate Fibre
Channel arbitrated loops or fabrics. The two ports can also be used to
provide redundant control paths to the robotics from a single Fibre
Channel arbitrated loop or fabric.
Controller failover can be configured using a second RIM2.
The USB ports (4) can be used to connect a USB device for updating the
RIM2 during a library package update.
Notes:

• The Ethernet ports on the RIM2 are reserved for future use.
• The CAN port, RS-232 port, and monitor port on the RIM2 are for
troubleshooting only.

RIM The RIM has two dual-channel 4 or 2-Gbps Fibre Channel ports (Port A
and Port B), which can be used to provide connections to two separate
Fibre Channel arbitrated loops or fabrics. The two ports can also be used
to provide redundant control paths to the robotics from a single Fibre
Channel arbitrated loop or fabric.
Controller failover can be configured using a second RIM.
Notes:

• The Ethernet port on the RIM is reserved for future use.
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Controller Description

• The Diag port on the RIM is for troubleshooting only.

Tape Drive (LTO-5
and later
generation)

The commands to control the motion of the robotics within the partition
are sent from the host to the exporting drive’s logical unit number 1 (LUN
1). The motion control commands are then routed to the robotics using the
exporting drive’s Automation/Drive Interface (ADI).

Tape Drives

The library supports LTO-4 and later generation Fibre Channel full-height drives, LTO-7 and
and later generation half-height Fibre Channel and SAS drives (not shown), TS11xx technology
drives, and T10K drives (not shown). The drives are mounted in drive sleds, which are
installed in DBAs in the main and drive expansion frames. Each DBA can accommodate up to
four drives. Drives are hot-swappable to provide uninterrupted operation.

Notes: l Beginning with BlueScale12.8.03, the library supports half-height LTO-7 and later
generation, Fibre Channel and SAS drives in full-height drive sleds.

l To prevent issues with transporter position calibration, do not put labels on the front
face of drives.

Figure 15 The LTO-5 and later
Fibre Channel drive sled.

Figure 16 The LTO-4 Fibre
Channel drive sled.

Figure 17 The TS11xx
technology drive sled.

The following table describes the drive components.

Component Description

Drive Sled The drive sled provides the electrical and logical connections to the
library, as well as the connections to the host Fibre Channel arbitrated
loop or fabric.
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Component Description

The drive sled firmware assigns an identifier to the drive based on
its location in the library (see Drive Identifiers on page 71). This
identifier is used to identify the drives in the BlueScale and XML
interfaces.

See Drive Connectivity on page 78 for additional information about
the Fibre Channel connectivity provided by the drive sled.

Fibre Channel
Connectors

Each Fibre Channel drive sled has two multi-mode optical SFP LC
connectors (Port A and Port B) that are used to connect the drive
directly to a Fibre Channel network. The two ports let you connect
two separate fiber optic cables to each drive.

Note: For half-height drives in a full-height sled, only port A is available.

SAS Connector Each SAS drive sled has a single, unshielded, single-port SFF-8088 serial
connector that provides the Serial Attached SCSI (SAS) connectivity for
the drive.

Status LED Indicates the operational status of the drive sled (not the drive).
• Flashing green — The drive sled is functioning normally.
• Flashing red/orange — The drive sled has experienced an error.
• Alternating flashing green and red/orange (LTO-5 and later
generation drives)— The drive is ready for replacement.

• Flashing red (LTO-4 and earlier generation drives) — The drive
is ready for replacement.

Drive Power LED
(TS11xx technology and
LTO-5 and later
generation drives)

Indicates if the drive is powered on.

Lock Release The drive sled automatically locks into place when it is installed in
the DBA to keep it from being accidentally pulled out of the library.
The lock release disengages the lock.

Ethernet and USB Ports
(TS11xx technology
and LTO-5 and later
generation drives)

These ports are typically unused, however, they may be used by
service personnel to perform drive firmware updates.

For more information about the drives in the library, see:

• LTO Ultrium Tape Drives on page 21 for a list of documents that provide information that
is applicable to all IBM LTO tape drives.

• TS11xx Technology Drives on page 21 for a list of documents that provide information that
is applicable to TS11xx technology drives.
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• StorageTek T10000 Drives on page 21 for a list of documents that provide information that
is applicable to T10K drives.

• Creating a Storage Partition on page 199 for information about creating storage partitions
that use the drives.

• LTO Tape Drive Specifications on page 589 for information about the transfer rates and
storage capacities of LTO drives.

• TS11xx Technology Tape Drive Specifications on page 594 for information about the
transfer rates and storage capacities of TS11xx technology drives.

• Component Interface Connectors on page 586 for cabling requirements for host connections
to the drives.

BlueScale Vision Camera

The BlueScale Vision camera lets you view the interior of the library while it is operating. The
main frame usually contains a camera. In multi-frame libraries, additional cameras can be
installed in the expansion frames to provide monitoring of the entire library. Each camera can
view the interior of the frame where it is mounted and a portion of one frame to either side.

Figure 18 White BlueScale Vision
camera.

Figure 19 Black BlueScale Vision
camera.

The BlueScale Vision camera is mounted at the top rear of a frame. The camera lets you
observe import and export operations, tape mounts, cartridge moves, and robotic operations in
real time. The ability to view the interior of the library without removing the side panels
provides an additional level of monitoring for your library.

Notes: l The LED lights mounted at the top of each frame provide illumination for the camera.

l The library must be powered-down to replace the BlueVision camera.

For information about using the BlueScale Vision camera, see Use the BlueScale Vision Camera
on page 180.
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TERAPACK CARTRIDGE HANDLING

The library optimizes space usage by storing media on horizontal shelves. This horizontal
storage provides very high density by using space within the library instead of the limited
space provided by the vertical library walls. Each horizontal shelf is divided into multiple
equal-sized media storage chambers. Each chamber accommodates a single TeraPack
magazine.

The library uses TeraPack magazines to import and export cartridges through the TAPs and to
store cartridges inside the library. Each magazine holds up to ten LTO cartridges or nine
TS11xx technology or T10K cartridges. The magazine has guides along each side and grooves
on the bottom to ensure proper alignment when it is inserted into the TAP.

Figure 20 TeraPack magazine with barcode labeled cartridges and
plastic dust cover (LTO shown).

Storing and handling cartridges in TeraPack magazines helps eliminate errors resulting from
mishandling individual tapes, which is the leading cause of tape damage. When inside the
library, TeraPack magazines are stored in semi-enclosed chambers. When not in the library, an
optional clear plastic dust cover snaps onto the magazine to protect the cartridges. The
cartridges are continually protected by the TeraPack magazine, both inside and outside of the
library.

Using TeraPack magazines offers the following advantages:

• Barcode labeling All of the cartridges in a TeraPack magazine, as well as the magazine
itself, are barcode labeled for easy identification.

• Grouped media The cartridges in a TeraPack magazine are treated as a single unit during
import and export operations. This grouped media handling simplifies media management
tasks by eliminating the need to import or export cartridges one by one.
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LIBRARY EXPANSION AND UPGRADES

The TFinity library is designed to transform and expand to meet a data center’s changing
storage requirements, as well as to achieve storage consolidation goals. See Media & Upgrades
on page 559 for additional information.

Capacity on Demand (CoD)

The library’s capacity-on-demand feature (CoD) lets you purchase a library that suits your
current needs and then purchase additional capacity later as required. CoD reduces up-front
costs, because you only pay for what you currently need. As more capacity is required, it can
be added in increments by purchasing activation keys to license additional chambers in the
library. You can then import additional TeraPack magazines to fill the licensed chambers.

Modular Expansion

The modular design makes it possible to increase media storage capacity or number of drives
in the library to meet storage and performance needs as they evolve within an organization.
From the basic three-frame TFinity library configuration, additional expansion frames can be
added to increase the tape slot and drive capacities. See Drive, Media, and Service Frames on
page 68 for more information.
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CHAPTER 2 - ARCHITECTURE OVERVIEW
The TFinity library is designed to provide maximum flexibility and ease of use in an
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MEDIA POOLS

Inside the library, magazines, and the cartridges they contain, are logically grouped through
the use of pools. These pools are made up of chambers, each of which accommodates a single
magazine. The library has three different types of pools: the free pool, one or more entry/exit
pools, and one or more storage pools. Figure 21 on page 64 shows how the entry/exit and
storage pools are related to partitions in the library.

Free pool

Chambers that are not assigned to a partition are in the free pool. These chambers can be
assigned to a storage partition or a cleaning partition. The chambers in the free pool cannot be
accessed through the BlueScale user interface or the storage management software until they
are added to a partition.

Entry/Exit pool

The chambers in a storage partition’s entry/exit pool provide an interim storage location for
cartridges during import and export operations. Together, the entry/exit pool and the TAP
function as a configurable entry/exit port for the library.

You specify the number of entry/exit pool chambers when you create a storage partition.
Cleaning partitions do not have an entry/exit pool.

IMPORTANT

The host storage management software cannot use the cartridges in the
entry/exit pool for backup jobs. However, the storage management software
can access the cartridges stored in the entry/exit pool to move them into the
storage pool.

A cartridge is in the entry/exit pool for one of the following reasons:

• It was ejected from the storage pool by the storage management software or moved
manually using the BlueScale user interface. To remove the cartridges from a library, the
operator uses the library’s BlueScale user interface to initiate the export process.

• A magazine containing one or more cartridges was imported into the library using the
TAP. From the entry/exit pool, the cartridges can be imported into the storage partition’s
storage pool either by the storage management software or manually through the BlueScale
user interface.

• A magazine containing one or more special-purpose cartridges was imported into the
library using the TAP. These cartridges may be used for cleaning a drive using the DLM
Drive Test feature, or for updating drive firmware using a code load tape.
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Storage pool

The chambers in a storage partition’s storage pool provide the cartridge storage for a partition.
You specify the number of chambers assigned to the storage pool when you create a partition.
See the next section, Library Partitions, for detailed information about how the storage pool is
used in partitions.

• Each storage partition has its own storage pool containing at least one chamber. The
cartridges in the storage pool are available for use by the host storage management
software that accesses the partition.

• A cleaning partition has at least one chamber in its storage pool and can be shared by
multiple storage partitions if they all use the same type of cleaning cartridge. The cleaning
cartridges stored in the cleaning partition are only accessible when the library is configured
to use the Auto Drive Clean feature. They are not accessible to the storage management
software.
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LIBRARY PARTITIONS
Partitions divide the library logically so that it appears as one or more physical libraries—one
library per configured partition. Partitioning simplifies storage consolidation through the
creation of virtual libraries, each with its own drives and media. Each partition:

• Has exclusive access to the tape drives and media storage assigned to it.

• Can control the TeraPorter(s) to move media within the partition.

The library supports two types of partitions, storage partitions and cleaning partitions. You
can configure a maximum of 16 partitions using the maximum number of physical controllers
noted below. One or more cleaning partitions can be configured in a single library. A single
cleaning partition can be associated with multiple storage partitions. Cleaning partitions do
not count against the storage partition maximum.

Notes: l Libraries running BlueScale software versions earlier than BlueScale12.6.3, are limited
to eight storage partitions.

l A tape drive can only provide the control path for one partition. A RIM can provide the
robotic control path for up to eight partitions. A RIM2 can provide the robotic control
path for up to 16 partitions.

l With BlueScale12.7.01 through BlueScale 12.8.01.04, the maximum number of
exporters (RIMs) supported by the library is six.

l With BlueScale12.8.07 and later, the library supports 12 RIM exporters and 48 drive
exporters.

l The more partitions in a library, the longer each move can take. You may need to
increase the timeout setting in your storage management software.

l Spectra Logic recommends using a direct-attached drive as the exporting controller for
a partition unless you need to configure the partition for media zoning, which is used
by software packages such as High Performance Storage System (HPSS) and HPE Data
Management Framework (DMF).

Figure 21 shows a conceptual illustration of a library configured with two storage partitions
and a shared cleaning partition. Each storage partition has an entry/exit pool and a storage
pool.

Note: Library elements in Figure 26 have been organized for ease of comprehension. See Main and
Drive Expansion Frame Rear Components on page 34 for the correct location of library
components.
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Figure 21 A library with two storage partitions and one shared cleaning
partition.

Storage Partitions

Overview

The library requires, at a minimum, one storage partition. This is the default configuration.
Each storage partition must have at least one drive and one chamber in its storage pool. Drives
and chambers can only be assigned to one storage partition at a time; they cannot be shared by
multiple partitions.

When additional partitions are needed, the library uses Shared Library Services (SLS)
virtualization technology to create the additional partitions. SLS support is an option you can
add to the library by purchasing an activation key from Spectra Logic.
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In some environments, using multiple storage partitions is crucial to data center efficiency and
growth. For example, multiple partitions are extremely useful in the following situations:

Multiple Storage Management Software Packages

If groups within your company use different storage management software packages, each
software package requires its own dedicated library. Instead of maintaining multiple physical
libraries — one per backup package — the data center can use a single Spectra Logic library
with multiple partitions, in which each partition appears to the software as a dedicated
library.

Multiple Databases

If your company uses multiple databases, partitioning the library preserves the backup
processes associated with each type of database.

Multiple Drive Generations

If your data center uses multiple generations of LTO drives, Spectra Logic strongly
recommends configuring separate partitions for each generation to ensure read/write
compatibility between the drives and cartridges.

Shared Resources

If each department in the company must keep their data segregated, partitioning the library
supplies this segregation, as well as the subsequent integrity of the data set. Each partition can
only access the drives and cartridge locations assigned to it. Data from other partitions cannot
become intermixed with the data stored on the media in the partition’s inventory.

Multiple Drive Technologies

If your data center uses a combination of LTO, TS11xx technology, and T10K drives, then the
drives, magazines, and cartridges associated with each drive technology must have their own
partition.

Encryption

If you want to encrypt some, but not all of your backup data, you can partition the library into
an encryption partition and non-encryption partition to segregate the two types of data.

Cleaning Partitions and Auto Drive Clean
Overview

The cleaning partition provides permanent storage for cleaning cartridges inside the library
when the Auto Drive Clean feature is enabled. This special-purpose partition does not have an
entry/exit pool or any drives associated with it. A single cleaning partition can be shared by
multiple storage partitions.
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Auto Drive Clean uses the cleaning cartridges in the cleaning partition to provide library-
based cleaning of drives with minimal user intervention. Automated drive cleaning results in
fewer failed tape read/write operations and is the preferred method for cleaning drives.

Drives in a partition with Auto Drive Clean enabled are cleaned no more than once in any 12
hour period. The library posts a message if an Auto Drive Clean does not occur because of the
12 hour restriction. If you want to clean the drive immediately, you can initiate a manual
cleaning.

Note: Software-initiated drive cleaning operations cannot use the cleaning cartridges stored in a
cleaning partition; the cartridges are not accessible to the storage management software.

Requirements

The Auto Drive Clean feature requires a cleaning partition to be associated with the storage
partitions that contain the drives you want to clean. Cleaning partitions are created separately
and then assigned to one or more storage partitions (see Creating a Cleaning Partition on
page 196 and Allocate Chambers and Drives on page 208).

Cleaning cartridges used in a cleaning partition must be stored in specially labeled
Maintenance TeraPack magazines. The cartridges themselves must be identified with “CLN”
at the beginning of the barcode on their labels. The library prevents you from importing
cleaning cartridges and magazines that are not properly labeled into a cleaning partition.

Auto Drive Clean Operation

The drives that are in a storage partition with an associated cleaning partition are cleaned
automatically when cleaning is required. When a drive is unloaded in response to a host
request and the data cartridge is moved to its storage location, the library queries the drive to
determine if it needs cleaning. If cleaning is required, the library delays notifying the host that
the SCSI move command for the unloaded data cartridge is complete while it performs an
automatic drive cleaning.

During the delay, the library retrieves a cleaning cartridge from the cleaning partition and
inserts it into the drive. When the cleaning is complete, the library returns the cleaning
cartridge to the cleaning partition and notifies the host that the SCSI move command for the
unloaded data cartridge is complete. The library then posts a system message that the cleaning
was successful.

In addition to automatic cleaning, you can use the BlueScale user interface to initiate a manual
cleaning operation using a cleaning cartridge stored in the cleaning partition. Only drives in a
storage partition that has an associated cleaning partition can be cleaned using this method.
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Expired Cleaning Cartridges

When an expired cleaning cartridge is loaded into a drive, it is immediately ejected without
attempting the cleaning. The library flags the cleaning tape as expired and generates system
messages to notify you of the expired cleaning tape and the failed drive cleaning. It marks the
cleaning cartridge as expired in its inventory and does not attempt to use it for subsequent
cleanings. These cartridges have an “x” next to the slot number when viewed on the Inventory
screen.

If the cleaning partition contains another, good cleaning cartridge, a cleaning that failed
because the cleaning cartridge is expired is reattempted the next time the host unloads a data
cartridge from the drive.

MLM Tracking of Cleaning Cartridges

When you enable the BlueScale Media Lifecycle Management (MLM) feature and use MLM-
enabled cleaning cartridges, the library stores usage information, including the number of
cleans remaining and the cartridge health (good, near expiration or expired), in the MLM
database. This information is retained in the MLM database even when a cleaning cartridge is
exported from the library.

When a cartridge is nearing the end of its useful life, the library notifies you so that you can
replace the cartridge. This early notification helps prevent failed cleanings resulting from
using an expired cleaning cartridge.

The library does not store any information about non-MLM cleaning cartridges in the MLM
database. However the library does mark an expired cleaning cartridge and does not attempt
to use it again as long as it remains in the library. If an expired non-MLM cartridge is
exported and then reimported into the library, it is identified as expired the next time it is
loaded into a drive.

Note: Starting with BlueScale12.7.04, TS11xx technology cleaning tapes are always treated as MLM
enabled by the BlueScale software.

See Configuring and Using Media Lifecycle Management on page 301 for detailed information
about MLM.
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DRIVE, MEDIA, AND SERVICE FRAMES

The TFinity library’s modular design makes it possible to increase media capacity or the
number of drives in the library to meet storage and performance needs as they evolve. The
minimum configuration TFinity library consists of three frames: the main frame and two
isolating (standard or bulk TAP) service frames or two non-isolating media expansion frames
(see Service Frames on page 41). A mix of media and drive expansion frames can be added for
a maximum total of 44 frames. The frames are positioned to provide the most efficient
configuration based on the site requirements. The service frames, bulk TAP service frames, or
non-isolating media expansion frames are always located at the outside ends of the library.

The following table shows the number of media storage chambers and drives in each type of
frame in the TFinity library.

Frame Type Description
Number of
Chambers for LTO
Frame a

Number of
Chambers for
TS11xx technology,
T10K, or Mixed
Media Frame b

Number of Drives

Main c Contains:
• the operator
panel

• the center TAP
assembly with
two chambers

• the LCM
• an RCM
• RIMs
• An EtherLib
switch
(optional)

• power supplies
• drives in either
three or six
DBAs

• 92 chambers
with 3 DBAs
and 3 TBAs

—OR—

• 80 chambers
with 6 DBAs

• 78 chambers
with 3 DBAs
and 3 shelves
installed

—OR—

• 66 chambers
with 6 DBAs

• From 1 to 12
drives with
3 DBAs

—OR—

• From 1 to 24 
drives with
6 DBAs

aA single magazine is stored in each chamber. Each magazine contains 10 slots for LTO cartridges.

bA single magazine is stored in each chamber. Each magazine contains nine slots for TS11xx technology or T10K cartridges.

cThe TAP cannot be used for magazine storage.
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Frame Type Description
Number of
Chambers for LTO
Frame a

Number of
Chambers for
TS11xx technology,
T10K, or Mixed
Media Frame b

Number of Drives

• chambers for
magazine
storage

Drive
expansion

Contains:
• an RCM
• RIMs
• power supplies
• drives in either
three or six
DBAs

• chambers for
magazine
storage

• 101 chambers
with 3 DBAs
and 3 TBAs

—OR—

• 89 chambers
with 6 DBAs

• 87 chambers
with 3 DBAs
and 3 shelves
installed

—OR—

• 75 chambers
with 6 DBAs

• From 1 to 12
drives with
3 DBAs

—OR—

• From 1 to 24 
drives with
6 DBAs

Media
expansion c

Contains:
• chambers for
magazine
storage

• 130 chambers d • 110 chambers e None

Service or
bulk TAP
service f

Contains:
• a service bay
for TeraPorter
maintenance

• power supplies
• an SCM
• chambers for
magazine
storage

• 50 chambers • 42 chambers None

aA single magazine is stored in each chamber. Each magazine contains 10 slots for LTO cartridges.

bA single magazine is stored in each chamber. Each magazine contains nine slots for TS11xx technology or T10K cartridges.

cIncluding non-isolating service frame configurations.

dFor a non-isolating service frame, 52 chambers are in the exclusion zone. See Service Frames on page 41.

eFor a non-isolating service frame, 44 chambers are in the exclusion zone. See Service Frames on page 41.

fThe bulk TAP service frame also includes a bulk TAP carousel with 14 chambers. The TAP carousel cannot be used for magazine
storage.
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COMPONENT IDENTIFIERS

The library’s BlueScale user interface and the XML command interface use component
identifiers for each drive and RIM. These identifiers also appear in system messages. The
component identifier is based on the component’s location relative to the frame and drive bay
assembly (DBA) where it is installed.

Figure 22 shows the relationship between the DBAs and the locations of the drives and RIMs
in the main frame. The relationships are the same in each drive expansion frame.

Notes: l DBAs are numbered from the bottom up, with DBA 1 being the bottom-most.

l Drives are numbered from left to right and bottom to top in a DBA, as viewed from the
back of the library. Each DBA can hold up to four full-height drives.

l If the frame contains 3 DBAs, DBAs 3, 4, and 5 become TBAs or shelves.

Figure 22 The relationship between the DBA, drive, and RIM locations and
their identifiers in the BlueScale interface and XML interfaces.
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RIM Identifiers

RIMs can be installed in any controller bay in the main frame or drive expansion frames. The
component identifier for a RIM is based on its location relative to the frame and the DBA
where it is installed.

The component identifier for a RIM is shown as FRx/DBAx/F-QIPn, where:

• FRx is the number of the frame from left to right when viewed from the front of the library.

• DBAx is the number of the DBA where the RIM is installed (see Figure 22 on page 70). The
main frame and each drive expansion frame accommodates from three to six DBAs.

• F-QIPn is the interface type (Fibre Channel) of the RIM and the number of the controller
bay where it is installed. Because each DBA contains only one controller bay, n is always 1.

Note: The component identifier for a RIM shows it as an F-QIP. For example, Figure 23 shows the
component identifier for the RIM installed in DBA 1 in Frame 2 (FR2/DBA1/F-QIP1) on the
Controllers screen. The device descriptor (2-Gbps FC RIM) indicates that the controller is a
RIM.

Figure 23 The Controllers screen showing the component
identifier for a RIM.

Drive Identifiers

The firmware in the drive sled that houses each drive assigns an identifier to the drive based
on its location in the library. This identifier is shown in the BlueScale user interface and is
used in the XML command interface. The identifier is also used to generate the World Wide
Name (WWN) that the library reports for the drive (see World Wide Names for Fibre Channel
Drives on page 78). Because the identifier is location-based, it remains constant even if the
physical drive is replaced by a new drive. The new drive assumes the location-based
identifier.

The component identifier for each drive is based on its location relative to the frame and the
DBA where it is installed, as viewed from the back of the library (see Figure 22 on page 70).
The component identifier for a drive is shown as FRx/DBAx/fTYPE-DRVx, where:

• FRx is the number of the frame from left to right when viewed from the front of the library.
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Note: The Drives screen allows you to select whether to display the physical frame location or the
logical frame location (see Monitoring Drive Health Using DLM on page 354 for more
information). All other screens display the physical frame location.

• DBAx is the number of the DBA containing the drive.

• xTYPE is the interface (x= f for Fibre Channel and s for SAS) and drive type (LTO for an
LTO drive, TS11xx for a TS11xx technology drive, or T10K for a T10K drive).

• DRVx is the number of the drive bay in the DBA, as viewed from the back of the library.

For example, Figure 24 shows the component identifier for a Fibre Channel LTO drive
installed in drive bay 1 of DBA 1 in Frame 5 (FR5/DBA1/fLTO-DRV1) on the Drives screen.
The Drive Type descriptor indicates that the drive is an IBM LTO-6 Fibre Channel drive.

Figure 24 The Drives screen showing the component
identifier for a drive.

JUNE 2025 72 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 2 - ARCHITECTURE OVERVIEW



FIBRE CHANNEL CONNECTIVITY

The library’s TeraPorter(s) (the robotics) and the library’s drives connect to the host system
over a Fibre Channel arbitrated loop or fabric, or a SAS fabric. These connections carry two
types of information:

• The commands from the storage management software that control the TeraPorter motion
and the read/write operations of the drives.

• The data being transferred to and from a drive by the host.

The following sections describe the connectivity for the library’s TeraPorter(s) and the drives.

TeraPorter Connectivity

Note: From the host perspective, both single TeraPorter libraries and dual TeraPorter libraries
contain a single TeraPorter. The library manages the two TeraPorters in a dual TeraPorter
library to provide the most efficient operation.

The TeraPorter(s) require a RIM to provide the robotic control path. When configuring a
storage partition, the RIM you select to provide the robotic control path is referred to as the
“exporting controller” for the partition. The exporting controller makes the partition accessible
to the hosts as a media changer (a library). It receives the media changer commands sent from
the host to the library and relays them to the RCM, which in turn processes them into the
motion commands used to control the robotics.

You can select multiple exporting controllers (RIMs) for a partition and use your host software
to either export the same changer interface over the controllers to provide redundancy, or
send multiple moves to the partition which are analyzed by MediaIQ so that the moves are
processed in the most efficient way.

Control Path Through a Direct-Attached Drive

In a direct-attached drive configuration, one or more drives in a storage partition are
designated as the exporting drive (also know as the exporting controller). The commands from
the host to control the motion of the robotics within the partition are routed to the exporting
drive’s logical unit number 1 (LUN 1). Commands to control the operation of the exporting
drive are sent from the host to LUN 0 of the drive.

Notes: l Using a drive to provide the robotic control path for a partition is supported in
BlueScale12.6.3 and later.

l If you have multiple storage partitions, you must designate an exporting drive for each
partition.

l A drive can only provide the robotic control path for the partition to which it is
assigned.
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l You can select multiple drives as controllers, and export the same changer interface
over the drives to provide redundancy, as long as your storage management software
can support this. These multiple paths cannot be used at the same time.

l Assigning multiple drive exporters to one partition reduces the total number of
partitions that can be configured in the library.

Figure 25 shows an example of a partition with two Fibre Channel drives providing the
robotic control path. LUN 1 on the drives provides the robotic control path over which the
commands to the robotics are received from the host.

Figure 25 An example of a partition with two direct-attached Fibre Channel drives providing
the robotic control path.

Control Path Through a RIM

A RIM provides the bridge between the external Fibre Channel interface from the host and the
internal interface used by the library to communicate with the TeraPorter(s).
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A RIM can support up to eight partitions; a RIM2 can support up to 16 partitions. Each
partition has full control of the robotics. For example, if the library contains two partitions, a
single RIM can provide the robotic control path for both partitions.

If the library contains two RIMs or two RIM2s it can be configured to use the BlueScale
Controller failover feature. This feature configures the two controllers as a failover pair to
provide a redundant control path to the TeraPorter(s) (see Controller Failover on page 80 for
additional information).

If desired, you can configure multiple RIMs as exporters for the same partition and use your
host software to either export the same changer interface over the RIMs to provide
redundancy, or send multiple moves to the partition, which are analyzed by MediaIQ so that
the moves are processed in the most efficient way.

Figure 26 shows an example of a partition with Fibre Channel drives and a RIM. Port A on the
RIM provides the robotic control path over which the commands to the TeraPorter(s) are
received from the host.

Figure 26 An example of a RIM in a partition with direct-attached Fibre
Channel drives.
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World Wide Names for Partitions
The World Wide Name (WWN) displayed for each partition on the Shared Library Services
screen is the WWN of the controller (RIM) that provides the robotic control path for the
partition (the exporting controller). The WWN is based on the physical location of the RIM in
the library and remains constant even if the RIM is replaced. The new RIM assumes the
location-based WWN.

Note: If multiple exporting controllers are configured in a partition, there are multiple WWNs for the
partition. Click Summary to display the Partition Settings screen, which lists all of the WWNs.

Figure 27 The WWN assigned to the partition.

• The partition WWN is the World Wide Node Name (WWNN) for the exporting controller.
• If multiple partitions use the same Fibre Channel port on the RIM, all of the partitions have
the same WWNN and the same World Wide Port Name (WWPN). However, the partitions
will have different LUNs under those controllers, starting at LUN zero (0).

• If you create two partitions and configure one partition to use Port A and another to use
Port B, the WWNN/WWPN of port A will start with 21 and the WWNN/WWPN of port B
will start with 22. In this case the ports are independent. However, both of the partitions
will show the WWN for Port A only.

• If you export the same partition out both port A and port B on a RIM, the WWNN will be
the same for both ports but the WWPN will be different. This scenario is a type of
redundant path to the robotics.

• For more information about WWNs, log on to the portal (see Accessing the Technical
Support Portal on page 534), open the Knowledge Base, and in the KBA field, enter 01764
to access the article Spectra Library World Wide Names (WWNs) for QIPs (the article discusses
F-QIPs; the concepts are the same for a RIM).

For Partitions with a Drive or Drives as the Exporting Controller
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• The partition WWN is the same as the WWN for the drive. The commands to control the
motion of the robotics within the partition are sent from the host to the exporting drive’s
logical unit number 1 (LUN 1). Commands to control the operation of the exporting drive
are sent from the host to LUN 0 of the drive.

• See World Wide Names for Fibre Channel Drives on the next page for more information
about WWNs for drives.

Fibre Channel Port Configurations

One or both of the external ports on the exporting controller can be used to provide the
network connectivity for the library partitions.

Single Port Connectivity

The simplest configuration uses a single library partition and only one of the interface ports on
the exporting controller. This configuration works well when only a single host is connected to
the library.

Figure 28 Single port network connectivity to the
exporting controller.

Dual-Path Connectivity

A slightly more complex configuration uses both interface ports on the exporting controller
with each connected to a different library partition. Each port is used as an independent
communications path. From a host perspective, each port is viewed as a unique, independent
path to a partition. The two ports can be connected to the same or possibly different storage
area networks (SANs). The library processes the motion commands and relays them to the
partitions in the order that they are received. This is a way to provide limited visibility
between the partitions. If you have more than two partitions you can use additional
controllers to provide additional isolation between partitions.

Dual-Port Connectivity

As an alternative to the configurations that use a single port for each partition, dual-port
configurations use both interface ports as a single communications path to the same partition.
The ports can be connected to the same or different SANs. The hosts on the network can use
either port to communicate with the robotics. A dual-port configuration allows a host to have
an alternate, redundant, path to reach the partition. Not all host software can support this type
of configuration.

Notes: l The two ports cannot be used simultaneously.
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l This type of configuration cannot be used in combination with the Controller Failover
feature (see Controller Failover on page 80).

Figure 29 Examples of a dual-path and dual-port
configurations.

Drive Connectivity

The drives in the library have either a Fibre Channel interface or a SAS interface.

Fibre Channel drives connect directly to the host using a Fibre Channel arbitrated loop or
fabric. Figure 26 on page 75 is a simple representation of how the robotics and direct-attached
Fibre Channel drives are connected directly to a Fibre Channel SAN through a switch or hub.

Note: When connecting Fibre Channel drives to an arbitrated loop, keep in mind that all of the
drives on an arbitrated loop must share the data transfer capacity (bandwidth) of the
interface. Having multiple devices on the same loop can negatively impact the performance of
all the devices.

Serial Attached SCSI (SAS) drives connect directly to a SAS HBA.

World Wide Names for Fibre Channel Drives

As part of providing network connectivity, the drive sled firmware assigns a location-based
WWN for the drive it houses. This WWN is displayed on the Drive Details screen and can be
used by the host software to address the drive. Because this WWN is location-based, it
remains constant even if a drive is replaced by a different one of the same type. The new drive
assumes the location-based BlueScale identifier and WWN.

Note: The WWN displayed on the Drive Details screen is actually the WWPN for port A on the drive
sled. The WWPN for port B is the same as the one for port A except that the second digit from
the left is 2 instead of 1.
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Figure 30 The WWN assigned to a Fibre Channel drive.
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HIGH-AVAILABILITY CONFIGURATIONS

In high-availability enterprise environments, keeping the library operating even in the event of
a network connection failure or component failure is extremely important. The following
sections describe the high-availability features of the TFinity library.

Redundant Connectivity

In a high-availability environment, the ability to maintain communications between the host
systems and the library and its drives in the event of a connection failure is essential.

• The library can be configured to use two RIMs or two RIM2s and the BlueScale Controller
Failover feature to provide redundant connectivity to the media changer functionality of
the library. See Configure Controller Failover on page 139 for information about
configuring controller failover.

IMPORTANT

The controllers must be running the same firmware version. If you install the
second controller after you update the BlueScale software, the BlueScale
versions for the two controllers may be different. Update the BlueScale
software as described in Updating the BlueScale Software and Library
Firmware on page 471 to correct the reported firmware mismatch.

• Alternatively, multiple RIMs in a partition can be configured either to export the same
changer interface to provide redundancy, or to send multiple moves to the partition which
are analyzed by MediaIQ so that the moves are processed in the most efficient way.

• The servers and Fibre Channel switches used to access the direct-attached Fibre Channel
drives in the library can use failover software to provide redundant connectivity through
the two Fibre Channel ports on each full-height drive.

Controller Failover

The BlueScale Controller Failover feature uses two RIMs or two RIM2s that are configured as a
failover pair. One RIM in the pair is the primary controller and the other is the secondary
controller. From the host perspective, the primary controller is the only controller present. The
secondary controller is not visible to the host.

Note: You cannot mix a RIM and a RIM2 in failover pair.

Figure 31 shows a simplified view of how the failover pair operates. Port A on each controller
in the pair is connected to the same Fibre Channel switch. Both ports have the same
configuration, except that the primary operates in target mode and the secondary is not active.
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Figure 31 Paired RIMs configured to provide failover
redundancy.

During normal operation, the active Fibre Channel port (port A) on the primary controller
receives and processes the media changer commands sent from the host. The active port on
the secondary controller does not receive or process the media changer commands from the
hosts.

Note: The paired ports on each controller can be connected to separate SANs and used
simultaneously. A failure of the primary controller causes both connections to failover to the
secondary controller.

The two controllers use the library’s internal communication bus to monitor each other and to
maintain a cache of the library’s inventory database.

A failover event occurs when the secondary controller detects that the primary controller is no
longer communicating on the library’s internal communication bus. After sending a query to
the primary controller to confirm that it is no longer communicating, the secondary controller
takes over the exact configuration of the primary controller and begins receiving and
processing the media changer commands sent from the host.

IMPORTANT

Only the secondary controller (acting as primary) is functional after the
failover. A failure on this controller disrupts communications with the hosts.
Troubleshoot the cause of the failover and reconfigure Controller Failover as
soon as possible.
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BlueScale Controller Failover allows backups to continue in the event that library
communication to the primary controller is disrupted. Because both controllers are connected
to the same Fibre Channel switch and maintain a synchronized image of the library’s
inventory database, the failover occurs without manual intervention. You can then
troubleshoot the failed controller at your convenience.

After you resolve the problem, the controller that originally caused the failover becomes the
secondary controller in the failover pair. The failover pair reverts to the original
primary/secondary relationship the next time the LCM restarts.

The BlueScale Controller Failover feature only affects the operation of the library’s controllers.
Controller Failover does not detect if the controller is accessible by the host. To take advantage
of the feature, the host must be configured to retry failed commands. This ensures that
commands that fail when the library connection to the primary controller is disrupted get re-
issued after the connection to the secondary controller is established. The retry timing must be
configured to allow for the time lag inherent in the process of disabling the host’s connection
to the primary controller and enabling the connection to the secondary controller.

Exporting Controller Redundancy

As an alternative to controller failover, you can select multiple RIMs as controllers for a single
partition, and export the same changer interface over them to provide redundancy, as long as
your data storage software can support this.

Note: If your data storage software uses multiple paths at the same time to send multiple moves to
the partition, MediaIQ will analyze the moves and process them in the most efficient way. This
does not provide redundancy.

Drive Connectivity Failover

The full-height Fibre Channel drives used with the library are equipped with two Fibre
Channel ports. The two Fibre Channel ports cannot be used simultaneously to provide
redundant data paths between the hosts and the drive. However, they can be used to provide
failover capability in the event that communication to the port currently in use is interrupted.
This failover can be accomplished several ways, including:

• Manually disconnect the fiber optic cable from the failed port and connect it to the other
port. You may need to reconfigure your host software to recognize the alternate port.

• Connect each port on the drive to a separate Fibre Channel HBA in the host. You can also
use a dual-port Fibre Channel HBA. Configure one HBA (or HBA port) as the primary
connection and the other HBA (or HBA port) as the failover connection. Install failover
software on the host computer to control the transfer of I/O from one HBA to the other in
case of a failure. You may also need to configure your storage management software to
correctly recognize both ports. Refer to your failover software, HBA, and storage
management software documentation for instructions.
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Note: Tape drives sold by Spectra Logic do not support MPIO.

Robotics Failover

The standard library configuration includes dual robotic TeraPorters. During normal operation
in a two TeraPorter library, each TeraPorter operates independently. The library’s BlueScale
software manages the TeraPorters to ensure that they perform as efficiently as possible and do
not interfere with each other.

In the event that one of the TeraPorters experiences a problem, it automatically moves into
service position, either in the service bay of a service frame or in the exclusion zone of a right
or left media expansion frame, and the other TeraPorter takes over all media move operations.
In the event that the malfunctioning TeraPorter is unable to move itself into its service
position, the other TeraPorter pushes it into position.

Note: Starting with BlueScale12.8.04, a non-isolating service frame configuration is available that
replaces the right and left service frame with media expansion frames. This provides more
storage slots at a lower cost, but means that some slots may be inaccessible if a TeraPorter is
in the service position.

Global Spare Drives

The BlueScale Global Spare feature provides a way to remotely substitute an available TS11xx
technology or Fibre Channel LTO-4 or later generation drive in the library for a failed drive of
the same type. The feature lets you configure an installed drive as a designated spare for other
drives in the library. This drive can then be substituted for a failed drive in any partition that
is configured to use the Global Spare drive. When a drive fails, you simply log into the
BlueScale web interface from any location, select the Global Spare option for the failed drive,
and continue normal operations. You can then physically replace the failed drive at your
convenience. See Assign Global Spare Drives on page 206 and Using a Global Spare Drive on
page 433 for more information.

Note: Global Spare drives are not supported for SAS drives.

Redundant Power Supplies

The library requires 5/12 VDC power supplies to power the drives in DBAs. There are two
different power supplies available depending on the age and configuration of the library (see
5/12 VDC Power Supply Modules on page 38 for more information). The number of supplies
required by a library is calculated by Spectra Logic based on the number and type of drives in
the library. Extra supplies provide redundancy and failover protection. The supplies can be
mixed in a power control module and older supplies can always be replaced by a newer
supply. However, newer supplies cannot always be replaced by an older supply. Contact
Spectra Logic Technical Support (see Contacting Spectra Logic on page 18) for more
information.
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The library main frame requires one 24 VDC power supply to provide power for the library
robotics, motors, fans, and interior LED panels. An additional 24 VDC supply can be installed
to provide redundancy.

The main frame and each drive frame have both a primary and a secondary AC power input.
When using a redundant AC power configuration, each input for a frame is connected to a
separate branch circuit, which allows for failover in the event of a power failure in one of the
circuits. When using a dual AC power module or dual AC power module with convenience
outlet, the two AC inputs for each frame must be on the same phase, and the voltages must be
the same within a few volts. If these requirements are not satisfied, there may be problems
switching between the two AC power sources. The dual AC 2 does not require the power
sources for the AC inputs for a frame to be on the same phase. See Input Power Requirements
on page 576 for more information.

CAUTION
If the power sources for the AC inputs for a frame using the dual AC or dual AC
with convenience outlets are not on the same phase, damage to the library
could result. This does not apply to a frame using the dual AC 2.
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CHAPTER 3 - INTRODUCING THE BLUESCALE
USER INTERFACE
The BlueScale user interface is used for configuring, monitoring, and maintaining the TFinity
library. The user interface displays on a color touch screen on the front of the library. It can
also be displayed remotely through a standard web browser using the Remote Library
Controller (RLC) or on a monitor connected directly to the LCM.

Note: The XML command interface can also be used to perform many of the functions provided by
the BlueScale user interface. See the Spectra Tape Libraries XML Command Reference for
detailed information about using the XML command interface.

This chapter describes the BlueScale user interface and how it is used.

Overview of the BlueScale User Interface 86
Access Options 86

User Interface Features 88

Library Management 95

Using the BlueScale User Interface 97
Log Into the User Interface 97

Log Off or Switch Users 101

Enter Information on Screens 101
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OVERVIEW OF THE BLUESCALE USER INTERFACE
The BlueScale user interface lets you set configuration options, view library and drive
information and metrics, manage media, monitor library operations, and perform maintenance
operations.

Figure 32 The General Status screen.

Access Options
The BlueScale user interface is accessed using either the touch screen on the library operator
panel or through the BlueScale web interface.

Operator Panel Touch Screen Interface

The touch screen on the operator panel of the main frame is the library’s local BlueScale user
interface. You select options and enter information by simply touching the appropriate
location on the screen with a stylus or your finger. The touch screen interface includes a soft
keyboard that you can use to enter alphanumeric characters into text fields. This soft keyboard
can be accessed from the keyboard icon that displays whenever text input is required.

In addition to using the touch screen, you can access the local user interface using a monitor,
keyboard, and mouse connected directly to the LCM (see Figure 11 on page 51). This method
of accessing the local BlueScale user interface provides the same functionality that is available
from the touch screen.

IMPORTANT
Do not use the Enter key on your keyboard when making selections in the
BlueScale user interface. It can cause inconsistent behavior in the BlueScale
interface.
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BlueScale Web Interface

The BlueScale web interface lets you use a standard web browser to access the library through
the Remote Library Controller (RLC). Simply enter the library’s IP address into a browser
running on a computer that can access the Ethernet network to which the library’s LCM is
connected.

IMPORTANT

l When accessing the library remotely through a web browser, do not use
the Enter key on your keyboard when making selections in the BlueScale
user interface. Various web browsers handle the Enter key differently,
causing inconsistent behavior in the BlueScale interface.

l Always use your mouse to make selections and click the buttons in
BlueScale screens instead of using your keyboard.

l Do not use the browser’s “back” button to return to a previously viewed
BlueScale screen. Always use the BlueScale toolbar and buttons on the
screen to navigate the BlueScale web interface.

l Using a keyboard command (for example, F5) to refresh the browser
when connected to the BlueScale web interface can cause unpredictable
results.

The BlueScale web interface provides access to the same features and functions that are
available through the touch screen, excluding functions that involve physical interaction with
the library (for example, using the TAP to import or export a TeraPack magazine).

When using the web interface, keep the following requirements in mind:

Number of Sessions

The BlueScale web interface supports up to eight simultaneous connections to the library. If
you attempt to establish more than eight simultaneous web interface connections, the existing
connection with the longest idle time is terminated.

Supported browsers

Remote access to the library through the web interface is only supported using the following
web browsers:

• Microsoft® Internet Explorer®

• Mozilla® Firefox®

• Google® Chrome™

• Apple® Safari®

Additional browsers have not been fully tested with the BlueScale web interface. Using an
unsupported browser may result in the BlueScale web interface not displaying or operating as
expected.
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User Interface Features

The following sections describe the common features that appear in all screens in the user
interface.

Figure 33 The BlueScale user interface features.

Toolbars

The toolbar panel appears along the left edge of each screen (see Figure 33) and lets you
navigate through the available toolbars to select options. Clicking on a toolbar expands it to
display the available options. The screen for the previously selected option remains displayed
until you select another option, either from the same toolbar or another one.

Option Overview

The following table provides an overview of the options available under each toolbar.

Toolbar Available Options

General The General toolbar (shown in Figure 33 on page 88) provides access to
the most frequently used library screens and controls:

• General Status — Displays the current status for all of the major library
components for the selected library partition. Moving the cursor over the
name of a component highlights the component in the system graphic.
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Toolbar Available Options

• Click Drives to display the Drives screen for more detailed
information about the status of the drives (see View Drive Status
Information on page 173). The Drives screen can also be accessed
from the Configuration toolbar (see Configuration below).

• Click Robotics to display the Robotics Status screen for more detailed
information about the TeraPorters and service bays (see View the
TeraPorter Status Information on page 176).

• Click Media to display the Inventory screen, which is also accessed
from the Inventory option on the General toolbar.

• Click Filled Capacity to display the Media Lifecycle Management
Report screen, which is also accessed from the Media Lifecycle
Management option on the General Status screen.

• Inventory — Displays the Inventory screen, which shows the library’s
media inventory information. Use the controls on the Inventory screen
to locate individual cartridges and move magazines and cartridges from
one location in the library to another. See Using the Cartridge Inventory
on page 279, to learn about the options available from this screen.

• Import/Export — Displays the Import/Export screen, which provides
controls for importing, exporting, and exchanging magazines and
cartridges. See Importing and Exporting Cartridges on page 238 to learn
about using the options available from this screen.

Note: The Import/Export option is not available when accessing the library
remotely using the BlueScale web interface.

• Metrics — Displays screens that show the metrics for drive performance,
power consumption, and storage density for the media types in the
library. See Use Performance Metrics on page 170 for information about
viewing the metrics available for the library.

• Media Lifecycle Management — Displays the Media Lifecycle
Management Report screen, which provides controls for generating
media lifecycle reports. See Using MLM Reporting on page 336 to learn
about using the options available from this screen.

Configuration The Configuration toolbar provides access to controls for configuring all
aspects of the library’s operation:

• Partitions — Displays the Shared Library Services screen, which
provides information about the currently selected partition and lets you
define new partitions or modify existing partitions. See Configuring and
Managing Partitions on page 188, to learn about configuring and using
both storage and cleaning partitions in your library.

• Drives or DLM — Displays the Drives screen, which lists all of the drives
installed in the library. Depending on the library configuration, the
screen offers options for performing different types of operations on
each drive.
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Toolbar Available Options

• If Drive Lifecycle Management (DLM) is enabled, the Drives icon in the
Configuration toolbar changes to DLM. The Drives screen changes to
include a DLM status icon next to each drive. This icon provides at-a-
glance information about the general health of the drive. See View Drive
Status Information on page 173 and Using Drive Lifecycle Management
on page 352, to learn about using the options available from the Drives
screen.

Note: DLM is automatically enabled when you enable Media Lifecycle
Management (MLM).

• Controllers — Displays the Controllers screen, which provides information
about the controllers (RIMs) installed in the library and lets you configure a
failover pair using two controllers. See Configure Controller Failover on
page 139) for detailed information about configuring and using the
Controller Failover feature.

Note: The Controllers screen may not have any entries if the library is using
direct-attached drives to provide the robotic control path for partitions.

• System — Displays the System Setup screen, which provides controls for
enabling purchased library options and configuring the library’s system-
wide operating parameters. See Configuring the Library on page 104, to
learn about the options available from the System Setup screen.

• Media Lifecycle Management — Displays the Media Lifecycle
Management Setting screen, which provides controls for enabling MLM
and configuring global settings for MLM. See Configuring and Using
Media Lifecycle Management on page 301, to learn about using the
options available from the Media Lifecycle Management Setting screen.

Maintenance The Maintenance toolbar provides access to maintenance and
troubleshooting options for the library and drives.

• Package Update — Displays the Package Update screen, which shows
the version of the BlueScale software the library is using and provides
controls for updating the BlueScale software and the firmware for
individual library components, managing update packages, and
configuring and managing package servers. See Configure a Package
Server on page 142 and Updating the BlueScale Software and Library
Firmware on page 471, to learn about using the options available from
the Package Update screen.

• Tools — Displays the Maintenance Tools screen. From this screen you
can access the Utilities, System Traces, and EtherLib Status screens
which provide tools used during maintenance and troubleshooting
procedures. See Library Troubleshooting on page 380, and Maintaining
the Library on page 467, to learn about using the options available from
the Utilities, Traces, and EtherLib Status screens.
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Toolbar Available Options

• Diagnostics—Displays the Diagnostics screen, which provides access to
diagnostics used for testing the library during troubleshooting procedures.
These tests should only be performed under guidance from Spectra Logic
Technical Support.

• AutoSupport — Displays the AutoSupport screen, which provides
controls for creating and maintaining AutoSupport profiles, opening and
updating support tickets, and configuring AutoSupport features. See
Configuring and Using AutoSupport on page 362, for detailed
information about configuring and using AutoSupport.

• Media Lifecycle Management — Displays the Media Lifecycle
Management Tools screen, which provides access to controls for using
MLM features. See Configuring and Using Media Lifecycle Management
on page 301, to learn about using the options available from the Media
Lifecycle Management Tools screen.

Security The Security toolbar provides access to options for managing users and for
configuring and using the Encryption feature for your library.

• Switch User — Displays the main BlueScale Login screen, which logs the
current user out of the library and lets a different user log in. See Log
Off or Switch Users on page 101 for information about using this option.

• Edit Users — Displays the Edit Users screen, which provides tools for
adding, editing, and deleting users. See Configuring Library Users on
page 106, to learn about using the options available on the Edit Users
screen.

• Encryption — Displays the Encryption Login screen. You must log into
the encryption feature before you can enable and configure the
encryption options, including the library’s built-in BlueScale encryption
key management. See the Spectra Tape Libraries Encryption User Guide for
information about configuring and using encryption with the library.

Note: BlueScale Encryption Standard Edition capability is included with the
library. You can purchase an activation key for either BlueScale Encryption
Professional Edition or the Spectra SKLM encryption key management system to
access additional encryption capabilities.

Status Bar

The status bar is located along the bottom edge of most screens. The information and icons
displayed on the status bar depend on the status of the system and whether you are using the
operator panel or the BlueScale web interface.

Note: See Additional Status Bar Icons on page 93 for additional icons that can also appear on the
status bar.
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Figure 34 The BlueScale status bar.

Refresh Display Button

Refreshes (updates) the information currently displayed on the user interface. If you set a long
interval for the refresh rate or disabled the automatic screen refresh by setting the refresh rate
to zero (see Refresh Rate on page 118), you can refresh the screen manually by clicking the
refresh display button.

IMPORTANT
Do not use keyboard commands (for example, F5) to refresh the browser
when connected to the BlueScale web interface. These keyboard commands
can cause unpredictable results.

System Status Icon

Indicates the status of library components. The BlueScale user interface uses the following
icons to indicate the status of library components. Click the status icon to view system
messages (see Check and Respond to Messages on page 167 for information about these
messages).

Note: These status icons also display next to the major system components shown on the General
Status screen (see Figure 33 on page 88).

Icon Description Meaning

A check mark (ü) in
a green circle

All system components are functioning correctly.

An i in a blue circle An informational message about a system component is
available. Check messages to determine the component.

An exclamation
point (!) in a yellow
triangle

A system component requires attention. Check messages to
determine the component.

An X in a red circle A system component has experienced an error condition.
Check messages to determine the component.
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Last Refresh Time and Date

Shows when the displayed information was last updated. The library refreshes different
screens at different rates, depending on the type of data displayed. The screen refresh rate can
be set for a specific interval or disabled (see Refresh Rate on page 118). The displayed
information can be refreshed manually by clicking the refresh display button.

BlueScale Version

Shows the BlueScale software version currently being used by the library.

Network Settings Icon or Library Name

Shows the Network Settings icon or name for the library. If you are managing the library from
the touch screen operator panel, the Network Settings icon displays on the status bar. Click the
icon to go to the Network Settings screen. If you are using the BlueScale web interface, the
library’s name is shown instead of the Network Settings icon.

Note: If you are using the BlueScale web interface and you did not set the library name, the right-
hand side of the status bar is blank.

If you need to view or set the library’s IP address or name, see Configure Network Settings on
page 124 and Library Name on page 117, respectively.

Additional Status Bar Icons

The status bar can also include the following additional icons.

Auto Download Icon

If one or more package servers are configured to automatically download firmware packages
(see Configure a Package Server on page 142) and a new package was downloaded, the Auto
Download icon (a wrench in a yellow circle) displays to indicate that an update package is
ready for installation. Click the icon to navigate to the Package Update screen. See Updating
the BlueScale Software and Library Firmware on page 471 and Updating Drive Firmware on
page 506 for information on installing the update.

Figure 35 The Auto Download icon in the BlueScale status bar.

Remote Support Icon

Provides you with online access to the support section of the Spectra Logic website where you
can search the Knowledge Base, access the Product Documentation, and download BlueScale
update packages and drivers. If you need additional assistance, contact Spectra Logic
Technical Support (see Contacting Spectra Logic on page 18).
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Figure 36 The Remote Support icon in the BlueScale status bar.

The remote support icon is also used to activate secure remote access capabilities using Cisco
WebEx technology. This remote access helps Spectra Logic Technical Support provide faster
resolution of support calls. This capability is only enabled on an as-needed basis during a
support call.

Notes: l The remote support icon is only visible when you are accessing the library through the
BlueScale web interface.

l When Spectra Logic Technical Support needs to launch a WebEx session to access your
library, they will send you a link via email.

HHM Icon

When the library or one of its components reaches its maintenance threshold, the Hardware
Health Monitor (HHM) notification icon appears on the status bar. As with the system
message icon, the color of the icon indicates the urgency of the notification.

You can click the icon to view information about the notification and send a Hardware Health
Monitor ticket to a contact person within your organization or to Spectra Logic Technical
Support. They can then review the logs and determine if any maintenance tasks are needed
(see Using BlueScale Hardware Health Monitoring on page 395).

Note: The HHM icon only displays if an HHM threshold has been reached. After any required tasks
are complete, the threshold can be reset. The HHM icon disappears until the next threshold is
reached.

Figure 37 The HHM icon in the BlueScale status bar.

Camera Icon

If one or more BlueScale Vision cameras are installed in the library and their IP addresses are
entered into the BlueScale user interface (see BlueScale Vision IP Address on page 122), up to
three camera icons appear on the status bar. Click the icon to launch the web-based Network
Camera viewer and use it to observe the interior of the library over an Ethernet network or the
Internet (see Use the BlueScale Vision Camera on page 180).

Note: The Camera icon only appears on the BlueScale web interface; it does not appear on the front
panel touch screen interface.
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Figure 38 The Camera icon in the BlueScale status bar.

Progress Bar

When the library is busy processing a command, a horizontal progress bar displays above the
status bar. Do not use the touch screen (or the BlueScale web interface) until the progress bar
disappears.

Library Management

The library management features in the BlueScale user interface provide maximum
configurability and ease of use for the TFinity library. To take full advantage of the library’s
versatility, read the following overview of the library’s management features.

Automatic Email Alerts

Simple Mail Transfer Protocol (SMTP) lets users receive library status information via email.
When the library generates messages through the library controller, it automatically sends
email notifications to users who are configured to receive them. Information included in the
notification consists of the message number, severity, details, remedy, and the time it was
generated. Message types are Information, Error, Warning, and Fatal (see Check and Respond
to Messages on page 167). You can select the types of messages each library user receives (see
Configure Mail Users on page 127).

AutoSupport

AutoSupport guides you through the process of sending email regarding library problems —
along with library logs and configuration information — directly to internal support personnel
or Spectra Logic Technical Support. See Configuring and Using AutoSupport on page 362 for
detailed information.

User Security

Library users are assigned to one of three groups, each with its own set of pre-defined library
privileges (also known as permissions). These privileges determine the type of operations a
user can perform on the library and are the primary means for configuring library security.
See Configuring Library Users on page 106 for detailed information about users.
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Note: An additional, separate password must be entered to access the encryption features. See the
Spectra Tape Libraries Encryption User Guide for information about the encryption user.
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USING THE BLUESCALE USER INTERFACE

The library’s BlueScale user interface lets you set configuration options, view library and drive
information and metrics, manage media, and monitor library operations.

Note: Unless otherwise specified, references to the user interface screens apply to both the touch
screen on the library operator panel and the screens presented through the BlueScale web
interface.

Log Into the User Interface

Before you can manage or configure the library, you must log into the BlueScale user interface.

After the library completes its power-on sequence, the Library Initialization screen displays.
This screen lists the required initialization steps and current status of the library’s major
components (Robotics, RCM, and LCM). Text boxes provide descriptions about the currently
active tasks.

Notes: l If your library has a static IP address, you can access the library using the BlueScale web
interface (RLC) as soon as the Library Initialization screen displays

l If the library cannot complete the initialization process, it will generate system
messages and enter maintenance mode. Contact Spectra Logic technical support for
assistance (see Contacting Spectra Logic on page 18)

Figure 39 The Library Initialization screen.
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After the library completes its initialization sequence, the Library Controller: Login screen
displays on the library operator panel. This Login screen also displays when you access the
library remotely using the BlueScale web interface (RLC), as well as when you switch users or
when the library automatically logs out the current user if auto-logout is enabled.

Figure 40 The Library Controller: Login screen.

If there is no interaction with the operator panel within 30 seconds after the Login screen
displays, the Login screen is replaced by the pre-login General Status screen. This General
Status screen provides at-a-glance status for the library and its components without requiring
you to log into the library. You can view the status of the entire library or a specific partition.

Note: The pre-login General Status screen does not display when you access the library remotely
through the BlueScale web interface.

Figure 41 Log in from the pre-login General Status screen.

JUNE 2025 98 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 3 - INTRODUCING THE BLUESCALE USER INTERFACE



Use the following steps to log into the library:

1. Connect to the library. The method depends on how you are accessing the library.

Using the front panel touch screen or a direct connection to the LCM

• If the Login screen is displayed, skip to Step 4 on page 100.

• If the pre-login General Status screen is displayed, touch or click select here to login at
the bottom of the screen to display the Login screen and then skip to Step 4 on
page 100.

Note: If the soft keyboard is open and covering the bottom of the pre-login General Status screen,
touch the keyboard icon to close the soft keyboard or use the scroll bar on the right side of
the screen to scroll down to the bottom of the screen.

Connecting to the library remotely using the BlueScale web interface

Enter the IP address of the TFinity library in the address bar of a web browser on a
computer on an active network that has access to the library. The steps you use depend
on whether SSL is enabled or not.

If SSL is... Use the following steps...

Not enabled
(the default
setting)

1. Enter the IP address using the form: http://nnn.nnn.nnn.nnn,
where nnn.nnn.nnn.nnn is the IP address you configured for the
library (see Configure Network Settings on page 124).

2. The BlueScale Login screen displays (see Figure 40 on page 98).
Proceed to Step 4 on page 100.

Enabled 1. Enter the IP address using the form: https://nnn.nnn.nnn.nnn,
where nnn.nnn.nnn.nnn is the IP address you configured for the
library. See Enable SSL on page 120 for information about enabling
SSL.

IMPORTANT When using SSL, you must prefix the IP address with https://
instead of just entering the IP address.

2. If you receive a warning about the website’s security certificate,
choose to ignore or resolve the warning.

Notes:

• The security warning only appears if you have not resolved the security
certificate warning, either by storing a valid security certificate on the
library (see Install a Security Certificate and Authentication Key on
page 133) or by creating a security exception for the library on the
browser (method depends on the browser you are using).

• If you do not resolve the warning, you will receive the warning about
the security certificate each time you access the BlueScale web interface.

3. The BlueScale Login screen displays (see Figure 40 on page 98).
Proceed to Step 4 on page 100.
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4. Select the User text box. A cursor appears in the box.

Note: When using the touch screen on the library operator panel, touch the keyboard icon on the
Login screen to activate the soft keyboard on the library’s touch screen. Use the stylus or your
finger to select fields and to type information using the soft keyboard.

Touching the keyboard icon again closes the soft keyboard.

Figure 42 Log into the library using the Library Controller:
Login screen.

5. Type your user name (su is the default user name for a superuser).

See Understanding User Groups and Security on page 106 for information about the
three types of user groups and the options and controls accessible to each user group.

6. Type your password in the Password text box. If you log in as one of the default users,
there is no password (unless you configured one).

Note: By default, passwords are not required to log into the library. If you want to password-protect
access to the library, set passwords for each user as described in Configuring Library Users on
page 106.

7. Click Login. The library’s General Status screen displays.

Note: If you just powered-on or reset the library, there may be a delay after you click Login while
the library completes its initialization. When the initialization is complete, the General Status
screen displays.
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Figure 43 The BlueScale user interface General Status
screen.

8. If you want to enable encryption or configure encryption settings or keys, select Security
> Encryption to log into the Encryption feature (see the Spectra Tape Libraries Encryption
User Guide for detailed instructions).

Log Off or Switch Users

1. If a screen other than the Login screen is displayed, select the Security toolbar to display
the Security options.

Figure 44 The Security toolbar.

1. Select Switch User to log out the currently logged in user and redisplay the Login screen.

2. If desired, log in again using the same or a different user name and password.

Enter Information on Screens

Entering information on a user interface screen requires using one of the following methods.
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BlueScale Web Interface

The BlueScale web interface lets you use your computer keyboard to enter information into the
user interface and a mouse to navigate through the user interface screens (see BlueScale Web
Interface on page 87). Using the web interface is the most convenient way to enter large
amounts of information when you are configuring the library.

When accessing the library remotely through a web browser, do not use the
Enter key on your keyboard when making selections in the BlueScale user
interface. Various web browsers handle the Enter key differently, causing
inconsistent behavior in the BlueScale interface.
Always use your mouse to make selections and click the buttons in BlueScale
screens instead of using your keyboard.

Note: Functions that require physical interaction with the library (for example, importing or
exporting magazines) are not available when using the BlueScale web interface.

Soft Keyboard

When using the touch screen on the operator panel, select the keyboard icon in the lower right
corner of any screen to activate the on-screen keyboard. When the keyboard is extended, an
icon in the lower right corner lets you select between alphabetic or numeric characters. Use a
stylus or your finger to select fields and enter alphanumeric information using the keyboard.
Touching the keyboard icon again closes the keyboard.

Note: The soft keyboard can also be used to access several
troubleshooting features provided through the BlueScale software
(see Troubleshooting BlueScale User Interface Issues on page 383).

External Keyboard and Mouse

If you cannot use the BlueScale web interface, using an external keyboard and mouse
connected to the library is useful when you need to enter large amounts of information. The
user interface options available when you use an external keyboard and mouse are the same as
when you use the library’s touch screen operator panel.

Not all characters on a USA-type keyboard are supported in the BlueScale user
interface. If a character does not appear on the soft keyboard, then its use is not
supported.
When accessing the library using an external keyboard connected to the library,
do not use the Enter key on your keyboard when making selections in the
BlueScale user interface. Doing so may cause inconsistent behavior in the
BlueScale interface.
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• You can connect a USA-type USB keyboard to the LCM (see Figure 10 on page 49) or to the
USB connector on the right-hand side of the operator panel (see Figure 7 on page 46).

Note: If using a non-USA type keyboard, you will need to find the equivalent for some characters like
the back slash or forward slash.

• You can connect a USB mouse to one of the USB ports on the LCM and use it for making
selections on the user interface.

• When using a keyboard and mouse connected directly to the library, it may also be useful
to connect a monitor to the monitor port on the LCM. The monitor displays the same
information as the touch screen.

Feedback Required Screens

When the BlueScale software needs you to make a selection or perform an action it displays a
Feedback Required screen. If you do not respond to the Feedback Required screen within 10
minutes, the request times out and the action fails.
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CHAPTER 4 - CONFIGURING THE LIBRARY
When it was installed, your library was configured according to your initial requirements.
This chapter describes the procedures for configuring the library’s system settings, including
the users, the network connections, and optional features.

Note: For instructions on how to operate the library, see:

l Operating the Library on page 161

l Configuring and Managing Partitions on page 188

l Configuring and Using Media Lifecycle Management on page 301

l Using Drive Lifecycle Management on page 352

l Configuring and Using AutoSupport on page 362

Configuring Library Users 106
Understanding User Groups and Security 106

Add a New User 107

Modify an Existing User 108

Delete an Existing User 109

Accessing the System Setup Screen 110
Enabling BlueScale Software Support, Options, and Upgrades 112

Enter Activation Keys 113

Add Options 115

Configuring the Global System Settings 117
Configure the System Settings 117

Configure Network Settings 124

Configure Mail Users 127

Enable Email for the Auto Configuration Save File 129

Set the Date and Time 131

Configuring Optional Library Settings 133
Install a Security Certificate and Authentication Key 133

Configure Routine Maintenance 136

Enable and Configure SNMP 137

Configure Controller Failover 139

Configure a Package Server 142

Modify Auto Download Options 145
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Configure Rotation Manager 147

Backing Up the Library Configuration 149
Use Automatic Backup of the Library Configuration 149

Use Manual Backup of the Library Configuration 150

Setting the Camera IP Address 154
Edit the Camera IP Address - White 155

Edit the Camera IP Address - Black 158
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CONFIGURING LIBRARY USERS

Overview

Each library user is assigned to one of three user groups, each with its own set of pre-defined
library privileges (also known as permissions).

User Privilege Requirements

Only a user with superuser privileges can add, modify, or delete users.

Understanding User Groups and Security

Before you begin, read this section to understand the three types of user groups and what
types of privileges each has.

Note: You must enter an additional password to access the encryption features. See the Spectra Tape
Libraries Encryption User Guide for information about the encryption user.

The following table describes the three user groups and the privileges of each. By default,
passwords are not required for any of the three default users.

User Group Type Description Default User
Name

Superuser Controls all aspects of the library’s configuration and
operation, including defining other library users and
assigning them to a user-privilege group.
Notes:

• The library requires a minimum of one superuser.
You cannot delete the last member of the superuser
group.

• Only a user with superuser privileges can add,
modify, or delete users.

• Only a user with superuser privileges can access and
configure encryption features.

• Only a user with superuser privileges can use the
Soft Power feature.

• Only a user with superuser privileges can enable or
disable the Enable Automatic Power-Up After Power
Failure feature.

su
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User Group Type Description Default User
Name

Administrator Configures and uses the library. With the exception of
creating or modifying library users, accessing the
encryption features, enabling Automatic Power-Up
After Power Failure, and using the Soft Power feature,
users in the Administrator group have the same
privileges as users in the superuser group.

administrator

Operator Performs day-to-day operations. Users assigned to the
Operator group can move media, and import and
export media using the Entry/Exit pool, but cannot
access the more sensitive library operations such as
configuration, diagnostics, and security.

operator

Add a New User

Use the following steps to add a new library user and assign that user to a user group.

1. Log into the library as a user with superuser privileges (see Log Into the User Interface
on page 97).

2. From the toolbar menu, select Security > Edit Users. The Library Users screen displays.

Figure 45 The Library Users screen.

3. Complete the information in the Add/Update User panel.
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For this field... Enter...

User The name for the user.

User names can contain any combination of lower and uppercase
alphabetic characters (a-z and A-Z) and the numbers 0-9.

Password
Retype Password

A password for the user and then retype the password to confirm. If
Complex Passwords is enabled (see Enable Complex Passwords on
page 123), the password must meet the following requirements:
• Minimum length 12 characters
• Minimum of two characters of each: lower case letters (a-z), upper case
letters (A-Z), numbers (0-9), and special characters

• Valid special characters: @`~!#$%^&*()-_=+[]{}\|;:'",.<>/?
• Maximum of three in a row of any character
• Cannot reuse any of the previous 24 passwords
• Must be changed every 90 days
• Cannot be changed within two days of a previous password change
Notes:

• For security, the text in the Password and Retype Password fields is
shown as asterisks (*).

• Though highly recommended, unless Complex Passwords is enabled,
passwords are not required for any of the three user types.

User Type Select the group to which the user belongs.

Note: See Understanding User Groups and Security on page 106 for
descriptions of the user groups and privileges associated with each.

4. Click Save. The new user name and group assignment is added to the list of users.

5. Repeat Step 3 and Step 4 for each additional library user.

Modify an Existing User

IMPORTANT
If you change the passwords for the default users, make sure that you keep a
record of the new passwords. The passwords cannot be reset if you forget
them.

IMPORTANT
If you change the passwords for the default users, make sure that you keep a
record of the new passwords. The passwords cannot be reset if you forget
them.

Use the following steps to change settings for an existing user.
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1. Log into the library as a user with superuser privileges.

2. From the toolbar menu, select Security > Edit Users. The Library Users screen displays
(see Figure 45 on page 107), showing a list of library user names.

3. Find the user’s name, then click Edit next to the name.

4. Change the user’s name, password, group, or any combination of these as required.

5. Click Save to save your changes.

Delete an Existing User

Use the following steps to delete an existing user.

IMPORTANT If you delete the default users, make sure that you keep a record of at least
one superuser name and password.

Note: The library requires there to be a minimum of one user assigned to the superuser group. You
cannot delete the last member of the superuser group.

1. Log into the library as a user with superuser privileges.

2. From the toolbar menu, select Security > Edit Users. The Library Users screen displays
(see Figure 45 on page 107), showing a list of library user names.

3. Locate the name of the user to delete, then click Delete next to that user’s name.

When the screen refreshes, the user list no longer includes the user name you just
deleted.
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ACCESSING THE SYSTEM SETUP SCREEN
Overview

All of the settings for the library’s general configuration options are accessed through the
System Setup screen. The screen is divided into two panes. You may need to use the scroll bar
to see the entire screen.
• Option Enablement pane—Used for entering the activation keys for any purchased
options, including BlueScale Software Support, licensed capacity (chambers), and Shared
Library Services (SLS). This panel also lists all of the currently licensed options.

Figure 46 The System Setup Option Enablement pane.

• Other Settings pane—Used for configuring the operational parameters for the library.
Note: The Other Settings pane can have up to three BlueScale Vision IP address fields depending on

the size of the library.
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Figure 47 The Other Settings pane of the System Setup
screen.

User Privilege Requirements

Only a user with superuser or administrator privileges can access the System Setup screens to
enable new options or change system configuration settings. See Understanding User Groups
and Security on page 106 for information about the three types of user groups and what types
of privileges each has.

Access the System Setup Screen

Use the following steps to access the System Setup screen when you want to enable a new
option or change a configuration setting.

1. Log into the library as a user with superuser or administrator privileges (see Log Into the
User Interface on page 97).

2. From the toolbar menu, select Configuration > System. The System Setup screen displays
(Figure 46 and Figure 47 on page 111 show the two panes of the screen).
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ENABLING BLUESCALE SOFTWARE SUPPORT, OPTIONS,
AND UPGRADES

Overview

Activation keys are required to enable the BlueScale Software Support license and any library
options and upgrades you purchase. These activation keys are tied to the library serial number
(the hardware ID). The library ships with activation keys for the initial BlueScale Software
Support license, the initial licensed slot capacity, and any additional options you purchased
with the library. You must enter the activation key for the BlueScale Software Support license
and each option into the library to make the option available for use.

Requirements for updating the library BlueScale software

A valid BlueScale Software Support key is required in order to update the library’s BlueScale
software and component firmware. When you renew or extend your service contract, you
receive an activation key that must be entered into the System Configuration screen to enable
continued BlueScale updates.

IMPORTANT

Your initial library purchase includes a BlueScale Software Support key that is
valid for the duration of the warranty period, or for the duration of any
uplifted or extended service contract you purchased with the library,
whichever is longer.
When you renew or extend your service contract, you must generate a new
BlueScale Software Support key and enter the new key into the library to
allow continued access to BlueScale upgrades (see Obtain the Option
Activation Key on page 115). If you have questions about your service
agreement, contact Spectra Logic Technical Support (see Contacting Spectra
Logic on page 18).

Standard and upgraded options for the library

The default library configuration includes a basic set of options that lets you start using the
library immediately. These options do not require activation keys to enable them. When you
purchase upgraded options or additional Capacity on Demand (CoD), you receive an
activation key that must be entered into the System Configuration screen to enable the
options. See Library Support and Upgrades on page 563 for information about the available
upgrade options.
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Option The default library
configuration includes... Upgrade if you need...

Partitions Support for using a single
storage partition.

Additional storage partitions. Purchase
a Shared Library Services (SLS)
activation key. See Library Partitions
on page 63 for information about how
SLS provides partitioning in the
library.

Encryption BlueScale Encryption Standard
Edition.

More advanced encryption
management capabilities. Purchase
either BlueScale Encryption
Professional Edition, the Spectra SKLM
encryption key management system, or
the KMIP encryption key management
system using HPE ESKM. See the
Spectra Tape Libraries Encryption User
Guide for information.

CoD Capacity The licensed number of
chambers you purchased with
the library.

Notes:

• Each chamber accommodates
one TeraPack magazine. Each
magazine contains ten slots
for LTO media or nine slots
for TS11xx technology media.

• The licensed chambers must
be enabled by entering the
activation key into the System
Configuration screen (see
Enter Activation Keys below).

Additional capacity. Purchase a CoD
activation key for the additional
chambers you need. See Library
Support and Upgrades on page 563 for
more information.

Notes:

• You must create or modify a
partition to make use of the added
capacity. See Configuring and
Managing Partitions on page 188 for
instructions.

• If the CoD capacity you purchase
exceeds the number of chambers that
are present in the library, the extra
licensed chambers cannot be used
unless you also purchase either a
TBA or shelves to replace a DBA in
an existing frame or an expansion
frame.

Enter Activation Keys

Notes: l Paper copies of the activation keys for the initial BlueScale Software Support license
and the options you purchased with the library are included with the library when
shipped.
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l The activation keys for the initial BlueScale Software Support license and the options
you purchased with the library are entered during the installation of the library.
Compare the paper copies of the activation keys with information in the Option
Enablement pane of the System Setup screen and enter any missing keys as described
in this section.

l If you purchase options after the initial library installation, you are provided an
activation key for each option as described in Add Options on the next page.

l If you receive activation keys by email, it is helpful to use the BlueScale web interface
(RLC) to access the System Setup screen. You can then cut and paste keys from the
email containing the keys into the System Setup screen instead of typing them.

Use the following steps to enter a new BlueScale Software Support key or the activation key
for a new option into the library.

1. Have on hand the activation key for the BlueScale Software Support license or other
option (see Obtain the Option Activation Key on the next page).

2. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

The Option Enablement pane at the top of the screen lists the currently licensed options.

Figure 48 Enter the keys in the Option Enablement pane of
the System Setup screen.

3. Enter the activation key for the option you want to enable in the Key field.

Note: The activation keys are not case-sensitive.

4. Click Save. The System Setup screen refreshes and displays the new activation key and
its description in the list of keys. The option is available for immediate use.

Note: Keep a record of all activation keys listed on the Option Enablement pane of the System Setup
screen. You need to re-enter them if the library is reset to factory defaults.
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Add Options

This section describes how to determine the Hardware ID and obtain activation keys for new
options after the initial installation. See Renewing the BlueScale Software Support Key on
page 469 if you need to renew or extend your service contract, which includes the BlueScale
Software Support key.

IMPORTANT
The BlueScale Software Support key and all option activation keys are tied to
the library serial number. If you have multiple libraries, you need separate
activation keys for each library.

Determine the Library Serial Number

The library serial number (Hardware ID) is required for renewing or extending your service
contract, which includes the BlueScale Software Support key, and for purchasing additional
Capacity on Demand (CoD) or other upgrade options.

Use the following steps to determine your library’s serial number.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Make a note of the library’s serial number (Hardware ID), which is needed to generate
the activation keys.

Figure 49 Locate the library’s serial number (Hardware ID).

Obtain the Option Activation Key

1. Contact your Spectra Logic sales representative to order the desired options (see
Contacting Spectra Logic on page 18).

2. When your order is processed, the Spectra Logic Customer Care team contacts you with
instructions for generating the activation key for each option.
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3. Enter each activation key into the Option Enablement pane of the System Setup screen
(see Enter Activation Keys on page 113).

JUNE 2025 116 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 4 - CONFIGURING THE LIBRARY



CONFIGURING THE GLOBAL SYSTEM SETTINGS

This section describes how to modify the library’s general configuration settings. To change
the current value for any of these settings, access the System Setup screen (see Accessing the
System Setup Screen on page 110), then scroll down to the Other Settings pane. The following
sections describe using this screen to configure the library.

Figure 50 The Other Settings pane of the System Setup
screen.

Configure the System Settings

The following table lists the system settings that are configured through the Other Settings
pane of the System Setup screen, describes how to change each setting, and provides the
default value for each setting, if applicable.

Setting Description Default

Library Name Set the name used to identify the library in messages
it sends to mail recipients.

blank
(no name set)
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Setting Description Default

1. Type a name for the library. Use a name that
helps identify the library to a remote user.

2. Click Save.

Web Server Port Set the port number for the dedicated Ethernet port
used to access the library’s embedded web server.

1. Enter a port number from 0 to 65,535.

The default port number is 80, which is
appropriate for most installations and is
strongly recommended. If you use a port
number other than 80, the port number must
be explicitly entered into the web browser
when accessing the library remotely.

IMPORTANT Do not set the web server port to 443.
Using this port number causes the front panel
display to become unstable.

2. Click Save.

3. Reset the library to enable the new web port
number setting (see Resetting the Library on
page 406).

80

Refresh Rate Set how frequently the information on the BlueScale
user interface screens is refreshed.

1. Use the Refresh drop-down list to select a
scheduled interval time.

2. Click Save.

Notes:

• You can manually refresh the displayed
information at any time by clicking the refresh
display button located at the left end of the status
bar (see Status Bar on page 91).

• If you want to disable automatic refreshing of the
display, set the refresh rate to off.

• For BlueScale12.8.01.02 and earlier, if you want a
refresh rate other than the default, or you want to
disable automatic refreshing, you must re-
configure the refresh rate every time you log into
the library.

60 seconds
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Setting Description Default

For BlueScale12.8.01.03 and later, the configured
refresh rate persists when you log out of the
library.

Auto Logout
Timeout

Set how long the current connection to the BlueScale
user interface is idle before the current user is
logged out.

1. Enter the number of minutes for the timeout.

2. Click Save.

Note: Setting the timeout value to zero disables auto
logout.

0 (zero) minutes

(Disabled)

Enable Drive
Performance
Monitoring

Enable or disable the option to monitor the
performance of the drives in the library (see View
Drive Performance Statistics on page 170).

IMPORTANT Make sure that the drives do not contain
media before you enable or disable Drive
Performance Monitoring. If you enable or disable
this option when a drive contains a cartridge, the
drive is reported as empty and backups may fail.

1. Select the Enable Drive Performance
Monitoring check box to enable the option (or
clear the check box to disable it).

2. Click Save.

Cleared (Disabled)

Enable Power
Consumption
Monitoring

Enable or disable the option to monitor the amount
of power your library is using through the Power
Consumption Monitor (EnergyAudit) feature (see
View Power Consumption Statistics on page 172).

1. Select the Enable Power Consumption Monitoring
check box to enable the option (or clear the check
box to disable it).

2. Click Save.

Note: When you disable and then re-enable power
consumption monitoring, the library does not begin
capturing data again until you power cycle the library.

Selected (Enabled)

Enable Automatic
Power-Up After
Power Failure

Enable or disable the option to automatically power
on the library after a power failure (see Use the
Automatic Power-Up After Power Failure Feature on
page 163).

Cleared (Disabled)
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Setting Description Default

1. Select the Enable Automatic Power-Up After
Power Failure check box to enable the option
(or clear the check box to disable it).

2. Click Save.

Note: The Enable Automatic Power-Up After Power
Failure feature can only be enabled or disabled by a
superuser.

Enable SSL Enable or disable Secure Socket Layer (SSL) access to
the BlueScale web interface.

IMPORTANT Enabling SSL configures the BlueScale web
interface to use a secure Internet connection.
You must prefix the IP address with https://
instead of just entering the IP address when
accessing the BlueScale web interface.

Note: Beginning with BlueScale 12.8.00, the library uses
TLS 1.2.

1. Select the Enable SSL check box to enable the
option (or clear the check box to disable it).

2. Click Save.

3. Click OK in response to the notification about
resetting the web server.

4. Wait for the web server to reset
(approximately 2 to 3 minutes), and then log
back into the library.

5. If desired, Install a Security Certificate and
Authentication Key as described on page on
page 133.

Cleared (Disabled)

Enable SNMP
Agent
SNMP Settings

Enable or disable the SNMP agent and configure
SNMP settings.

1. Select the Enable SNMP check box to enable
the option (or clear the check box to disable
it).

2. Click Save.

3. If you enabled SNMP, click SNMP Settings to
configure the SNMP options. See Enable and
Configure SNMP on page 137 for detailed
information and instructions.

Cleared (Disabled)
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Setting Description Default

4. Click Save to save the SNMP settings and
return to the System Setup screen.

Notes:

• The option to edit the SNMP Settings is only
present after you select Enable SNMP Agent
and click Save.

• Spectra Logic libraries implement SNMP
Version 2.

Enable Soft
Power

Enable or disable the Soft Power feature. See Use the
Soft Power Feature on page 164 for information
about the Soft Power feature and instructions for
using it.

1. Select the Enable Soft Power check box to
enable the option (or clear the check box to
disable it).

2. Click Save.

Note: The Soft Power feature can only be enabled or
disabled by a superuser.

Cleared (Disabled)

Syslog Server IP
Address

Enter the IPv4 or IPv6 address of an external Syslog
server used to collect the system messages posted by
the library. See Use Syslog on page 169 for
information about what the Syslog messages
contain.

1. Enter a valid IPv4 or IPv6 address for the
Syslog server. Do not include http: or https:.
To disable a server do one of the following:

• For BlueScale12.7.04.01 or earlier, set the IP
address to 0.0.0.0

• For BlueScale12.7.04.02 or later, clear the IP
address.

2. Click Save. The library immediately begins
forwarding all system messages to the server at
the specified IP address.

BlueScale
12.7.04.01 or
earlier: 0.0.0.0

BlueScale
12.7.04.02 or later:
cleared

(Disabled)
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Setting Description Default

BlueScale Vision
IP Address
(up to three
BlueScale Vision
IP address fields
display
depending on the
size of the
library)

Enable the BlueScale Vision camera icon for the
camera at the specified IP address. If you have not
yet set the IP address for the camera, see Setting the
Camera IP Address on page 154. For each IP address
you enter, a camera icon displays on the status bar
(see Figure 96 on page 181). See Use the BlueScale
Vision Camera on page 180 to learn about using the
camera.

1. Enter a valid IPv4 or IPv6 address for the
camera for which you want to display the
icon. Do not include http: or https:. To remove
a link to a camera do one of the following:

• For BlueScale12.7.04.01 or earlier, set the IP
address to 0.0.0.0

• For BlueScale12.7.04.02 or later, clear the IP
address.

2. Click Save.

3. If desired, repeat these steps to enable up to
two additional camera icons.

Notes:

• It is not necessary to enable the camera icon to
connect to the BlueScale Vision viewer for a camera.
After connecting an Ethernet cable to the camera’s
Ethernet port on the back of the library (see Figure 68
on page 154), enter the camera’s IP address in your
web browser.

• If the camera is configured to use DHCP or if you
do not know the current fixed IP address for the
camera, see Discovering and Setting the BlueScale
Vision Camera IP Address on page 410 for
information about how to determine the current IP
address.

• Read the BlueScale Vision Camera User Guide for
detailed information about configuring and using
the white camera or the Vivotek FD8361 Fixed Dome
Network Camera User’s Manual for information
about configuring and using the black camera.

BlueScale
12.7.04.01 or
earlier: 0.0.0.0

BlueScale
12.7.04.02 or later:
cleared

(Disabled)
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Setting Description Default

Network Settings Set the IPv4 or IPv6 addressing for the LCM
Ethernet port. You can also configure up to two
DNS IP addresses for use with the NTP service. See
Configure Network Settings on the next page for
detailed information and instructions.

Note: Depending on how you are accessing the library,
the status bar shows:

• The library’s current IP address when you access
the library using the touch screen or a direct
connection to the LCM.

• The library’s name, if set, when you are accessing
the library using the BlueScale web interface
through a web browser connection.

DHCP

Mail User Configure recipients for emails containing system
messages, traces, and diagnostic results generated by
the library. See Configure Mail Users on page 127
for detailed information and instructions.

autosupport@
spectralogic.com

Auto
Configuration
Save

Enable or disable sending the Auto Configuration
Save file to a previously configured mail recipient.
See Enable Email for the Auto Configuration Save
File on page 129 for detailed information about this
option and instructions for configuring it.

Note: The Auto Configuration Save file is always
generated, regardless of the setting for this option. See
Use Automatic Backup of the Library Configuration on
page 149 for information about the Auto Configuration
Save file.

Cleared
(Disabled)

Routine
Maintenance

Enable or disable the routine maintenance option for
the LCM operating system. See Configure Routine
Maintenance on page 136 for detailed information
about this option and instructions for configuring it.

Cleared (Disabled)

Date And Time See Set the Date and Time on page 131 for detailed
information and instructions for setting the date and
time.

Current date and
time for the
Mountain time
zone (US and
Canada)

Enable Complex
Passwords

Click Edit and then enable of Disable complex
passwords for library users. Complex passwords
have the following requirements:
• Minimum length 12 characters

Cleared
(Disabled)
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Setting Description Default

• Minimum of two characters of each: lower case
letters (a-z), upper case letters (A-Z), numbers (0-
9), and special characters

• Valid special characters: @`~!#$%^&*()-_=+[]
{}\|;:'",.<>/?

• Maximum of three in row of any character
• Cannot reuse any of the previous 24 passwords
• Must be changed every 90 days
• Cannot be changed within two days of a previous
password change

Configure Network Settings

Overview

Spectra Logic highly recommends that you configure your library for network access. Without
network access, you are unable to perform any of the following operations:

• Access the BlueScale web interface for remote management of the library using a standard
web browser.

• Open support incidents from the library front panel or send ASLs (AutoSupport Logs) on
demand to Spectra Logic Technical Support for troubleshooting.

• Automatically email system messages or reports to configured mail users.

• Automatically send a notification to a specified recipient when certain critical events occur.

• Download the latest BlueScale package from Spectra Logic’s Support portal directly to the
library.

Using DHCP Addressing

By default, the IP address for the Ethernet port on the LCM is set automatically using the
Dynamic Host Configuration Protocol (DHCP).

Notes: l If you select DHCP addressing, the LCM must be connected to an Ethernet network that
has a DHCP server to obtain an IP address.

l Do not select DHCP addressing if your network does not have a DHCP server.
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Using Static IP Addressing

If your network does not use DHCP, or if you simply want the library to have a fixed IP
address, you can configure a static (fixed) IP address as described in this section. Using a static
IP address ensures that you always know the IP address for the library and is highly
recommended.

Configuration Process

Use the following steps to configure the library for network access.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Click Edit next to Network Settings. The Network Settings screen displays.

Figure 51 The BlueScale12.7.04.01 and earlier
Network Settings screen.

Figure 52 The BlueScale12.7.04.02 and later
Network Settings screen.

3. Decide which type of addressing you want the library to use.

• DHCP—The library is issued an IP address by the DHCP server.

• Static (highly recommended)—The library uses a fixed IP address. If you select static
addressing, enter the following information:

Note: When entering IP addresses, do not include http: or https:

For BlueScale12.7.04.01 or earlier:

For this field... Enter...

Address A valid IPv4 address.
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For this field... Enter...

Subnet The subnet mask. The subnet mask must be a valid IPv4 address.

Gateway A valid network gateway IPv4 address. Enter 0.0.0.0 for the Gateway if
your network does not use a gateway.

For BlueScale12.7.04.02 or later:

For this field... Enter...

If the IPv4 check box is selected:
(if the IPv4 check box is not selected, the IPv4 address defaults to 127.0.0.1 and is effectively
disabled)

Address A valid IPv4 address.

Subnet The subnet mask. The subnet mask must be a valid IPv4 address.

Gateway A valid network gateway IPv4 address. Leave the field blank if the
network does not use a gateway.

If the IPv6 check box is selected:

Address A valid IPv6 address. The library compresses the IPv6 address when
saved.

Prefix Enter an integer between 1 and 128 to indicate the portion of the IPv6
address that indicates a group of IP addresses on the same network.

Gateway A valid network gateway IPv6 address. Leave the field blank if the
network does not use a gateway.

4. Optionally, enter the IPv4 address for a Domain Name Server.

If you plan to use NTP to automatically set the library’s date and time, you must enter a
valid IPv4 address for at least one DNS server used by the NTP service (see Set the Date
and Time on page 131).

Note: To delete an already saved DNS setting, do one of the following:

l For BlueScale12.7.04.01 or earlier, set the IP address to 0.0.0.0.

l For BlueScale12.7.04.02 or later, clear the IP address.

5. Click Save to change the IP addressing.

Notes: l If you are connected to the library through the BlueScale web interface and you change
the addressing, the library’s IP address changes as soon as you click Save. As a result,
you lose the connection to the library.
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l If you are using the operator panel, select any option on the toolbar menu to leave the
Network Settings screen.

Configure Mail Users

Overview

The library can send email messages with system messages, traces, and diagnostic results to
selected recipients. These recipients can be configured to receive messages automatically as
they are generated by the library, or on demand when traces are run, reports are generated, or
the library's configuration data is backed up. Recipients can also be configured to receive
AutoSupport messages.

Notes: l The library must be connected to a network with Internet access before you configure
mail recipients.

l You must configure the SMTP server used by the autosupport@spectralogic.com mail
user if you want to open an AutoSupport ticket directly from the library (see
Configuring and Using AutoSupport on page 362). This mail user is also used to send
the ASL and HHM files that the library generates to Spectra Logic Technical Support
when troubleshooting a problem.

Add or Modify Mail Users

Use the following steps to add or modify mail recipients.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Click Edit next to Mail Users. The Mail Recipients screen displays.
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Figure 53 The Mail Recipients screen.

3. To modify an existing recipient, click Edit next to the desired recipient in the Recipients
pane.

The Add/Update Recipient pane refreshes to show the current information for the
selected recipient.

4. Enter the information for a new recipient or update the information for an existing
recipient in the Add/Update Recipient pane.

For this field... Do the following...

To Enter the email address of the recipient. Be sure to use the full address
using the standard email format, including the @ symbol.

IMPORTANT The email address cannot contain spaces or other non-
alphanumeric characters (for example, an ampersand, &). To include
multiple addresses, leave a space between each address.

From Enter an alphanumeric string to uniquely identify the library (for example,
the name or location of the library).

IMPORTANT The string cannot contain spaces or non-alphanumeric characters
(for example, the & or the @ symbols).

SMTP IP Address Enter the IPv4 or IPv6 address of your SMTP server in the SMTP IP
Address field.
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For this field... Do the following...

Receive Select the type(s) of messages that the user receives by selecting one or
more of the message types listed.

• Fatal—An error occurred that prevents the library from continuing
operation. Immediate attention is required.

• Error—An error occurred that impacts the operation of the library.
Determine the cause of the error and remedy it as soon as possible.

• Warning—The library detected conditions that may impact operation.
Determine the cause of the problem and remedy it as soon as possible.

• Informational—Activities that generate system messages occurred.
Notes:

• Selecting a message type automatically sends all messages of that type to
the recipient as they are generated by the library.

• If no message type is selected, the library does not automatically send
messages to the recipient. However, messages can still be sent to the
recipient on an individual basis when traces or diagnostics are run.

• Do not select message types for the autosupport@spectralogic.com mail
recipient. This mail recipient is only used to receive AutoSupport ticket
requests or ASL and HHM files that are generated by the library.

5. Click Save. The screen refreshes to show the new or updated mail recipient in the
Recipients portion of the Mail Recipient screen (Figure 53 on page 128).

6. Repeat Step 2 on page 127 through Step 5 to configure or modify additional email
recipients.

7. If desired, select Send Test next to the newly added mail recipient to send a test email.

8. Click Previous to return to the System Setup screen.

Enable Email for the Auto Configuration Save File

Overview

Having a current backup of the library‘s metadata (the library partition configuration, the
MLM and DLM databases, and any BlueScale encryption keys) is an essential component of
any disaster recovery plan. For more information about protecting the library metadata, see
Back Up and Protect the Library Metadata on page 547.

In the event that you need to restore the library configuration, you can use either the
automatically saved configuration backup file from the LCM or the emailed copy (see Restore
From an Auto Configuration Save File on page 420).
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Auto Configuration Save Process

The library generates an Auto Configuration Save backup file once a week and every time you
create or modify a partition. This backup file contains the current library configuration, the
MLM and DLM databases, and any BlueScale encryption keys stored in the library.

Notes: l The time for generating the weekly Auto Configuration Save backup file is based on the
first time the file was generated.

l The library does not generate an Auto Configuration Save backup file when you make
configuration changes other than creating or modifying a partition.

Auto Configuration Save Email Process

Configuring the library to automatically send the Auto Configuration Save backup file as an
email attachment to a previously configured email recipient is highly recommended. The
library sends the email whenever it generates the Auto Configuration Save backup file. The
email includes instructions for using the attached file to restore the library.

IMPORTANT
To use this automatic email option, you must first configure the user to whom
you want the backup file sent as a mail recipient (see Configure Mail Users on
page 127).

Configure Automatic Email Option

Use the following steps to configure the automatic email option for the Auto Configuration
Save backup file.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Click Edit next to Auto Configuration Save in the Other Settings pane. The Automatic
Configuration Save Setup screen displays.

Figure 54 The Automatic Configuration Save Setup screen.

3. Select the Email Configuration check box, and then use the drop-down list to select the
desired recipient from the list of previously configured mail recipients.

Note: Do not use the default autosupport@spectralogic.com email recipient. Spectra Logic does not
save emailed configuration files.
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Set the Date and Time

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Click Edit next to Date And Time in the Other Settings pane. The Date and Time screen
displays showing the method currently selected for setting the date and time.

3. Select the method you want to use for setting the date and time.

Note: Changing the method of setting the library time and date from Automatic Time and Date
Settings (NTP) to Manual Time and Date Settings or the other way around requires an LCM
reboot to enable the new setting.

If you select... Then...

Automatic Time
and Date Settings
(NTP)

If not already displayed, the Date and Time screen refreshes to show
options for configuring a Network Time Protocol (NTP) server.

1. Enter the NTP Hostname for the NTP server you want to use. Do not
include !@#$^&*()> and < in the NTP hostname. For information about
NTP, see
support.ntp.org/bin/view/Main/WebHome.

2. Select the Time Zone you want to use (typically the one
corresponding to the location of the library).

3. Click Save. As soon as you click Save, the library reboots to start
using the new settings.

Notes:

• Because the NTP server is addressed using a hostname instead of an IP
address, you must configure at least one DNS server before you can use
NTP (see Configure Network Settings on page 124).
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If you select... Then...

• After you configure NTP, it can take up to an hour for the time to
synchronize with the NTP server.

Manual Time and
Date Settings
(Default)

If not already displayed, the Date and Time screen refreshes to show
options for manually setting the date and time.

1. Use the Date and Time + and – buttons to select the month, day
(date), year, hour, and minute values.

Note: The values in the Date & Time counters do not wrap. For example, to
change the month from December to January, click and hold the – button to
decrement the month.

2. Click Save. Click Previous to return to the System Setup screen.
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CONFIGURING OPTIONAL LIBRARY SETTINGS

This section describes optional configuration settings that you may select to use for your
library and operating environment.

Install a Security Certificate and Authentication Key

If you enabled SSL (see Enable SSL on page 120), use the following steps to obtain and install
a security certificate and private key.

Note: Beginning with BlueScale 12.8.00, the library uses TLS 1.2.

1. Obtain a security certificate and private key using one of the following methods:

IMPORTANT

The ssl.crt and ssl.key files can only contain ONE certification or key. The
BlueScale software does not support multiple keys (chaining keys) in the key
or certificate files. If there are multiple keys in the files, they are all considered
invalid.

IMPORTANT
When generating a self signed certificate using openssl, use the -x509
command line option. Loading a file without this option may cause the LCM
to hang.

IMPORTANT
When generating a self signed certificate or a certificate signing request using
openssl, use the -nodes command line option to prevent the key from being
encrypted.

• Create a Self-Signed Certificate

For example, to create a self-signed certificate and authentication key using openssl, use
the following command.

openssl req -x509 -nodes -days 365
-newkey rsa:2048 -keyout ssl.key -out ssl.crt

The openssl req command is a certificate request and certificate generating utility.
The following parameters are used in the example:

• -x509 - This option outputs a self signed certificate instead of a certificate request.
• -nodes - This option specifies that the private key not be encrypted.
• -days n - When the -x509 option is also used, this option specifies the number of
days (n) that the certificate is valid.

• -newkey rsa:nbits - Generates an RSA key nbits in size. The Library supports
RSA keys in bits of 512, 768, 1024 and 2048.

• -keyout filename - This option specifies the private key file name.
• -out filename - This option specifies the certificate file name.
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After entering the command, you are prompted to provide the following information.
Sample responses are shown.
• Country Name (2 letter code) [AU]: US
• State or Province Name (full name) [Some-State]: Colorado
• Locality Name (eg, city) []: Boulder
• Organization Name (eg, company) [Internet Widgits Pty Ltd]: Spectra Logic
• Organizational Unit Name (eg, section) []: DVT Test
• Common Name (e.g. server FQDN or YOUR name) []: T950@company.com
• Email Address []: support@company.com

• Request a Certificate Using a Certificate Signing Request

Request a security certificate and the authentication key from your signing authority
and process the key for use in with the BlueScale software.

i. Request a certificate from verisign.com, instantssl.com, letsencrypt.org or another SSL
certificate vendor to obtain the certificate. For example, to generate a certificate
signing request using openssl, use the following command:

openssl req -newkey rsa:2048 -nodes
-subj "/C=US/ST=Colorado/L=Boulder/O=Spectra/CN=DVT-T950" -out
ssl.csr -keyout ssl.key

The openssl req command is a certificate request and certificate generating utility.
The following parameters are used in the example:

• -newkey rsa:nbits - Generates a new certificate signing request and a new RSA
private key nbits in size. The Library supports RSA keys in bits of 512, 768, 1024 and
2048.

• -nodes - This option specifies that the private key not be encrypted.
• -subj "arg" - This option provides the answers to many of the prompts shown in
the example above.

• -keyout filename - This option specifies the private key file name.
• -out filename - This option specifies the certificate signing request file name.

ii. Send the certificate signing request to the signing authority. A certificate named
ssl.crt and a key named ssl.key will be returned.

2. The BlueScale web server must use an RSA private key and cannot use a key with a
passphrase. If the private key does not include BEGIN RSA PRIVATE KEY in the
header or uses a passphrase, rename the key to original_ssl.key and issue the
following command.

openssl rsa -in original_ssl.key -out ssl.key

If the key has a passphrase, issuing this command prompts you for the passphrase.

3. Save the security certificate file (ssl.crt) and the private key (ssl.key) in the root
folder of a USB device.
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Note: The security certificate file must be named ssl.crt and the private key must be named
ssl.key.

4. Connect the USB device to a port on the LCM (see Figure 10 on page 49) or the front
panel and wait for the device to mount.

5. Log into the library as a user with superuser or administrative privileges (see Log Into
the User Interface on page 97).

6. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

7. Select Utilities. The Utilities screen displays.

8. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

9. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

10.Scroll through the list of advanced utilities and select the Load SSL Certificate and Key
from USB utility.

Figure 55 Use the Load SSL Certificate and Key from USB
utility to load the security certificate onto the library.

11.Click Run Utility to copy the security certificate and private key to the TFinity library
web server.

Notes: l The SSL keys are not stored as part of the library configuration. If you replace the SD
card, you will have to reload these keys.

l To change or update the SSL keys, you must first manually delete the old keys from the
LCM. Contact Spectra Logic Technical Support for assistance (see Contacting Spectra
Logic on page 18).
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Configure Routine Maintenance

Overview

The Routine Maintenance option configures the library to automatically reset (reboot) the LCM
once a week. Using this option is not required as part of normal library operation and should
be left disabled unless you are requested to enable this by Spectra Logic Technical Support in
the course of troubleshooting or problem resolution.

IMPORTANT Do not enable this option unless specifically instructed to do so by Spectra
Logic Technical Support.

Enable the Routine Maintenance Option

Use the following steps if Spectra Logic Technical Support instructs you to enable the Routine
Maintenance option.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110).

2. Click Edit next to Routine Maintenance in the Other Settings pane. The Routine
Maintenance Configuration screen displays.

Figure 56 The Routine Maintenance Configuration screen.

3. Select Enable to enable the Routine Maintenance option.

4. Use the Day of Week and Hour drop-down lists to select when you want the automatic
reboot to occur.

Notes: l When the library automatically resets, all data storage operations currently in progress
fail. Spectra Logic recommends that you select a time when you are not performing
data storage operations.

l The reboot occurs sometime within the specified hour, not necessarily at the exact
time shown.

5. Click Save to finish. Click Previous to return to the System Setup screen.

JUNE 2025 136 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 4 - CONFIGURING THE LIBRARY



Enable and Configure SNMP

Overview

Simple Network Management Protocol (SNMP) is a protocol for monitoring the health and
welfare of your library by using integrated alerts. When SNMP is enabled, the Other Settings
pane in the System Setup screen includes options for enabling the SNMP agent and
configuring SNMP settings.

Note: Spectra Logic libraries implement SNMP Version 2.

Network-Based Library Management

If you are using a network-based library monitor/management application other than the
library’s BlueScale user interface, you may need to identify the library’s SNMP settings to the
application. These settings include the read, write, and broadcast community strings.

Configure SNMP

Use the following steps to enable and configure SNMP.

1. Access the System Setup screen (see Accessing the System Setup Screen on page 110) and
scroll down to the Other Settings pane.

2. Select Enable SNMP Agent to enable SNMP in the library and click Save. The System
Setup screen refreshes to include an option for editing the SNMP settings.

The agent returns information contained in the library’s Management Information Base
(MIB) to the workstation used to manage the network. The MIB defines what information
is available from the library over the network.

The MIB file is available for download from Spectra Logic at
support.spectralogic.com/downloads/tools/. The T950 and TFinity libraries use the same MIB
file.

3. Click Edit next to SNMP Settings. The SNMP Settings screen displays.
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Figure 57 The SNMP Settings screen.

4. Enter the following information on the SNMP Settings screen.

Field Description

System Contact Maps to the value for system.4 (sysContact) object in the MIB. Enter the
informations and click Save.

System Location Maps to the value for system.6 (sysLocation) object in the MIB. Enter the
informations and click Save.

Valid Query
Communities

Lists all SNMP communities to which the library currently belongs. The
library only responds to SNMP queries from members of these
communities. The default valid query community is public.

• Click Edit next to the setting you need to modify. The current settings
display in the corresponding Add/Update section of the screen. Click
Save in the corresponding Add/Update section of the screen after you
make your changes.
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Field Description

IMPORTANT Community strings are case sensitive. If the library is configured
to include the community called “OurCommunity,” it answers to queries from
OurCommunity but not from a community called “ourcommunity.”

• Click Delete to remove a setting.

Trap Destinations Lists all the currently configured trap destinations (IP addresses) to which
the library sends SNMP traps. There are no default trap destinations
configured.

• To add a trap destination, enter the required information in the
Add/Update Trap Destinations pane and click Save.

• Click Edit next to the setting you need to modify. The current settings
display in the corresponding Add/Update section of the screen. Click
Save in the corresponding Add/Update section of the screen after you
make your changes.

• Click Delete to remove a setting.

5. Click Previous to return to the System Configuration screen.

Configure Controller Failover

Overview

The library supports using two controllers (RIMs or RIM2s) to provide a redundant connection
to the TeraPorter(s). One RIM can be configured as the failover controller for multiple
partitions. See Controller Failover on page 80 for information about how controller failover
functions.

To use the controller failover feature, you must assign a failover partner to the RIM that is
configured to provide the partition’s robotic control path.

Notes: l You cannot mix a RIM and a RIM2 in a failover pair.

l If desired, you can configure multiple RIMs for the same partition and export the same
changer interface over them to provide redundancy as long as your software can
support this.

l If you configure controller failover before you create storage partitions, the secondary
controller in the failover pair is not available for use as the exporting controller for the
partitions.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure controller failover. See
Understanding User Groups and Security on page 106 for information about the three types of
user groups and what types of privileges each has.
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Configure Controller Failover

Use the following steps to enable and configure controller failover.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Controllers to display the Controllers
screen.

Figure 58 The Controllers screen before the failover
controller is selected.

3. Identify the controller that you configured to provide the robotic control path in a
partition (see Select the Robotic Control Path on page 205). This controller is the primary
controller in the failover pair.

Note: If you have not yet configured partitions, identify two RIMs. Both RIMs must be the same type
and at the same firmware version.

4. Click Failover next to the controller you want to be the primary controller in the failover
pair. The Controller Failover screen displays with a list of the other RIMs in the library
that can be used as the failover partner.

Notes: l The component identifiers for the RIMs show them as F-QIPs. See RIM Identifiers on
page 71 for more information.

l Only controllers the same type (RIM or RIM2) as the first controller selected, are listed
as possible failover partners.
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Figure 59 The Controller Failover screen.

5. Select the controller that you want to use as the failover partner for the primary
controller. This controller is the secondary controller in the failover pair.

IMPORTANT Make sure that the RIM you select is not already being used to provide the
robotic control path for another partition.

Notes: l To disable controller failover, select None. This is the default setting.

l When you select None or if you select a different RIM as the failover partner, the RIM
previously configured as the failover partner is once again available for use in a
partition.

6. Click OK to complete the assignment. The Controllers screen redisplays to show the two
controllers configured as a failover pair.

For example, in Figure 60 the RIM identified as FR2/DBA1/F-QIP1 is the primary
controller in the failover pair and provides the robotic control path for any partitions in
which it is used. The RIM identified as FR3/DBA1/F-QIP1 is the secondary controller in
the failover pair and automatically takes over for the primary controller if it detects a
problem.

Figure 60 The Controllers screen after configuring controller failover.
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7. To use the configured failover pair in a partition, select the RIM that is the primary
controller (see Step 3 on page 140) as the exporting controller (see Select the Robotic
Control Path on page 205).

Configure a Package Server

Overview

Configuring a package server is optional. A local package server can be used to store
BlueScale packages downloaded from Spectra Logic for updating the BlueScale software or
library component firmware. Update packages can also be downloaded directly from the
Spectra Logic website to the memory card in the library’s LCM or to a USB device.

Note: For additional information about BlueScale packages and how to use them, see Updating the
BlueScale Software and Library Firmware on page 471.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure a package server in the
BlueScale interface.

Configure a Package Server

Use the following steps to configure, modify, or delete a local package server.

1. Identify the server or servers you want to use for storing BlueScale packages. Make sure
that these servers can access the Internet and that they are on the same network as the
libraries you want to update.

Note: Both Microsoft’s Internet Information Services (IIS) and the Unix-based Apache server work as
package servers.

2. Log into the library as a user with superuser or administrator privileges.

3. Select Maintenance > Package Update. The Package Update screen displays.
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Figure 61 The Package Update screen.

4. Click Manage Package Servers.

The Manage Package Servers screen displays, and provides the following information for
each currently configured package server:

• Server name — Name assigned to the server when it was added.

• Server configuration settings — Includes the IP address of the package server, the
port, the IP address of the proxy server (if configured), and the directory where
BlueScale packages are stored.

• Auto Download setting — Indicates whether Auto Download is configured. If
configured (See Add a package server on the next page), the library checks the package
server once a week for a library update package and drive firmware package newer
than what the library is currently running. If a new package is available, the library
downloads it, generates a system message, and displays an icon on the status bar to
indicate the update is available (see Auto Download Icon on page 93). To modify auto
download options, see Modify Auto Download Options on page 145.

Figure 62 The Manage Package Servers screen.
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5. Click the correct button to add, delete, or edit a package server.

Task Procedure

Add a
package
server

1. Click Add. The Configure Package Server screen displays.

2. Fill in the requested information:

• Required—Name and IP Address

• Optional—Port, Proxy, and Directory fields use default values if nothing
is entered

3. Select or clear Automatically Download Latest Package.

• If selected, the library checks the package server once a week for a library
update package and drive firmware package newer than what the library
is currently running. If a new package is available, the library downloads
it, generates a system message, and displays an icon on the status bar to
indicate the update availability.

• If cleared, you must check for updates manually.

4. Click Save. The screen refreshes and adds the new server to the list of
available package servers.

Note: If you specify the directory, make sure you include the full path to the
directory where the BlueScale packages are stored.

Edit a
package
server

1. Click Edit next to the server’s name and details. The Configure Package
Server screen displays, with the appropriate fields completed.

2. Edit the server information as necessary.
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Task Procedure

3. Click Save.

Delete a
package
server

Click Delete next to the server’s name and details.

IMPORTANT There is no confirmation requested when you delete a package server.
After you click Delete, the server is immediately removed from the list of
available package servers. However, the packages on the server are not deleted.

Modify Auto Download Options

Overview

When auto download is enabled for a package server (see Add a package server on the
previous page) you can configure when the library sends notification of a new downloaded
package update or drive firmware update, and whether the download is automatically staged
to library devices capable of staging.

Note: For additional information about BlueScale packages and how to use them, see Updating the
BlueScale Software and Library Firmware on page 471.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure auto download options.

Configure Auto Download Options

Use the following steps to configure or modify auto download options.

1. Log into the library as a user with superuser or administrator privileges.

2. Select Maintenance > Package Update. The Package Update screen displays.
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Figure 63 The Package Update screen.

3. Click Auto Download Options. The Auto Download Options screen displays showing the
current auto download settings.

Figure 64 The Auto Download Options screen.

4. If you want to delay the notification about a new package, enter the number of days to
delay in the Delay Announcement field.

5. Enable or disable auto-staging of component firmware by selecting or clearing Auto-
stage library component firmware. The library does not apply the firmware until you
initiate a library or drive update. Enabling auto-staging decreases the time required to
complete a library or drive update.

6. Click Save to save the new settings.
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Configure Rotation Manager

Overview

If your site uses NetBackup™ Vault Manager or Symantec™ NetBackup, you can purchase the
Rotation Manager option to simplify identifying tapes moved off site. With Rotation Manager
installed, the library sends an email for each magazine that is exported (ejected) from the
library to a specified email recipient. The email includes the barcode information for the
magazine and an attachment that contains the barcode information for the cartridges it
contains.

Administrators can follow the instructions in the email they receive to import identifying
information for every barcode labeled cartridge and its off-site location into the storage
management software. Because the cartridge barcodes are associated with the barcode of the
magazine containing the cartridges, groups of cartridges can be located using a single barcode.
Refer to the documentation that accompanied your software for information about using the
vltcontainers command to manage the off-site magazines and cartridges.

Note: Before you can use Rotation Manager, you must enter the activation key to enable it as
described in Enter Activation Keys on page 113.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure Rotation Manager. See
Understanding User Groups and Security on page 106 for information about the three types of
user groups and what types of privileges each has.

Configure Rotation Manager

Use the following steps to configure the Rotation Manager.

1. Log into the library as a user with superuser or administrator privileges.

2. If necessary, obtain the activation key for Rotation Manager and enable it as described in
Enabling BlueScale Software Support, Options, and Upgrades on page 112.

3. From the toolbar menu, select General > Import Export > Rotation Manager. The
Rotation Manager Configuration screen displays.

Figure 65 The Rotation Manager Configuration screen.
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4. Symantec NetBackup is the only vendor supported by Rotation Manager and is selected
automatically.

Note: NetBackup Vault Manager was acquired by Symantec and continues to be supported by
Rotation Manager even though it is not listed on the Rotation Manager Configuration screen.

5. Select the Mail To email address to use for sending notifications.

Only previously configured mail recipients are listed. To send the notification to
someone who is not already listed as a library user, you must first configure that person
as an email recipient (see Configure Mail Users on page 127).

6. Click Save.
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BACKING UP THE LIBRARY CONFIGURATION

Overview

Keeping valid backup copies of your library’s configuration, the MLM and DLM databases,
and BlueScale encryption keys ensures that you can easily restore the library in the event of a
disaster. Having a backup of the library’s configuration is also extremely useful if problems
require you to replace the LCM or the memory card in the LCM. After the replacement
procedure is complete, you can use the saved configuration to restore the library’s settings,
including the partitions, instead of having to manually re-enter all of the information.

IMPORTANT Backing up the library configuration also backs up any BlueScale encryption
keys that are stored in the library at the time the file is created.

IMPORTANT
The backup configuration can only be used to restore the library that
generated the backup. The configuration is tied to the Hardware ID of the
library and cannot be transferred to another library.

Note: If the MLM database contains a large number of MLM and DLM records, generating the Auto
Configuration Save file can take several minutes.

Options

The library provides two methods for backing up the configuration:
• Automatic — See Use Automatic Backup of the Library Configuration below.

• Manual — See Use Manual Backup of the Library Configuration on the next page.

If you have valid backups of the library’s configuration and MLM database, you can use them
to restore the library (see Restoring the Library Configuration on page 420).

See Back Up and Protect the Library Metadata on page 547 for additional information about
backing up the library’s configuration information, the MLM database, the DLM database, and
any BlueScale encryption keys.

Use Automatic Backup of the Library Configuration

The Auto Configuration Save feature, which operates automatically, saves a backup of the
library configuration, the MLM and DLM databases, and any stored BlueScale encryption keys
to a time-stamped zip file on the memory card in the LCM. The zip file is named
<date-time>cfg.zip, where <date-time> is the time stamp for when the backup was created.
The library generates the Auto Configuration Save backup file once a week and whenever a
partition is created or modified.
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Note: The library does not generate an Auto Configuration Save backup file when you make
configuration changes other than creating or modifying a partition.

As an extra security measure, you can configure the library to automatically email the time-
stamped zip file to a previously configured email recipient each time the backup file is
created. Saving an external copy of the automatically generated configuration backup file
ensures that you can recover the library configuration, the MLM and DLM databases, and the
BlueScale encryption keys stored in the library in the event of a disaster.

When the recipient receives the email, they should verify the backup as described in Verify the
Configuration Backup on page 152 and Verify the Database Backup File on page 347.

For detailed information about configuring a mail recipient for the Auto Configuration Save
file and using it to restore the library, see:

• Enable Email for the Auto Configuration Save File on page 129

• Restore From an Auto Configuration Save File on page 420

Use Manual Backup of the Library Configuration

Overview

Whenever you make a configuration change to the library that does not result in the library
automatically generating a configuration backup file (for example, you entered activation keys
after the creation date of the most current automatically generated backup file), you can
manually back up the library configuration as described in this section.

Notes: l The Save Library Configuration utility described in this section does not back up the
MLM database or the DLM database.

To back up the MLM and DLM databases, use the Save MLM Database utility, as
described in Back Up the MLM and DLM Databases on page 345. After you create the
backup, be sure to verify it as described in Verify the Database Backup File on
page 347.

l Backing up the library configuration also backs up any BlueScale encryption keys that
are stored in the library at the time the file is created.

User Privilege Requirements

Only a user with superuser or administrator privileges can create a manual backup of the
library configuration. See Understanding User Groups and Security on page 106 for
information about the three types of user groups and what types of privileges each has.

Back Up the Library Configuration

1. Log into the library as a user with superuser or administrator privileges.
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2. If you want to save the configuration to a USB device, connect the device to a USB port
on the LCM or operator panel and wait for the device to mount before continuing.

Note: The save library configuration to USB option is only available if you connect a USB device
before you access the utilities screen (see Connect a USB Device to the Library on page 186).

3. Select Maintenance > Tools > Utilities. The Utilities screen displays a list of Basic
Utilities.

Figure 66 The Utilities screen.

4. Select the Save Library Configuration utility. The screen refreshes to show the details for
the utility.

Figure 67 The Save Library Configuration utility.

5. Use the Select the destination drop-down list to select where you want to save the file.

Note: Do not use the check boxes at the top of the screen. They act on the Utility Results message,
not the configuration file.
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Select... To...

save library
configuration to
USB

Save the library configuration file to the USB device connected to a USB
port on the LCM or operator panel. The backup file is stored in a folder
called SavedConfigs\<date-time>, where <date-time> is the time stamp
for when the backup was created. The folder contains multiple
configuration files with the format cnnnnnn.cfg, where n is a number
between 0 and 9.

mail library
configuration to
[mail recipient]

Send the library configuration file as a zip file attached to an email
addressed to a previously configured mail recipient (see Configure Mail
Users on page 127).

Note: Do not mail the file to autosupport@spectralogic.com unless Spectra Logic
Technical Support specifically requested the file for troubleshooting.

6. Click Run Utility.

After a brief delay, the Utility Results screen displays, showing that the configuration file
was either saved or sent.

7. Confirm that the backup was successful, as described in Verify the Configuration
Backup.

Verify the Configuration Backup

After creating a backup of your library configuration, use one of the methods described in the
following sections to verify that the backup was successful as soon as possible after you create
it.

When Saved to a USB Device

1. Plug the USB device into a USB port on an available computer.

2. Examine the list of files on the USB device and locate the \SavedConfigs folder.

3. Open the \SavedConfigs folder and verify that a folder with a name corresponding to
the date and time you created the backup is present.

4. Open the time-stamped folder and confirm that it contains several configuration files
named using the format cnnnnnn.cfg, where n is a number between 0 and 9. Make sure
the files are more than 0 bytes in size.

5. If the configuration files are present and are more than 0 bytes in size, the backup was
successful. Store the USB device in a safe location.

Note: You can zip the files in the folder and email the zip file to others or make additional copies of
the folder for safekeeping.
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6. If the configuration files are not present, or if any of the files are 0 bytes in size, repeat
the backup process (Use Manual Backup of the Library Configuration on page 150) using
a different USB device.

When Sent as an Email Attachment

1. Open the email and confirm that it contains a zip file attachment.

2. Open the zip file and confirm that it contains several configuration files named using the
format cnnnnnn.cfg, where n is a number between 0 and 9. Make sure the files are
more than 0 bytes in size.

3. If the configuration files are present and are more than 0 bytes in size, the backup was
successful. Save the zip file attachment to a safe location from which you can copy it to a
USB device, if needed.

Note: If desired, rename the zip file to indicate the date of the backup.

4. If the email attachment does not contain the configuration files or if one or more of the
files are 0 bytes in size, repeat the backup process (Use Manual Backup of the Library
Configuration on page 150) to send the email again.

Read Back Up and Protect the Library Metadata on page 547 for additional information about
backing up the library’s configuration information, the MLM and DLM databases, and
BlueScale encryption keys (this information is collectively referred to as the library metadata).

JUNE 2025 153 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 4 - CONFIGURING THE LIBRARY



SETTING THE CAMERA IP ADDRESS

Each BlueScale Vision camera requires a unique IP address. The camera IP addresses are
separate from the IP address used for communications with the library.

1. Connect an Ethernet cable from the BlueScale Vision camera connector on the back of the
frame containing the camera directly to a computer or to a network that is accessible to
the computer that will be used to configure the camera. The BlueScale Vision camera
connector is located at the top left of each frame that contains a camera.

Notes: l When you perform the initial IP address configuration for the camera, it may be helpful
to connect a computer directly to the BlueScale Vision camera connector for one
camera at a time instead of using a connection over a network.

l Depending on how the computer you are using is configured, you may need to
temporarily change the computer’s network settings so that it can access the camera.
The factory default settings for all cameras are:

IP Address Subnet Mask Default Gateway

10.10.10.11 255.255.255.0 10.10.10.1

l In order to comply with EMC requirements, use a shielded Ethernet cable to connect
the camera to your network.

Figure 68 Location of the BlueScale Vision camera connector.

JUNE 2025 154 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 4 - CONFIGURING THE LIBRARY



2. Start a web browser session on the computer you want to use to configure the camera.

Note: The software included with the black camera requires ActiveX to view the streaming video
and controls. You must use Internet Explorer or see Streaming video and camera controls do
not work for the library camera on page 391 for alternate solutions.

3. Enter the camera’s current IP address in the browser’s Address field. The start page for
the BlueScale Vision viewer opens.

Notes: l If this is the first time you are connecting to the camera, your browser may indicate
that an add-on is required.

l If you do not know the current IP address for the camera and the default IP address
does not work, see Discovering and Setting the BlueScale Vision Camera IP Address on
page 410.

Figure 69 The white BlueScale Vision camera
viewer start page.

Figure 70 The black BlueScale Vision camera
viewer start page.

4. Using Figure 69 and Figure 70, determine the type of BlueScale vision camera you have,
and use the appropriate section to configure the camera.

• If you have the white BlueScale vision camera, use Edit the Camera IP Address - White
below.

• If you have the black BlueScale vision camera, use Edit the Camera IP Address - Black
on page 158.

Edit the Camera IP Address - White

1. On the start page, click Administration.

JUNE 2025 155 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 4 - CONFIGURING THE LIBRARY



Figure 71 The white BlueScale Vision camera viewer start
page.

2. Log in using administrator (all lower case, case-sensitive) for the user name; leave the
password field blank, and click OK.

Figure 72 The Administration login screen.

3. On the System Settings screen, If desired, change the Camera Name to something that
helps you identify it in your environment. The default device name for the camera is
SLnnnnnn, where nnnnnn are the last 6 digits of the camera’s 12 digit hexadecimal MAC
address.
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Figure 73 The BlueScale Vision System Settings screen.

4. Select Network. The network connections configuration screen displays.

Figure 74 Configure the camera IP addressing.

5. Select either Obtain an IP address automatically (DHCP) or Use the following IP address.
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If you select Use the following IP address, enter the desired IP address, subnet mask, and
gateway addresses as required for your network and click Save. The factory defaults are:

IP Address Subnet Mask Default Gateway

10.10.10.11 255.255.255.0 10.10.10.1

6. After saving the new camera configuration verify the settings by attempting to access the
camera at the new IP address (see Using a Web browser on page 181).

7. If the library contains multiple cameras, repeat Step 1 on page 155 through Step 6 for
each camera. Make a record of the IP address for each camera and the frame in which
each camera is located.

IMPORTANT

If you set the camera to use a fixed IP address, record that address for later
reference. If you do not know the camera’s IP address, you must reset the
camera to use DHCP addressing before you can connect to it. The reset
process requires physically accessing the camera. Contact Spectra Logic
Technical Support for assistance (see Contacting Spectra Logic on page 18).

Edit the Camera IP Address - Black

1. Click Configuration to see the options for configuring the camera.

Figure 75 The viewing software home page.

2. Select System > General settings.

3. On the System General Settings screen, enter the following information:
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• If desired, change the Host name for the camera so that you can easily identify it. The
default hostname is “BlueScale Vision”. This name displays at the top of the screen. In
general, a hostname should not contain a space.

• Select to Keep current date and time, Synchronize with computer time, set the time
manually, or set the time automatically by entering the IP address or domain name for
an NTP server.

Figure 76 Enter a Host name and set the date if necessary.

4. Click Save.

5. Select Network > General settings.

6. On the Network General Settings screen, select Get IP address automatically (DHCP) or
Use fixed IP address.

If you select Use fixed IP address, set the desired IP, subnet mask, and gateway
addresses as required for your network and DNS (Domain Name Server) information.
The factory defaults are:

IP Address Subnet Mask Default Gateway

10.10.10.11 255.255.255.0 10.10.10.1

Notes: l The Primary DNS address is required in order to use the email alert or to access the
camera by hostname.

l The Secondary DNS is optional. If provided, it is used if the Primary DNS is unavailable.
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Figure 77 If you select Use fixed IP address, configure
the IP address for the camera.

7. Click Save.

8. After saving the new camera configuration verify the settings by attempting to access the
camera at the new IP address or hostname (see Using a Web browser on page 181).

9. If the library contains multiple cameras, repeat Step 1 on page 158 through Step 8 for
each camera. Make a record of the IP address for each camera and the frame in which
each camera is located.
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CHAPTER 5 - OPERATING THE LIBRARY
This chapter describes the following procedures for day-to-day operation of your library.

Controlling the Library Power 162
Power On the Library 162

Power Off the Library 163

Monitoring Your Library 166
Check and Respond to Messages 167

Use Performance Metrics 170

View Drive Status Information 173

View the TeraPorter Status Information 176

View a Partition’s World Wide Name 179

Use the BlueScale Vision Camera 180

Using a USB Device 185
Continuing Backups While Using a USB Device 185

Connect a USB Device to the Library 186

Controlling the Interior Lights 187
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CONTROLLING THE LIBRARY POWER

The library power is controlled using the front panel power button or the BlueScale Soft
Power feature.

Power On the Library

Before powering on the library, make sure that all of the library’s power cables are plugged
into AC outlets and that the AC breaker switches corresponding to each cable, on the back of
the main frame and each drive expansion frame, are set to the on (up) position.

IMPORTANT

For redundant AC power configurations, connect the primary and secondary
input for each frame to a separate branch circuit, which allows for failover in
the event of a power failure in one of the circuits (see Power Specifications on
page 576 for additional requirements).

Figure 78 Connect the AC inputs and set the breaker switches
to the on position.
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Use the Front Panel Power Button

1. Press and hold the front panel power button until the button’s LED illuminates and the
LCD operator panel turns on.

Figure 79 Connect the AC inputs and set the breaker switches
to the on position.

2. Wait while the library completes its power-on sequence. After the library completes its
power-on sequence, the Library Initialization screen displays (see Figure 39 on page 97).
This screen lists the required initialization steps and current status of the library’s major
components (Robotics, RCM, and LCM). Text boxes provide descriptions about the
currently active tasks.

3. After initialization is complete, the BlueScale login screen displays (see Log Into the User
Interface on page 97).

Note: If the library cannot complete the initialization process, it generates system messages and
enters maintenance mode. Contact Spectra Logic Technical Support for assistance (see
Contacting Spectra Logic on page 18).

Use the Automatic Power-Up After Power Failure Feature

The Automatic Power-Up After Power Failure feature lets you configure the library to power
on without user intervention after a power failure.

Notes: l The Automatic Power-Up After Power Failure feature must be enabled on the System
Setup screen (see Enable Automatic Power-Up After Power Failure on page 119).

l The library will not automatically power on if it was powered off using the front panel
power button or the Soft Power feature.

Power Off the Library

Before powering off the library, use the following steps to prepare for shut-down.

1. Use your storage management software to stop any backups running to the library.

2. Pause PostScan if it is running (see Pause the PostScan Process on page 334). Any tapes
currently being scanned are returned to their storage locations.
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3. Power off the library using one of the methods described in the following sections.

Note: If you intend to leave the library powered down for an extended length of time, set the AC
breaker switches on the back of the library (see Figure 78 on page 162) to the off position
after you power off the library.

Use the Front Panel Power Button

To power off the library, press and hold the front panel power button for approximately 5
seconds (the button’s LED starts flashing). The library begins its power-off sequence, which
allows the BlueScale software and components to shut down gracefully.

Use the Soft Power Feature

The Soft Power feature disables the physical power button on the library front panel and
enables the soft power button on the General Status screen. Using the Soft Power feature gives
users with superuser privileges exclusive control over powering the library off; other types of
users cannot power off the library, either by using the physical power button on the library
front panel or the Soft Power button on the General Status screen.

Notes: l The Soft Power feature is only available from the library’s front panel touch screen
interface; it is not available through the BlueScale web interface (RLC).

l When you click the Soft Power button, you must respond to a confirmation message
before the library is powered off.

l The Soft Power feature must be enabled on the System Setup screen before you can
use it (see Enable Soft Power on page 121).

l The feature can only be enabled or disabled by a superuser.

Follow these steps to power off the library using the Soft Power feature.

1. Log into the library as a user with superuser privileges (see Log Into the User Interface
on page 97).

2. From the toolbar, access the General Status screen.

3. Using the stylus, touch the blue power button on the picture of the library.
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Figure 80 The Soft Power button on the General Status screen.

When the cursor comes near the button, it changes to a pointing finger.

4. When you touch the button, the Soft Power Shutdown confirmation screen displays after
a brief delay. Click Continue to power off the library.

Figure 81 The Soft Power Shutdown confirmation screen.
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MONITORING YOUR LIBRARY
Overview

The BlueScale user interface provides a number of tools for monitoring the health and
performance of the library, its components, and its media. The quickest way to obtain
important information is to check the icons and bar graphs on the General Status screen (see
Status Bar on page 91). They provide at-a-glance information about the status of major system
components and resource usage, respectively. The icons on the status bar provide additional
system-level status information.

The following table lists where to find additional information about the health and
performance of the library, its components, and its media.

Check... To monitor... For details, see...

System Messages Events that resulted in system
messages about the library and its
operation.

Check and Respond to Messages
on the next page

Performance
Metrics

The performance of your library and
its drives.

• View Drive Performance
Statistics on page 170

• View Power Consumption
Statistics on page 172

• View Storage Density Statistics
on page 172

Drive Status The status, firmware level, and
cleaning status of the drives. The
Drive Details for each Fibre Channel
drive shows the World Wide Name
(WWN) for the drive.

• View Drive Status Information
on page 173

• Using a Global Spare Drive on
page 433

BlueScale Vision
Camera

The interior of the library using the
BlueScale Vision cameras.

Use the BlueScale Vision Camera
on page 180

Media Lifecycle
Management
(MLM)

The usage and health of MLM-
enabled media in the library.

Note: MLM also provides limited
health information about media that is
not MLM-enabled.

Configuring and Using Media
Lifecycle Management on page 301

Drive Lifecycle
Management
(DLM)

The usage and health of the drives
in the library.

Using Drive Lifecycle Management
on page 352
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Check... To monitor... For details, see...

Hardware Health
Monitoring

The health of key library
components.

Using BlueScale Hardware Health
Monitoring on page 395

User Privilege Requirements

All users can view system messages, view performance metrics, and use the BlueScale Vision
camera. The user privileges required to use the other monitoring tools depend on the tool.

Check and Respond to Messages

Check the library’s system messages regularly. These messages provide important information
about the library, its operation, and any library problems. Reviewing the messages is the first
step in troubleshooting.

Note: When you configure mail users, you can specify which types of system messages the library
automatically emails to each mail user. See Configure Mail Users on page 127 for detailed
information.

Use the BlueScale User Interface

Use the following steps to view BlueScale system messages through either the operator panel
or a web browser.

1. Log into the library.

2. Select the System Status icon on the status bar (see Figure 34 on page 92). The System
Messages screen displays.

Figure 82 The System Messages screen.
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The following table describes the severity ranking for messages.

Message Severity Description Response

Informational The library is working as intended.
An event occurred that generated
information about an operation or a
system component.

Example: The utility completed
successfully.

No action is required.

Warning The library is working as intended. An
event occurred that may require
attention to keep the library running at
100%.

Example: QuickScan did not
complete, but will retry.

If the event was unexpected,
determine the cause of the event
and take remedial steps.

Error The library operation is impaired and
requires user intervention.

Example: QuickScan did not
complete, and there is a tape stuck in
a drive as a result.

Determine the cause of the error
and take remedial steps.

Fatal Error The library has experienced an event
that prevents it from continuing
operations.

Example: The robot is not responding.

Examine any additional
information in the message and
take the required remedial steps.

3. Read the message(s), and follow any recommended steps.

Note: Some error messages are followed by a series of errors that provide additional information. To
understand the sequence of events, scroll back to view the first error message that was
produced, then read the others for clarification.

If you need assistance, contact Spectra Logic Technical Support (see Contacting Spectra
Logic on page 18).

4. When you are finished reading the messages and have completed the appropriate
actions, you can select and delete individual messages or you can delete all of the
messages.
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Use Syslog

The BlueScale Syslog feature sends all system messages logged by the library to a previously
configured Syslog server. Syslog is a standard for forwarding log messages over an Internet
Protocol (IP) computer network. It provides separation of the software that generates log
messages from the system that stores the messages.

Each system message the library sends to the Syslog server contains the original system
message posted by the library and the remedy information associated with the system
message.

See Syslog Server IP Address on page 121 for information about entering the IP address of the
Syslog server. Entering a valid IP address enables the Syslog feature.

When enabled, the BlueScale Syslog feature automatically sends all system messages posted by
the library to a single, previously configured Syslog server. The library transmits the messages
to the Syslog server using the format:

<severity level>BlueScale<library name>[PP]:(<message number>) <message text>

where:

Variable Definition

severity level Indicates the severity the library assigned to the message. This severity
corresponds to the syslog priorities as follows:

This library system message
severity...

Corresponds to this Syslog
priority...

Informational 6 (Informational)

Warning 4 (Warning)

Error 3 (Error)

Fatal Error 2 (Critical)

library name The name of the library, if configured. If the library name is not
configured, this value is set to “UnknownLibrary.”

Refer to Library Name on page 117 for information about setting the library
name.

PP Indicates the ID number of the process that was being performed by the
library’s BlueScale software when the system message was posted. This ID
number is for internal use only.
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Variable Definition

message number Indicates the order in which the Syslog server received the messages. The
counter increments each time a message is received, beginning at zero. The
counter can be used to determine whether all messages are arriving at the
Syslog server.

message text Shows the actual message posted by the library. Each system message
posted by the library generates two Syslog messages; one for the message
text and one for the remedy text. The two messages have the same
message number, which is included at the beginning of the message.

Use Performance Metrics

The library includes the following metrics for monitoring the performance of your library and
its drives.

• View Drive Performance Statistics on this page

• View Power Consumption Statistics on page 172

• View Storage Density Statistics on page 172

View Drive Performance Statistics

The Drive Performance metrics let you monitor the performance of your drives. This
innovative feature helps you optimize drive performance through load-balancing, tuning your
SAN, and identifying performance bottlenecks.

Note: The Drive Performance Monitoring option is disabled by default. Enable Drive Performance
Monitoring on page 119 provides instructions for enabling this option.

Use the following steps to view the performance data.

1. Select General > Metrics from the toolbar menu. The screen for the last metric you
viewed displays.

2. Select how you want to view the performance information from the available options:

• Total Library—The consolidated statistics for all the drives in the library.
• Partition n—The statistics for the drives in the specified partition.
• Drive n—The statistics for a specific drive.

3. Select either Drive Write Performance or Drive Read Performance from the Metric drop-
down menu.

Note: If you enabled or disabled the Drive Performance Monitor option when a drive contained a
cartridge, the drive is reported as empty on the Drive Performance screens.

4. Click Go. A screen showing the selected metric displays.
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Figure 83 The Drive Performance Monitor screen (Write
Performance for the Total Library shown).

5. Alternatively, you can view the Drive Performance metrics by selecting Configuration >
Drives (or DLM) and then clicking Drive Performance.

Note: The Drive Performance button is not present if Drive Performance Monitoring is not enabled
(see Enable Drive Performance Monitoring on page 119).

Figure 84 The Drives screen.
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View Power Consumption Statistics

In addition to the Power bar graph on the General Status screen, the BlueScale EnergyAudit
feature provides a configurable graphical display of the library’s power consumption.

Use the following steps to view the power consumption data for the library.

1. Select General > Metrics from the toolbar menu. The screen for the last metric you
viewed displays.

2. Select which power consumption metric you want to view from the Metric drop-down
menu:

• Power Consumption (kWh)

• Power Consumption (kWh/Ft2)

• Power Consumption (kWh/Ft3)

• Power Consumption (kWh/TB)

3. Click Go. A screen showing the selected metric displays.

Figure 85 The Power Consumption metrics screen.

View Storage Density Statistics

The Storage Density metrics let you monitor the amount of data your library is capable of
storing based on the number of data cartridges currently stored in the library.

Use the following steps to view the storage density data for the library.

1. Select General > Metrics from the toolbar menu. The screen for the last metric you
viewed displays.

2. Select Storage Density from the Metric pull-down menu.
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3. Select the media type and the unit of measure for the density values.

4. Click Go. The Storage Density screen showing the selected metrics displays.

Figure 86 The Storage Density metrics screen.

View Drive Status Information

The drive status icon on the General Status screen indicates the overall status of the library’s
drives. If the status icon indicates that a drive is experiencing a problem, view the Drive and
Drive Details screens for detailed information about a specific drive.

The Drive Details screen includes the drive firmware version and the manufacturer’s serial
number, as well as more detailed status information. From the Drive Details screen you can
access the Drive Lifecycle Management (DLM) report for the drive. See Using Drive Lifecycle
Management on page 352 for detailed information about DLM.

Use the following steps to view information about the individual drives in the library.

1. Log into the library as a user with administrator or superuser privileges.

2. Select Configuration > DLM (or Drives if DLM is not enabled) to display the Drives
screen. This screen lists all of the drives in the library, along with basic information
about each drive and the available operations for each drive.

Note: The operations available for each drive depend on how you are accessing the BlueScale user
interface and whether or not:

l DLM is enabled

l The drive is configured in a partition

l Auto Drive Clean is enabled for the partition
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Figure 87 The Drives screen.

3. Click Detail next to the drive for which you want to view detailed information. The
Drive Details screen displays.

Figure 88 The Drive Details screen.

The Drive Details screen shows the following information:

This field... Shows...

Drive Health The drive health icon (see Using the Drive Health Icons on page 356).

Drive WWN The Fibre Channel WWN for the drive (see World Wide Names for Fibre
Channel Drives on page 78 for detailed information about the WWNs for
drives) or the SAS port identifier for a SAS drive.

Spectra Drive SN The location-based serial number for the drive while it is in the library.
This serial number makes it possible to replace one drive with another
without having to reconfigure the storage management software that
accesses the drive.
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This field... Shows...

Note: For TS11xx technology drives, the serial number provided in response to
SCSI commands from the host has 00 appended to the end of the number that
displays on the front panel or is retrieved using XML.

Mfg Drive SN The serial number assigned to the physical drive by the drive
manufacturer. This serial number is required for tracking the drives when
they are not inside the library.

Drive FW The firmware version being used by the drive itself.

DCM FW The firmware version being used by the drive sled that houses the drive.

POST Status Shows the results of the drive’s POST (Power-On Self-Test).

Cleaning Status Shows the status of the drive’s Cleaning Tape Alert flag.

Library-based
Clean

Shows the last time that the drive was cleaned using the Auto Drive Clean
feature.

Note: This field is only present when a cleaning partition is associated with the
storage partition containing the drive.

LED Status Shows the state of the drive’s front panel status LED (see Interpreting the
Status LED Information on page 446).

Display Character
(SCD) or Display
Message (MCD)

Shows the code displayed on the drive’s single-character display (SCD) or
multi-character display (MCD) (see Interpreting the SCD and MCD Codes
on page 447).

Cartridge Status Indicates whether the drive is configured to compress data as it is written
and whether the drive contains a cartridge.

Note: No tape motion indicates either that the drive is empty or, if the drive
contains a cartridge, that the tape is not moving.

Automation Drive
Interface status

Whether the drive is configured to use the serial ADI transport protocol
(sADT) or the internet (Ethernet) ADI transport protocol (iADT), or
whether the ADI protocol is unknown.

4. From the Drive Details screen click DLM to access the Drive Lifecycle Management
(DLM) report for the drive (see Viewing and Saving a Detailed Drive Health Report on
page 357).

5. Use the information on the Drive Details screen and the DLM report to troubleshoot
drive problems (see Troubleshooting Drives on page 443).

If the drive is in an error state, contact Spectra Logic Technical Support (see Contacting
Spectra Logic on page 18).
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View the TeraPorter Status Information

The Robotics status icon on the General Status screen indicates the overall status of the
library’s robotic TeraPorter(s). If the status icon indicates that a TeraPorter may have a
problem, you can use the library’s Robotics Status screen to view information about the
current status of the individual TeraPorter(s) and the two isolating service bays, if included.

Note: The service bay is the area at the outer end of a service frame where the TeraPorter is parked
during service operations. Starting with BlueScale12.8.04, a non-isolating service frame
configuration is available that replaces the right and left service frame with media expansion
frames (see Service Frames on page 41).

The tabbed Robotics Status screen provides detailed information about each TeraPorter and its
service bay, if included. The Robotics Status screen also provides options for moving a
TeraPorter into service position, either in the service bay of a service frame or in the exclusion
zone of a right or left media expansion frame, and closing the safety door in a service frame.

Use the following steps to view the status of the TeraPorter(s) and service bays.

1. Log into the library.

2. From the toolbar menu, select General > General Status to display the library’s General
Status screen.

When you move the cursor over Robotics in the graphic, it changes to highlight the
robotics, as shown in Figure 89.

Figure 89 The General Status screen showing the robotics.

3. Click Robotics to display the Robotics Status screen.
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Note: See System Status Icon on page 92 for a description of the status icons that appear on this
screen.

Figure 90 The Robotics Status screen.

The Robotics Status screen contains three tabs:

• The Robots tab shows general status information about the TeraPorter(s) (robots).

Notes: l The icon in the upper right corner shows the status of the robotics power supply.

l The Begin Service button prepares the TeraPorter for service. It is only present if you
log into the library as a superuser or administrator from the library’s operator panel.

l Do not select Begin Service unless you have been instructed to do so by Spectra Logic
Technical Support. The TeraPorter can only be serviced by a Spectra-certified service
provider.

• The Service Frames tab only displays if the library has isolating service frames. It shows
information about the two service frames.

• The Tools tab is not currently used.

4. Click Details to view detailed information about the selected TeraPorter (robot).
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Figure 91 The Robot Details screen.

5. Click Previous to return to the Robotics Status screen.

6. Select the Service Frames tab to view the status of the two service frames.

Figure 92 The Robotics Status screen.

Notes: l See System Status Icon on page 92 for a description of the status icons that appear on
this screen.

l The Service Frames tab does not display if the library has non-isolating service frames.

l The Close Door button disengages the solenoid lock on the service bay safety door so
that it can be closed. It is only present if you log into a library with service frames as a
superuser or administrator from the library’s operator panel.

l Do not select Close Door unless you have been instructed to do so by Spectra Logic
Technical Support.

7. Click Details on the Service Frames tab to view detailed information about the selected
service bay.
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Figure 93 The Service Frame Details screen.

8. Click Previous to return to the Robotics Status screen.

9. Select any option on the Toolbar menu to exit the Robotic Status screen.

View a Partition’s World Wide Name

When monitoring connections to multiple libraries through a Fibre Channel switch, knowing
the World Wide Name (WWN) for a storage partition is useful for identifying a particular
library.

Note: From the Fibre Channel switch, each storage partition defined in the library appears as an
independent library connected to the Fibre Channel arbitrated loop or fabric.

To view the WWN for each storage partition configured in the library, select Configuration >
Partitions.The Shared Library Services screen displays.

Note: If multiple RIMs are configured as exporting controllers in a partition, there are multiple WWNs
for the partition. Click Summary to display the Partition Settings screen, which lists all of the
WWNs.
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Figure 94 The WWN assigned to the partition.

See World Wide Names for Partitions on page 76 for detailed information about the partition’s
WWN.

Use the BlueScale Vision Camera

The BlueScale Vision camera and web-based viewer let you see the interior of the library to
observe import and export operations, tape mounts, cartridge moves, and robotic operations in
real time.

Use the following steps to launch the BlueScale Vision viewer.

1. Connect an Ethernet cable from the BlueScale Vision camera connector on the back of the
frame to an Ethernet network.
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Figure 95 Location of the BlueScale Vision camera connector.

1. Connect to the BlueScale Vision viewer.

• Using the Camera Icon

i. Using a remote connection, log into the library’s BlueScale web interface using a
web browser.

Note: The software included with the black camera requires ActiveX® to view the streaming video
and controls. You must use Internet Explorer or see Streaming video and camera controls do
not work for the library camera on page 391 for alternate solutions.

ii. Select the camera icon on the status bar.

Notes: l The camera icons used to launch the BlueScale Vision viewer are not present until you
enter the IP addresses for up to three cameras in the System Configuration screen (see
BlueScale Vision IP Address on page 122).

l The order of the camera icons corresponds to the IP Address fields in the System Setup
screen and does not necessarily have any relationship to the physical position of the
cameras in the library. Make sure that you know which frame contains which camera.

Figure 96 The Status bar showing the camera icon.

• Using a Web browser
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In your web browser, enter the IP address of the camera you want to use. To determine
the IP address see Setting the Camera IP Address on page 154 and Discovering and
Setting the BlueScale Vision Camera IP Address on page 410.

Note: The software included with the black camera requires ActiveX® to view the streaming video
and controls. You must use Internet Explorer or see Streaming video and camera controls do
not work for the library camera on page 391 for alternate solutions.

2. The start page for the BlueScale Vision viewer opens.

Note: Depending on the firmware of the black camera, you may need to log into the camera. The
default username is root. The default password is Spectra123.

Figure 97 The white BlueScale Vision camera
viewer start page.

Figure 98 The black BlueScale Vision camera
viewer start page.

3. Using Figure 97 and Figure 98 on page 182, determine the type of BlueScale vision
camera you have, and see the appropriate section for information on controls for viewing
the inside of the library.

• If you have the white BlueScale vision camera, use Using the White BlueScale Vision
Camera on this page.

• If you have the black BlueScale vision camera, use Using the Black BlueScale Vision
Camera on the next page.

Using the White BlueScale Vision Camera

Select View Video on the start page to see the camera’s view of the library’s interior.
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Figure 99 The interior of the library as viewed by the
BlueScale Vision camera.

The buttons on the screen let you control the motion of the camera lens.

Note: There may be a short delay after you click on the icon for the desired motion. Wait a couple of
seconds for the camera to respond instead of clicking again.

Button Function

Moves the camera lens through the Preset positions in the
sequence defined by the Camera Administrator.

Pans the camera lens from left to right.

Moves the camera lens to the Motion Detection Preset
position.

Points the camera lens to the position corresponding to the
arrow on the button.

Read the BlueScale Vision Camera User Guide for detailed information about configuring and
using the BlueScale Vision camera. This guide also describes installing and using the camera’s
Viewing/Recording Utility.

Using the Black BlueScale Vision Camera

The screen displays the camera’s view of the library’s interior.
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Figure 100 The interior of the library as viewed by the
BlueScale Vision camera.

The buttons on the screen let you control the viewing area. The following table describes the
most commonly used buttons.

Note: There may be a short delay after you click on the icon for the desired change. Wait a couple of
seconds for the camera to respond instead of clicking again.

Button Function

Moves the camera view of a zoomed image in the direction
corresponding to the arrow on the button. These button only
operate after the camera view has been zoomed in. Click the
home button in the center of the position arrows to return to the
default view.

Zooms in and out. Click the home button, in the center of the
position arrows, to return to the default view.

Captures and saves still images. The captured images are
displayed in a pop-up window.

Starts recording a video clip to your computer in MP4 file
format.

Ends recording.

Read the Vivotek FD8361 Fixed Dome Network Camera User’s Manual for detailed information
about the remaining buttons and configuring and using the BlueScale Vision camera.
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USING A USB DEVICE

You can plug a USB device into the USB port on the library’s operator panel or into a USB
port on the LCM for transferring information such as backing up or restoring the library
configuration, backing up or restoring the MLM and DLM databases, importing or exporting
BlueScale encryption keys, gathering log files, or to upload BlueScale software updates to the
library.

IMPORTANT After connecting a USB device, allow time for the device to mount before
continuing.

IMPORTANT
Do not leave a USB device plugged into the library control module
indefinitely, unless specifically directed to do so by Spectra Logic Technical
Support.

One Spectra Logic USB device is shipped with the library, but most types of USB devices
work.

IMPORTANT
The library only recognizes FAT-formatted, not NTFS-formatted, USB devices.
If you are unable to access a USB device from the library, remove it and use a
different one.

Continuing Backups While Using a USB Device

When using a USB device, keep the following requirements in mind:

It is... to continue backups while...

Safe Exporting or importing a BlueScale encryption key to a USB device.

Saving library configurations and other information to a USB device.

Capturing traces and saving the trace results data to a USB device.

Not Safe Restoring a saved library configuration and other information from a USB
device.

Updating the library BlueScale software using an update package on a
USB device.
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Connect a USB Device to the Library

IMPORTANT Unless specifically instructed to do so, do not connect a USB device to the
USB port on the RCM.

Notes: l When connecting the USB device to the LCM, make sure that you do not inadvertently
connect it to the RCM. See Figure 11 on page 51 to identify the LCM.

l The library only recognizes FAT-formatted, not NTFS-formatted, USB devices.

l Not all USB devices are compatible with the library. If you are unable to access a USB
device from the library, remove it and use a different one. If the LCM stops responding
after you insert an incompatible USB device, reboot the LCM as described in Reset the
LCM or RCM on page 407.

l Plug the USB device into the LCM or operator panel and allow time for the device to
mount before beginning a procedure that reads or writes data. For many utilities, the
option to read from or write data to a USB device is not available if a USB device was
not connected before you select the utility.

Use the following steps to connect a USB device to the library.

1. Locate the USB port you want to use.

2. Plug the USB device into the USB port and allow time for the device to mount.

Figure 101 Location of the USB port on the library operator panel and the LCM.
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CONTROLLING THE INTERIOR LIGHTS

The LED light panels inside the library can be powered off if you are not using a BlueScale
Vision camera to monitor library operations. Use the following steps to power-off the interior
lights.

1. Log into the library with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Tools to display the Maintenance Tools
screen.

Figure 102 The Maintenance Tools screen.

3. Select Utilities. The Utilities screen displays.

4. Scroll down and select Turn Interior Lights Off. The Utilities screen refreshes to show a
description of the Turn Interior Lights Off utility.

Figure 103 The Utilities screen.

5. Select Run Utility to turn off the LED light panels in the library.

6. To turn the interior lights on again, repeat Step 1 through Step 5, using the Turn Interior
Lights On utility.
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CHAPTER 6 - CONFIGURING AND MANAGING
PARTITIONS
This chapter describes how to use the BlueScale partition wizard to configure and manage
partitions in the library.

Partition Configuration Overview 190
Partition Types and Requirements 190

Preparing to Configure Partitions 193

Creating a Cleaning Partition 196
Define the Initial Cleaning Partition Settings 196

Creating a Storage Partition 199
Define the Initial Storage Partition Settings 199

Configure Advanced Settings 201

Enter Storage Partition Name and Media Type 201

Enable or Disable SlotIQ 202

Select Barcode Options 203

Select the Robotic Control Path 205

Assign Global Spare Drives 206

Allocate Chambers and Drives 208

Enable and Configure MLM PreScan and PostScan 210

Select the Encryption Mode 214

Configure the Drive Fibre Channel Addressing 217

Specify the Partition Users 218

Configure the Robotic Path Visibility 218

Configure the Port Addressing for the Controllers 219

Confirming and Saving the Partition Settings 221
Configure Advanced Partition Settings 224

Configuring Emulation 224

Enable Soft Load 226

Enable Media Zoning 227

Enable Time-based Access Order System (TAOS) 228

Enable Robotic Load Balancing 230

Modifying an Existing Partition 232

JUNE 2025 188 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 6 - CONFIGURING AND MANAGING PARTITIONS



Deleting a Partition 236
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PARTITION CONFIGURATION OVERVIEW

Before you start configuring partitions in your library, it may be helpful to read the following:
• Media Pools, beginning on on page 61, to understand how the storage chambers in the
library are allocated.

• Library Partitions, beginning on on page 63, to learn how the library uses storage partitions
to create multiple virtual libraries.

• MLM PreScan and PostScan on page 308 to learn how the MLM PreScan and PostScan
features interact with the storage partitions.

Partition Types and Requirements

The library supports two types of partitions: storage partitions and cleaning partitions. When
configuring partitions, keep in mind the requirements in the following sections.

Global Considerations

The following information applies to both cleaning and storage partitions.

User Privilege Requirements

Only users with superuser or administrator privileges can create or modify partitions.

Background operations

You cannot create, modify, or delete a partition if the library is actively running a Media Auto
Discovery, PreScan, or PostScan operation, or if the library is performing certain other
background processes (for example, importing or exporting magazines using the bulk TAP or
updating drive firmware using the Update Drive Firmware wizard).

If you do not want to wait for a Media Auto Discovery, PreScan, or PostScan operation to
complete, you can stop the Media Auto Discovery or PreScan operation or pause the PostScan
operation. For other background operations, wait for the process to complete.

• To stop Media Auto Discovery or PreScan, click Stop Discovery on the Media Lifecycle
Management Tools screen (see Stop the Discovery Process on page 324).

• To pause PostScan for one hour, click Pause PostScan on the Media Lifecycle Management
Tools screen (see Pause the PostScan Process on page 334).

Configuring and Using Cleaning Partitions and Auto Drive Clean

• Cleaning partitions do not count against the partition maximum.
• A cleaning partition can be shared by multiple storage partitions as long as the cleaning
cartridges are compatible with the drive types in each storage partition.
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• Cleaning partitions use chambers that are not licensed with a Capacity On Demand (CoD)
key. If all of the chambers are licensed, a cleaning partition uses any chambers that are not
already assigned to another partition.

• Configuring a cleaning partition and assigning it to one or more storage partitions
automatically enables the Auto Drive Clean feature for those storage partitions (see
Creating a Cleaning Partition on page 196 and Allocate Chambers and Drives on page 208).

The drives in the storage partitions with an associated cleaning partition are cleaned
automatically when a drive indicates that it needs cleaning. In addition, you can use the
BlueScale user interface to initiate a manual cleaning. See Manually Cleaning a Drive on
page 502.

• The option to perform a manual cleaning operation using a cleaning cartridge in a cleaning
partition is only available for drives that are in storage partitions associated with a cleaning
partition.

• The cleaning cartridges in the cleaning partition are inaccessible to the storage management
software. If your storage management software supports automated drive cleaning and you
plan to use this method to clean the drives, store a TeraPack magazine (not a Maintenance
TeraPack magazine) containing one or more cleaning cartridges in the storage partition’s
storage pool. The storage management software can then access the cleaning cartridges
when needed.

IMPORTANT

If you store cleaning cartridges in the storage partition, make sure that they
are identified as required by your storage management software to prevent
the storage management software from attempting to use the cartridges for
writing or reading data.

• The cleaning cartridges used in a cleaning partition must be stored in specially labeled
Maintenance TeraPack magazines.

• If you do not configure a cleaning partition and associate it with the storage partitions, you
must use your storage management software to perform the cleaning or use the BlueScale
user interface to manually move a cleaning cartridge to the drive that needs cleaning (see
Manually Cleaning a Drive on page 502).

• If you configure a Global Spare drive for a partition, it is cleaned using a cleaning cartridge
stored in the cleaning partition. If a cleaning partition is not associated with the storage
partition, the Global Spare drive must be cleaned manually (see Manually Cleaning a Drive
on page 502).

JUNE 2025 191 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 6 - CONFIGURING AND MANAGING PARTITIONS



Configuring and Using Storage Partitions
• You can configure storage partitions either before or after you configure cleaning
partitions. However, if you know that you want to use Auto Drive Clean with a storage
partition, it is easier to configure the cleaning partition before you configure the storage
partition. If you choose to create the storage partition before you create the cleaning
partition, you need to modify the storage partition to assign the cleaning partition to it
(thereby enabling Auto Drive Clean for the partition).

• The library requires, at a minimum, one storage partition to be configured before you can
use the library. Each storage partition must have a minimum of one chamber assigned to
the storage pool. Each storage partition must also have at least one drive assigned to it.

• When using multiple tape technology generations, Spectra Logic strongly recommends
configuring separate partitions for each generation.

• When using both Fibre Channel and SAS drives in the library, the different drive interface
types must be in separate partitions.

• Chamber Availability — The number of chambers available for a storage partition depends
on how many chambers in the library are licensed, how many chambers are used by other
partitions, and whether or not Thin Provisioning is enabled.

• If Thin Provisioning is not enabled, the library automatically makes any licensed
chambers that are not already configured for use in another partition available to be
configured in the new partition. If all of the licensed chambers in your library are
already assigned to existing partitions, you must modify one or more partitions to make
chambers available for creating a new partition (see Modifying an Existing Partition on
page 232). You may also be able to license more chambers or make hardware upgrades
that increase the storage capacity of the library (see Hardware Expansion and Upgrades
on page 565).

• If Thin Provisioning is enabled, up to a combined total of 60,000 elements, including
storage slots (not chambers), entry/exit slots (not chambers), and drives are available for
each partition, no matter how many chambers are licensed or already assigned to
existing partitions. Using Thin Provisioning, it is possible for the combined configured
number of storage slots in all partitions to exceed the licensed or physically available
number of slots. Empty slots are inaccessible elements until a TeraPack magazine is
imported into a partition. At that time, the slots are made accessible to only the
partition into which the magazine was imported.

• Restrictions on the Number of Partitions — By default, you can only create a single storage
partition. If you need additional storage partitions, you must purchase a Shared Library
Services (SLS) activation key. Refer to Enabling BlueScale Software Support, Options, and
Upgrades on page 112 for information about purchasing and entering activation keys.

• Libraries running BlueScale software versions earlier than BlueScale12.6.3, are limited to
eight storage partitions.

• Libraries using BlueScale12.6.3 or later can have a maximum of 16 storage partitions.
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Notes: l Cleaning partitions do not require an SLS activation key and do not count toward the
partition maximum.

l The more partitions in a library, the longer each move can take. If move requests can
be sent to several partitions at once, you may need to increase the timeout setting in
your storage management software.

• Restrictions on Exporters — Each partition is exported by a RIM or drive.

• With BlueScale12.7.00 to BlueScale 12.8.01.04, the maximum number of physical
exporting devices (RIMs) supported by the library is six. If the library contains RIMs in
excess of the six exporters, the additional RIMs can be used for failover (see Controller
Failover on page 80).

• With BlueScale12.8.07 or later, the library supports 12 RIM exporters and 48 drive
exporters.

Note: A single RIM can export up to eight partitions, but still only count as one exporter; a single
RIM2 can export up to 16 partitions, but still only count as one exporter.

• If the library has Thin Provisioning enabled, a single RIM can export 60,000 elements. A
single RIM2 does not have this limit.

• If desired, you can configure multiple exporting RIM controllers to a single partition
and use your host software to export the same changer interface over the controllers to
provide redundancy.

• Spectra Logic recommends using a direct-attached drive as the exporting controller for a
partition unless you need to configure the partition for media zoning, which is used by
software packages such as High Performance Storage System (HPSS) and HPE Data
Management Framework (DMF).

PREPARING TO CONFIGURE PARTITIONS

Before you begin configuring partitions, gather the information listed in the following table.

Note: Each chamber holds a single magazine.

Component Description

Media type Determine the type of media (for example, LTO or LTO Clean) to be used in the
partition. You can only select from media types that are compatible with the drives
already installed in the library. If there are multiple drive technologies installed in
the library, the media type you select determines the type of drive that can be used
in the partition. Selecting a “Clean” media type starts the process of creating a
cleaning partition for use with the specified media type.
Note: Only one media type can be used in each partition. Each media type has its own
unique TeraPack magazine and TeraPack barcode.
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Component Description

Cleaning
partition:
number of
chambers

If you plan to use the Auto Drive Clean feature, determine the number of
chambers to be used for the cleaning partition. A cleaning partition can be shared
by multiple storage partitions as long as the cleaning cartridges are compatible
with the drives in the storage partitions. See Configuring and Using Cleaning
Partitions and Auto Drive Clean on page 190 for information about using cleaning
partitions.

Entry/Exit
pool:
number of
chambers

Determine the number of chambers to be used for the partition’s entry/exit pool.
See Entry/Exit pool on page 61 for information about how the entry/exit pool is
used.

Storage pool:
number of
chambers

Determine the number of chambers to be used for the partition’s storage pool. See
Storage pool on page 62 for information about how the storage pool is used.

Drives
assigned
to the storage
partition

Determine which drives to assign to the partition. Only drives that are already
installed in the library and are compatible with the media type you select are
available. Each storage partition must have at least one drive assigned to it. You
cannot use Fibre Channel and SAS drives in the same partition.

Note: In a library with multiple partitions, optimize performance by assigning drives to
the partition using the following best practices:

• Assign drives physically located in the same vertical column to one partition;
when possible, do not use drives from one vertical column in different
partitions.

• If the number of drives needed in the partition is greater than the number of
drives in a single column, use drives in adjacent columns.

Global Spares Determine which drives to designate as Global Spares if you plan to use this
feature. See Assign Global Spare Drives on page 206 for detailed information about
the requirements for using Global Spares.

IMPORTANT If you plan to use one of the PostScan features that uses a Global Spare,
one or more Global Spare drives must be configured for the partition.

Note: SAS drives cannot be configured as Global Spares.

PreScan and
PostScan

Decide whether or not you want the library to scan the cartridges in the partition
for media errors. See Using PreScan on page 325 and Using PostScan on page 327
for detailed information about the PreScan and PostScan features.

Encryption
mode

Decide whether or not to encrypt data in the partition and what type of encryption
and encryption key management to use. The Encryption screen does not display
unless you are logged into the library as an encryption user and have either
created one or more BlueScale encryption keys or configured a Spectra SKLM or
KMIP server. See the Spectra Tape Libraries Encryption User Guide for details.
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Component Description

Robotic
control path

Decide on the exporting controller (drive or RIM) for the library’s robotics.

IMPORTANT If the exporting controller is used by other partitions, wait for any
moves in progress to complete, and make the controller offline to all host
applications before creating a new partition.

Notes:

• If you plan to select both ports on the exporting controller, make sure that the
software used with the partition supports using multiple control paths and that
the ports are cabled correctly. Selecting both ports provides redundancy, but
requires software that supports two control paths to the robotics.

• You can select multiple exporting controllers (Drives or RIMs) for a partition and
use your host software to either export the same changer interface over the
controllers to provide redundancy, or send multiple moves to the partition
which are analyzed by MediaIQ so that the moves are processed in the most
efficient way.

• With BlueScale12.7.03 to BlueScale12.8.01.04, the maximum number of exporters
supported by the library is six. A single RIM can export up to eight partitions,
but still only count as one exporter; a single RIM2 can export up to 16 partitions,
but still only count as one exporter.

• For BlueScale12.8.07 and later, the library supports 12 RIM exporters and 48
drive exporters.

• A single RIM can export up to eight partitions, but still only count as one
exporter; a single RIM2 can export up to 16 partitions, but still only count as one
exporter.

• Spectra Logic recommends using a direct-attached drive as the exporting
controller for a partition unless you need to configure the partition for media
zoning, which is used by software packages such as High Performance Storage
System (HPSS) and HPE Data Management Framework (DMF).

Controller
(RIM) port
addressing

Decide what port addressing (soft addressing or Loop ID) and Fibre mode (Loop,
Fabric, or Auto-negotiate) each port on the controller uses. If you select soft
addressing, each Fibre Channel port is assigned a unique address when it connects
to the Fibre Channel arbitrated loop, fabric, or SAN. If you do not use soft
addressing, each port uses the fixed Loop ID you set.

Direct-
attached
Fibre Channel
drive
addressing

For each Fibre Channel drive, decide whether to use soft addressing or an assigned
Loop ID. If you select soft addressing, each Fibre Channel port is identified by an
address assigned to the drive when it connects to the Fibre Channel arbitrated
loop, fabric, or SAN. If you do not use soft addressing, each port uses the fixed
Loop ID you set.

JUNE 2025 195 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 6 - CONFIGURING AND MANAGING PARTITIONS



CREATING A CLEANING PARTITION

The following sections describe using the BlueScale partition wizard to create a cleaning
partition for your library.

If you know that you want to use Auto Drive Clean with a storage partition, it is easier to
configure the cleaning partition before you configure the storage partition(s). If you choose to
create the storage partitions before you create the cleaning partition, Auto Drive Clean is not
enabled until you modify the storage partitions to assign a cleaning partition to them.

Note: If you want to configure the storage partitions first, skip to Creating a Storage Partition on
page 199.

Define the Initial Cleaning Partition Settings

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions to display the Shared Library
Services screen.

• If one or more partitions are already created, the existing partitions are listed in
alphabetical order. Click New to display the Name and Media Type screen.

Note: If the New button is not displayed then all chambers in the library are allocated. You need to
delete a partition or edit an existing partition to free up chambers, or make hardware
upgrades that increase the storage capacity of the library before you can create another
partition.

Figure 104 Click New on the Shared Library Services screen
to begin creating the cleaning partition.

• If the library does not currently have any partitions configured, select Manually create a
partition, then click New to display the Name and Media Type screen.

IMPORTANT

Do not select the Automatically create a partition option. Doing so
configures a storage partition using the majority of the licensed chambers.
You then need to modify the storage partition to make chambers available
for a cleaning partition.
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Figure 105 Select Manually create a partition.

3. Enter a name for the partition and select LTO Clean or TS11x0 Clean as the media type.

Figure 106 Enter a name for the partition and select LTO
Clean or TS11x0 Clean to create a cleaning partition.

For this
field... Do the following...

Name Enter a unique, descriptive name to identify the partition as a cleaning partition. Names
can be any length and can include @ - _ /. and the space character. Partition names over
32 characters causes a scroll bar to display on some screens and are not recommended.

Note: The default name for a cleaning partition is “Cleaning n”, where n is a number. The
partition names are listed alphabetically on many of the BlueScale screens. If you want the
cleaning partitions to be listed after the storage partitions, precede the name with a “z” or “_”.

Media
Type

Select LTO Clean or TS11x0 Clean to create a cleaning partition.
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4. >From the Name and Media Type screen, click Next. The Chambers and Drives screen
displays.

Figure 107 Specify the number of chambers.

5. Enter the number of chambers you want to assign to the cleaning partition.

6. Proceed to Confirming and Saving the Partition Settings on page 221.
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CREATING A STORAGE PARTITION
The following sections describe using the BlueScale partition wizard to create a new storage
partition.

Define the Initial Storage Partition Settings
If you did not yet create any partitions on the library, you can choose to either have the
BlueScale partition wizard automatically create a single storage partition that uses all or most
of the licensed chambers and installed drives or you can use the wizard to manually create
storage partitions to your own specifications.

IMPORTANT The drives you plan to use in the partition must be installed in the library
before you start configuring the partition.

IMPORTANT Components not configured in a partition may not display in the BlueScale
interface for a few minutes after library initialization.

Automatically Create a Partition

Use the following steps to have the BlueScale partition wizard automatically create a single
storage partition. The partition uses all installed drives, has a single chamber assigned to the
entry/exit pool, and has all or most of the remaining licensed chambers assigned to the storage
pool. If the entire library is licensed, one chamber per frame is left out of the partition to
optimize tape movements.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions to display the Shared Library
Services screen.

3. Select Automatically create a partition from the initial Shared Library Services screen
(see Figure 108 on page 200) and click New.

Notes: l This option is only available if all of the drives in the library are of the same type (LTO
or TS11xx technology) and there are currently no partitions, including cleaning
partitions.

l If you want to use Auto Drive Clean with the partition and the library does not contain
unlicensed chambers, you need to modify the partition after it is created to remove
some of the chambers assigned to it so that you can create a cleaning partition.

l If you want to use the Global Spare option with the partition, you need to modify the
partition after it is created to unassign one or more of the drives that were
automatically assigned to the partition, and then reassign those drives as Global
Spares.
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l If you want to use encryption with the partition, you need to modify the partition after
it is created to enable encryption (see the Spectra Tape Libraries Encryption User Guide).

l If the library includes a bulk TAP for importing and exporting magazines, you may
want to modify the partition after it is created to reassign some of the chambers
assigned to the storage pool to provide additional chambers in the entry/exit pool.

4. Continue with Confirming and Saving the Partition Settings on page 221.

Manually Create a Partition

Use the following steps to create a storage partition using the partition wizard.

1. Log in as a user with superuser or administrator privileges. If you want to configure
encryption in the partition, you must also log in as an encryption user (see the Spectra
Tape Libraries Encryption User Guide for more details).

2. From the toolbar menu, select Configuration > Partitions to display the Shared Library
Services screen.

• If one or more partitions already exist, the existing partitions are listed in alphabetical
order. Click New to display the Name and Media Type screen.

Note: If the New button is not displayed, then all chambers in the library are allocated or the
maximum number of partitions already exist. You need to delete or edit an existing partition
to free up chambers, license more chambers, or make hardware upgrades that increase the
storage capacity of the library before you can create another partition.

Figure 108 Click New on the Shared Library Services screen
to begin creating the storage partition.

• If the library does not currently have any partitions configured, select Manually create a
partition and click New to display the Name and Media Type screen
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Figure 109 Select Manually create a partition on the
Shared Library Services screen when there are no partitions.

Configure Advanced Settings

If necessary, click Advanced to configure advanced partition settings. See Configure Advanced
Partition Settings on page 224 for a description of the advanced options and instructions for
configuring them.

CAUTION Advanced partition settings should only be used when recommended by
Spectra Logic Technical Support.

Otherwise, continue with Enter Storage Partition Name and Media Type.

Enter Storage Partition Name and Media Type

Enter a name for the storage partition and select the media type.

Note: If the storage partition media type is grayed out, then all licensed chambers are assigned to
partitions. Edit an existing partition to free up chambers or purchase a Capacity on Demand
key to increase the number of available storage chambers
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Figure 110 Enter a name for the partition and select the
media type.

For this
field... Do the following...

Name Enter a unique, descriptive name to identify the partition. Names can be any length and
can include @ - _ /. and the space character. Partition names over 32 characters causes a
scroll bar to display on some screens and are not recommended.

The default name for a storage partition is “Partition n”, where n is a number.

Note: In many of the BlueScale screens, the partitions are listed alphabetically. Keep this in
mind when naming your partitions.

Media
Type

Select LTO to create a storage partition that uses LTO drives and media or TS11x0 to create a
storage partition that uses TS11xx technology drives and media.

Enable or Disable SlotIQ
Choose whether the partition uses SlotIQ, which optimizes performance by virtualizing the
library inventory.

Notes: l SlotIQ is not compatible with T10K drives.

l SlotIQ cannot be enabled if the advanced utility Tape Barcode Verification is enabled.

1. From the Name and Media Type screen, click Next. The SlotIQ screen displays.
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Figure 111 Enable or disable SlotIQ.

2. Select Default or Enable SlotIQ.

Select Barcode Options

Choose the barcode label options for the partition. Spectra Certified data cartridges with
standard barcode labels use a barcode with eight human-readable characters followed by a
checksum character that is not
human-readable.

By default, the library:

• Expects barcode labels with checksums (that is, it treats the right-most character as a
checksum character).

• Uses the checksum character to validate the barcode.

• Reports up to 16 characters but does not report the checksum character.

Note: If you change the barcode options for a partition, the library will report a tape mismatch error
when tape cartridges previously discovered by MLM are loaded into a drive.

1. From the SlotIQ screen, click Next. The Barcode Options screen displays.
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Figure 112 Select barcode options for the partition.

2. Select the checksummed behavior.

Use this
parameter If...

Non-check-
summed
barcodes

Your labels do not include a checksum.

Check-
summed
barcodes
(default)

Your labels include a checksum and you want the barcode verified against the
checksum when it is read. Verification is not generally required, but adds extra
confirmation that the barcode label was read correctly by the barcode reader.

Ignore
check-sum
barcodes

Your labels include a checksum character but you do not want the barcode verified
against the checksum when it is read.

3. Select from which side to truncate if not all characters are reported.

Use this
parameter If...

Report left-
hand
characters

You want the library to report only the left-most x characters in the barcode, where
x is any number from 1 to 16.

For example, if the barcode is 1234567L2 and you configure the library to report
only the five left-most characters, the library reports the barcode as 12345.
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Use this
parameter If...

IMPORTANT Be careful when specifying the number of left-most characters to report.
You may end up with duplicate barcodes reported. For example, 12345XXXL2 and
12345ABCL3 are both reported as 12345.

Report right-
hand
characters
(default)

You want the library to report only the right-most x characters in the barcode,
where x is any number from 1 to 16.

For example, if the barcode is 1234567L2 and you configure the library to report the
five right-most characters, the library reports the barcode as 567L2.

IMPORTANT Be careful when specifying the number of right-most characters to report.
You may end up with duplicate barcodes reported. For example, 1234567L2 and
ABCD567L2 are both reported as 567L2.

4. If you want to specify the number of barcode characters the library reports, enter a
number from 1 to 16 in the Select the number of characters to report field. If your labels
include a checksum, the number you enter includes the checksum character. The default
number of characters is 16.

Select the Robotic Control Path

Controllers in the library are used to provide the robotic control path for the partition. The
controller “exports” the partition to the hosts, receiving and processing the robotic motion
commands sent from the host to move tapes. RIMs, LTO-6 and later generation drives, and
TS1155, TS1160, and TS1170 technology drives can act as controllers.

Spectra Logic recommends using a direct-attached drive as the exporting controller for a
partition unless you need to configure the partition for media zoning, which is used by
software packages such as High Performance Storage System (HPSS) and HPE Data
Management Framework (DMF).

Notes: l A RIM is identified as an F-QIP in the Robotic Control Path screen and other screens
that reference the controllers. See RIM Identifiers on page 71 for additional information
about the RIM identifier.

l You can select multiple exporting controllers (RIMs or drives) for a partition and use
your host software to either export the same changer interface over the controllers to
provide redundancy, or send multiple moves to the partition which are analyzed by
MediaIQ so that the moves are processed in the most efficient way.

l Partitions with greater than 930 slots, or spanning more than one frame, should use a
RIM for robotic control path. Exceeding this number with a drive providing the robotic
control path may cause an inventory operation to time out in your data storage
software.

l If a partition uses multiple exporting controllers, the partition cannot use QuickScan.
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l For BlueScale12.7.03 through BlueScale12.8.01.04, the maximum number of exporters
supported by the library is six.

l For BlueScale12.8.07 and later, the library supports 12 RIM exporters and 48 drive
exporters.

l A single RIM can export up to eight partitions, but still only count as one exporter; a
single RIM2 can export up to 16 partitions, but still only count as one exporter.

Use the following instructions to select the robotic control path:

1. From the Barcode Options screen, click Next. The Robotic Control Path screen displays a
list of the controllers currently installed in the library.

Figure 113 Select the exporting controller.

2. Select the controller(s) to provide the control path for the robotics.

IMPORTANT

If you want to use the controller failover feature for RIMs (see Configure
Controller Failover on page 139), keep the following requirements in mind:
l You must have at least two RIMs installed in the library.
l If you configured controller failover before you configured the storage

partition, select the primary controller in the failover pair to provide the
robotic control path.

Assign Global Spare Drives

The Global Spare option lets you remotely substitute a working drive for a failed one using a
spare drive in the library. Having a Global Spare drive in the library lets you continue your
backup operations and replace the failed drive the next time you are physically present at the
library. See Using a Global Spare Drive on page 433 for instructions on how to use the Global
Spare drive in place of a failed drive.

Requirements

Before you can configure the Global Spare option, the following requirements must be met:
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• The partition must use direct-attached Fibre Channel LTO or TS11xx technology drives.
SAS drives are not supported as Global Spares.

• In addition to the drives assigned to the partition for use by the host software, the library
must have direct-attached Fibre Channel drives available for use as spares in the partition.

• All of the drives in a partition with a Global Spare must match the technology and
generation of the Global Spare.

• The drives that are configured as Global Spares must be connected to the same Fibre
Channel arbitrated loop or fabric as the drives they would replace. You may need to
reconfigure your switch to access the Global Spare drive.

Partition Requirements

When configuring the partition, keep the following in mind:

• The type of drive you select as the Global Spare determines the type of drives that you can
assign to the partition.

• The library prevents you from selecting drives that cannot be used as Global Spares,
including drives already selected as controllers.

• Although a Global Spare drive can be shared by multiple partitions, the drive can only be
used by one partition at a time. To ensure that each partition has access to a Global Spare
when needed, configure one or more dedicated Global Spare drives for each partition.

• If you do not currently have a drive that can be used as a Global Spare installed in the
library, but install one later, you can edit the partition to configure Global Spares.

PostScan Requirements

If you plan to use one of the MLM PostScan features that requires a Global Spare drive, you
must configure at least one Global Spare drive for the partition.

Keep in mind that when the PostScan process starts, it “owns” the Global Spare drive it is
using until all of the cartridges in the PostScan queue are processed (unless you pause the
PostScan operation as described in Pause the PostScan Process on page 334). If a shared Global
Spare drive is being used for PostScan it is not available for use as a spare. Configuring one or
more dedicated Global Spare drives for each partition that uses PostScan is highly
recommended.

Note: See Using PostScan on page 327 for information about the PostScan feature.

Configuration Process

Use the following steps to configure one or more Global Spare drives for the partition.

1. From the Robotic Control Path screen, click Next. The Spare Drives screen lists the drives
that are available for use as Global Spares.

If you do not want to configure spare drives, click Next again and skip to Allocate
Chambers and Drives on the next page.
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2. Select one or more of the available drives to be designated as spares. Drives that cannot
be used as spares are grayed out.

Figure 114 Select the drives you want to use as Global
Spares.

Allocate Chambers and Drives

Use the following steps to allocate chambers and drives for the partition.

Note: In a library with multiple partitions, optimize performance by assigning drives to the partition
using the following best practices:

l Assign drives physically located in the same vertical column to one partition; when
possible, do not use drives from one vertical column in different partitions.

l If the number of drives needed in the partition is greater than the number of drives in
a single column, use drives in adjacent columns.

Use the following steps to allocate chambers and drives for the partition.

1. From the Spare Drives screen, click Next. The Chambers and Drives screen displays.
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Figure 115 The Chambers and Drives screen
for a library without Thin Provisioning enabled.

Figure 116 The Chambers and Drives screen for
a library with Thin Provisioning enabled.

2. Complete the following information in the Chambers and Drives screen.

For this
field... Do the following...

Storage
Chambers

Enter the number of storage chambers to assign to the storage pool for this partition.
If Thin Provisioning is not enabled in the library, the screen displays how many
chambers are available for the partition. If Thin Provisioning is enabled, the screen
displays how many elements (storage slots + entry/exit slots + drives) are allowed.
Notes:

• Each chamber accommodates one TeraPack magazine. Each magazine has slots for
either ten LTO cartridges or nine TS11xx technology cartridges.

• If Thin Provisioning is enabled it is possible for the combined configured number
of storage slots in all partitions to exceed the licensed or physically available
number of slots.

• If Thin Provisioning is not enabled:
• If you plan to create multiple partitions, be sure to reserve enough chambers to
configure the other partitions.

• If you licensed all of the chambers in the library and want to use a cleaning
partition, be sure to reserve enough chambers for the cleaning partition. If you
did not license all of the chambers in the library, the unlicensed chambers are
available for use in cleaning partitions.
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For this
field... Do the following...

EE
Chambers

Enter the number of chambers to assign to the entry/exit pool for this partition.

Notes:

• Some storage management software features require an entry/exit pool. Spectra
Logic recommends assigning at least one entry/exit chamber.

• It is useful for the entry/exit pool to be larger than the expected import/export
operations you plan to do on a daily or weekly basis. If you plan to use a bulk
TAP for importing or exporting multiple magazines, you may want to assign 14
chambers to the entry/exit pool.

• The cartridges stored in the entry/exit pool are not accessible to the storage
management software for writing or reading data.

Drives Select the drives to be dedicated to this partition. The check boxes for any installed
drives that cannot be used in the partition are grayed out. Any drive already
selected as a controller is automatically selected and cannot be cleared.

• You cannot use Fibre Channel and SAS drives in the same partition.
• If you enabled Global Spares (see Assign Global Spare Drives on page 206), you
can only select direct-attached Fibre Channel drives of the same generation as the
Global Spare drive assigned to the partition.

• If you plan to mix multiple generations of LTO cartridges in the same partition,
make sure that the drives in the partition are compatible with every generation of
data cartridge in the partition (see LTO Read/Write Compatibility on page 600 for
compatibility information).

Cleaning
Partition

Select the name of the cleaning partition to be used for the drives in the storage
partition. Associating a cleaning partition with the storage partition enables the
Auto Drive Clean feature for the partition. If you do not want to enable Auto Drive
Clean, select None.
Note: The option to select a cleaning partition is only available if you previously
configured a cleaning partition that uses the same type of media as the storage partition
(see Creating a Cleaning Partition on page 196). If you create a cleaning partition later,
edit the storage partition to associate the cleaning partition with it.

Enable and Configure MLM PreScan and PostScan

When MLM is enabled, you can configure the partition to use the MLM PreScan and PostScan
features. The available features depend on the drive type used in the partition. See Using
PreScan on page 325 and Using PostScan on page 327 for information about these features.

Notes: l MLM is enabled by default. If you want to use PreScan and PostScan but do not see the
MLM Media Verification screen, check to see if MLM is disabled (see Enabling MLM and
Configuring Global Settings on page 313).
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l If MLM is not enabled and you do not want to use the PreScan and PostScan features,
skip to Select the Encryption Mode on page 214.

l If you enable PostScan, the options for SKLM or KMIP Encryption are not available
when you get to the Encryption screen.

l If a partition uses multiple exporting controllers, the partition cannot use QuickScan.

Drive Type PreScan

PostScan:
Drive
Firmware
RequiredFullScan QuickScan

QuickScan
with Global
Spares

LTO-4, Fibre
Channel

available available unavailable unavailable 97F9 or
later

LTO-5, Fibre
Channel

available available available available B170 or
later

LTO-6, Fibre
Channel

available available available available C9T4 or
later

LTO-7, Fibre
Channel

available available available available FA10 or
later

LTO-7, SAS available unavailable available unavailable FA10 or
later

LTO-8, Fibre
Channel

available available available available HB82 or
later

LTO-8, SAS available unavailable available unavailable HB82 or
later

LTO-9, Fibre
Channel

available available available available N2T0 or
later

LTO-9, SAS available unavailable available unavailable N2T0 or
later

LTO-10, Fibre
Channel

available available available available S570 or
later

LTO-10, SAS available unavailable available unavailable S570 or
later

TS1140
Technology,
Fibre Channel

3524 or
later

3A07 or later 3A07 or later 460E or later see
previous
columns
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Drive Type PreScan

PostScan:
Drive
Firmware
RequiredFullScan QuickScan

QuickScan
with Global
Spares

TS1150
Technology,
Fibre Channel

4470 or
later

460E or later 460E or later 460E or later see
previous
columns

TS1155
Technology,
Fibre Channel

available available available available 47A2 or
later

TS1160
Technology,
Fibre Channel

available available available available 544F or
later

TS1170
Technology,
Fibre Channel

available available available available 6495 or
later

Use the following steps to configure the PreScan and PostScan features used in the partition.

1. From the Chambers and Drives screen, click Next. The MLM Media Verification screen
displays.

Note: If you do not want to use the PreScan and PostScan features, click Next again and skip to
Select the Encryption Mode on page 214.

Figure 117 The Media Verification screen when
the partition uses LTO-4 drives.

Figure 118 The Media Verification screen when
the partition uses LTO-5 and later generation
drives.

2. Enable and configure the PreScan and PostScan options for the partition.
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Notes: l Selecting any of the PostScan triggers automatically enables the selected PostScan
option for the partition.

l If you enable PostScan, the options for SKLM or KMIP Encryption are not available
when you get to the Encryption screen.

l The automatic PostScan operation configured on this screen only verifies MLM-
enabled cartridges. If your partition uses cartridges that are not MLM-enabled, you
must add them to the PostScan queue manually (see Request a Manual PostScan on
page 332).

The following table describes the PreScan and PostScan options.

Option When selected... Default

Enable PreScan Enables the PreScan feature. When enabled, PreScan
replaces the more basic Media Auto Discovery process. See
Using PreScan on page 325 for information about this
option.

Disabled
(cleared)

FullScan Enables the FullScan feature. When enabled by selecting one or
more PostScan triggers, FullScan uses a Global Spare drive
assigned to the partition to verify all of the data on each
cartridge. See Using PostScan on page 327 for information
about this option.

Note: FullScan is only available if a Global Spare drive is
configured for the partition.

Disabled
(no
PostScan
triggers
selected)

QuickScan Enables the QuickScan feature. When enabled by selecting one
or more PostScan triggers, QuickScan uses one of the drives in
the partition to verify the data on a single wrap, from the
beginning of the tape (BOT) to the end of the wrap or the end
of recorded data (EOD), whichever comes first. See Using
PostScan on page 327 for information about this option.

Note: QuickScan is only available if the partition uses LTO-5 or
later generation drives or TS11xx technology drives.

Disabled
(no
PostScan
triggers
selected)

QuickScan using
Global Spares

Enables the QuickScan using Global Spares feature. When
enabled by selecting one or more PostScan triggers,
QuickScan uses a Global Spare drive assigned to the
partition to verify the data on a single wrap, from the
beginning of the tape (BOT) to the end of the wrap or the
end of recorded data (EOD), whichever comes first. See
Using PostScan on page 327 for information about this
option.

Notes:

• QuickScan using Global Spares is only available if a
Global Spare drive is configured for the partition.

Disabled
(no
PostScan
triggers
selected)
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Option When selected... Default

• QuickScan using Global Spares is only available if the
partition uses LTO-5 or later generation Fibre Channel
drives or TS11xx technology drives.

PostScan Triggers Enables PostScan and configures one or more triggers.

• Verify After Time—Add the cartridges in the partition to
the automatic PostScan queue after the specified number
of days have passed since the last scan. Enter the number
of days in the Days field.

• Verify After Write—Add a cartridge to the automatic
PostScan queue each time data is written to it.

• Verify After Read—Add a cartridge to the automatic
PostScan queue each time data is read from it.

Note: Selecting any of these triggers automatically enables the
selected PostScan option.

Disabled
(cleared)

Select the Encryption Mode

If you are creating a partition or editing a partition that does not currently use encryption, the
Encryption screen only displays if you are logged into the library as an encryption user and
have either created one or more BlueScale encryption keys, or configured a Spectra SKLM or
KMIP server. If you are not logged into the library as an encryption user and you are editing a
partition with encryption, the Encryption screen does not display, or displays with all options
grayed out depending on your version of BlueScale software.

Note: If the Encryption screen does not display, proceed to Configure the Drive Fibre Channel
Addressing on page 217. You can modify the partition to use encryption later.

Requirements

If you created a BlueScale encryption key, you can enable BlueScale Encryption for the
partition and assign an encryption key to it.

• If the storage partition uses LTO-5 or later generation drives or TS11xx technology drives
and you configured a Spectra SKLM server, you can enable Spectra SKLM encryption key
management for the partition.

To use Spectra SKLM encryption key management with your library, all LTO-5
drives in the encrypted partition must use firmware version C7RC or later. LTO-6
and later drives, and TS11xx technology drives can use any firmware supported
by the library.
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• If the storage partition uses LTO-6 and later generation drives or TS11xx drives and you
configured a KMIP server, you can enable KMIP encryption key management for the
partition.

To use KMIP encryption key management the library must use BlueScale12.7.04
or later. The drives must have the following firmware:
l LTO-6 drives must use firmware version G352 or later
l LTO-7 drives must use firmware version G5S2 or later
l LTO-8 and later generation drives can use any firmware supported by the

library
l TS1140 technology drives must use firmware version 3B0E or later
l TS1150 technology drives must use firmware version 4718 or later
l TS1155 technology drives must use firmware version 47A2 or later
l TS1160 technology drives must use firmware version 544F or later
l TS1170 technology drives must use firmware version 6495 or later

Notes: l See the Spectra Tape Libraries Encryption User Guide for detailed instructions about
configuring and using encryption in the library.

l Any options that are not supported for the partition you are currently configuring are
grayed out.

l You can only use one type of encryption in a partition.

l You can only configure KMIP encryption or Spectra SKLM encryption, not both.

l KMIP encryption and Spectra SKLM encryption are not compatible with PostScan. Do
not enable PostScan for the partition if you want to use KMIP encryption or Spectra
SKLM encryption.

l Spectra SKLM key management, KMIP encryption, and BlueScale encryption are not
compatible with each other. Data encrypted using one type of encryption key
management cannot be decrypted using another.

Use the following steps to configure encryption in the partition:

1. From the Chambers and Drives screen, click Next. The Encryption screen displays.

JUNE 2025 215 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 6 - CONFIGURING AND MANAGING PARTITIONS

https://support.spectralogic.com/documentation/user-guides/encryption-user-guide.pdf


Figure 119 Select whether to use encryption in the
partition.

2. Select the type of encryption you want to enable. See the Spectra Tape Libraries Encryption
User Guide for detailed instructions.

Encryption
Option Description

No Encryption Turns off encryption. None of the data in the partition is encrypted.

Spectra SKLM
Encryption

Turns on Spectra SKLM Encryption key management for drive-based encryption
using direct-attached LTO-5 and later generation drives or TS11xx technology
drives.
Note: If PostScan is enabled for the partition, do not select Spectra SKLM Encryption.

KMIP
Encryption-
Reuse
(not shown)

Turns on KMIP encryption key management for drive-based encryption using
LTO-6 and later generation drives or TS11xx technology drives. The library reuses
KMIP encryption keys when tapes are overwritten.
Note: If PostScan is enabled for the partition, do not select KMIP Encryption.
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Encryption
Option Description

KMIP
Encryption -
No Reuse
(not shown)

Turns on KMIP encryption key management for drive-based encryption using
LTO-6 and later generation drives or TS11xx technology drives. The library does
not reuse KMIP encryption keys when tapes are overwritten.
Note: If PostScan is enabled for the partition, do not select KMIP Encryption.

BlueScale
Encryption:
QIP-based

The QIP-based encryption option is not supported and cannot be selected.

BlueScale
Encryption:
Drive-based

Turns on BlueScale Encryption key management for drive-based encryption using
direct-attached LTO-4 and later generation drives, and TS11xx technology drives.
All key management tasks are performed through the BlueScale user interface.

Note: If you have BlueScale Encryption Professional edition and multiple encryption
keys configured on the library, select the primary key for the partition. This key is used
when encrypting and decrypting data. Then, select none, one, or up to eight keys to be
associated with the partition for decrypting data.

Configure the Drive Fibre Channel Addressing

For partitions containing Fibre Channel drives, the Fibre Channel Loop ID screen configures
the Fibre Channel addressing used by each drive in the partition. In general, you want to
select the same type of addressing for every drive in a partition.

Note: SAS tape drives do not have Loop IDs. For partitions with SAS drives, continue with Specify the
Partition Users on the next page.

1. From the MLM Media Verification screen (or the Encryption screen), click Next. The
Fibre Channel Loop ID’s screen displays.

Figure 120 Select the type of addressing to be used by the
Fibre Channel drives.

2. Select Soft Addressing or Hard Addressing for each of the drives listed.

• Soft addressing is selected by default. A drive is assigned a soft address when it
connects to the Fibre Channel arbitrated loop or fabric.
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• If you select Hard Addressing, enter a value between 0 and 125 in the text field. This
value is the Loop ID used by the drive when it connects to the Fibre Channel arbitrated
loop or fabric. The ID you enter must be unique for every device in the loop or fabric.

Note: Spectra Logic recommends using soft addressing where possible for Fibre Channel drives.

Specify the Partition Users

1. From the Fibre Channel Loop ID’s screen, click Next. The Partition Users screen displays.

Figure 121 Select which users can access the partition.

2. Select the users who are allowed access to this partition. Only users who were previously
configured can be selected (see Configuring Library Users on page 106).

Notes: l All of the users who are configured with operator privileges are listed under Allow
only. Select one or more of these users to enable partition-based security for operators.

l If you did not configure additional Operator level users, you can do so later and then
edit the partition to give them access.

l Superusers and administrators always have full access to all partitions.

Configure the Robotic Path Visibility

Robotic path visibility determines whether one or both of the Fibre Channel ports on the
exporting controller provide the robotic control path to the TeraPorter(s).

Use the following steps to configure the robotic path visibility.

1. From the Partition Users screen, click Next. The Robotic Path Visibility screen displays.
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Figure 122 Select the port(s) on the exporting controller(s)
that will be used to communicate with the robotics
(partition with multiple exporters shown)

2. Select either one or both ports to provide the robotic control path.

Notes: l Selecting both ports provides a redundant connection to the TeraPorter(s), but requires
software that supports two control paths.

l Alternatively, you can use two RIMs and configure controller failover (see Configure
Controller Failover on page 139).

l The WWPN of the Fibre Channel port on the exporting controller is used as the WWN
for the partition. See World Wide Names for Partitions on page 76 for detailed
information about the relationship between the Fibre Channel port on the exporting
controller and WWNs for partitions.

Configure the Port Addressing for the Controllers
The RIM you selected to provide the robotic control path for the TeraPorter is said to “export”
the partition to the host. In this context, the RIM is referred to as the exporting F-QIP. Use the
Exporting F-QIP Settings screen to configures the port addresses for the RIM (see Select the
Robotic Control Path on page 205).

If you previously configured the settings for the exporting controller in the partition and do
not want to make any configuration changes, click Next on the F-QIP Configuration screen to
proceed to Confirming and Saving the Partition Settings on page 221.

Any changes to the port addressing affect all partitions exported from the RIM.
The RIM needs to stop and restart the fibre ports for the changes to take affect.
Only make changes when ALL partitions exported out a RIM are idle.

Use the following steps to configure the port addressing for the exporting controller(s).
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1. From the Robotic Path Visibility screen, click Next. The Exporting F-QIP Configuration
screen displays.

Note: A RIM can export up to eight partitions; a RIM2 can export up to 16 partitions. If the RIM
exports more than one partition, a confirmation screen warns you that any changes you make
apply to all partitions associated with the RIM.

Figure 123 Choose the type of Fibre Channel addressing to
be used by the RIM.

2. Select one of the following combinations for the Address and Fibre Mode:

• Use Soft Address and Fabric.

• Use Soft Address and Auto-negotiate.

• Use Loop ID and Loop. The Loop ID must be between 0 and 125.

• Use Loop ID and Auto-negotiate. The Loop ID must be between
0 and 125.

Note: If you select Loop as the Fibre Mode, the Fibre Channel switch to which the RIM is connected
may override your settings.

3. If you selected both ports on the Robotics Visibility screen (Configure the Robotic Path
Visibility on page 218), repeat the configuration steps in this section for the other Fibre
Channel port.

If you have multiple exporters, repeat the configuration steps in this section for the port
(s) on the additional exporters.

If you only selected one port in the Robotic Path Visibility screen or if you have already
configured both ports, proceed to Confirming and Saving the Partition Settings.
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CONFIRMING AND SAVING THE PARTITION SETTINGS

After you finish configuring a partition, confirm and save the partition settings to complete
the creation process.

Note: If you want to save the configuration to a USB device, connect the device to the USB port on
the LCM (see Connect a USB Device to the Library on page 186) or the operator panel and
allow time for the device to mount before continuing.

1. After you complete the configuration screens for the partition as described in the
previous sections, click Next. The Save Library Configuration screen displays.

Figure 124 The Save Library Configuration screen.

2. Select whether you want to save the current library configuration.

• Don’t Save Library Configuration—A backup of the changed library configuration is not
saved.

• Save Library Configuration To (highly recommended)—Saves a backup of the library
configuration to the selected destination. Using this option is highly recommended to
ensure that you can easily restore the previous library configuration, if necessary.

Select whether to save the library configuration file to a USB device or to email it to an
already-configured mail recipient (see Configure Mail Users on page 127).

Note: Do not use the default autosupport@spectralogic.com email recipient. Spectra Logic does not
save emailed configuration files unless they are specifically requested for troubleshooting.

3. Click Next. The Save Partition screen displays.

Note: The Save Partition screen on your library may be different from the ones shown in Figure 125
and Figure 126. The information on this screen varies depending on the type of partition you
configured and the options you chose.
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Figure 125 The Save Partition screen for a
cleaning partition.

Figure 126 The Save Partition screen for a
storage partition that uses a Global Spare and a
cleaning partition.

4. Review the information on the screen and confirm that all settings are correct for this
partition’s configuration.

• If the configuration information is correct, proceed to Step 5 on page 222.

• If the configuration information is not correct, do one of the following:

• Click Previous to move backward through the configuration screens until you reach
the settings that need correcting. As you move backward through the configuration
screens, the values reset to their default values. After you reach the desired screen
and make the necessary changes, click Next to advance through the screens and re-
enter the necessary information until you return to the Save Partition screen.

Note: If the screen requiring the correction is toward the beginning of the configuration process, it
may be easiest to click Cancel and repeat the entire configuration process.

• Click Cancel to configure the partition again from the beginning.

5. Click Save. The library requires several minutes to create the partition, after which the
Shared Library Services screen redisplays with the partition you just created added to
the list of partitions.
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Figure 127 The Shared Library Services showing a cleaning
partition and storage partitions.

Notes: l If you assigned a cleaning partition to the storage partition, the partition icon changes
as shown in Figure 127.

l When you save the partition, the library automatically generates a configuration
backup file and saves it to the memory card in the LCM. This backup file contains the
library configuration, the MLM and DLM databases, and any BlueScale encryption keys
that are currently stored in the library.

l If you configured the email option for the automatically generated backup file, the
library sends an email with the backup file attached to the specified recipient (see
Enable Email for the Auto Configuration Save File on page 129).

6. To configure another storage partition, repeat the entire configuration process, beginning
with Creating a Storage Partition on page 199.

To configure another cleaning partition, repeat the entire configuration process,
beginning with Creating a Cleaning Partition on page 196.
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CONFIGURE ADVANCED PARTITION SETTINGS

The Advanced Partition Settings screen allows you to enable library emulation, Soft Load for
drives, returning zone information in Read Element Status, Media Zoning, Time-based Access
Order System (TAOS), and Robotic Load Balancing.

CAUTION Advanced partition settings should only be used when recommended by
Spectra Logic Technical Support.

Configuring Emulation

Overview

The library identifies itself as “SPECTRA PYTHON” in response to a SCSI Inquiry command.
If your storage management software or operating system does not specifically support one of
the Spectra Logic libraries that identifies itself as “SPECTRA PYTHON,” you can configure
one or more partitions to emulate another type of library. Because most storage management
software is certified for one or more of these libraries, using the emulation mode may allow
these applications to support the library.

CAUTION Using emulation is not the preferred method of operation and should only be
used when recommended by Spectra Logic Technical Support.

Note: Configuring emulation changes how the library identifies itself to the operating system or
storage management software.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure emulation. See
Understanding User Groups and Security on page 106 for information about the three types of
user groups and what types of privileges each has.

Configure Emulation

Use the following steps to configure a new or existing partition to emulate another type of
library.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit to modify an existing partition or New to create a new partition. The Name
and Media Type screen displays (see Figure 110 on page 202).
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4. Click Advanced. The Advanced Partition Settings screen displays.

Figure 128 Specifying the emulation type.

5. Select the type of library you want the TFinity library to emulate. You can either:

• Select a preconfigured emulation from the Use preset drop-down list.

—OR—

• Create a custom emulation, enter the Vendor and Model for the library to be emulated.
These fields are used in the string that the library returns in response to a SCSI Inquiry
command.

Note: The default setting is SPECTRA PYTHON.

6. If you want the SCSI Read Element Status command response to include Media Domain,
Media Type, Drive Domain, and Drive Type, select Include tape generation in Read
Element Status. See the Spectra Tape Libraries SCSI Developer’s Guide for more information.

Note: You cannot use both Include tape generation in Read Element Status and Enable media
zone information (see Enable Media Zoning on page 227) at the same time.

7. Click Next. The Robotic Control Path screen displays listing the RIMs currently installed
in the library.

The Robotic Control Path screen is the beginning of a series of configuration screens. The
sequence of steps and screens matches those described in Creating a Storage Partition on
page 199.
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Enable Soft Load

The Soft Load feature uses the drives soft load (or auto load) functionality to improve library
performance. Soft Load requires that the library have high performance transporters and that
the partition use TS11xx technology or LTO-5 or later generation drives.

IMPORTANT Soft Load should only be used when recommended by Spectra Logic
Technical Support.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure Soft Load.

Configure Soft Load

Use the following steps to configure a new or existing partition to use Soft Load.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit to modify an existing partition or New to create a new partition. The Name
and Media Type screen displays (see Figure 110 on page 202).

4. Click Advanced. The Advanced Partition Settings screen displays.

Figure 129 Enable Soft Load.

5. Select Enable Soft Load.

6. Click Next. The Robotic Control Path screen displays.
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The Robotic Control Path screen is the beginning of a series of configuration screens. The
sequence of steps and screens matches those described in Creating a Storage Partition on
page 199.

Enable Media Zoning

Media Zoning provides zone information in the Read Element Status response. Zones in the
library are assigned by frame. Frames in the left half of the library as viewed from the front,
are zone 0; frames in the right half of the library (including the center frame if the number of
frames is odd) are in zone 1. In order to reduce TeraPorter contention and improve
performance, there should be drive frames in each zone. If only one drive frame is present,
there is no performance gain from Media Zoning.

IMPORTANT Media Zoning should only be used when recommended by Spectra Logic
Technical Support.

IMPORTANT Media Zoning is only compatible with RIM2 controllers.

IMPORTANT Media Zoning can only be used in a single partition library.

Note: You cannot use both Include tape generation in Read Element Status (see Configuring
Emulation on page 224) and Enable media zone information at the same time.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure Media Zoning.

Configure Media Zoning

Use the following steps to configure the partition to return media zone information in Read
Element Status.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit to modify an existing partition or New to create a new partition. The Name
and Media Type screen displays (see Figure 110 on page 202).

4. Click Advanced. The Advanced Partition Settings screen displays.
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Figure 130 Enable Media Zoning.

5. Select Enable media zone information.

6. Click Next. The Robotic Control Path screen displays.

The Robotic Control Path screen is the beginning of a series of configuration screens. The
sequence of steps and screens matches those described in Creating a Storage Partition on
page 199.

Enable Time-based Access Order System (TAOS)

Time-based Access Order System (TAOS) is a way to speed up the time it takes to read several
data segments from a single tape. Given a host-provided list of proposed reads, the Spectra
Logic tape library provides a list back to the host that has been re-ordered to achieve a
minimal total read time. The intent of TAOS is to minimize the re-positioning the drive must
do between reads of multiple locations, to improve the overall read time and reduce drive and
media wear by limiting the total travel amount of the media within the drive. This feature is
supported for LTO-7 and later generation drives.

IMPORTANT TAOS should only be used when recommended by Spectra Logic Technical
Support.

IMPORTANT See the Spectra Tape Libraries SCSI Developer’s Guide for details on the host
interaction with TAOS enabled.

IMPORTANT TAOS is supported for LTO-7 and later generation drives only.
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User Privilege Requirements

Only a user with superuser or administrator privileges can configure TAOS.

Configure TAOS

Use the following steps to configure the partition to respond to Generate Time-Based Access
Order System commands and Receive Time-Based Access Order System commands.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit to modify an existing partition or New to create a new partition. The Name
and Media Type screen displays (see Figure 110 on page 202).

4. Click Advanced. The Advanced Partition Settings screen displays.

Figure 131 Enable TAOS.

5. Select Enable TAOS.

6. Click Next. The Robotic Control Path screen displays.

The Robotic Control Path screen is the beginning of a series of configuration screens. The
sequence of steps and screens matches those described in Creating a Storage Partition on
page 199.
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Enable Robotic Load Balancing

When used with host software that is limited to one exporter per partition, such as IBM
Spectrum Protect, the Robotic Load Balancing advanced partition setting improves library
performance for a two TeraPorter library. With Robotic Load Balancing enabled, after checking
the library inventory to verify that the source slot is full and the destination slot is empty, the
library immediately sends a success message for the first move received, sends the move to a
TeraPorter, and then processes the second move received using the second TeraPorter, thus
allowing two moves in parallel. If the first move fails, the library and host inventories go
through a re-synchronization process.

IMPORTANT Robotic Load Balancing should only be enabled when recommended by
Spectra Logic Technical Support.

Note: You cannot use both Enable media zone information (see Enable Media Zoning on
page 227) and Enable Robotic Load Balancing at the same time.

User Privilege Requirements

Only a user with superuser or administrator privileges can configure Robotic Load Balancing.

Configure Robotic Load Balancing

Use the following steps to configure the partition to use Robotic Load Balancing.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit to modify an existing partition or New to create a new partition. The Name
and Media Type screen displays (see Figure 110 on page 202).

4. Click Advanced. The Advanced Partition Settings screen displays.
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Figure 132 Enable Robotic Load Balancing.

5. Select Enable Robotic Load Balancing.

6. Click Next. The Robotic Control Path screen displays.

The Robotic Control Path screen is the beginning of a series of configuration screens. The
sequence of steps and screens matches those described in Creating a Storage Partition on
page 199.
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MODIFYING AN EXISTING PARTITION
Overview

This section describes how to edit or modify an existing partition.

CAUTION

Use your storage management software to empty all drives and discontinue host
operations before modifying an existing partition. If the library has SlotIQ enabled,
run the Advanced Utilities Unload All Drives followed by Resolve SlotIQ
Virtualized Drive to Slot Moves.

Note: You cannot change the media type (and thus the drive type) specified for the partition.

You might want to modify an existing partition for any of the following reasons:

• Assign a Cleaning Partition—If you created a cleaning partition and now want to assign it
to the storage partition, you need to modify the Chambers and Drives screen for the
storage partition to add the cleaning partition.

• Assign a Global Spare Drive—If you want to designate one of the unassigned drives as a
Global Spare, you need to modify the Spare Drives screen to assign the drive to the
partition.

• Make Resources Available to Create a New Cleaning or Storage Partition—If the
existing partitions use all of the licensed chambers in the library, and you want to create a
new partition, you need to reduce the number of chambers assigned to an existing partition
to provide the chambers needed for the new partition. If you want to create a storage
partition, you may also need to install additional drives or unassign drives that were
previously assigned to other partitions.

• Rename Partition—If you want to rename the partition, you need to modify it in the Name
and Media Type screen.

• Disable PreScan or Change the PostScan Settings—If you want to change the settings
that you chose (to take advantage of a new Global Spare drive, for example), you need to
select a different setting in the MLM Media Verification screen.

• Enable or Disable Encryption—If you need to modify encryption settings for the partition,
you need to log in as an encryption user and make the necessary changes.

• Adding Additional Exporting Controllers—If a partition is configured with one exporting
controller, and you want to add additional controllers to export the library, you need to
edit the partition and select the additional controllers.

Preparation

Before making changes to an existing partition, review the information at the beginning of this
chapter to ensure that you address any requirements (see Partition Types and Requirements
on page 190). In addition, address the following recommendations and requirements:
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• Spectra Logic strongly recommends backing up the library configuration, either to a USB
device or as an attachment to an email sent to a previously configured mail recipient,
before you make changes.

• When reducing the number of chambers assigned to a partition, physically export any
magazines in those chambers, as described in Exporting or Exchanging Magazines and
Cartridges on page 257, before you remove chambers from the partition.

IMPORTANT

By default, the library deletes empty chambers from a partition first. However,
if all chambers are full, the library is forced to delete populated chambers.
When this happens, the magazines in the deleted chambers are no longer
accessible through the BlueScale interface or storage management software.
You must add these chambers to either a new or an existing partition before
the magazines are accessible again.

Auto Configuration Save

When you make a change to a partition, the library generates an auto-configuration file and
saves it to the memory card in the LCM. If you configured the email option for the Auto
Configuration Save file, an email containing the updated library configuration, the MLM and
DLM databases, and any BlueScale encryption keys stored in the library, are sent to the
specified recipient (see Enable Email for the Auto Configuration Save File on page 129).

Note: Do not use the default autosupport@spectralogic.com email recipient. Spectra Logic does not
save emailed configuration files unless they are specifically requested for troubleshooting.

Modify a Partition

Use the following steps to modify an existing partition.

1. Log into the library as a user with superuser or administrator privileges.

2. Select Maintenance > Media Lifecycle Management to display the Media Lifecycle
Management Tools screen. If Media Auto Discovery, PreScan, or PostScan is running (as
indicated by the presence of a Stop Discovery or Pause PostScan button, respectively),
do the following:

• Click Stop Discovery to temporarily stop Media Auto Discovery or PreScan (see
Figure 177 on page 324).

• Click Pause PostScan to pause the PostScan for one hour (see Figure 180 on page 335).

3. If you configured the partition to use encryption or if you want to enable encryption in a
partition that did not previously use it, select Security > Encryption. The Encryption User
Login screen displays.

JUNE 2025 233 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 6 - CONFIGURING AND MANAGING PARTITIONS



Figure 133 Log into the Encryption feature if you need to
change the encryption setting for the partition.

a. Type the encryption user password, if one is set. Otherwise, leave the password
blank.

b. Click OK to display the Encryption Configuration screen. After you log into the
encryption feature, you can modify the encryption settings for the partition (see
Select the Encryption Mode on page 214).

4. From the toolbar menu, select Configuration > Partitions to begin the partition
configuration process. The Shared Library Services screen displays.

Figure 134 The Shared Library Services screen.

5. Click either Summary or Edit. Either option can be used when modifying a partition.

• If you click Summary next to the partition that you want to edit, the Partition Settings
screen displays, showing summary information related to the selected partition.
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Figure 135 The Partition Settings screen (storage partition).

If you want to make changes or see all of the configuration settings for the
partition, click Edit.

• If you click Edit from either the Partition Settings screen or the Shared Library Services
screen the Name and Media Type screen displays.

Figure 136 The Name and Media Type screen
for a storage partition.

Figure 137 The Name and Media Type screen
for
a cleaning partition.

6. The Name and Media Type screen is the beginning of a series of configuration screens.
Depending on the type of partition you are modifying, choose one of the following:

• To modify a cleaning partition, see Creating a Cleaning Partition on page 196.

• To modify a storage partition, see Creating a Storage Partition on page 199.
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DELETING A PARTITION
Overview

When you delete a partition, the drives and chambers previously assigned to that partition are
available to be assigned to a new or existing partition.

Preparation

Before deleting an existing partition, review the information at the beginning of this chapter to
be sure that you address any requirements (see Partition Types and Requirements on
page 190). In addition, make sure you address the following:

• Spectra Logic strongly recommends backing up the library configuration, either to a USB
device or as an attachment to an email sent to a previously configured mail recipient,
before you delete a partition.

• To ensure that you do not inadvertently mix cartridges from one storage partition with that
from another, use your storage management software to eject all of the cartridges from the
storage partition’s storage pool. The library moves the media to the partition’s entry/exit
pool. Export the media from the library as described in Exporting or Exchanging
Magazines and Cartridges on page 257.

IMPORTANT
After the partition is deleted, any magazines in the chambers that were
assigned to the partition’s storage and entry/exit pools are not accessible
until the chambers are assigned to another new or existing partition.

• If the storage partition is configured to use BlueScale encryption, make sure that you
export the BlueScale encryption key for any cartridges that were in the partition (see the
Spectra Tape Libraries Encryption User Guide). The encryption key is required in order to
access the data on the cartridges at a later date.

• If you plan to delete a cleaning partition, edit any storage partitions that use the cleaning
partition to unassociate the cleaning partition from the storage partition, otherwise, the
delete fails.

Auto Configuration Save

When you delete a partition, the library automatically generates a configuration backup file
and saves it to the memory card in the LCM. If you configured the email option for the Auto
Configuration Save file, an email with the backup file as an attachment is sent to the specified
recipient (see Enable Email for the Auto Configuration Save File on page 129).

Note: Do not use the default autosupport@spectralogic.com email recipient. Spectra Logic does not
save emailed configuration files unless they are specifically requested for troubleshooting.
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Delete a Partition

Use the following steps to delete an existing partition.

1. Log in as a user with superuser or administrator privileges.

2. Select Maintenance > Media Lifecycle Management to display the Media Lifecycle
Management Tools screen. If Media Auto Discovery, PreScan, or PostScan is running (as
indicated by the presence of a Stop Discovery or Pause PostScan button, respectively),
do the following:

• Click Stop Discovery to temporarily stop Media Auto Discovery or PreScan (see
Figure 177 on page 324).

• Click Pause PostScan to pause the PostScan for one hour (see Figure 180 on page 335).

3. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

4. Click Delete for the partition you want to delete. A Feedback Required screen displays.

5. Select whether you want to save the current library configuration.

• Don’t Save Library Configuration — A backup of the changed library configuration is
not saved.

• Save Library Configuration To (highly recommended) — Saves a backup file of the
changed library configuration to either a USB device connected to the LCM or the
operator panel, or as an attachment to an email sent to a previously configured recipient
(see Configure Mail Users on page 127). Using this option is highly recommended to
ensure that you can easily restore the library configuration if necessary.

Note: If you want to save the configuration to a USB device, connect it to a USB port on the LCM or
the operator panel and allow time for the device to mount before continuing.

6. Click Ok to confirm that you want to delete the partition.

The screen refreshes and the deleted partition is no longer listed on the Shared Library
Services screen.
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CHAPTER 7 - IMPORTING AND EXPORTING
CARTRIDGES
This chapter describes importing cartridges into and exporting cartridges out of the library.

• See Using the Cartridge Inventory on page 279 for information about moving cartridges
from one location to another in a partition.

• See Configuring and Using Media Lifecycle Management on page 301 for information
about using MLM to manage the cartridges in the library.

Preparing Cartridges for Use 239
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LTO-7 Type M Media 242
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Importing into a Storage or Cleaning Partition 246
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Exchange Magazines or Cartridges in a Partition 262
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PREPARING CARTRIDGES FOR USE

Before you can load cartridges into the library, you must prepare and load them into TeraPack
or Maintenance TeraPack magazines (referred to as magazines and maintenance magazines,
respectively).

Cartridge Guidelines and Requirements

When preparing cartridges for use, keep the following guidelines and requirements in mind:

Spectra Certified Media

For best performance, use Spectra Certified Media (both data and cleaning cartridges), which
guarantees both media compatibility and the cartridge itself over its lifetime. Using Spectra
Certified Media also lets you take full advantage of the library’s Media Lifecycle Management
(MLM) features. See Configuring and Using Media Lifecycle Management on page 301 for
detailed information about using MLM to monitor the health of data and cleaning cartridges.

Multiple Tape Technology Generations

When using multiple tape technology generations, Spectra Logic strongly recommends
configuring separate partitions for each generation. It is especially important to not use LTO-4
data cartridges with both LTO-4 and LTO-5 drives. This ensures the accuracy of the LTO-4
media health data (see Media Tracking and Reporting on page 305).

TeraPack Magazines

Data cartridges are stored in TeraPack magazines while they are inside the library. Each
TeraPack magazine holds either ten LTO cartridges or nine TS11xx technology cartridges.
Similarly, the cleaning cartridges used in a cleaning partition are stored in Maintenance
TeraPack magazines. Each maintenance magazine holds the same number of cartridges as a
data cartridge magazine.

Barcode Labels

To ensure that the library can properly maintain its media inventory, make sure that all
cartridges and magazines have unique barcode labels. For your convenience, all Spectra
Certified Media is available pre-labeled with sequential barcode labels. Optional custom
barcode sequences can be ordered, if desired.

• Data Cartridges—The library prevents you from importing tape cartridges with
blank/unreadable barcodes, with barcodes that duplicate barcodes already in the partition,
or whose labels indicate that the media type or generation is not supported by the
partition.
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• TeraPack Magazines—Unique barcode labels are required on all magazines. If you attempt
to import a magazine with a duplicate or unreadable barcode label, the library will reject it.
Maintenance TeraPack magazines are identified by Spectra-unique labels. For your
convenience, the pre-loaded magazines are labeled with sequential barcode labels. Optional
custom barcode sequences can be ordered, if desired.

• Cleaning Cartridges and Maintenance TeraPack Magazines—If you plan to use a cleaning
partition and the Auto Drive Clean feature, the cleaning cartridges must be identified with
“CLN” at the beginning of the barcode sequence on their labels. This requirement applies
to both standard and custom barcode labels. The cleaning cartridges must be stored in
Maintenance TeraPack magazines, which are identified by Spectra-unique labels.

If you plan to store cleaning cartridges in a storage partition, it is highly recommended to
label the cleaning cartridges with “CLN” at the beginning of the barcode sequence on their
labels to help prevent the storage management software from attempting to use a cleaning
cartridge for writing or reading data.

Write Protection

Before loading data cartridges into the library, make sure that the write-protection switch is
properly set. For normal backup operations, the write protect switch is set to the write-enabled
or unlocked position. The write-protect switch is typically set to the write-protect or locked
position when the cartridge is removed from the library for storage and during restore
operations.

Prepare the Cartridges for Use

Use the following steps to prepare the individual cartridges to be loaded into the library.

1. If your cartridges are unlabeled, prepare and affix a barcode label to each cartridge.
Position each label in the indented area on the cartridge, as illustrated in Figure 138. See
Barcode Label Specifications on page 602 for detailed information about barcode labels.

CAUTION
Do not place labels on any surface of the cartridge except the area shown in
Figure 138. An improperly positioned label can become dislodged and damage the
drive.

IMPORTANT Before importing cartridges into the library, allow them to acclimate to the
ambient environment—temperature, humidity, and so forth—for 24 hours.

IMPORTANT
If you are using Auto Drive Clean, all cleaning cartridges must be identified
with “CLN” at the beginning of the barcode sequence on their labels. This
requirement applies to both standard and custom barcode labels.
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Figure 138 Attach barcode labels to cartridges and check write-protect
switch setting (LTO cartridge shown).

2. Depending on whether you plan to write data to a cartridge or restore data from a
cartridge, make sure the write-protect switch on the cartridge is set for the desired
operation.

Note: Cleaning cartridges do not have a write-protect switch.

If the switch... The cartridge is...

Does not cover the
opening

Write-enabled. Data can be written to or read
from the tape.

Does cover the opening Write-protected. Data can be read from the
tape. Data cannot be written to or erased from
the tape.

3. Insert the prepared cartridges into the magazine. Make sure that the cartridges are
oriented with the hub side toward the front of the magazine, which has a textured
surface on each side.

IMPORTANT
Do not put data cartridges in a Maintenance TeraPack magazine. The
Maintenance TeraPack magazine, with properly labeled cleaning cartridges,
can only be used in a cleaning partition.
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Figure 139 Insert prepared cartridges into the TeraPack magazine (LTO
shown).

LTO-7 Type M Media

When the library loads an unused LTO-7 tape cartridge with a barcode label ending with
“M8” into an LTO-8 tape drive using firmware HB82 or later, the drive attempts to initialize
the tape for LTO-7 type M density, increasing the density from 6 TB to 9 TB. Once initialized,
the tape can no longer be written to, or read by, an LTO-7 drive.

To use the LTO-7 type M feature, make sure that your tape library uses the default barcode
reporting configuration or a configuration that reports the last two characters, not including
the checksum.

If the tape drive determines that the tape cartridge does not meet the unused criteria, the LTO-
7 type M initialization fails and the tape retains LTO-7 density. If the library or your storage
management software reports an LTO-7 type M initialization failure, Spectra Logic
recommends replacing the barcode on the tape with an L7 barcode.

Note: M8 tapes cannot be read by or written to by LTO-9 drives.
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IMPORT AND EXPORT OVERVIEW

Importing cartridges into the library and exporting cartridges from the library are the primary
interactions you have with the physical library. You import magazines filled with cartridges
into the library during your initial setup, and both import and export cartridges during
normal day-to-day backup operations.

The method you use to import or export cartridges depends on the library configuration and
the number of magazines you need to move.

Center TAP

For day-to-day operations involving a small number of magazines, you can import or export
magazines one at a time using the center TAP located in the main frame. The two TAP doors
open alternately.

Bulk TAP

When you need to import or export a large number of magazines, you can use a bulk TAP to
process up to 14 magazines at a time.

Requirements

User Privilege Requirement

Any user with operator privileges who is assigned to the partition and all users with
superuser or administrator privileges can perform import or export operations. See Specify the
Partition Users on page 218 for information about assigning users to a partition.

Note: Operators assigned to the partition can only import and export to and from the Entry/Exit
pool.

Cartridge and Magazine Labeling

Make sure that each cartridge and magazine is labeled with a unique barcode. The barcode
labels on Spectra Certified Media contain information about the media type. To ensure that the
correct type of cartridges are stored in a partition, the library prevents you from importing the
wrong cartridge type into a partition.

TeraPack Magazines

Cartridges are always imported and exported using a TeraPack magazine (or a maintenance
magazine for cleaning partitions), regardless of whether you have an individual cartridge or a
group of cartridges.

• When you want to import a single cartridge, you must first put the prepared cartridge in a
magazine, then import the magazine.
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• When you want to export a single cartridge, you must export the magazine containing the
cartridge and remove the desired cartridge from the magazine. You can then reimport the
magazine, if desired.

Restrictions

Using the BlueScale Web Interface (RLC)

The import and export options are not available when you access the library using a remote
connection to the BlueScale web interface (RLC). These operations are always performed from
the local BlueScale user interface on the library operator panel.

Background Operations

You cannot import, export, or exchange cartridges or magazines if the library is actively
running a background operation such as Media Auto Discovery, PreScan, or PostScan.

If you do not want to wait for a Media Auto Discovery, PreScan, or PostScan operation to
complete, you can stop the Media Auto Discovery or PreScan operation or pause the PostScan
operation. For other background operations, wait for the process to complete.

• Click Stop Discovery on the Media Lifecycle Management Tools screen to stop a Media
Auto Discovery or PreScan operation (see Stop the Discovery Process on page 324).

• Click Pause PostScan on the Media Lifecycle Management Tools screen to pause the
PostScan operation for one hour (see Pause the PostScan Process on page 334).

Auto Discovery

Media Auto Discovery and PreScan are background operations that use the drives in a
partition to discover newly imported LTO cartridges and add them to the MLM database. The
discovery process cannot begin while the hosts are actively loading cartridges into or
unloading cartridges from the drives. If you import cartridges during this time, the library
posts a failure message stating that no drives are available to perform the discovery process.

Either wait until the library is idle before beginning the import or manually start the discovery
process for imported cartridges when the library is idle. See Discover Cartridges Manually on
page 322 for instructions.

SlotIQ

In partitions with SlotIQ enabled, the inventory in the partition’s storage pool is virtualized.
At times, the library may only virtually move tapes from drives: that is, the library inventory
shows the tape in a slot, but the tape physically stays in the drive until that drive or tape is
needed for another operation. Also, tape cartridges in magazines may not match the inventory
presented by the host software. However, the TeraPack Magazine Contents field on the
Advanced Import/Export screen does show the physical contents of the selected chamber.
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If you are exporting from the storage pool of a partition with SlotIQ enabled, run the
advanced utility Resolve SlotIQ Virtualized Drive to Slot Moves to physically move tapes that
were virtually moved from drives to slots previously.

When you import magazines into this partition, the library assigns its own virtual mapping of
the magazine inventory.
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IMPORTING INTO A STORAGE OR CLEANING PARTITION

Overview

During normal operations, magazines containing data cartridges are typically imported to a
storage partition’s entry/exit pool and then moved to the storage pool using your storage
management software. This process ensures that the media inventory maintained by the
storage management software is accurate.

An exception is the first time that cartridges are loaded into a storage partition. Unless your
storage management software requires you to use the software to perform all imports,
importing magazines directly into a storage partition’s storage pool simplifies loading a
storage partition for the first time. After the cartridges are imported into the storage pool, they
are available for immediate use by the storage management software.

Import Requirements

Partitions

You must have one or more partitions defined before you can import magazines into the
library. See Architecture Overview on page 60 for information about partitions and pools.
Configuring and Managing Partitions on page 188 provides detailed instructions for creating
partitions.

Cartridges and Magazines

All cartridges are imported into the library using magazines. Before beginning, have on hand
the cartridges that you want to import into the partition. If necessary, prepare the cartridges as
described in Preparing Cartridges for Use on page 239.

If you are importing magazines into the storage partition’s storage pool for the first time, the
maximum number of magazines you need equals the number of chambers assigned to the
storage pool for the partition (see Creating a Storage Partition on page 199). You do not need
to fill all slots in the magazines or all of the chambers in the partition. However, any empty
chambers are inaccessible to the storage management software.

Entry/Exit Pool

For daily operations, TeraPack magazines containing data cartridges are typically imported or
exported using a storage partition’s entry/exit pool. When using the entry/exit pool for
importing/exporting, the following must be true:

• The entry/exit pool must have sufficient empty chambers available for importing new
magazines. If you need to import new magazines and all of the chambers in the entry/exit
pool are full, you must export one or more magazines to make space for the new
magazines (see Export Magazines from a Partition on page 258).
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• The entry/exit pool must have sufficient empty slots available to accommodate any
cartridges that the storage management software ejects from the partition. If all of the slots
in the entry/exit pool are full, either move newly imported cartridges to the partition’s
storage pool, leaving empty slots in the entry/exit pool, or export one or more full
magazines and replace them with magazines that have empty slots.

IMPORTANT
Make sure that the magazines you export are not filled with cartridges that
you just imported but did not yet move to the storage pool using your
storage management software.

• You can import a magazine containing a cleaning cartridge into the partition’s entry/exit
pool and then use the Inventory screen to move the cartridge to a drive for cleaning (see
Moving Cartridges Within a Partition on page 289). When the cleaning is complete, move
the cleaning cartridge back to the entry/exit pool and export the magazine from the
entry/exit pool.

Storage Pool

A storage partition’s storage pool contains all of the cartridges that can be accessed by the
storage management software for the purpose of writing or reading data.

• If you are importing magazines into the entry/exit pool and using your storage
management software to move the cartridges to the storage pool, the storage pool must
have sufficient empty slots to accommodate each cartridge imported into the entry/exit
pool.

• If you are importing directly into the storage pool, the storage pool must have sufficient
empty chambers to accommodate the magazines you plan to import.

• Any chambers in the storage pool that do not contain magazines are inaccessible to the
storage management software. You can, however, import magazines into the empty
chambers using the library’s BlueScale user interface.

Cleaning Partition

When importing cleaning cartridges into a cleaning partition, keep the following in mind:

• Cleaning cartridges must be identified with “CLN” at the beginning of the barcode
sequence on their labels. This requirement applies to both standard and custom barcode
labels.

• Cleaning cartridges used in a cleaning partition must be in Maintenance TeraPack
magazines, which are identified by Spectra-unique labels. The library automatically
prevents importing cleaning cartridges and magazines that are not properly labeled into a
cleaning partition.

Note: Maintenance TeraPack magazines filled with appropriately labeled cleaning cartridges are
available from Spectra Logic.
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• Make sure that the Maintenance TeraPack magazine does not contain any data cartridges.
The library will not import a Maintenance TeraPack magazine that contains cartridges that
are not identified with “CLN” at the beginning of the barcode sequence on their labels.

• Make sure that you import only cleaning cartridges that are compatible with the drives in
the storage partition associated with the cleaning partition. To ensure that the correct type
of cleaning cartridges are stored in a cleaning partition, the library prevents you from
importing the wrong cartridge type.

• The cleaning cartridges in a cleaning partition can only be used for drives in storage
partitions configured to use that cleaning partition. Associating a cleaning partition with
drives in a storage partition automatically enables the Auto Drive Clean feature for that
partition. (see Allocate Chambers and Drives on page 208).

• The cleaning cartridges in the cleaning partition are inaccessible to the application software
running on the host. Make sure you disable any software-based drive cleaning to prevent
repeated requests to import a cleaning cartridge.

• If your storage management software supports automated drive cleaning and you plan to
use this method to clean the drives instead of the library’s Auto Drive Clean feature, refer
to your software documentation for instructions. You must import the properly labeled
cleaning cartridges into the storage partition using a TeraPack magazine (not a
Maintenance TeraPack magazine).

Additional Requirements and Restrictions

See Import and Export Overview on page 243 for information about additional requirements
and restrictions when importing magazines and cartridges.

Prepare the Storage Partition or the Cleaning Partition

Before importing magazines into a storage partition or a cleaning partition, make sure that the
partition has sufficient empty slots or chambers available to accommodate the cartridges or
magazines you plan to import.

• If you plan to import cartridges into the storage partition’s entry/exit pool, and then use
your storage management software to move the cartridges to the storage pool, check the
Inventory screen for the partition to make sure that the storage pool has an empty slot
available to accommodate each imported cartridge (see Viewing and Downloading the
Cartridge Inventory on page 281). If there are insufficient empty slots available in the
storage pool, do one of the following to prepare the storage pool to receive the imported
cartridges:

• If the partition’s storage pool has empty chambers, import one or more TeraPack
magazines with empty slots into the storage pool (see Import the Magazines on the next
page).
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• If the partition’s storage pool does not have any magazines with empty slots, use your
storage management software to eject cartridges from the library. The library moves the
ejected cartridges from the partition’s storage pool to magazines in its entry/exit pool.
You can then export the magazines from the library (see Export Magazines from a
Partition on page 258). The resulting empty slots in the storage pool are now available
for newly imported cartridges.

• Exchange a full magazine in the storage pool for one containing empty slots (see
Exchange Magazines or Cartridges in a Partition on page 262).

• If you plan to import cartridges directly into the partition’s storage pool, make sure that
the storage pool has an empty chamber for each magazine you plan to import. The
partition’s Import/Export TeraPack Magazines screen shows the number of empty
chambers available in the partition’s storage pool (see Figure 140 on page 250). If there are
no empty chambers available in the storage pool, export one or more magazines from the
storage pool (see Export Magazines from a Partition on page 258).

• If you plan to import cleaning cartridges into a cleaning partition, make sure that there is
an empty chamber for each maintenance magazine you plan to import. If there are no
empty chambers available in the cleaning partition, export one or more magazines.
Alternatively, you can exchange expired cleaning cartridges for new ones in the magazines
already present in the cleaning partition without having to import additional magazines
(see Export or Exchange Expired Cleaning Cartridges on page 266).

Import the Magazines

1. Log into the library as a user with the appropriate privileges (see User Privilege
Requirement on page 243).

2. From the toolbar menu, select General > Import/Export. The Import/Export TeraPack
Magazines screen displays, showing the information for the last partition that was
viewed on either the Import/Export TeraPack screen or the Inventory screen.

3. Select the partition and TAP you want to use from the drop-down lists, then click Go.
The Import/Export TeraPack Magazines screen refreshes to show the current status of the
chambers assigned to the selected partition.

JUNE 2025 249 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 7 - IMPORTING AND EXPORTING CARTRIDGES



Figure 140 Select the partition and the TAP (storage
partition shown).

Select this TAP... If you want to use...

Center The dual TAP located in the main frame.

Left The bulk TAP located in the bulk TAP service frame on the left end of the
library, if present.

Right The bulk TAP located in the bulk TAP service frame on the right end of
the library, if present.

LeftAndRight Both the bulk TAP located in the bulk TAP service frame on the left end
of the library, and the bulk TAP located in the bulk TAP service frame on
the right end of the library.

4. Click the appropriate Import button to select the destination (the storage pool or
entry/exit pool for a storage partition or cleaning for a cleaning partition) for the
imported magazines.

Notes: l If there are no empty chambers in the selected pool, the Import button is not present.
Export one or more magazines to make space for the new magazines.

l If the library has a non-isolating service frame configuration, the Import/Export
TeraPack Magazine screen displays how many magazines can be imported before the
exclusion zone is used.

l Operators can only import into the entry/exit pool.
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Figure 141 Click Import for the desired destination
(storage partition shown).

For a... Select Import
for.... If you want to import...

Storage partition Storage: Empty
Chambers

Magazines into the storage pool.

Entry/Exit: Empty
Chambers

Magazines into the entry/exit pool.

Note: Importing into the entry/exit pool is the preferred
method (see Import and Export Overview on page 243).

Cleaning partition Cleaning: Empty
Chambers

Maintenance magazines into the cleaning partition.

5. The next steps in the import process depend on which TAP you selected.

If you selected the Center TAP

The top TAP door opens and a Feedback Required screen displays instructing you to
place a TeraPack in the TAP.

a. Insert a magazine into the tray on the open TAP, making sure that it is oriented
with the textured surface on each side toward the outside of the library, as shown
in Figure 142.
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Figure 142 Insert a magazine into the TAP, making sure that it is correctly
oriented.

a. Return to the operator panel and select the appropriate option on the Feedback
Required screen.

Note: If you wait more than 10 minutes to respond, the library times out and displays a message on
the operator panel. The TAP door is left open.

Select... If...

Continue You plan to import another magazine after the one currently in the TAP.
The import process continues as follows:

1. The TAP door closes automatically. The TeraPorter retrieves the
magazine from the TAP and moves it to a chamber in the selected
destination.

2. If there are still empty chambers available in the selected
destination, the second TAP door opens, ready to accept the next
magazine. The TAP doors alternate as you continue to import
magazines.

3. The import process continues as long as there are empty chambers
available or until you click Stop Importing on the Feedback
Required screen. Continue to insert magazines into the TAP,
clicking Continue after each one. When there are no empty
chambers remaining in the selected destination, the process stops
automatically and the Import/Export TeraPack Magazines screen
displays.

Stop Importing The magazine you placed in the TAP is the last one you want to import.
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If you selected the Left, Right, or LeftAndRight TAP

The Bulk TAP Move Confirmation screen displays a confirmation message with
instructions for performing the import operation.

Figure 143 Read the instructions on the Bulk TAP Move
Confirmation screen, then click Continue.

a. Click Continue. The bulk TAP carousel rotates to face the outside of the library.

Note: If you selected LeftAndRight TAP and there are fewer than 14 empty chambers available in
the destination, only the left bulk TAP rotates to face outward. If you select LeftAndRight TAP
and more than 14 chambers are available, both bulk TAPs rotate outward.

IMPORTANT

If the carousel contains magazines from a previous export or import
operation, the library will alert you to remove those magazines. When the
door release button LED is solid green, press it to open the bulk TAP door.
Remove the magazines, close the door firmly by pressing at the top and
bottom, and click Continue to restart the import process.
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b. When the door release button LED is solid green, press the button to open the bulk
TAP door.

Note: If you wait more than 10 minutes to open the door, the LED turns off and the carousel rotates
to face the interior of the library. The library considers the import operation complete.

Figure 144 Press the door release button to open the
door.

c. Slide one or more magazines onto the shelves in the bulk TAP carousel.

CAUTION

When you place a magazine in the bulk TAP, make sure that the textured surface
on each side of the magazine is toward the inside of the library and that the guides
on the sides of the magazine fit into the media guides on the media shelf, as shown
in Figure 145 on page 254. Loading the magazines incorrectly or at an angle can
result in damage to the carousel or the robotics.

l The correct orientation of the magazines when inserted into the left or right TAP is
opposite that for the center TAP.

l You can insert up to 14 magazines at a time.

Figure 145 Insert the magazine into the bulk TAP carousel, making sure that it is correctly
positioned.
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d. Close the bulk TAP door firmly by pressing at the top and bottom. An audible click
indicates that the door is latched closed. The carousel rotates the magazines to the
interior of the library and the TeraPorter begins moving the magazines to open
chambers in the selected destination. The Import/Export TeraPack Magazines screen
refreshes to show that the moves are in progress.

Notes: l If you fail to close the door within 10 minutes, the import operation times out.

l Click Stop Importing to terminate the import operation. If there are still magazines in
the bulk TAP, you will be instructed to remove them before the next import or export
operation.

l If you selected LeftAndRight TAP, the library starts processing moves as soon as you
close one bulk TAP door. The library completes processing moves from the first bulk
TAP before starting to process moves for the second bulk TAP.

Figure 146 The Import/Export TeraPack Magazines screen
shows that the import process is underway.

e. When a TeraPorter finishes moving all of the magazines out of a bulk TAP, the
carousel rotates to face the outside of the library and the door release button LED
turns solid green again, indicating that it is ready to for you to load additional
magazines. The process described in this section continues until one of the
following occurs:

• You insert fewer than 14 magazines in a bulk TAP — When the library detects
that the bulk TAP door was closed with fewer than 14 magazines inserted, the
magazines are imported, if applicable the other bulk TAP is checked and magazines
imported, and the operation ends.

• There are no more empty chambers in the destination — The operation ends when
the destination is full. If the selected destination did not contain enough empty
chambers to accommodate all of the magazines that you loaded into the carousel, the
extra magazines are left in the bulk TAP. If desired, see Using the Advanced
Import/Export Options on page 268 to export magazines from the desired location to
provide chambers for the magazines that could not be imported.

• You click Stop Importing — When you click Stop Importing the import operation
terminates. If there are still magazines in the bulk TAP, you will be instructed to
remove them before the next import or export operation.
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4. If you imported magazines into a storage partition’s entry/exit pool, use your storage
management software to move the cartridges to empty slots in the partition’s storage
pool. The inventory maintained by the software is updated during this process.

Prepare the Entry/Exit Pool

After the storage management software moves the cartridges out of the entry/exit pool, export
empty magazines to provide empty chambers for future import operations (see Export
Magazines from a Partition on page 258). Be sure to leave at least one magazine with empty
slots in it in the entry/exit pool. These empty slots are used for the cartridges that the library
moves from the storage pool when the storage management software ejects cartridges from the
partition. Over the course of time, normal operations typically result in the entry/exit pool
containing at least one magazine with empty slots.

IMPORTANT

If the entry/exit pool does not contain a magazine with sufficient empty slots,
the storage management software halts its eject operation. You must
exchange the full magazines in the entry/exit pool for empty ones, as
described in Exchange Magazines or Cartridges in a Partition on page 262,
before retrying the eject operation.

If you plan to import additional cartridges, export empty magazines left in the entry/exit pool
after the storage management software moves all of the previously imported cartridges to the
storage pool. The resulting empty chambers are needed for future import operations (see
Export Magazines from a Partition on page 258).

IMPORTANT
Make sure that the magazines you export are not filled with cartridges that
you just imported but have not yet moved to the storage pool using your
storage management software.

If there are no magazines with empty slots in the entry/exit pool, follow the steps in Exchange
Magazines or Cartridges in a Partition on page 262 to exchange the full magazines for
magazines that have empty slots.
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EXPORTING OR EXCHANGING MAGAZINES AND
CARTRIDGES

Overview

This section provides instructions for exporting or exchanging all of the magazines and
cartridges in a storage partition’s entry/exit or storage pool or all of the maintenance
magazines in a cleaning partition.

Note: If you want to export or exchange a specific magazine or a specific cartridge, use the
Advanced option, as described in Using the Advanced Import/Export Options on page 268.
You can also use the Inventory screen to move the magazine containing the desired cartridge
to the TAP so that you can remove or exchange an individual cartridge and then move the
magazine back to its original location (see Moving Cartridges Within a Partition on page 289).

Requirements

See Import and Export Overview on page 243 for information about requirements and
restrictions when exporting or exchanging magazines.

Export process

The export process uses either the dual TAP in the main frame or the bulk TAP to physically
remove all of the magazines (and any cartridges they contain) from the selected location (a
cleaning partition or a storage partition’s entry/exit pool or storage pool). The exported
magazines are not replaced by new magazines.

Exchange process

The exchange process moves each of the magazines in the selected location to either the dual
TAP in the main frame or the bulk TAP so that you can exchange the magazines for others of
the same type.

You can also remove or exchange one or more individual cartridges in a magazine while
leaving the other cartridges in place. Exchanging cartridges in a magazine is especially useful
when you need to temporarily import a cleaning cartridge into the storage pool as part of
drive maintenance.

Prepare for the Export or Exchange

• If you are exchanging cartridges or magazines, have on hand the prepared data cartridges
and properly labeled magazines (see Preparing Cartridges for Use on page 239).
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• Recommended If you want to export cartridges from a storage partition, use your storage
management software to eject the desired cartridges from the partition’s storage pool. You
can then export the cartridges from the entry/exit pool. Using this method to export
cartridges from a storage partition ensures that the media inventory maintained by the
storage management software remains accurate.

The following steps describe the process for ejecting cartridges from a storage partition
using the entry/exit pool.

1. Use your storage management software to tell the library to eject the cartridges from the
library.

2. The library moves each cartridge out of the partition’s storage pool and into an empty slot
in a TeraPack magazine already stored in the entry/exit pool.

3. When all of the requested cartridges have been move to the entry/exit pool, the library
reports to the software that the export request is complete.

4. At your convenience, you can then export the magazines in the entry/exit pool from the
library using controls on the Import/Export TeraPack Magazines screen of the user
interface and either the center TAP, left TAP, or right TAP.

• If you are exporting directly from the storage pool of a partition with SlotIQ enabled, run
the advanced utility Resolve SlotIQ Virtualized Drive to Slot Moves to resolve all
virtualized drive to slot moves before exporting magazines. The tape inventory presented
to the host software, or displayed on the Inventory screen, may not match the physical
location of tapes in the inventory. The TeraPack Magazine Contents field on the Advanced
Import/Export screen can be used to determine the physical contents of a chamber.

IMPORTANT
When exporting tape cartridges from a partition with SlotIQ enabled, Spectra
Logic recommends that you use your host software to move the cartridges to
the Entry/Exit pool before exporting.

• Exporting a magazine directly from the storage pool is not recommended unless you are
exporting all of the magazines from a partition. This process is often referred to as a “bulk
export.”

If you choose to export magazines directly from the storage partition’s storage pool, be
sure to use your storage management software to update its media inventory after
completing the export (see Updating the Storage Management Software Inventory on
page 278).

Export Magazines from a Partition

1. Log into the library as a user with the privileges appropriate to the location from which
you are exporting magazines (see User Privilege Requirement on page 243).
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2. From the toolbar menu, select General > Import/Export. The Import/Export TeraPack
Magazines screen displays showing the information for the last partition that was
viewed on either the Import/Export TeraPack Magazines screen or the Inventory screen.

3. Select the partition and TAP you want to use from the drop-down lists, then click Go.

The Import/Export TeraPack Magazines screen refreshes to show the current status of the
chambers assigned to the selected partition.

Figure 147 Use the Import/Export TeraPack Magazines
screen to export or exchange magazines (storage partition
shown).

Select this TAP... If you want to use...

Center The dual TAP located in the center of the main frame.

Note: When exporting TeraPack magazines, using the center TAP is the most
straightforward option unless you need to export a large number of magazines.

Left The bulk TAP located in the bulk TAP service frame on the left end of the
library, if present.

Right The bulk TAP located in the bulk TAP service frame on the right end of
the library, if present.

LeftAndRight Both the bulk TAP located in the bulk TAP service frame on the left end of
the library, and the bulk TAP located in the bulk TAP service frame on the
right end of the library.

4. Click the appropriate Export/Exchange button to select the location from which you want
to export or exchange magazines.
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Note: If there are no full chambers in the selected location, the Export/Exchange button is not
present.

For a... Select Export/Exchange
for.... If you want to export or exchange...

Storage partition Storage: Full Chambers All of the magazines in the storage pool.

Entry/Exit: Full Chambers All of the magazines in the entry/exit pool.

Entry/Exit: Populated
Chambers

Only the magazines in the entry/exit pool
that contain one or more cartridges.

Cleaning partition Cleaning: Full Chambers All of the magazines in the cleaning
partition.

5. The next steps depend on which TAP you selected.

If you selected the Center TAP

a. A TeraPorter retrieves a magazine from the specified pool and places it in the
center TAP. The TAP door opens and a Feedback Required screen displays.

b. Remove the magazine from the open TAP and set it aside.

c. Return to the operator panel and select the appropriate option on the Feedback
Required screen.

Note: If you wait more than 10 minutes to respond, the library times out and displays a message on
the operator panel. The TAP door is left open.

Select... If...

Continue You want to export another magazine. The process continues as follows:

1. The TAP door closes automatically when you click Continue. The
TeraPorter retrieves the next magazine and delivers it to the other
chamber of the center TAP. The TAP doors alternate as you
continue to export magazines.

2. The export process continues as long as there are magazines in the
selected location or until you click Stop Exporting on the Feedback
Required screen. Continue to remove the magazines and click
Continue after each one. When all of the magazines in the selected
location are exported, the process stops automatically and the
Import/Export TeraPack Magazines screen displays.

Stop Exporting The magazine you removed from the TAP is the last one you want to
export.
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If you selected the Left, Right, or LeftAndRight TAP

a. The Bulk TAP Move Confirmation screen displays a message with instructions for
performing the export operation.

IMPORTANT

If the carousel contains magazines from a previous export or import
operation, the library alerts you to remove those magazines. When the door
release button LED is solid green, press it to open the bulk TAP door. Remove
the magazines, close the door firmly by pressing at the top and bottom, and
select Continue to restart the import process.

Figure 148 Read the instructions on the Bulk TAP Move
Confirmation screen, then click Continue.

b. Click Continue. The TeraPorter retrieves magazines from the specified pool and
places them in the bulk TAP.

Note: If you selected LeftAndRight TAP, and there are fewer than 14 magazines to export, all of the
magazines are moved to the left bulk TAP. If you selected LeftAndRight TAP and there are
more then a 14 magazines to export, the magazines are distributed as evenly as possible
between the two bulk TAPs.

c. The Import/Export TeraPack Magazines screen refreshes to show that the moves are
in progress.

Figure 149 The Import/Export TeraPack Magazines screen
shows that the export process is underway.
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Note: Click Stop Exporting on the Import/Export TeraPack Magazines screen to end the current
export operation. If there are magazines in the bulk TAP, you will be instructed to remove
them before the next import or export operation.

d. When all of the magazines have been retrieved or when a bulk TAP is full, the
carousel rotates to face the outside of the library and the door release button LED
turns solid green. Press the button to open the bulk TAP door (see Figure 144 on
page 254).

Note: If you wait more than 10 minutes to open the door, the library considers the export operation
complete. The LED turns off and the carousel rotates to face the interior of the library. When
you attempt the next import or export operation using the bulk TAP, the library will require
you to remove any magazines in the carousel before you can proceed.

e. Remove the magazines from the carousel(s) and set them aside.

f. Close the bulk TAP door firmly by pressing at the top and bottom. An audible click
indicates that the door is latched closed.

Note: If you fail to close the door within 10 minutes, the export operation times out.

g. If the bulk TAP could not accommodate all of the magazines in the selected
location, the TeraPorter moves the next set of magazines from the selected location
to the carousel. The process continues as long as there are magazines in the selected
location. When the process stops, the door release button LED turns off, the
carousel rotates to face the interior of the library, and the Import/Export TeraPack
Magazines screen displays.

3. If you exported magazines directly from the storage pool, use your storage management
software to update the media inventory it maintains (see Updating the Storage
Management Software Inventory on page 278).

Exchange Magazines or Cartridges in a Partition

The process for exchanging a magazine or cartridges in a partition is the same as that for
exporting a magazine up to the point where the magazine is delivered to the selected TAP.

Note: If you want to exchange only the expired cleaning cartridges in a cleaning partition, skip to
Export or Exchange Expired Cleaning Cartridges on page 266.

1. Complete Step 1 on page 258 through Step 4 on page 259 to begin the exchange process.

2. The next steps depend on which TAP you selected.

If you selected the Center TAP

a. When you click Export/Exchange, the TeraPorter retrieves a magazine from the
selected location and places it in the TAP. The TAP door opens and a Feedback
Required screen displays.

b. Remove the magazine from the TAP and either:
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• Place another magazine of the same type in the TAP.

—OR—

• Remove or exchange one or more cartridges in the magazine and then place the
magazine back in the TAP.

Note: If you are exchanging cartridges, make sure to only exchange cartridges of the same type.

c. Return to the operator panel and select the appropriate option on the Feedback
Required screen.

Note: If you wait more than 10 minutes to respond, the library times out and displays a message on
the operator panel. The TAP door is left open.

Select... If...

Continue You want to make additional exchanges. The process continues as follows:

1. The TAP door closes automatically. The TeraPorter returns the
magazine to its original location. It then retrieves the next magazine
and delivers it to the second TAP. The TAP doors alternate as you
continue the exchange process.

2. The exchange process continues as long as there are magazines in
the selected location or until you click Stop Exporting on the
Feedback Required screen. Continue to make exchanges, clicking
Continue after each one. When all of the magazines in the selected
location have been presented for exchange, the process stops
automatically and the Import/Export TeraPack Magazines screen
displays.

Stop Exporting The magazine or cartridge you exchanged is the last one you want to
process.

If you selected the Left , Right, or LeftAndRight TAP

a. The Bulk TAP Move Confirmation screen displays a confirmation message with
instructions for performing the export operation.
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Figure 150 Read the instructions on the Bulk TAP Move
Confirmation screen, then click Continue.

b. Click Continue. The TeraPorter retrieves magazines from the selected pool and
places them in the bulk TAP.

IMPORTANT

If the carousel contains magazines from a previous export or import
operation, the library alerts you to remove those magazines. When the door
release button LED is solid green, press it to open the bulk TAP door. Remove
the magazines, close the door firmly by pressing at the top and bottom, and
click Continue to restart the export process.

c. The Import/Export TeraPack Magazines screen refreshes to show that the moves are
in progress.

Figure 151 The Import/Export TeraPack Magazines screen
shows that the export or exchange process is underway.

Notes: l Click Stop Exporting on the Import/Export TeraPack Magazines screen to end the
current exchange operation. If there are magazines in the bulk TAP, you will be
instructed to remove them before the next import or export operation.

l If you selected LeftAndRight TAP, and there are 14 or fewer magazines to exchange,
all of the magazines are moved to the left bulk TAP. If you selected LeftAndRight TAP
and there are more then 14 magazines to exchange, the magazines are distributed as
evenly as possible between the two bulk TAPs.
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d. When all of the magazines have been retrieved or when a bulk TAP is full, the
carousel rotates to face the outside of the library and the door release button LED is
solid green. Press the button to open the bulk TAP door (see Figure 144 on
page 254).

Note: If you wait more than 10 minutes to open the door, the library considers the operation
complete. The LED turns off and the carousel rotates to face the interior of the library. When
you attempt the next import or export operation using the bulk TAP, the library will require
you to remove any magazines in the carousel before you can proceed.

e. Make the desired exchanges.

CAUTION

When you place a magazine in the bulk TAP, make sure that the textured surface
on each side of the magazine is toward the inside of the library and that the guides
on the sides of the magazine fit into the media guides on the media shelf, as shown
in Figure 145 on page 254. Loading the magazines incorrectly or at an angle can
result in damage to the carousel or the robotics.

IMPORTANT
To ensure that you place the magazine in the same location that it originally
occupied in the carousel, remove one magazine at a time, perform the
desired exchange, and place the magazine back in the carousel.

• If you are exchanging magazines, remove each magazine from the carousel and
replace it with another one of the same type.

• If you are exchanging one cartridge for another, remove the magazines from the
carousel one at a time, exchange the desired cartridges, and then put the magazine
back into the same location that it originally occupied.

f. Close the bulk TAP door firmly by pressing at the top and bottom. An audible click
indicates that the door is latched closed.

Notes: l If you fail to close the door within 10 minutes, the exchange operation times out.

l If you selected LeftAndRight TAP, the library starts processing moves as soon as you
close one bulk TAP door. The library completes processing moves from the first bulk
TAP before starting to process moves for the second bulk TAP.

g. The TeraPorter moves the magazines in the carousel back to the locations they
originally occupied. If there are additional magazines to exchange, the TeraPorter
then retrieves the next set of magazines and delivers them to the bulk TAP(s). The
process continues as long as there are magazines that have not been processed in
the selected location or until you click Stop Exporting on the Import/Export
TeraPack Magazines screen.

JUNE 2025 265 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 7 - IMPORTING AND EXPORTING CARTRIDGES



3. If you exchanged cartridges in a storage partition’s storage pool, be sure to update your
storage management software’s media inventory (see Updating the Storage Management
Software Inventory on page 278).

Export or Exchange Expired Cleaning Cartridges

The export and exchange processes described in this section only operate on Maintenance
TeraPack magazines that contain expired cleaning cartridges. The Maintenance TeraPack
magazines are always stored in a cleaning partition.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select General > Import/Export. The Import/Export TeraPack
Magazines screen displays showing the information for the last partition that was
viewed on either the Import/Export TeraPack Magazines screen or the Inventory screen.

3. Select the desired cleaning partition and the center TAP, then click Go. The
Import/Export TeraPack Magazines screen refreshes to show the current status of the
chambers assigned to the partition.

IMPORTANT
Using the bulk TAP to export or exchange expired cleaning cartridges is not
supported. The Export/Exchange Expired button does not appear on the
Import/Export TeraPack Magazines screen if you select the left or right TAP.

4. Click Export/Exchange Expired on the Import/Export TeraPack Magazines screen.

Figure 152 Select Export/Exchange Expired.

5. The TeraPorter retrieves a magazine that contains expired cleaning cartridges from the
cleaning partition and places it in the TAP. The TAP door opens and a Feedback
Required screen displays, indicating which cartridges to remove from the magazine.

a. Remove or exchange the expired cleaning cartridges indicated on the Feedback
Required screen.

b. Place the magazine back in the TAP if you removed it.
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6. Return to the operator panel and click the appropriate option on the Feedback Required
screen.

Note: If you wait more than 10 minutes to respond, the library times out and displays a message on
the operator panel. The TAP door is left open.

Click... If...

Continue You removed the expired cleaning cartridges in the magazines and did not
replace them with new cartridges, or you removed or exchanged the entire
magazine. The process continues as follows:

1. The TAP door closes automatically. If you exchanged magazines,
the TeraPorter first moves the new magazine into the cleaning
partition. It then retrieves the next magazine from the cleaning
partition and delivers it to the second TAP. The TAP doors alternate
as each magazine is retrieved.

Note: If you exchanged cartridges and clicked Continue instead of Override,
click Ok in response to a message stating that the slot containing the
exchanged cartridge should be empty.

2. The process continues as long as there are magazines with expired
cleaning cartridges in the cleaning partition or until you click Stop
Exporting on the Feedback Required screen. Remove the expired
cartridges from each magazine, place the magazine back into the
TAP, and click Continue for each one. When there are no expired
cleaning cartridges left in the cleaning partition, the process stops
automatically and the Import/Export TeraPack Magazines screen
displays.

Override You exchanged the expired cleaning cartridges in the magazine for new
ones. The process continues as follows:

1. The TAP door closes automatically. The TeraPorter moves the
magazine in the TAP back to the cleaning partition. It then retrieves
the next magazine from the cleaning partition and delivers it to the
second TAP. The TAP doors alternate as each magazine is retrieved.

2. The process continues as long as there are magazines with expired
cleaning cartridges in the cleaning partition or until you click Stop
Exporting on the Feedback Required screen. Exchange the expired
cartridges in each magazine, place the magazine back into the TAP,
and click Override for each one. When there are no expired cleaning
cartridges left in the cleaning partition, the process stops
automatically and the Import/Export TeraPack Magazines screen
displays.

Stop Exporting The expired cleaning cartridge you removed or exchanged is the last one
you want to process.
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USING THE ADVANCED IMPORT/EXPORT OPTIONS

Overview

The Advanced option on the Import/Export TeraPack Magazines screen lets you import a
magazine into a specific chamber in a partition or export a specific magazine from a partition.

Note: If you only need to import or export a single cartridge, you can also use the options on the
Inventory screen (see Using the Cartridge Inventory on page 279). This chapter also provides
instructions for moving cartridges from one location to another within a partition.

Requirements

When using the advanced import/export options, keep the following in mind:

• Only a user with superuser or administrator privileges can access the advanced
import/export options.

• Refer to the following sections for additional requirements and restrictions:

• Import and Export Overview on page 243

• Importing into a Storage or Cleaning Partition on page 246

• Exporting or Exchanging Magazines and Cartridges on page 257

Populate the Import/Export move queue using one of the following:

• Manually Create a Move Queue below

• Upload a Move Queue on page 272

Manually Create a Move Queue

1. To import one or more cartridges, place the prepared cartridges in an empty TeraPack
magazine (see Preparing Cartridges for Use on page 239).

2. Log into the library as a superuser or administrator.

3. From the toolbar menu, select General > Import/Export. The Import/Export TeraPack
Magazines screen displays showing the information for the last partition that was
viewed on either the Import/Export TeraPack Magazines screen or the Inventory screen.

4. Click Advanced. The Advanced Import/Export screen displays showing the information
for the partition that was selected on the basic Import/Export TeraPack Magazines
screen.
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5. On the Advanced Import/Export screen, use the drop-down lists to select the partition,
the TAP you want to use, and the direction you want to move the magazine, then click
Go.

Figure 153 Select the partition, TAP, and the direction of
the move.

Select the TAP

Select this
TAP... If you want to use...

Center The dual TAP located in the center of the main frame.
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Select this
TAP... If you want to use...

Left The bulk TAP located in bulk TAP service frame on the left end of the
library.

IMPORTANT When using a bulk TAP, all moves in the queue must be either
imports or exports. Building a move queue that contains moves both to and
from the carousel is not supported.

Right The bulk TAP located in the bulk TAP service frame on the right end of the
library.

IMPORTANT When using a bulk TAP, all moves in the queue must be either
imports or exports. Building a move queue that contains moves both to and
from the carousel is not supported.

LeftAndRight Both the bulk TAP located in the bulk TAP service frame on the left end of
the library, and the bulk TAP located in the bulk TAP service frame on the
right end of the library.

IMPORTANT When using a bulk TAP, all moves in the queue must be either
imports or exports. Building a move queue that contains moves both to and
from the carousel is not supported.

Notes:

• If the move queue contains commands to import 14 or fewer TeraPack
magazines into chambers in the library, only the left bulk TAP is rotated
and unlocked.

• If the move queue contains commands to export 14 or fewer TeraPack
magazines, it places all of the magazines into chambers in the left bulk
TAP.

Select the direction

For a... Select... To move the magazine from...

Storage
partition

TAP > Storage The selected TAP to the selected chamber in the storage
pool.

Storage > TAP The selected chamber in the storage pool to the selected
TAP.

TAP > EE The selected TAP to the selected chamber in the entry/exit
pool.

EE > TAP The selected chamber in the entry/exit pool to the selected
TAP.
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For a... Select... To move the magazine from...

Cleaning
partition

TAP > Storage From the selected TAP to the selected chamber in the
cleaning partition.

Storage > TAP From the selected chamber in the cleaning partition to the
selected TAP.

TAP > EE

EE > TAP

For a cleaning partition, the options for moving to or from
the entry/exit pool are not valid.

6. Use the Chamber drop-down list to select the source chamber for the move, then click Go
to refresh the screen.

• For moves to the TAP from either the entry/exit or storage pool, the selected chamber is
the source for the move. The TeraPack Case Contents list shows the barcodes of the
cartridges in the magazine in the selected chamber.

• For moves from the TAP to either the entry/exit or storage pool, the selected chamber is
the destination for the move. Use the Chamber drop-down list to select an empty
chamber in the selected pool.

7. Click Add Move. An entry listing the move you just defined appears in the Move Queue
list.

Figure 154 Add the move to the Move Queue.

8. Repeat Step 5 on page 269 through Step 7 to add more moves to the Move Queue.

Notes: l Changing the selected partition or the selected TAP clears the move queue.
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l If you select the Center TAP, You can add moves from different directions to the same
move queue. When using a bulk TAP, all moves in the queue must be either imports or
exports.

l If you do not want to perform one or more of the moves in the queue, do the
following:

l Select the move and click Delete to remove it from the Move Queue list.

l Click Delete All to remove all of the defined moves from the Move Queue list.

9. Continue with Start the Moves on page 274.

Upload a Move Queue

1. Create a media exchange move file listing the offsets for the imports or exports you want
to initiate. You can create the file using the
mediaExchange.xml?action=prepareImportExportList command (see the
Spectra Tape Libraries XML Command Reference for more information) or manually. If you
are creating the move file manually, keep the following in mind:

• The file must be a Windows format ASCII text file (End of line is carriage return and
line feed).

• Each line in the file must contain a 1-based TeraPack offset.

• All chambers indicated by the offsets in a file must be full indicating an export, or all
chambers must be empty indicating an import. You cannot mix import and export
moves in one file.

• If you are using a USB device to upload the file, the file must be named
MediaExchangeMoves.txt and the file must be saved to the root of the USB device.

2. Log into the library as a superuser or administrator.

3. If you saved the move queue file to a USB device, connect the device to one of the USB
ports on the LCM or operator panel and allow time for the device to mount before
proceeding.

4. Access the Upload Media Exchange Move List screen.

Using RLC, from the toolbar menu, select General > Import/Export. The Upload Media
Exchange Move List screen displays.

— OR—

Access the Upload Media Exchange Move List screen from the front panel.

a. On the toolbar menu, select General > Import/Export. The
Import/Export TeraPack Magazines screen displays showing the information for the
last partition that was viewed on either the Import/Export TeraPack Magazines
screen or the Inventory screen.
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b. Click Advanced. The Advanced Import/Export screen displays showing the
information for the partition that was selected on the basic Import/Export TeraPack
Magazines screen.

c. On the Advanced Import/Export screen (see Figure 153 on page 269), click Upload.
The Upload Media Exchange Move List screen displays.

Figure 155 Add the move to the Move Queue.

5. Select the Partition from which you want to export, or to which you want to import,
TeraPack magazines.

6. Select whether to move magazines to, or from, the Storage pool or entry/exit (EE) pool.

7. Select the desired option for uploading the move queue file.

Select... To...

Remote Upload the move queue file using the BlueScale web interface.

Note: This option is only available if your are logged in using the RLC.

USB Upload the move queue file from a USB device connected to the LCM or
operator panel.

IMPORTANT The move queue file must be named
MediaExchangeMoves.txt. The library does not recognize any other
file name. The file must be stored in the root of the USB device.

8. Click Upload.

• If you selected USB, the Advance Import/Export screen displays. Continue with Step 9
on page 274.

• If you selected Remote, the RLC Upload Media Exchange Move File screen displays.
Use your web browser’s upload feature to find the file, and then click Next. The
Advanced Import/Export screen displays with a new button labeled Populate.
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Figure 156 The Advanced Import/Export screen with the
Populate button.

9. Click Populate to add the imports or exports in the media exchange move file to the
move queue.

10.Select a TAP for the magazines to be imported from, or exported to.

Note: For moves to the bulk TAP Left, Right, or LeftandRight), the magazine is moved to an available empty
chamber in the carousel.

Select this TAP... If you want to use...

Center The dual TAP located in the center of the main frame.

Left The bulk TAP located in the bulk TAP service frame on the left end of the
library.

Right The bulk TAP located in the bulk TAP service frame on the right end of
the library.

LeftAndRight Both the bulk TAP located in the bulk TAP service frame on the left end of
the library, and the bulk TAP located in the bulk TAP service frame on the
right end of the library.

11.Continue with Start the Moves below.

Start the Moves

1. Click Start Moves to begin processing the moves.

2. The next steps depend on which TAP you selected.
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If you selected the Center TAP

The TAP door opens.

a. Depending on the direction of the move, either remove the magazine or insert a
magazine.

b. Return to the operator panel and select one of the following options on the
Feedback Required screen.

Note: If you wait more than 10 minutes to respond, the library times out and displays a message on
the operator panel. The TAP door is left open.

Select... To...

Continue Process the next move in the queue.

1. The TAP door closes automatically and the TeraPorter performs the
next move.

2. The TAP door opens and a Feedback Required screen displays
waiting for you to remove or insert a magazine. The TAP doors
alternate as additional moves are processed.

3. The process continues until all of the moves in the queue are
processed or until you click Stop Exporting on the Feedback
Required screen. Continue to remove or insert a magazine in the
TAP, clicking Continue for each one. When all of the defined moves
are completed, the process stops automatically and the Advanced
Import/Export TeraPack Magazines screen displays.

Stop Exporting Stop processing the move queue.

If you selected the Left, Right, or LeftAndRight TAP

The bulk TAP Move Confirmation screen displays instructions for performing the move
operation (see Figure 143 on page 253).

a. Select Continue.

IMPORTANT

If the carousel contains magazines from a previous export or import
operation, the library will alert you to remove those magazines. When the
door release button LED is solid green, press it to open the bulk TAP door.
Remove the magazines, close the door firmly by pressing at the top and
bottom, and select Continue to restart the import process.

The Import/Export TeraPack Magazines screen refreshes to show that the moves are
in progress (for example, see Figure 146 on page 255 or Figure 149 on page 261).
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Note: Depending on the direction of the move, you can select Stop Importing or Stop Exporting
on the Import/Export TeraPack Magazines screen to terminate the moves. If there are
magazines in the bulk TAP, you will be instructed to remove them before the next import or
export operation.

b. The library begins processing the move queue as follows:

If the direction of
the move is... Then...

From the bulk
TAP to a storage
partition pool or
to a cleaning
partition,

The bulk TAP carousel(s) rotate to face the outside of the library and the
door release button LEDs turn solid green.

1. Press the button to open the bulk TAP door (see Figure 144 on
page 254).

Note: If you wait more than 10 minutes to open the door, the LED turns off and
the carousel rotates to face the interior of the library.

2. Place the magazines on the carousel shelves.

CAUTION When you place a magazine in the bulk TAP, make sure that the
textured surface on each side of the magazine is toward the inside of the
library and that the guides on the sides of the magazine fit into the media
guides on the media shelf, as shown in Figure 145 on page 254. Loading
the magazines incorrectly or at an angle can result in damage to the

carousel or the robotics.

3. Close the bulk TAP door firmly by pressing at the top and bottom.
An audible click indicates that the door is latched closed. The
TeraPorter moves the magazines to the chambers specified in the
move queue.

Note: If you fail to close the door within 10 minutes, the import operation times
out.

4. If there are additional chambers listed in the move queue, the
process continues until all of the chambers are filled or until you
select the Stop Importing option on the Import/Export TeraPack
Magazines screen. When all of the chambers are full, the process
stops automatically and the Import/Export TeraPack Magazines
screen displays.

From a pool to
the bulk TAP,

The TeraPorter retrieves the magazines in the move queue and places
them in the bulk TAP carousel(s). When all of the magazines in the move
queue have been retrieved or when the shelves are full, the bulk TAP
carousel rotates to the unload position and the door release button LED is
solid green.
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If the direction of
the move is... Then...

Note: If you take more than 10 minutes to press the door release button to
open the door, the LED turns off and the carousel rotates to face the interior of
the library. The library considers the move complete. When you attempt the
next import or export operation, the library will require you to remove the
magazines before you can proceed.

1. Press the button to open the bulk TAP door (see Figure 144 on
page 254).

2. Remove the magazines and set them aside.

3. Close the bulk TAP door firmly by pressing at the top and bottom.
An audible click indicates that the door is latched closed.

Note: If you fail to close the door within 10 minutes, the export operation times
out.
If there are additional chambers listed in the move queue, the process
continues until all of the magazines in the list have been exported or until
you select the Stop Exporting option on the Import/Export TeraPack
Magazines screen. When all of the magazines have been exported, the
process stops automatically and the Import/Export TeraPack Magazines
screen displays.

4. If you imported magazines into a partition’s storage pool or exported magazines from a
partition’s storage pool, be sure to use your storage management software to update its
media inventory after completing the export (see Updating the Storage Management
Software Inventory).
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UPDATING THE STORAGE MANAGEMENT SOFTWARE
INVENTORY

As the library imports magazines, it reads the barcode labels on the individual cartridges and
the magazines and automatically updates the physical inventory that it maintains. This process
does not automatically update the media inventory maintained and used by the storage
management software.

The storage management software maintains its own media inventory, which it uses when
performing backup/restore operations and for media management. To avoid errors when the
storage management software requests a specific cartridge, be sure to use your storage
management software to update its media inventory whenever you import cartridges into or
export/exchange cartridges from a storage partition’s storage pool as described in this chapter.
Refer to your software documentation for more information.
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CHAPTER 8 - USING THE CARTRIDGE
INVENTORY
This chapter describes using the library’s cartridge inventory to identify and move cartridges
within the library. See Importing and Exporting Cartridges on page 238 for information about
importing and exporting magazines and cartridges.

Understanding the Cartridge Inventory 280
Viewing and Downloading the Cartridge Inventory 281

View the Cartridge Inventory for a Location 281

Download the Cartridge Inventory 283

Locating a Specific Cartridge 288
Moving Cartridges Within a Partition 289

Move Cartridges Using the BlueScale Inventory Screen 289

Move Cartridges Using an ASCII Move File 294
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UNDERSTANDING THE CARTRIDGE INVENTORY

The inventory is a record of all the cartridges stored in each library partition and their current
locations (for example, in a specific slot in a TeraPack magazine, or in a drive). As cartridges
are imported into a partition, the barcode reader on the transporter reads the barcode labels
on the individual cartridges and the magazines. The library uses this barcode information to
maintain its physical inventory, which is stored in the RCM.

The Inventory screen, available from the General toolbar, lets you interact with the cartridge
inventory in the following ways:

The inventory screen lets you...

View information
about the
cartridges in a
partition,

• View the cartridges located in a storage partition’s storage pool, its
entry/exit pool, or a drive.

• View the cartridges located in a cleaning partition and identify expired
cartridges. An “x” appears next to the slot number if the cleaning
cartridge is expired.

• Download an XML file that lists the inventory of every location in the
selected storage partition (see Download the Cartridge Inventory on
page 283).

Locate a specific
cartridge in the
partition,

Search for a cartridge using either its barcode label information or its slot
location (see Locating a Specific Cartridge on page 288).

Move a cartridge
from one location
to another,

• Find and select a specific cartridge within a partition and move it to
another location (see Moving Cartridges Within a Partition on
page 289).

• Automate a series of moves in a storage partition by uploading a specially
formatted ASCII text file that contains a sequence of moves to the partition
(see Create a Move Queue File on page 294).
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VIEWING AND DOWNLOADING THE CARTRIDGE
INVENTORY

Overview

The Inventory screen provides information about the cartridge inventory for each of the
partitions configured in the library. It also provides options for interacting with that inventory
to move cartridges from one location to another.

Requirements

When using the Inventory screen, keep the following requirements in mind:

• Any user with operator privileges who is assigned to the partition and all users with
superuser or administrator privileges can view and download the cartridge inventory.

• Downloading an XML file containing the current cartridge inventory for a partition
requires either a remote connection to the library using the BlueScale web interface (RLC)
or a USB device connected to the LCM or operator panel.

View the Cartridge Inventory for a Location

Note: You can also view the cartridge inventory for a specific location using the Media Lifecycle
Management Report screen (see Using MLM Reporting on page 336).

1. Log into the library.

2. From the toolbar menu, select General > Inventory. The Inventory screen displays,
showing the information for the last partition that was viewed on either the
Import/Export TeraPack Magazines screen or the Inventory screen.

3. Select the partition for which you want to view the inventory from the Partition drop-
down list, then click Go. The screen refreshes to show the cartridge inventory for the
Source type that was selected the last time the Inventory screen was viewed.

Note: The Destination list shows all of the empty locations of the selected type.
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Figure 157 The Inventory screen.

4. Use the Source drop-down list to select the location for which you want to view the
cartridge inventory, then click Go. The Source list refreshes to display a list of the
cartridges in the requested location type.

Figure 158 Select the source type for which you want to view the inventory.

Notes: l The available sources depend on the type of partition selected.

l If the selected source does not contain any cartridges, the source list shows “No
sources found.”

JUNE 2025 282 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 8 - USING THE CARTRIDGE INVENTORY



l The From TAP option is only available when you access the user interface from the
front panel.

Partition Type Available Sources

Storage • Storage — Lists the barcodes of the cartridges currently in the selected
partition’s storage pool.

• Entry/Exit — Lists the barcodes of the cartridges currently in the
partition’s entry/exit pool.

• Drives — Lists the barcode of the cartridge currently in each drive
assigned to the partition. Only drives that contain a cartridge are
included in the list.

• From TAP — Configures a move that transfers the magazine containing
the destination slot to the TAP so that you can insert a cartridge (see
Moving Cartridges Within a Partition on page 289).

• All — Lists all of the cartridges in the partition, regardless of location.

Cleaning • Cleaning — Lists the cleaning cartridges currently in the selected
cleaning partition.

• From TAP — Configures a move that transfers the magazine containing
the destination slot to the TAP so that you can insert a cartridge (see
Moving Cartridges Within a Partition on page 289).

• All — Lists all of the cartridges in the partition, regardless of location.
Note: If an “x” appears next to the slot number in the source list for a cleaning
partition, the cleaning cartridge is expired.

Download the Cartridge Inventory

If desired, you can download the inventory for the selected partition as an XML file. You can
use the information in the downloaded inventory when creating a move queue file (see Create
a Move Queue File on page 294).

• If you are using the BlueScale user interface from the operator panel, the cartridge
inventory is saved as an XML file on a USB device that is connected to the LCM or
operator panel.

• If you are accessing the library using the BlueScale web interface, the cartridge inventory is
displayed using the XML format in a new browser window on the computer that you are
using to access the library. From there you can save the file to a convenient location for
later use. If a USB device is connected to the LCM or operator panel, you can also save the
XML file to the USB device.

The inventory lists the following information for all magazine slots in the partition’s storage
pool and entry/exit pool and for the drives in the partition.
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• For each slot and drive, the list shows the location ID and indicates whether or not it is full
(occupied).

• For each occupied slot or drive, the list also indicates the barcode information of the
cartridge.

Note: You can also use the XML command interface to obtain the full inventory of the partition,
including both full and empty slots and drive numbers (see inventory.xml in the Spectra Tape
Libraries XML Command Reference).

Usage Requirements

Downloading an XML file containing the current cartridge inventory requires either a remote
connection to the library using the BlueScale web interface (RLC) or a USB device connected to
the LCM or operator panel.

Download the Inventory

Use the following steps to download the inventory.

1. Log into the library.

2. If you want to save the XML file containing the cartridge inventory to a USB device,
connect the device to the USB port on the LCM or operator panel and allow time for the
device to mount before proceeding (see Connect a USB Device to the Library on
page 186).

3. From the toolbar menu, select General > Inventory. The Inventory screen displays,
showing the information for the last partition that was viewed on either the
Import/Export TeraPack Magazines screen or the Inventory screen.

4. If you want to download the inventory for a partition other than the one currently
displayed, select the desired partition from the Partition drop-down list, then click Go
(see Figure 157 on page 282).

5. Click Advanced to display the options for uploading moves and downloading the
inventory.
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Figure 159 Select Advanced to display the advanced
options for the selected partition.

6. On the Advanced Inventory screen, select the Download Inventory tab.

IMPORTANT
The option to download the inventory file to a USB device is unavailable if the
USB device is not connected and given time to mount before you click
Advanced on the inventory screen.

Figure 160 Select the download option for the inventory
file.

7. Select the desired option for downloading the inventory file. As soon as you make your
selection, the download process begins.
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Click... To...

Remote Browser Automatically open the XML file on the computer accessing the library’s
BlueScale web interface.

Notes:

• This option can only be selected if you are accessing the library using
the BlueScale web interface (RLC).

• If the application associated with XML files is a web browser, the XML
file opens in a new browser window.

USB Save the XML file to the root of the USB device connected to the LCM or
operator panel. The file name uses the following format:
[Partition Name]_[yyyy-mm-dd]_[hh_mm_ss].xml

Note: This option can only be selected if you connected a USB device in Step 2
on page 284.

8. If the XML file was successfully saved to the USB device or if the library detected errors,
a Download Verification screen displays. If errors are reported, resolve them and then
repeat the download process.

Note: The Download Verification screen does not display if the file successfully downloads to the
remote computer.

9. Open the XML file.

• If you selected the Remote Browser option for downloading the XML file, the file opens
automatically. You can then save the file to your computer for later use.

Note: See inventory.xml in the Spectra Tape Libraries XML Command Reference for a description of
the fields in the XML file.

Figure 161 The cartridge inventory XML file opened in a
web browser.
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• If you selected the USB option, move the USB device to a computer and open the XML
file.

• To view the XML file in spreadsheet format, use Microsoft Excel® 2007 or later, or use
another spreadsheet program that supports the XML file format.

Figure 162 Example of the cartridge inventory XML file
opened in Excel.
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LOCATING A SPECIFIC CARTRIDGE

The Inventory screen provides three different methods for locating a specific cartridge in the
library.

1. Log into the library.

2. Display the cartridge inventory for the desired partition location (see View the Cartridge
Inventory for a Location on page 281).

3. Locate the desired cartridge using one of the following methods.

To locate using... Do the following...

The Source list, 1. Scroll through the list until you find the barcode for the desired
cartridge.

2. Click the barcode to select the cartridge.

The slot number, 1. Enter the slot number for the cartridge you want in the View Source
Slot field.

2. Click Go. The Source list refreshes to show the requested slot
highlighted at the top of the list.

3. Click the cartridge to select it.

The barcode label
information,

1. Enter the barcode label information for the cartridge you want to
locate in the Find by Barcode field.

2. Click Find. The Source inventory list refreshes to show the requested
cartridge highlighted at the top of the Source list.

3. Click the barcode to select the cartridge.

IMPORTANT Only the slots below the top one displayed in the list are
searched. Scroll to the top of the source list before clicking Find. The
search starts at the second visible slot.
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MOVING CARTRIDGES WITHIN A PARTITION
Overview

During normal operations, you typically use your storage management software to move
cartridges from one location to another within the library. However, you may occasionally
need to create and process a move queue to direct the library to move cartridges manually.
This can be done using the library’s BlueScale interface to locate and move individual
cartridges (for example, to move a cleaning cartridge stored in the storage partition to a drive
if you are not using the Auto Drive Clean option) or by uploading a series of moves to a
storage partition using a specially formatted ASCII text file. Use the instructions in one of the
following sections to manually direct cartridge moves.

• Move Cartridges Using the BlueScale Inventory Screen

• Move Cartridges Using an ASCII Move File on page 294

User Privilege Requirements

The user privilege requirements when moving cartridges in a storage partition depend on how
the library is being accessed. See Specify the Partition Users on page 218 for information about
assigning users to a partition.

• Any user with operator privileges who is assigned to the partition and all users with
superuser or administrator privileges can move cartridges within the partition using the
BlueScale interface on the operator panel.

• Only a user with superuser or administrator privileges can move cartridges within the
partition using the BlueScale web interface (RLC) or upload a move queue file.

Usage Requirements

Uploading a move queue file requires either a remote connection to the library using the
BlueScale web interface (RLC) or a USB device connected to the LCM or operator panel.

Move Cartridges Using the BlueScale Inventory Screen
The library uses a move queue to direct tape cartridge moves. The move queue lists one or
more source/destination pairs, with each pair representing a single move operation.

Manually Create the Move Queue

Use the following steps to create the move queue using the BlueScale Inventory screen.

1. Log into the library as a user with the required privileges (see User Privilege
Requirements above).

2. Display the cartridge inventory for the desired partition location (see View the Cartridge
Inventory for a Location on page 281 for more details).

a. From the toolbar menu, select General > Inventory.
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b. Select the partition for which you want to view the inventory from the Partition
drop-down list, then click Go.

3. Use the Source drop-down list to select the source type for the move, then click Go.

Notes: l Selecting a specific source type instead of using All displays fewer items through which
you must scroll to locate the desired cartridge.

l The From TAP option is only available when you access the user interface from the
front panel.

l The TAP only contains cartridges while an import or export operation is in progress.
Cartridges are not stored in the TAP.

l If you select Entry/Exit from the Source drop-down list and there are cartridges in the
entry/exit pool, a Bulk Load button displays at the bottom of the Inventory screen.
Clicking Bulk Load automatically adds operations to the move queue for moving each
cartridge in the entry/exit pool to an empty slot in the storage pool.

Partition Type Available Sources

Storage • Storage—Lists the cartridges currently in the selected storage partition’s
storage pool.

• Entry/Exit—Lists the cartridges currently in the partition’s entry/exit
pool.

• Drives—Lists the drives in the partition that currently contain a
cartridge.

• From TAP—Configures a move that transfers the magazine containing
the destination slot to the TAP so that you can insert a cartridge. The
magazine is then returned to its original location.

• All—Lists all of the cartridges in the partition, regardless of location.

Cleaning • Cleaning—Lists the cleaning cartridges currently in the selected cleaning
partition.

• From TAP—Configures a move that transfers the maintenance magazine
containing the destination slot to the TAP so that you can insert a
cartridge. The magazine is then returned to its original location.

• All—Lists all of the cartridges in the partition.

4. If you are moving a cartridge that is already in the library, locate and select the cartridge
you want to move in the Source list, as described in Locating a Specific Cartridge on
page 288.

5. Use the Destination drop-down list to select the type of location to which you want to
move the cartridge, then click Go. The destination list refreshes to show all of the empty
slots in the selected location.
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IMPORTANT
You cannot use the Inventory screen to move a cleaning cartridge in a
cleaning partition to a drive in a storage partition. Instead, use the Clean
button on the Drives screen (see Manually Cleaning a Drive on page 502).

Notes: l The available destinations depend on the type of partition you selected.

l The To TAP option is only available when accessing the BlueScale user interface from
the front panel.

Figure 163 Select the Destination for the cartridge.

Partition Type Available Destinations

Storage • Storage—Lists all of the empty slots in the selected storage partition’s
storage pool.

• Entry/Exit—Lists all of the empty slots in the selected partition’s
entry/exit pool.

• To TAP—Configures a move that transfers the magazine containing the
source slot to the TAP so that you can remove the cartridge from the
specified slot. The magazine is then returned to its original location.

• Drives—Lists the drives in the partition that are currently empty.
• All—Lists all of the empty slots in the partition, regardless of the
location.

Note: Selecting a specific destination type instead of using All displays fewer
items through which you must scroll to locate the desired destination slot.

JUNE 2025 291 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 8 - USING THE CARTRIDGE INVENTORY



Partition Type Available Destinations

Cleaning • Cleaning—Lists all of the empty slots in the selected cleaning partition.
• To TAP—Configures a move that transfers the maintenance magazine
containing the source slot to the TAP so that you can remove or replace
the cleaning cartridge from the specified slot. The magazine is then
returned to its original location.

• All—List all available destinations in the partition, regardless of the type.
Note: Selecting a specific destination type instead of using All displays fewer
items through which you must scroll to locate the desired destination slot.

6. If you are moving a cartridge to a slot, locate and select the desired slot in the
Destination list.

7. Click Add Move. An entry listing the move you just defined appears in the Move Queue
list.

Figure 164 Add the move to the Move Queue.

8. Repeat Step 3 on page 290 through Step 7 on this page for each additional cartridge you
want to move.

Note: If you want to remove one or more of the moves in the queue:

l Select the move and click Delete to remove it from the Move Queue list.

l Click Delete All to remove all of the defined moves from the Move Queue list.
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Process the Move Queue

Use the following steps to process the move queue created using the Inventory screen.

1. If you are moving cartridges into the library, prepare the cartridges as described in
Preparing Cartridges for Use on page 239.

Note: When importing cartridges, you do not need to put the prepared cartridges into a magazine.
You are prompted to insert the prepared cartridge into the selected empty slot in the
magazine that is delivered to the TAP.

2. Choose one of the move processing modes:

Figure 165 Click Start Moves or Start in Background to begin processing
the move queue.

Click... To...

Start Moves Begin processing the moves in the order that they are listed in the queue.
A progress screen tracks the progress of the move operations. When all of
the moves in the queue have been processed, the screen displays the
status of each move. No other operations can be started until the moves
complete.

Note: If the TAP is the source for or destination for a move, a Feedback
Required screen displays.
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Click... To...

• From TAP—The magazine containing the destination slot is moved to
the TAP so that you can insert a cartridge in the slot indicated by the
Feedback Required screen. The magazine is then returned to its original
location.

• To TAP—The magazine containing the source slot is moved to the TAP
so that you can remove or replace the cartridge from the slot indicated
by the Feedback Required screen. The magazine is then returned to its
original location.

Start in
Background

Begin processing the moves in the background. The front panel or RLC is
available for some operations.

Notes:

• You are not able to edit the partition, import or export cartridges into
the partition, or create another move queue for the partition while
background moves are in progress.

• Start in Background is not available if the move queue includes moves
to or from the TAP.

• The library posts informational messages after every 10 moves in the
move queue and when the all moves complete.

3. When the moves complete, use your storage management software to update the
inventory it maintains, if necessary (see Updating the Storage Management Software
Inventory on page 278).

Move Cartridges Using an ASCII Move File

Create a Move Queue File

If desired, you can create a Windows format ASCII text file (End of line is carriage return and
line feed) that lists sources and destinations for a series of moves and upload that move queue
file to the library. This option is particularly useful if you need to move a large number of
cartridges.

IMPORTANT The maximum number of moves that can be configured in a single move
queue is 100 source/destination pairs.

IMPORTANT

The barcode for a cartridge can only be used as the source in the first move
of that cartridge in a connected sequence of moves. The remaining moves in
the sequence must specify either a slot or a drive as the source. For example,
in a sequence that moves a cartridge from a storage slot to a drive and then
back to the storage slot, only the move from the slot to the drive can use the
barcode as the source.
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Notes: l The option to upload a move queue file is only available for storage partitions.

l Moves to or from the TAP are not supported.

1. Use one of the following methods to obtain an inventory listing for the partition in
which you plan to move the cartridges:

• Download the partition inventory using the Advanced option on the Inventory screen
(see Download the Cartridge Inventory on page 283).

• Download the partition inventory using the XML command interface. See the Spectra
Tape Libraries XML Command Reference for a detailed description of each parameter in the
downloaded inventory file.

Note: Both methods return the same information.

2. Using an ASCII text editor, create a file containing the list of moves you want to
configure. Each line of the move queue file must specify a source and destination
separated by a delimiter.

The format of each line is:

[source_id][source_num][delimiter][destination_id]
[destination_num]

where:

Note: The slot numbers and drive numbers are assigned by the library.

For this variable... The possible values are... Description...

source_id • SLOT—The cartridge is moved
from a slot in the storage pool.

• EE—The cartridge is moved
from a slot in the entry/exit
pool.

• DRIVE—The cartridge is moved
from the drive.

• BC—The cartridge to be moved
is identified by its barcode label
information.

Note: The values are not case-
sensitive.

Specifies the location type for the
source from which you want to move
the cartridge.

source_num • A positive integer for all source_
id values except BC.

• The human-readable barcode
label character string if the
source_id is BC.

Specifically identifies the cartridge to
be moved, either by the ID of the slot
or drive where it is currently located
or by the barcode label on the
cartridge.
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For this variable... The possible values are... Description...

IMPORTANT If the cartridge does
not have a valid barcode label,
then you must specify both the
element type for the source_id
and the number of the slot in
the entry/exit or storage pool or
the number of the drive where
the cartridge is located for the
source_num.

• If the source_id is SLOT or EE, this
value is the number assigned to
the slot where the cartridge is
currently located. Locate the
<offset> parameter for the desired
cartridge in the downloaded
inventory file and use that value as
the source_num.

• If the source_id is DRIVE, this value
is the number of the drive where
the cartridge is currently located.
Locate the <offset> parameter for
the drive in the downloaded
inventory file and use that value as
the source_num.

• If the source_id is BC, this value is
the human-readable barcode
character string for the cartridge to
be moved. Locate the <barcode>
parameter for the desired cartridge
in the downloaded inventory file
and use that value as the source_
num.

delimiter ; (semicolon)

: (colon)

Note: Either character is acceptable.

The character that separates the
source from the destination.

destination_id • SLOT—The cartridge is moved
to an empty slot in the storage
pool.

• EE—The cartridge is moved to
an empty slot in the entry/exit
pool.

• DRIVE—The cartridge is moved
to the specified drive.

Note: The values are not case-
sensitive.

Specifies the location type for the
destination of the cartridge move.

destination_num A positive integer. Specifies the ID of the location to
which the cartridge is moved.

• An empty slot in the entry/exit or
storage pool for the partition
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For this variable... The possible values are... Description...

• The number of the drive
Locate the <offset> parameter for the
desired slot or drive in the
downloaded inventory file and use
the value as the destination_num.

Example

The following lines in a move queue file specify a series of moves.

This line in the file... Moves...

BC000618L3;Slot3 The cartridge with barcode label 000618L3 to slot 3 of the storage
pool.

Slot10;EE5 The cartridge in slot 10 of the storage pool to slot 5 in the entry/exit
pool.

EE10;Slot15 The cartridge in slot 10 of the entry/exit pool to slot 15 in the storage
pool.

Drive3;Slot18 The cartridge in Drive 3 to slot 18 of the storage pool.

BC000618L3;Drive1 The cartridge with barcode label 000618L3 to Drive 1.

3. Examine the move queue file carefully to make sure that each line is formatted correctly
and contains both a source and a destination. When the library parses the uploaded file,
it will reject the file if it contains any syntax errors.

4. Save the move queue file as a Windows format ASCII text file.

Notes: l If you plan to use a USB device to upload the move queue file, save the file to the root
of the drive using the file name MoveQueue.txt.

l Unix/Linux format ASCII text files may cause errors.

Upload and Process the Move Queue File

After you finish creating the move queue file, use the following steps to upload and process
the file.

1. Log into the library as a user with superuser or administrative privileges.

2. If you saved the move queue file to a USB device, connect the device to one of the USB
ports on the LCM or operator panel and allow time for the device to mount before
proceeding (see Connect a USB Device to the Library on page 186).
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IMPORTANT
The option to upload the move queue file from a USB device cannot be
selected if the USB device is not connected and mounted before you click
Advanced on the inventory screen.

3. From the library user interface, select General > Inventory. The Inventory screen displays
showing the information for the last partition that was viewed on either the Inventory
screen or the Import/Export TeraPack Magazines screen.

4. If you want to upload the move queue to a storage partition other than the one currently
displayed, select the desired partition from the Partition drop-down list, then click Go.

Note: Using a move queue file is only supported for storage partitions.

5. Click Advanced to display the options for uploading and processing the move queue file
(see Figure 159 on page 285).

6. On the Advanced Inventory screen, select the Upload Moves tab.

Figure 166 Select the upload options for the move queue
file.

7. Select the desired option for uploading the move queue file.

Select... To...

Remote Upload the move queue file using the BlueScale web interface.

USB Upload the move queue file from a USB device connected to the LCM or
operator panel.

IMPORTANT The move queue file must be named MoveQueue.txt. The
library does not recognize any other file name. The file must be stored in
the root of the USB device.
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8. Click the button that describes how you want the file processed.

Click... To...

Upload to Move
Queue

Upload the file to the library. Once uploaded, you can view the parsed
move queue file in the Move Queue list on the Inventory screen to review
the uploaded moves. After reviewing the Move Queue, choose one of the
following:

• Click Start Moves to begin processing the moves in the order that they
are listed in the queue. The front panel is locked while the library
processes the moves.

• Click Start in Background to begin processing the moves without
locking the front panel.

Upload and Start
Moves

Upload the file to the library and begin the moves immediately. No other
operations can be started until the moves complete.

Upload and Start
in Background

Upload the file and start the moves in the background. The front panel or
RLC is available for some operations.

Notes:

• The library posts informational messages after every 10 moves in the
move queue and when the all moves complete.

• You are not able to edit the partition, import or export cartridges into
the partition, or create another move queue for the partition while
background moves are in progress.

• If you selected the USB option, the library retrieves the move file from the USB device.

• If you selected the Remote option, the RLC Upload Files screen displays. Use your web
browser’s upload feature to find the file, and then click Next.

Figure 167 Locate the move queue file and select it
(Internet Explorer shown).

9. After the move queue file uploads, the library parses the file to create the move queue.

The parser ignores blank lines and case where possible. It does not determine whether
the moves or the order of the moves is possible. If the parser encounters any parsing
errors which are insurmountable or if the file contains syntax errors, the library rejects
the move file and generates a system message indicating that the move file contained
errors and listing the line numbers where the errors were detected.
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For example, if line 1 in the MoveQueue.txt file uploaded from the USB device is
BC000618L3;Slot, the library posts the following message indicating that the line did not
include a value for destination_num:

--------------------------------------------

File \USB Disk\MoveQueue.txt has invalid moves in its list

Invalid Parse on line 1: BC000618L3;Slot

---------------------------------------------

If the library detected an error in the move file, correct the move file (see Create a Move
Queue File on page 294) and then repeat Step 2 on page 297 through Step 8 on page 299.

10.The library then processes the moves based on your selection in Step 8 on page 299.
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CHAPTER 9 - CONFIGURING AND USING
MEDIA LIFECYCLE MANAGEMENT
This chapter describes how to use BlueScale Media Lifecycle Management to proactively
monitor and report on the health of the cartridges in your library. See MLM Best Practices on
page 543 for information about using Media Lifecycle Management (MLM) effectively in your
environment and ensuring that your MLM data is protected.

BlueScale Media Lifecycle Management 303
Spectra Certified MLM-Enabled Media 303

Automatic Media Discovery 303

Media Tracking and Reporting 305

MLM PreScan and PostScan 308

Additional MLM Features 310

Enabling MLM and Configuring Global Settings 313
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Back Up the MLM and DLM Databases 345

Verify the Database Backup File 347

Delete MLM Records From the Database 348

Download the MLM Database for Analysis and Archival 350
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BLUESCALE MEDIA LIFECYCLE MANAGEMENT

This section describes the major features of BlueScale Media Lifecycle Management (MLM).
The remainder of the chapter provides detailed information about configuring and using
MLM.

IMPORTANT Before you can use Media Lifecycle Management, you must enable it as
described in Enabling MLM and Configuring Global Settings on page 313.

Note: MLM is supported for TS11xx technology drives and LTO-4 and later generation drives and
compatible media.

Overview

BlueScale Media Lifecycle Management (MLM) helps you manage your tape media
(cartridges) by giving you tools to proactively detect potential media errors well before they
happen. When used in combination with Spectra Certified MLM-enabled media, MLM lets you
manage, track, and report all facets of tape usage from creation to retirement. When used with
media that is not MLM-enabled, MLM tracks and reports the general health of the media.

Spectra Certified MLM-Enabled Media

Media Lifecycle Management starts with packaged, barcode labeled, Spectra Certified MLM-
enabled media (LTO data cartridges and cleaning cartridges or TS11xx technology data
cartridges). Before shipment, Spectra Logic writes baseline data to the MAM (Medium
Auxiliary Memory) embedded in each cartridge. Throughout its life, the cartridge MAM
continually collects data to support MLM tracking and reporting. See Spectra Certified Media
on page 560 for additional information.

Note: Starting with BlueScale12.7.04, TS11xx technology cleaning tapes are always treated as MLM
enabled by the BlueScale software.

Automatic Media Discovery

Overview

The Media Auto Discovery feature is a background process that loads MLM-enabled
cartridges into a TS11xx technology drive or an LTO-4 or later generation drive, records the
MLM information to the cartridge MAM, adds the cartridge to the MLM database, and returns
the cartridge to its original location. The process is performed by the library independently
from the storage management software. Media Auto Discovery must be enabled on the library,
as described in Enabling MLM and Configuring Global Settings on page 313, before it can be
used.
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Note: If you do not want to use automatic media discovery, you can wait until the library loads and
then unloads each cartridge from an MLM-capable drive for the first time during normal
operation. When the cartridge is unloaded from the drive, the library discovers it and records
the MLM data to the cartridge MAM and enters the data into the MLM database.

When Media Auto Discovery is enabled, MLM provides two options for proactively
discovering media in a partition:

• Media Auto Discovery—The default process that collects information from the cartridge
MAM and adds it to the MLM database. The Media Auto Discovery process only operates
on newly imported cartridges that are not already in the MLM database.

Note: Media Auto Discovery loads and reads the MAM in the tape, but does not thread the tape. The
drive only reports the maximum and remaining capacity for the tape after the tape is
threaded. Therefore, these statistics report as "0" until a drive reads from, or writes to, the
tape.

• PreScan—An optional process that replaces Media Auto Discovery. If the PreScan feature
is enabled in a partition, the PreScan process runs instead of the Media Auto Discovery
process and operates on all of the media in the partition, regardless of whether it is already
in the MLM database or not.

In addition to adding information collected from the cartridge MAM to the MLM database,
PreScan performs a basic functionality test and health check on each imported cartridge
(see Using PreScan on page 325 for more information).

Discovery Process

The discovery process can either be manually initiated by you or set to run automatically so
that the library discovers the cartridges and adds their information to the MLM database
shortly after a cartridge is imported into the library. The discovery process is independent of
any storage management software.

The discovery process depends on whether the library is using Media Auto Discovery or
PreScan. With Media Auto Discovery the library reads the barcode label on each new cartridge
in the partition; with PreScan the library reads the barcode label on every cartridge in the
partition. If a barcode is not already in the MLM database, the library loads the cartridge into
a drive and performs either a PreScan or the basic Media Auto Discovery.

• If the cartridge is MLM-enabled, the library collects the available MLM information from
the cartridge’s MAM, including the born-on date. If the cartridge was used previously, the
library also collects media health and encryption status from the MAM. The library updates
the MLM database to include the collected information and the name of the partition where
it currently resides. Any updated MLM information is also written to the MAM in the
cartridge.

• If the cartridge is not MLM-enabled, the library collects the cartridge barcode label
information, the cartridge health information, and the name of the partition where the
cartridge currently resides. It then adds this information to the MLM database.
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When the discovery process is complete, the drive unloads the cartridge and the library
returns the cartridge to its original location. Each subsequent load/unload updates the MLM
database and the cartridge MAM, providing ongoing tracking and reporting for the cartridge.

Manual Discovery

If Media Auto Discovery is not enabled or if you enabled MLM when the library already
contained cartridges, you can start the media discovery process manually to add the cartridges
to the MLM database (see Discover Cartridges Manually on page 322).

Note: After you enable Media Auto Discovery, importing a cartridge into a partition triggers the
discovery process in that partition.

Automatic Discovery During Normal Operations

Automatic media discovery cannot begin while the library is actively loading cartridges into
drives. If you import cartridges during this time, the library posts a failure message stating
that no drives are available.

To avoid this failure, either wait until the library is idle before importing media or start the
manual discovery process for the imported media when the library is idle. See Discover
Cartridges Manually on page 322 for instructions.

Media Tracking and Reporting

Overview

MLM uses the information from the cartridge’s MAM to maintain a database of vital
information about each MLM-enabled cartridge in the library, including the drives into which
it was loaded and any errors it encountered. The statistical and diagnostic information in the
MLM database helps you proactively manage your tape media throughout its life. Using the
information in the database, MLM can generate a variety of reports that let you monitor
important health information about every MLM-enabled data cartridge and cleaning cartridge
in your library. If desired, you can save the reports to a USB device or email them to a
previously configured mail user. You can also download the MLM database as a comma-
separated-value (CSV) file.

Notes: l The MLM database also includes limited information about cartridges that are not
MLM-enabled.

l The cartridge inventory is separate from the MLM database and only shows cartridges
currently stored in the library. The cartridge inventory does not differentiate between
MLM-enabled cartridges and those that are not MLM-enabled.
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Discovery Requirement

Until an MLM-enabled cartridge is discovered, either through the automatic media discovery
process or when it is loaded into and then unloaded from a drive for the first time, it is not
included in the MLM database; nor is the capacity of a non-discovered data cartridge included
on the Filled Capacity bar graph shown on the General Status screen.

Media Health Score

The initial load/unload during discovery establishes an initial media health score for each
cartridge and adds this information to the MLM database. This initial health score may not
accurately reflect the actual health of the media. The health score stabilizes and becomes more
accurate after the first four loads/unloads as current usage statistics are updated and used in
the tape’s health scoring.

MLM Health Reports

MLM reports let you review important health information about every MLM-enabled data
tape and cleaning tape in your library. You can generate comprehensive health reports for the
MLM-enabled media in the whole library or in an individual partition. You can also generate
more detailed reports with information about compression ratios, load counts, write errors,
remaining capacity, encryption status, and more.

The MLM reports help you identify tapes with high error rates or other problems (for
example, a dropped leader pin) that pose a risk to protecting your data. These tapes can then
be removed before they cause data corruption or other problems. See Generate MLM Reports
on page 336 for detailed information about the types of reports you can generate.

MLM Database Management

After a cartridge is added to the MLM database, its MLM data remains in the database even if
the cartridge is exported from the library. If the cartridge is later reimported, the MLM
database is updated to reflect any new information obtained from the cartridge MAM. When a
cartridge is permanently removed from service, it can be manually deleted from the database.

The MLM database is restricted to a maximum of 75,000 records. When this limit is reached,
the record for the least recently exported cartridge, as determined by the Export Date tracked
by MLM, is automatically deleted. The library does not notify you when it reaches the
maximum number of records.

To ensure that you have a complete record of all the cartridges that are used in the library,
regularly generate and export a Media Health report for the entire library (see Using MLM
Reporting on page 336). When a cartridge is retired or permanently exported from the library,
its record can be deleted from the MLM database. Records can be deleted individually or as a
group (see Delete MLM Records From the Database on page 348).
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If desired, the information in the MLM database can be exported to a comma-separated-value
(CSV) file, which can then be imported into Microsoft Excel® or other software applications
that support this file type (see Download the MLM Database for Analysis and Archival on
page 350).

Data Cartridge Tracking

A primary function of MLM is to track the health and usage of the data cartridges that are
currently in or were previously in the library.

Functional Overview

Each time a Spectra Certified MLM-enabled data cartridge is loaded into a drive, MLM records
over 30 data points about the cartridge. These data points include health information, the
cartridge age, how many times it was loaded and into which drives, and how many errors it
accumulated. It also records when the cartridge is exported from the library and by whom.
Each MLM-enabled data cartridge has a unique identifier that allows each cartridge to be
tracked throughout its life, even if its barcode label is damaged or removed.

Remaining Capacity Calculations

In addition to media health, the library uses information in the MLM database to estimate the
Remaining Capacity report for the cartridges in the selected partition. If the partition contains
a mix of MLM and non-MLM-enabled data cartridges, the report only shows the estimated
capacity on the MLM-enabled cartridges.

Note: Until a data cartridge is loaded into, threaded, and then unloaded from a drive for the first
time, its remaining capacity is not included in the Remaining Capacity report.

Cleaning Cartridge Tracking

Functional Overview

The library tracks expired cleaning cartridges in the cartridge inventory and does not attempt
to use an expired cleaning cartridge. You can identify expired cartridges by examining the
Inventory screen. Expired cleaning cartridges are identified by an “x” next to the slot number.

When you enable MLM and use Spectra Certified MLM-enabled cleaning cartridges, MLM
tracks and reports usage information for the cleaning cartridges. This information, which
includes the number of cleans remaining and the cartridge health (good, near expiration, or
expired), is stored in the MLM database.

When a cartridge is nearing the end of its useful life, MLM notifies you so that you can have
another on hand to replace it. This early notification helps prevent failed cleanings resulting
from using an expired cleaning cartridge. See Enabling MLM and Configuring Global Settings
on page 313 for information about setting the threshold for generating the notification.

JUNE 2025 307 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 9 - CONFIGURING AND USING MEDIA LIFECYCLE MANAGEMENT



Note: Starting with BlueScale12.7.04, TS11xx technology cleaning tapes are always treated as MLM
enabled by the BlueScale software.

Expired MLM-Enabled Cleaning Cartridges

Each time an MLM-enabled cleaning cartridge is used in a drive, the drive decrements the
number of cleans remaining on the cartridge. When the cartridge is unloaded from the drive,
MLM reads the number of cleans remaining from the cartridge MAM. When the number of
cleans remaining reaches zero, the library flags the cartridge as expired and does not attempt
to use the cartridge again. Because the library does not need to load a cleaning cartridge into a
drive to determine that it is expired, cleaning failures due to an expired cartridge are
eliminated (assuming the cleaning partition contains a good cleaning cartridge). Information
about an expired cleaning cartridge remains in the MLM database even after the cartridge is
exported from the library.

Expired Non-MLM Cleaning Cartridges

When MLM is not enabled or if the cleaning cartridges are not MLM-enabled, the library must
load the cleaning cartridge into a drive to determine whether it is expired. When an expired
cleaning cartridge is loaded into a drive, it is immediately ejected; the cleaning fails. The
library flags the cleaning tape as expired in the cartridge inventory and generates system
messages to notify you of the expired cleaning tape and the failed drive cleaning. The library
does not attempt to use the expired cartridge for subsequent cleanings.

The library does not store any information about non-MLM cleaning cartridges in the MLM
database. The library retains the information about an expired cleaning cartridge for as long as
it remains in the library or until the library is power-cycled. If an expired non-MLM cartridge
is exported and then reimported into the library, the cartridge must be loaded into a drive in
order to identify it as expired.

MLM PreScan and PostScan

Overview

MLM PreScan and PostScan are configurable background processes that use a TS11xx
technology drive or an LTO-4 or later generation drive to provide two levels of verification for
data cartridges. See Using PreScan on page 325 and Using PostScan on page 327 for detailed
information about configuring and using PreScan and PostScan.

Note: PostScan and Spectra SKLM or KMIP encryption key management cannot be configured for
use in the same partition.
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Enable and Configure PreScan and PostScan

Both PreScan and PostScan are enabled and configured as part of the partition creation
process, as described in Enable and Configure MLM PreScan and PostScan on page 210.
During configuration you set the scanning frequency and select the types of scan you want to
use.

Usage Requirements

Although a Global Spare drive can be shared by multiple partitions, assigning a separate
Global Spare drive to each partition is recommended. If you select to perform a FullScan or a
QuickScan using a Global Spare drive, each partition can then perform PostScan operations
whenever the prerequisites are met, without waiting for PostScan in another partition to
complete.

Refer to the following sections for additional information about using the PreScan and
PostScan features:

This section... Provides...

Assign Global Spare Drives
on page 206

Information about configuring a Global Spare drive. A Global
Spare drive must be configured for the partition before the
FullScan option can be used.

Using PreScan on page 325 Usage requirements for PreScan.

Using PostScan on
page 327

Detailed information about how the QuickScan and FullScan
options in the PostScan feature operate. This section also
provides instructions for manually adding a tape to the PostScan
queue and pausing the currently running PostScan process.

PreScan and PostScan System Messages

Both PreScan and PostScan generate system messages as possible error conditions are detected
(for example, a broken leader or a media error). The messages indicate that the error condition
was detected by the PreScan or PostScan process and not during normal operation.

Interaction with Move Requests

If a host requests a move while a cartridge is being scanned using one of the partition drives
(PreScan or QuickScan), the move is delayed until the scan completes and the cartridge is
returned to its slot.

JUNE 2025 309 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 9 - CONFIGURING AND USING MEDIA LIFECYCLE MANAGEMENT



Background Operations

To protect you against making changes that could negatively impact the library’s operation,
the BlueScale software automatically prevents you from performing certain operations while
the library is performing background operations, including Media Auto Discovery, PreScan, or
PostScan.

• You cannot import or export cartridges while the library is running a Media Auto
Discovery or PreScan operation, nor can you use the BlueScale user interface to move
cartridges from one location to another in the library.

If you cannot wait for the operation to complete, you can stop Media Auto Discovery or
PreScan and then manually start it at another time (see Stop the Discovery Process on
page 324).

• You cannot perform any of the following operations while either a FullScan or a QuickScan
that uses Global Spare drives is running in a partition:

• Import cartridges into or export cartridges from the library

• Use the BlueScale user interface to move a cartridge from one location to another

• Use the Global Spare drive being used by PostScan to replace a malfunctioning drive in
the partition

• Change the library configuration settings

• Create or modify partitions

• Update BlueScale software or the drive firmware

If you need to perform any of these operations or if you need to reset the library, you can
pause the PostScan process for one hour (see Pause the PostScan Process on page 334). The
library returns any cartridges currently being scanned to their original locations. After an
hour passes, the library checks the prerequisites for starting PostScan (see Prerequisites for
Starting a PostScan Operation on page 327) and when met, restarts the PostScan operation
on the tape that was being verified at the time of the interruption.

Additional MLM Features

In addition to the features described in the previous sections, MLM provides the following
features (listed in alphabetical order):

Broadcast Capacity

The Broadcast Capacity option changes the capacity displayed on the General Status screen to
show broadcast-centric hours of programming used and hours of programming remaining
instead of raw capacity (see Configure How Storage Capacity Displays on page 316).
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Database Management

Management tools let you manually delete one or more tape records from the MLM database
when the tape is retired or permanently exported from the library. You can also download the
MLM database as a comma-separated-value (CSV) file and open the file in any software
application that supports this type of file (for example, spreadsheet software).

Filled Capacity Information

In addition to tracking media health and generating reports, MLM displays a Filled Capacity
bar graph on the General Status screen. This graph shows the remaining uncompressed
storage capacity for the MLM-enabled media in the entire library or in a specific partition.
Click on the Filled Capacity bar graph to view the Media Lifecycle Management Report screen
(Figure 182 on page 338).

Note: Until a data cartridge is loaded into, threaded, and then unloaded from a drive for the first
time, its data capacity is not included on the Filled Capacity bar graph shown on the General
Status screen.

Figure 168 The General Status screen shows the storage capacity usage for
the selected partition.

Media Alert

The Media Alert feature generates a system message when a tape’s health is identified as poor
(red) during five consecutive loads. This message is only generated once per tape. A separate
system message is generated whenever a cartridge experiences a hard error.
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Tracking Non-MLM-Enabled Media

MLM tracks the basic health information for data cartridges that are not MLM-enabled. This
basic health information is based on tape log data retrieved from an MLM-capable drive when
the cartridge is ejected. The data pertinent to media health is stored in the MLM database and
used to determine the media health status (Usable or Impaired) included in Media Lifecycle
Management reports.
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ENABLING MLM AND CONFIGURING GLOBAL SETTINGS

Overview

This section describes enabling MLM on the library and configuring the global MLM features.
The global features are optional and operate for every partition that is configured to use
PreScan and PostScan (see Enable and Configure MLM PreScan and PostScan on page 210).

Notes: l MLM is enabled by default. If you do not want to use MLM, you must disable it.

l Disabling MLM also disables DLM.

IMPORTANT

Before disabling (or re-enabling) Media Lifecycle Management, make sure
that none of the drives in the library contain a cartridge. Use your application
software to unload cartridges from the drives and return them to the slots in
the library.

User Privilege Requirements

Only a user with superuser or administrator privileges can enable MLM and configure the
global MLM features.

Enable MLM and Configure Settings

Use the following steps to enable MLM and Media Auto Discovery and configure the global
settings for MLM. These settings affect all partitions in the library.

Note: Enabling MLM automatically enables Drive Lifecycle Management (DLM) as well. See Using
Drive Lifecycle Management on page 352 for information about DLM.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Media Lifecycle Management. The Media
Lifecycle Management Settings screen displays.
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Figure 169 Use the Media Lifecycle Management Settings
screen to enable MLM and configure the global
configuration settings.

3. Select the MLM features you want to use.

Select this
option... To... Default

Setting

Enable Media
Lifecycle
Management

Enable the Media Lifecycle Management (MLM) features
in the library. MLM is enabled by default. Enabling
Media Lifecycle Management also enables Drive
Lifecycle Management (DLM), which is described in
Using Drive Lifecycle Management on page 352.

Selected
(Enabled)

Enable Alerts for
Non-Certified
Media

Configure MLM to generate an alert message when a
cartridge that is not MLM-enabled is loaded into a drive.
Notes:

• Enabling this alert is only recommended if all of the
media typically used in the library is MLM-enabled.

• Starting with BlueScale12.7.04, TS11xx technology
cleaning tapes are always treated as MLM enabled by
the BlueScale software.

Cleared
(Disabled)
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Select this
option... To... Default

Setting

Enable Alerts for
Load Count
Discrepancies

Configure MLM to generate an alert message when the
load count for the cartridge stored in the MLM database
differs from the load count stored on the cartridge’s
MAM.

Cleared
(Disabled)

Minimum
Cleaning Passes
Before Warning

Set the threshold for the minimum number of cleaning
passes remaining on a cleaning cartridge. When an
MLM-enabled cleaning cartridge reaches this threshold, a
warning message is generated showing that the cleaning
cartridge is nearly expired. The warning message is
generated every time the cleaning tape is used while the
number of cleanings remaining is at or below the threshold
value.

Zero (0)

Maximum Tape
Loads Before
Warning

Set the number of times a tape can be loaded into a drive
before a load count warning message is generated. When
the number of tape loads reaches the specified threshold,
a warning message is generated. Subsequent loads do
not generate additional messages.
Generate a Load Count Media Lifecycle Report to
determine the current usage status of the media in your
library (see Using MLM Reporting on page 336 for
detailed information).
Note: If you began using MLM-enabled cartridges before you
enabled MLM, some of your media may already exceed the
thresholds you set.

10,000 loads

Enable Media
Auto Discovery

Enable the Media Auto Discovery feature.
Media Auto Discovery must be enabled before the
library proactively discovers newly imported cartridges
and adds them to the MLM database.
If you enable PreScan for the partition, the Media Auto
Discovery process is replaced by the more in depth
PreScan process for that partition (see Enable and
Configure MLM PreScan and PostScan on page 210).
Requirements
• Media Lifecycle Management must be enabled.
• All cartridges must have barcode labels.
Notes:

• The Media Auto Discovery process identifies MLM-
enabled cartridges as well as those that are not MLM-
enabled.

Cleared
(Disabled)
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Select this
option... To... Default

Setting

• The Media Auto Discovery process may be affected by
your storage management software. In addition,
software that polls the drives on a regular basis is
affected by the discovery process. If you encounter
negative interactions with your storage management
software, you can choose to either stop the storage
management software from accessing the library before
starting the discovery process or you can choose not to
use Media Auto Discovery.

• If you do not enable Media Auto Discovery, you can
start the discovery process for a specific partition
manually. See Discover Cartridges Manually on
page 322 for instructions.

—OR—

You can let the library discover cartridges and add
them to the MLM database the first time they are
loaded and unloaded from an MLM-enabled drive
during normal operations.

Minimum Idle
Minutes Before
Auto Discovery

Set the number of minutes that the library needs to be
idle before the Media Auto Discovery process begins.

5 minutes

Convert to
Broadcast Hours

Display the MLM capacity using a broadcast-centric
method based on hours of content used and total hours
of content available instead of raw capacity for all MLM-
enabled cartridges. See Configure How Storage Capacity
Displays below for detailed information.

None
(Disabled)

PostScan
Blackout Periods

Configure time periods during which the automatic
PostScan process does not operate. See Configure
PostScan Blackout Periods on page 318 for detailed
information.

Zero (0)
(Disabled)

4. Click Save to enable the selected MLM features.

Configure How Storage Capacity Displays

By default, the General Status screen shows the raw storage capacity for all MLM-enabled
cartridges in the selected partition. If desired, you can configure the library to use a broadcast-
centric method for displaying the storage capacity in terms of hours of content used and total
hours of content available.

1. Log into the library as a user with superuser or administrator privileges.
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2. From the toolbar menu, select Configuration > Media Lifecycle Management. The Media
Lifecycle Management Settings screen displays (see Figure 169 on page 314).

3. Select the method for converting to broadcast capacity from the Convert to Broadcast
Hours drop-down list.

Note: To return to displaying raw capacity, select None.

If you select None in the Convert to Broadcast Hours field, leave the Override
Broadcast Bit Rate value set to 0.

Figure 170 Select the conversion settings on the Convert
to Broadcast Hours drop-down list.

4. The choice that you make in the Broadcast Hours field automatically selects a default
Override Broadcast Bit Rate. If necessary, change the Override Broadcast Bit Rate as
required for your environment. The default value for the broadcast bit rate depends on
the Broadcast Hours conversion you selected.

5. Click Save. The Filled Capacity bar graph on the General Status screen changes to reflect
hours of content based on the settings for Convert to Broadcast Hours.
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Figure 171 The General Status screen changes to show
capacity as Hours of Content.

Configure PostScan Blackout Periods

If desired, you can configure blackout periods during which the automatic PostScan process
does not operate. Configuring blackout periods ensures that during your backup window, all
of the cartridges in the partition are immediately available and ensures that a Global Spare
drive is available if needed.

IMPORTANT

When configuring blackout periods, keep the following information in mind:
l The blackout periods you configure apply to all of the partitions in the

library.
l If PostScan is actively verifying a tape at the time the blackout period

starts, it completes the current scan. No additional tapes are scanned
until the blackout period expires.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Media Lifecycle Management. The Media
Lifecycle Management Settings screen displays.

3. In the PostScan Blackout Periods pane, use the Start and Stop drop-down lists to set the
start and end times for the blackout period for each day of the week.

Notes: l Times are based on a 24-hour clock, where 0 is midnight.

l To disable the blackout period for a specific day, set both Start and Stop to 0.

l By default, the blackout periods are all set to 0 (disabled). The PostScan process runs
whenever there are tapes in the PostScan queue and a Global Spare drive is available.
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Figure 172 Select the desired blackout periods for
PostScan.

4. Click Save.

5. The blackout periods you set take effect when you enable PostScan for individual
partitions by configuring one or more PostScan triggers (see Enable and Configure MLM
PreScan and PostScan on page 210).
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USING MEDIA LIFECYCLE MANAGEMENT

Overview

After you enable MLM and configure the global settings (see Enabling MLM and Configuring
Global Settings on page 313), you are ready to begin using MLM to track and monitor the
media in the library.

Note: If you want to use the PreScan and PostScan options, you must enable and configure these
options for each partition (see Enable and Configure MLM PreScan and PostScan on
page 210).

User Privilege Requirements

See Specify the Partition Users on page 218 for information about assigning users to a
partition.

• Only a user with superuser or administrator privileges can manually start and stop media
discovery (using either Media Auto Discovery or PreScan), manually start and pause
PostScan operations, and manage the MLM and DLM databases.

• Any user with operator privileges who is assigned to the partition and all users with
superuser or administrator privileges can generate and save MLM reports.

Add Cartridges to the MLM Database

The cartridges used in the library are not added to the MLM database until they are
discovered. The process you use to discover cartridges and add them to the MLM database
depends on when you loaded the cartridges into the library.

IMPORTANT If a cartridge is write-protected when it is inserted into a drive, the library
cannot update the MLM information on the cartridge’s MAM.

Notes: l Media Auto Discovery cannot begin while the library is actively loading media into
drives. If you import media during this time, the library posts a failure message stating
that no drives are available. Either wait until the library is idle before importing media
or start the discovery process for imported media manually when the library is idle.

l If you import cartridges into the library with MLM disabled, those cartridges are not
automatically discovered and added to the MLM database. After you enable MLM, you
must use the manual discovery process to add the cartridges to the MLM database (see
Discover Cartridges Manually on page 322).

The following table provides information about different possible scenarios for adding
cartridges to the MLM database.
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If you... Do this to add the cartridges to the MLM database...

Recently purchased your
library and are
importing cartridges into
the library for the first
time,

1. Make sure that MLM is enabled (see Enabling MLM and
Configuring Global Settings on page 313).

2. If desired, enable PreScan (see Using PreScan on page 325).

3. Import media into the partitions to trigger the automatic
discovery process.

IMPORTANT Discovery cannot begin while the hosts are actively
loading cartridges into and unloading cartridges from drives. If you
import cartridges during this time, the library posts a failure
message stating that no drives are available. Either wait until the
library is idle before importing cartridges or manually start the
discovery process when the library is idle.

Have an existing library
with the most current
BlueScale version
installed. Cartridges
have already been
imported into the
library, but you have just
recently enabled MLM,

1. If you want to detect any non-MLM-enabled cartridges being
imported, temporarily enable the alert on the Media Lifecycle
Management Settings screen (see Enable Alerts for Non-
Certified Media on page 314). The alert is disabled by
default.

2. If desired, enable PreScan (see Using PreScan on page 325).

3. Discover the cartridges in the library using one of the following
methods:

• Import new cartridges into the partition to trigger the
automatic discovery process. If you do not have PreScan
enabled, the discovery process only checks cartridges that are
not already in the MLM database. If PreScan is enabled, all of
the cartridges in the partition are processed, regardless of
whether or not they are already in the MLM database.

IMPORTANT Discovery cannot begin while the hosts are actively
loading cartridges into and unloading cartridges from drives. If you
import cartridges during this time, the library posts a failure
message stating that no drives are available. Either wait until the
library is idle before importing cartridges or manually start the
discovery process when the library is idle.

• If you do not want to wait until you import new cartridges to
have the cartridges already in the library added to the MLM
database, manually start the discovery process (see Discover
Cartridges Manually on the next page).

• Use your storage management software to load each cartridge
into a drive and then unload it.
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If you... Do this to add the cartridges to the MLM database...

• Let the library update the MLM database as part of normal
operation. The information for each cartridge will be added to
the MLM database the first time the cartridge is loaded into
and then unloaded from a drive.

4. When the initial discovery process is complete, disable the
alert about non-MLM-enabled media, if desired.

5. To routinely verify the readability of the cartridges, configure
PostScan for each partition in the library (see Using PostScan
on page 327).

Discover Cartridges Manually

1. Make sure that Media Lifecycle Management is enabled before you start the discovery
process (see Enabling MLM and Configuring Global Settings on page 313).

2. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

3. Click Discover Media to start the manual discovery process.

Note: If all of the media in the library was previously discovered, the Discover Media button is
unavailable. You do not need to perform a manual media discovery.

Figure 173 Click Discover Media on the MLM Tools
screen to begin configuring a manual media discovery
process.

4. Select the partition containing the cartridges you want to add to the MLM database, then
click Next.
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Figure 174 Select the partition containing the cartridges
you want to add to the MLM database.

5. Click OK on the Start Media Discovery screen to begin the discovery process.

Figure 175 Click OK on Start Media Discovery screen to
start media discovery.

6. When the Media Discovery Start Results screen displays, click OK to confirm that the
process started and return to the Media Lifecycle Management Tools screen.

The discovery process continues in the background while the library continues to
operate.

Note: See Background Operations on page 310 for information about operations that cannot be
performed while the discovery process is running.

Figure 176 The Media Discovery Start Results screen
displays when the discovery process starts.
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Stop the Discovery Process

If for some reason you need to interrupt the discovery process before it is complete, click Stop
Discovery on the Media Lifecycle Management Tools screen. The library completes any Media
Auto Discovery or PreScan operations that are in progress and returns the cartridges to their
slots.

Figure 177 Click Stop Discovery to stop the discovery
process.

To resume the discovery process, repeat the steps in Discover Cartridges Manually on
page 322 or wait until you import additional cartridges into the partition to trigger the
discovery process automatically.
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USING PRESCAN
Overview

The MLM PreScan feature is a background process that replaces the default Media Auto
Discovery process in partitions where it is enabled; unlike Media Auto Discovery it does not
operate globally. PreScan is enabled when you configure the partition (see Enable and
Configure MLM PreScan and PostScan on page 210).

PreScan provides verification of data cartridges by performing a basic functionality test and
health check on each imported cartridge using available LTO-4 or later generation drives or
TS11xx technology drives in the partition. As a part of the PreScan process, any cartridges that
are not already in the MLM database are added to the MLM database.

During the PreScan process, the library automatically inserts each cartridge into an available
LTO-4 or later generation drive or TS11xx technology drive assigned to the partition. The
drive loads the cartridge and checks it to determine whether it has any of the following
characteristics:

• Non-MLM-enabled

• Broken or dislodged leader

• Red media health

• Write protected

• Encrypted tape with a moniker not currently stored in the library

When the PreScan process is complete, the library stores the tape health information for the
cartridge in the MLM database. It also writes the MLM data to the cartridge MAM. When the
drive ejects the cartridge, the library returns it to its original slot.

Requirements for Use

When using PreScan, make sure that you consider the following requirements:

Consideration Requirement

Drive Firmware • LTO-4: requires 97F9 or later firmware.
• LTO-5: requires B170 or later firmware.
• LTO-6 and later: supported with any firmware.
• TS11xx technology: supported with any firmware.

Updating MLM
Data on MAM

Updating the cartridge MAM requires the cartridge to be write-enabled.

IMPORTANT If a cartridge is write-protected when it is inserted into a drive, the
information about the cartridge is added to the MLM database, but the
library cannot update the MLM information on the cartridge’s MAM.
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Consideration Requirement

Drive Availability The media discovery process loads the cartridges in the partition into the
drives assigned to that partition. While in use for PreScan, host moves to
the drives being used are delayed until the PreScan operation completes.
Spectra Logic highly recommends that you perform the manual media
discovery process when your storage management software is not
accessing the library and the library is idle.

Auto Drive Clean
Restrictions

Auto drive clean operations do not start while PreScan is running on any
partition that is associated with the cleaning partition. If a drive requires
cleaning, wait until the PreScan operation is complete and then manually
clean the drive.

Cleaning
Partitions

The PreScan feature cannot be enabled for a cleaning partition and does
not affect the operation of cleaning cartridges.
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USING POSTSCAN
This section provides detailed information about how PostScan operates, as well as
prerequisites for using PostScan and performing manual PostScan operations.

IMPORTANT

PostScan is enabled and configured for each individual partition. PostScan
does not operate until the PostScan option is selected and one or more
triggers are specified for the partition (see Enable and Configure MLM PreScan
and PostScan on page 210).

Note: PostScan cannot be configured for use in the same partition as Spectra SKLM or KMIP
encryption key management.

Operational Overview

PostScan—either FullScan or QuickScan—performs a readability verification test to verify data
integrity for all of the cartridges in the MLM database. FullScan uses an LTO-4 or later
generation or TS11xx technology Global Spare drive assigned to the partition and QuickScan
uses an LTO-5 or later generation or TS11xx technology drive in the partition or Global Spare
drive assigned to the partition to check each cartridge in the partition for media errors that can
impact the ability to restore the data.

The PostScan process is performed by the library independent of the storage management
software normally used to read and write data to the tape. You can choose to perform
PostScan either automatically or manually. For automatic scans you can set the scanning
frequency and select options to determine the type of scan performed.

Using FullScan on tapes that are written using variable block sizes is not recommended.Using
FullScan on tapes that are written using variable block sizes is not recommended.Using
FullScan on tapes that are written using variable-length block sizes is not recommended.

Prerequisites for Starting a PostScan Operation

When an MLM-enabled cartridge meets the PostScan trigger criteria configured for the
partition, the cartridge is added to the PostScan queue. The queue is processed in a first-in-
first-out (FIFO) basis.

Note: The automatic PostScan triggers only apply to MLM-enabled cartridges. Cartridges that are
not MLM-enabled must be manually added to the PostScan queue (see Request a Manual
PostScan on page 332).

Before beginning the PostScan process, the library verifies that the following prerequisites are
met:
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• The system has been idle for the period of time specified for the partition (see Enable and
Configure MLM PreScan and PostScan on page 210).

• The library is not currently in a PostScan blackout period (see Configure PostScan Blackout
Periods on page 318).

• If Full Scan is enabled, an LTO-4 or later generation or TS11xx technology Global Spare
drive assigned to the partition is available.

—OR—

If QuickScan is enabled, an LTO-5 or later generation or TS11xx technology drive in the
same partition as the cartridge that met the PostScan trigger criteria is available.

—OR—

If QuickScan with Spare Drives is enabled, an LTO-5 or later generation or TS11xx
technology Global Spare drive assigned to the partition is available.

Cartridge Scanning

If the PostScan prerequisites are met, the library inserts the first cartridge in the PostScan
queue into an available drive. The cartridges in the PostScan queue are processed on a first-in-
first-out (FIFO) basis. Depending on the PostScan option selected for the partition, the drive
loads the cartridge and begins one of the following operations to check for media errors.

Notes: l PostScan reads the data on the tape but does not process this data into a usable form.
It simply verifies that it can read the data from the tape.

l See Enable and Configure MLM PreScan and PostScan on page 210 for additional
information about the differences between the FullScan and QuickScan processes.

This PostScan
option... Uses...

FullScan A Global Spare drive assigned to the partition. FullScan verifies all of the
data on the tape, from the beginning of the tape (BOT) to the end of the
recorded data (EOD) or the physical end of the tape, whichever comes
first.

Notes:

• If the partition uses LTO-4 drives, FullScan is the only available option.
• A Global Spare drive must be assigned to the partition.
• Partitions using SAS drives cannot use FullScan.
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This PostScan
option... Uses...

• The cartridge does not appear on the BlueScale inventory screens while
it is being scanned. If the cartridge is requested by the storage
management software it is immediately ejected from the drive that is
performing the verification and moved to the location requested by the
storage management software. A system message is posted to indicate
that the FullScan operation was interrupted. The cartridge is returned to
the top of the PostScan queue and is the first one processed after it is
returned to its slot.

• The Global Spare drive cannot be activated while FullScan is running.
You must first pause the PostScan process (see Pause the PostScan
Process on page 334). The library immediately aborts the FullScan
currently in progress and returns the cartridge to its original location.
You can then activate the Global Spare drive (see Using a Global Spare
Drive on page 433). The aborted FullScan process resumes when the
Global Spare drive is again available.

• The time to complete a FullScan depends on the type and amount of
data on the tape and whether it was written using fixed- or variable-
length blocks.

• Using FullScan on tapes that are written using variable-length block
sizes is not recommended.

QuickScan One of the LTO-5 or later generation or TS11xx technology drives in the
partition. QuickScan verifies all of the data on a single wrap, from the
beginning of the tape (BOT) to the end of the wrap or the end of recorded
data (EOD), whichever comes first.

Notes:

• If a Global Spare drive is not assigned to the partition, a QuickScan
using one of the partition’s drives is the only option available.

• If possible, the library avoids using the drive in which the cartridge was
most recently unloaded to perform the QuickScan.

• A QuickScan using a partition’s drive is limited to three minutes. If the
QuickScan exceeds this time limit, the operation is aborted and the
cartridge is returned to its slot. The library posts a message stating that
the QuickScan failed. Use FullScan to verify the cartridge.

• While QuickScan is running, all moves in the partition are delayed until
the scan is complete.

QuickScan using a
Global Spare

An LTO-5 or later generation or TS11xx technology Global Spare drive.
QuickScan verifies all of the data on a single wrap, from the beginning of the
tape (BOT) to the end of the wrap or the end of recorded data (EOD),
whichever comes first.

Notes:
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This PostScan
option... Uses...

• A Global Spare drive must be assigned to the partition.
• Partitions using SAS drives cannot use FullScan.
• The cartridge does not appear on the BlueScale inventory screens while
it is being scanned. If the cartridge is requested by the storage
management software it is immediately ejected from the drive that is
performing the verification and moved to the location requested by the
storage management software. A system message is posted to indicate
that the QuickScan operation was interrupted. The cartridge is returned
to the top of the PostScan queue and is the first one processed after it is
returned to its slot.

• The Global Spare drive cannot be activated while a QuickScan using
Global Spares is running. You must first pause the PostScan process (see
Pause the PostScan Process on page 334). The library immediately aborts
the QuickScan currently in progress and returns the cartridge to its
original location. You can then activate the Global Spare drive (see
Using a Global Spare Drive on page 433). The aborted QuickScan
process resumes when the Global Spare drive is again available.

• A QuickScan using a Global Spare drive is limited to 10 minutes. If the
QuickScan exceeds this time limit, the operation is aborted and the
cartridge is returned to its slot. The library posts a message stating that
the QuickScan failed. Use FullScan to verify the cartridge.

Updating the MLM Database

When the PostScan process on a cartridge is complete, the library writes the scan date and a
pass/fail test result to the cartridge MAM and updates the MLM database with the scan date,
the pass/fail test result, and when (or if) the next scan should occur. The drive then unloads
the cartridge and the library returns it to its original slot. The library then posts a system
message showing that the cartridge was scanned. If the QuickScan used a partition drive, the
library reports that the unload move for the backup operation that preceded the QuickScan is
complete.

Global Spare Drive Cleaning

After a cartridge is unloaded from a Global Spare drive following a PostScan verification, the
library checks to see if the drive requires cleaning. If cleaning is required and a cleaning
partition is associated with the storage partition to which the Global Spare is assigned, the
drive is cleaned before the next cartridge is processed.
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Note: If a cleaning partition is not present, periodically check the Drive Details screen for each drive
to determine whether cleaning is required. If cleaning is required, follow the instructions
provided in Manually Cleaning a Drive on page 502.

Address Requirements for Use

As you configure and use PostScan, keep the following in mind:

Consideration Description

Drive Firmware • LTO-4: requires 97F9 or later firmware.
• LTO-5: requires B170 or later firmware.
• LTO-6 and later generations: supported with any firmware.
• TS1140 technology: requires 3A07 or later firmware.
• TS1150 technology: requires 460E or later firmware.
• TS1155 technology and later generations: supported with any firmware.

Updating MLM
Data on MAM

Updating the cartridge MAM requires the cartridge to be write-enabled.

IMPORTANT If a cartridge is write-protected when it is inserted into a drive, the
information about the cartridge is added to the MLM database, but the
library cannot update the MLM information on the cartridge’s MAM.

Drive Support for
PostScan

• LTO-4: Only the FullScan option is available when using LTO-4 drives.
• FullScan, QuickScan, and QuickScan using Global Spare are available
for all Fibre Channel LTO-5 and higher, and TS11xx technology drives.

• Partitions using SAS drives cannot use FullScan or QuickScan using a
Global Spare drive.

Note: While a drive is in use for QuickScan operations, it is unavailable to the
storage management software.

Background
Operations

To protect you from making changes that could negatively impact the
library's operation, the BlueScale software automatically prevents you
from performing certain operations while either a FullScan or a QuickScan
that uses Global Spare drives is running. However, you can pause the
FullScan or QuickScan operation if you cannot wait for it to complete. See
Background Operations for detailed information.

Storage
Management
Software
Configuration

When using automatic PostScan to check your cartridges, configure your
storage management software to allow at least 15 minutes for a requested
move to complete. If a cartridge is in the process of being scanned when it
is requested for a backup or restore operation, it must be unloaded from
the Global spare and moved to another drive before the move request is
reported as complete.
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Consideration Description

Global Spare
Drives

Both FullScan and QuickScan using Global Spare require a Global Spare
drive. Although a Global Spare drive can be shared by multiple partitions,
assigning a separate Global Spare drive to each partition is recommended.
Each partition can then perform PostScan whenever the prerequisites are
met, without waiting for PostScan in another partition to complete.

Blackout Periods Because the storage management software can potentially request a tape
that is currently undergoing verification, you can configure blackout
periods during which the PostScan operation is suspended. Configuring
blackout periods ensures that PostScan does not operate during your
normal backup window. The blackout periods apply to all of the storage
partitions in the library. See Configure PostScan Blackout Periods on
page 318 for instructions.

Cleaning
Partitions

The PostScan feature cannot be enabled for a cleaning partition and does
not affect cleaning tapes.

Enable PostScan

PostScan is enabled by selecting one or more trigger criteria when you configure a partition
(see Enable and Configure MLM PreScan and PostScan on page 210). The available PostScan
options depend on the drive type and whether or not a Global Spare drive is assigned to the
partition.

IMPORTANT
PostScan is enabled and configured for each individual partition. PostScan
does not operate until the PostScan option is selected and one or more
triggers are specified for the partition.

Request a Manual PostScan

The automatic PostScan triggers only add MLM-enabled data cartridges to the PostScan queue.
However, cartridges can also be added to the PostScan queue manually. This is especially
useful if your library contains cartridges that are not MLM-enabled. You can also use the
manual PostScan process to verify a suspect MLM-enabled cartridge even if it was previously
scanned.

Cartridges that are manually added to the PostScan queue are processed before cartridges that
were added as a result of the trigger criteria for the partition. They are processed using the
PostScan option that was specified for the partition.

Use the following steps to manually start the PostScan process.

1. Enable Media Lifecycle Management if it is not already enabled (see Enabling MLM and
Configuring Global Settings on page 313).
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2. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

Figure 178 Click Manual PostScan on the MLM Tools
screen.

3. Click Manual PostScan. The MLM Manual PostScan screen displays showing the
information for the partition that was selected the last time the screen was viewed.

Figure 179 Use the MLM PostScan screen to select the
cartridges to add to the PostScan queue.

4. If the media is in a different partition than the one currently displayed, select the desired
partition from the Partition drop-down list, and then click Go. The Source list refreshes
to display a list of the cartridges in the requested partition. The list shows the name of
the location (for example, the slot number) and the barcode label information for the
cartridge in that location.

5. Select the cartridge that you want to check for media errors. You can select the cartridge
either from the Source list, by entering its barcode, or by entering the slot number where
it is located.
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To select a cartridge using
the... Follow these steps...

Source list Scroll through the list of available media and select the desired
cartridge.

Slot number 1. Enter the slot number for the cartridge you want in the
View Source Slot field.

2. Click Go. The Source list refreshes to show the requested
cartridge highlighted at the top of the list.

3. Click the cartridge to select it.

Barcode label information 1. Enter the barcode label information for the cartridge you
want to locate in the Find by Barcode field.

2. Click Find. The Source list refreshes to show the
requested cartridge highlighted at the top of the list.

3. Click the cartridge to select it.

IMPORTANT Only the slots below the top one displayed in the list
are searched. Scroll to the top of the source list before clicking
Find. The search starts at the second visible slot.

4. Click Add to add the selected cartridge to the Tape List.

5. Repeat Step 4 on page 333 though Step 4 to add additional tapes to the Tape List.

Note: If you want to remove one or more cartridges from the Tape List:

l Select the cartridge and click Delete to remove it from the list.

l Click Delete All to remove all of the cartridges from the list.

6. Click Submit to add the cartridges in the Tape List to the PostScan queue.

Pause the PostScan Process

If you need to perform any of the operations listed in Background Operations on page 310 or
if you need to reset the library, you can pause the PostScan process. The library returns any
cartridges currently being scanned to their original locations.

IMPORTANT Pausing PostScan affects all partitions that are configured to use PostScan.

Use the following steps if you need to temporarily pause the PostScan process.

1. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

Note: The Pause PostScan button is only present if the PostScan process is running.
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Figure 180 Click Pause PostScan on the MLM Tools
screen to interrupt the PostScan process.

2. Click Pause PostScan to pause the PostScan operation for one hour so that you can use
the Global Spare or perform other library operations.

After an hour passes, the library restarts the PostScan operation on the tape that was
being verified at the time of the interruption, provided the PostScan prerequisites listed
on on page 327 are met.
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USING MLM REPORTING

After the LTO cartridges in your library are added to the MLM database, you are ready to
make use of this powerful tool to manage, track, and report all facets of tape usage from
creation to retirement.

Generate MLM Reports

1. Log into the library.

2. From the toolbar menu, select General > Media Lifecycle Management. The Media
Lifecycle Management Report screen displays.

Note: You can also click on the Filled Capacity bar graph on the General Status screen (Figure 168 on
page 311).

3. Select either Total Library or a specific partition from the Partition drop-down list, and
then click Go.

Note: By default, the Media Lifecycle Management Report screen shows a Media Health report for all
Spectra Certified MLM-enabled cartridges in the entire library.

Figure 181 Select the partition for which you want to
display the media health report.

4. Select the type of report you want from the Report drop-down list.

Note: Information about MLM-enabled cleaning cartridges only appears in the Exported Media,
Cleans Remaining, and Born on Date reports.
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This report... Shows...

Media Health • The barcode label information, the overall health (media health), and the
load count (the number of times the cartridge was loaded into a drive)
for each MLM-enabled cartridges in the selected location.

• The barcode label information for each non-MLM-enabled cartridge and
whether the cartridge appears to be usable or impaired.

Remaining
Capacity

The remaining capacity and maximum capacity for each MLM-enabled
data cartridge. The capacity reflects the native capacity of the cartridge,
not the compressed capacity.
Notes:

• Until a data cartridge is loaded into, threaded, and then unloaded from
a drive for the first time, its remaining capacity and maximum capacity
report as “0”.

• The remaining capacity and maximum capacity for a cartridge are
displayed as GB or TB.

• This report is not available for non-MLM-enabled cartridges.

Load Count The load count for each MLM-enabled data cartridge in the selected
location and the born on date (the date on which Spectra Logic enabled
the cartridge to support MLM tracking and reporting).
Note: This report is not available for non-MLM-enabled cartridges.

Write Errors The number of soft errors and the load count for each MLM-enabled data
cartridge.
Note: This report is not available for non-MLM-enabled cartridges.

Cleans Remaining The number of cleanings remaining and the born on date for each MLM-
enabled cleaning cartridges.
Note: This report is not available for non-MLM-enabled cartridges.

Born on Date The date that the MLM-enabled cartridge (both data and cleaning) was
created and certified by Spectra Logic and the load count for each
cartridge.
Note: This report is not available for non-MLM-enabled cartridges.

Exported Media A list of all the MLM-enabled cartridges (both data and cleaning) that
were exported from the library, sorted by the export time (oldest first).
The report also shows the user name of the person who exported the
media.
Note: This report is not available for non-MLM-enabled cartridges.

Last Write Time
Last Read Time

Shows the time and date for the most recent write and read operations for
each MLM-enabled data cartridge.
Note: This report is not available for non-MLM-enabled cartridges.
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Note:

5. Click Go. The Media Lifecycle Management Report screen refreshes to display the
selected report with a list of the barcode labels for all media in the selected location. A
media health icon indicates the overall health of each MLM-enabled cartridge as of the
last time it was loaded into a drive.

Note: Health icons are not used with LTO media that is not MLM-enabled Spectra Certified media.

Figure 182 Use the health icons on the Media Lifecycle Management Report
screen to quickly assess media health.

The following table describes the meaning of each media health icon. Select the barcode
next to the icon to view detailed information about that specific piece of media.

Icon
Health
score Meaning

100 – 80 The media health is Good.
• Data cartridge: The media is in good condition and operating
properly. The cartridge can be used for writing new data and reading
previously written data.

• Cleaning cartridge: More than 10 cleaning cycles remain on the
cartridge.

79 – 50 The media health is Average.
• Data cartridge: When the Health graph on the Details screen for the
cartridge falls below a health score of 80, the media health icon
changes from green to yellow (generally due to normal aging). For
maximum reliability, only use the cartridge for restores.
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Icon
Health
score Meaning

• Cleaning cartridge: The cleaning cartridge is near expiration. From
one to ten cleaning cycles remain.

49 – 0 The media health is Poor.
• Data cartridge: When the Health graph on the Details screen for the
cartridge falls below a health score of 50, the media health icon
changes to red. The combination of media errors, tape age, and usage
indicates that the media reached the end of its useful life for reliable
data backups and restores and should be retired.

If you are experiencing an unexpected number of cartridges with
poor media health, you may want to investigate further:
• Review the media health data for each cartridge to see if it has a
high error rate. A high error rate can indicate either that the media
health is poor and the cartridge should be retired or that the
cartridge was written to by a drive that is having trouble.

• If multiple cartridges with high error rates were written to by the
same drive, the drive may be the source of the errors. Clean the
drive or, if necessary, replace it.

Notes:

• If the source of the high error rate is a drive, the media health icon
for the affected cartridges should return to either green or yellow
after approximately three load/read or write/unload cycles in a
known good drive.

• If your cartridge has a high error rate that cannot be attributed to a
faulty drive, environmental factors, or the end of the cartridge’s
normal working life, contact Spectra Logic Technical Support for
troubleshooting assistance (see Contacting Spectra Logic on
page 18).

• Cleaning cartridge: The cleaning cartridge is expired. No more
cleaning cycles remain. Replace the cleaning cartridge.

The media health is Unknown. The status of the media cannot be
determined.

6. If you want to view detailed information about a specific cartridge, use one of the
following methods to locate the cartridge.
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To find a
cartridge using
the...

Follow these steps...

Cartridge list Scroll through the list of cartridges on the Media Lifecycle Management
Report screen to locate the desired cartridge.

Barcode label
information

1. Enter the barcode label information for the cartridge you want to
locate in the Find by Barcode field.

2. Click Find. The list of cartridges refreshes to show the requested
cartridge highlighted at the top of the list.

IMPORTANT Only the slots below the top one displayed in the list are searched.
Scroll to the top of the source list before clicking Find. The search starts at
the second visible slot.

3. Click the barcode in the Media Lifecycle Management Report screen to view detailed
information about the cartridge. The Details screen for the selected cartridge displays.
The Details screen displays different information for Spectra Certified media, and non-
certified media

• For Spectra Certified Media, all MLM information for the tape cartridge displays,
including

• A Health graph — Media health is based on the MLM-tracked history of the
cartridge. The health status indicated by the Health graph may fluctuate until the
cartridge is loaded six times.

• Cartridge data — Information about the manufacturing and use of the cartridge such
as: load count, soft errors, cartridge manufacturer and manufacturing date, and
remaining capacity.

• Environmental Statistics — For LTO-9 media or LTO-8 media used in an LTO-9
drive, environmental information for the time the tape was in the drive displays.
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Figure 183 MLM details for Spectra Certified media.

• For media that is not Spectra Certified, only a Health graph displays. Media health is
based on the MLM-tracked history of the cartridge. The health status indicated by the
Health graph may fluctuate until the cartridge is loaded six times.

Additionally, for LTO-9 media or LTO-8 media used in an LTO-9 drive, environmental
information for the time the tape was in the drive displays.

Note: For BlueScale12.8.04.01 and earlier, you cannot get Details for media that is not Spectra
Certified.
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Figure 184 MLM details for non-Spectra Certified media.

4. Click Previous to return to the main Media Lifecycle Management Report screen
(Figure 182 on page 338).

Save an MLM Report

You can choose to save a copy of the MLM report, which is a comma-separated text file (*.rpt),
to a USB device, mail the saved report to previously configured email recipient, or both. If
desired, you can zip the file before saving it.

Note: You can also download the MLM database as a comma-separated-value (CSV) file (see
Download the MLM Database for Analysis and Archival on page 350).

1. Generate the desired report as described in Generate MLM Reports on page 336.

2. If you want to save the MLM report to a USB device, connect the device to a USB port on
the LCM or operator panel and allow time for the device to mount before continuing.

Note: The option to save the report to a USB device is only available if you connect a USB device to
the library before you click Save Report on the Media Lifecycle Management Report screen.

3. Click Save Report to display the Save Media Lifecycle Management Report screen.

Figure 185 Select the desired options on the Save Media
Lifecycle Management Report screen.
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4. Select the data to include in the saved report and how you want the report saved.

Note: If you want to email the report, the intended recipient must be a previously configured mail
user (see Configure Mail Users on page 127).

This option... Saves...

Report All Media
Lifecycle Data

A report containing all of the available detailed MLM data for MLM-
enabled media in the selected location (a specific partition or the total
library).

Note: Depending on the number of cartridges in the selected location, this
report can be quite large.

Report Selected
Data

Only the fields displayed in the report that you selected on the Media
Lifecycle Management Report screen (Figure 182 on page 338).

Note: The headings in the saved report reflect the fields displayed in the report
you selected in the Media Lifecycle Management Report screen.

Zip Report The report as a zip file. Zipping the report is especially useful when
emailing the Report All Media Lifecycle Data report.

Note: If you unzip the report using the standard format used by most file-
zipping applications, the application creates the following directory structure:
*\hard disk\lc\reports.

Mail Report to The report and attaches it to an email sent to a previously configured mail
user. Use the drop-down list to select the recipient for the report file.

Note: Do not use the default autosupport@spectralogic.com email user. Spectra
Logic does not save emailed MLM report files unless they are specifically
requested for troubleshooting.

Save to USB Save the report to the USB device.

Note: The USB option is only available if you connected a USB device to the
library before you clicked Save Report on the Media Lifecycle Management
Report screen.

5. Click Save to send the report to the selected destination. Click Previous to return to the
Media Lifecycle Management Report screen without sending the report.

Override a Poor Cartridge Health Report

Under certain circumstances you may need to override the health of an MLM-enabled
cartridge that is reported as poor (a red health icon appears next to the cartridge barcode).
When the cartridge health is poor, a green arrow button, that can be used to override the
reported health, displays.
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During the override process, the library progressively eliminates any recent hard errors from
the tape health calculation. If the health is still red, all hard errors are eliminated from the tape
health calculation. The library continues to use this adjusted tape health until the cartridge
health returns to either Good or Average as part of the normal health monitoring.

IMPORTANT
Do not reset the cartridge health unless you believe that the reported poor
health is due to drive problems and not the cartridge or you are specifically
directed to do so by Spectra Logic Technical Support.

Use the following steps to reset the health of a single cartridge.

1. Display the Media Lifecycle Reports screen as described in Generate MLM Reports on
page 336.

2. Locate the barcode of the cartridge for which you need to reset the health (see Step 3 on
page 340).

3. Click the green arrow button for the cartridge. The library adjusts parameters used to
calculate the tape health until the reported health is Average.

Figure 186 Click the green override button to reset the reported health for
an MLM-enabled LTO cartridge.

4. Attempt to resolve the issues that were causing the media health to be reported as poor.
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MANAGING THE MLM DATABASE

The MLM database contains the usage history, health, and the verification data for all of the
MLM-enabled cartridges in your library. It also contains the Drive Lifecycle Management data
for all of the drives in your library (see Monitoring Drive Health Using DLM on page 354).

Deciding when and how often you back up the MLM database depends on many factors,
including how often tapes are loaded into a drive.

• If all of the tapes are loaded into drives frequently, the MLM database can be rebuilt
relatively quickly. The database can be backed up less frequently.

• If many of the tapes remain in the library without being loaded into a drive for a long
period of time, or if tapes are exported and stay outside of the library for a long period of
time, rebuilding the MLM database can take a long time. Back up the MLM database more
frequently.

Back Up the MLM and DLM Databases

Based on your environment, determine how frequently backups are needed, then use the
following steps to create a backup. You can choose to save the backup to a USB device or send
it as an email attachment to a previously configured mail recipient.

1. Use your storage management software to stop all backup or restore operations on the
library.

IMPORTANT Backing up the MLM and DLM databases requires the library to be idle.

2. Log into the library as a user with superuser or administrator privileges.

3. If you want to backup the MLM database to a USB device, connect the device to the
library and allow time for the device to mount before continuing.

4. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

5. Select Utilities. The Utilities screen displays.

6. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

7. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

8. Scroll down and select Save MLM Database. The screen refreshes to show the details for
the utility.
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Figure 187 Select the Save MLM Database utility.

9. Use the Select the Destination drop-down list to select the destination for the saved file.

Notes: l To send the file to someone who is not already listed as a library mail user, you must
first configure that person as an email recipient as described in Configure Mail Users on
page 127.

l The check box options at the top of the screen only relate to the system messages
indicating that the utility completed successfully (or failed). They do not relate to the
MLM database file itself.

Select this
option... To...

Save MLM
Database to USB

Backup the MLM database to a USB device.

Mail MLM
Database to...

Send the MLM database file as an email attachment to the specified mail
recipient.

Note: Do not use the default autosupport@spectralogic.com email recipient.
Spectra Logic does not save emailed files unless they are specifically requested
for troubleshooting.

10.If you want to compress the file to make it smaller, select On in the Compress Files?
drop-down list.

11.Click Run Utility.

After a brief delay, the Utility Results screen displays, showing that the database file was
either saved or sent.
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Verify the Database Backup File

After backing up the MLM database, use one of the procedures in the following table to
confirm that the backup file was generated.

If the backup
was... Follow these steps...

Saved to a USB
Device

1. Plug the USB device into a PC. It does not need to be connected to
the library.

2. Examine the list of files on the USB device and locate the
SavedMLMDB folder.

3. Open the folder to verify that it contains one of the following files:

xlminfo<date-time>.db (if you chose not to zip the file)

—OR—

cminfo_<date-time>.zdt (if you chose to zip the file)

where date-time is the time stamp for when the backup was
created.

4. Verify that the file is more than 0 bytes in size.

5. If a file with the correct filename format is present and is more than
0 bytes in size, the database backup was successful and the file is
usable. Store the USB device in a safe location.

6. If the MLM database file is not present or if it is 0 bytes in size,
repeat the backup process (Back Up the MLM and DLM Databases
on page 345) using a different USB device.

Sent as an Email
Attachment

1. Open the email attachment and verify that:

• The attachment contains a zip file called

cminfo_<date-time>.zdt

—AND—

• The file is more than 0 bytes in size.

2. If the zip file is present and is more than 0 bytes in size, the backup
was successful and is usable. Save the email attachment to a safe
location from which you can copy it to a USB device, if needed.

3. If the zip file is not present or if it is 0 bytes in size, repeat the
backup process (Back Up the MLM and DLM Databases on
page 345) to generate the email again.
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Delete MLM Records From the Database

When the maximum number of records for the MLM database is reached, the record for the
least recently exported cartridge, as determined by the Export Date tracked by MLM, is
automatically deleted. The library does not notify you when it reaches the maximum number
of records.

When a tape is retired or permanently exported from the library, you can manually delete its
record from the MLM database. Records can be deleted individually or as a group.

Delete an Individual Record

If you only need to delete one or two cartridges from the MLM database, you can use the
Media Lifecycle Report screen to delete individual records.

1. Log into the library as a user with superuser or administrator privileges.

2. Display the Media Lifecycle Reports screen as described in Generate MLM Reports on
page 336.

3. Locate the barcode of the cartridge you want to remove from the MLM database (see
Step 3 on page 340).

Note: An asterisk (*) next to the barcode indicates that the cartridge was exported from the library.

4. Click the trash can icon next to the barcode to delete the record.

Figure 188 Use the trash can icon to delete individual records from the MLM
database.
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5. Respond to the confirmation message to delete the record.

Delete Multiple Records

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

Figure 189 Click Delete Records on the MLM Tools screen
to begin removing records from the MLM database.

3. Click Delete Records. The Delete MLM Records screen displays.

Figure 190 Select the cartridges to remove from the MLM
database on the Delete MLM Records screen.

4. Select the cartridge records you want to delete from the MLM database.

Note: An asterisk (*) indicates that the cartridge was exported from the library.

5. Click Delete Selected to remove the selected records from the MLM database.

JUNE 2025 349 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 9 - CONFIGURING AND USING MEDIA LIFECYCLE MANAGEMENT



Download the MLM Database for Analysis and Archival

If desired, you can download the MLM database as a comma-separated-value (CSV) file for
analysis and archival. You can then open the file in any software application that supports this
type of file (for example, spreadsheet software) and view the information it contains.

IMPORTANT
The MLM information contained in the CSV file cannot be used to restore the
MLM database. Always maintain a current backup of the MLM database as
described in Back Up the MLM and DLM Databases on page 345.

Note: The MLM Report button is only available when you access the library using the BlueScale
web interface (RLC). It is not available from the operator panel.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

Figure 191 Click MLM Report on the MLM Tools screen.

3. Click MLM Report and use your browsers Open File dialog box to open or save the file.

4. To view the information stored in the MLM database, open the CSV file using a software
program that supports this file type.
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Figure 192 An example of the downloaded MLM database
file (opened in Microsoft Excel).

JUNE 2025 351 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 9 - CONFIGURING AND USING MEDIA LIFECYCLE MANAGEMENT



CHAPTER 10 - USING DRIVE LIFECYCLE
MANAGEMENT
This chapter describes how to use BlueScale Drive Lifecycle Management to proactively
monitor the health of the drives in your library.

BlueScale Drive Lifecycle Management 353
Monitoring Drive Health Using DLM 354

Using the Drive Health Icons 356

Viewing and Saving a Detailed Drive Health Report 357

Downloading the DLM Database 360

JUNE 2025 352 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 10 - USING DRIVE LIFECYCLE MANAGEMENT



BLUESCALE DRIVE LIFECYCLE MANAGEMENT

Overview

BlueScale Drive Lifecycle Management works in conjunction with MLM to help you identify
drives that experience a high number of errors or other problems during operation.

IMPORTANT
The BlueScale Drive Lifecycle Management feature is supported for libraries
with LTO drives and libraries with TS11xx technology drives that use
BlueScale12.6.3 and later.

Each time a cartridge is unloaded from a drive, the library collects the media health data from
the drive. This data includes read/write errors, tape alerts, and flags generated during the time
the most recent cartridge was loaded in the drive. It also includes the current value for the
drive’s single character display (SCD) and any errors detected at the time the cartridge is
unloaded. All of this data, plus the MLM data for the 50 most recently loaded cartridges, is
stored in the DLM database. This data is used to generate an overall drive health status for the
library, as well as health reports for each individual drive.

Enabling DLM

BlueScale Drive Lifecycle Management (DLM) is automatically enabled when Media Lifecycle
Management (MLM) is enabled and cannot be used without MLM. See Configuring and Using
Media Lifecycle Management on page 301 for detailed information about enabling and using
MLM.

Drive Health Reports

A health icon next to each drive indicates the overall health of the drive. Detailed reports
provide information about the cartridges that have been loaded into the drive and any errors
reported. The DLM database containing the health information for every drive in the library is
backed up whenever the MLM database is backed up. The reports can also be saved and
exported as XML files.

Drive Testing

If a drive is experiencing problems, the DLM drive test wizard lets you test the basic
functionality of the drive. This test, when used in conjunction with other DLM data and MLM
data, can help you determine whether a drive or the media is the source of the errors you are
investigating.

User Privilege Requirements

Only a user with superuser or administrator privileges can access and use the DLM features.
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MONITORING DRIVE HEALTH USING DLM
When DLM is enabled, the Drives icon in the Configuration toolbar changes to the DLM icon.
Selecting DLM from the toolbar displays the Drives screen, which uses health icons to provide
at-a-glance information about the health of each drive in the library. From the Drives screen
you can access detailed drive health reports for each drive in the library, as well as drive
management tools.

Figure 193 Enabling DLM changes the Drive icon in the
Configuration toolbar.

Each button on the Drives screen lets you perform additional operations.

This button... Lets you...

Go Change whether to display the physical frame number, or the logical
frame number, in the drive component identifier.
• If you select physical frames for the Display Option, FRx is the number
of the frame from left to right when viewed from the front of the library.
This is the default display option and the way that drive locations are
displayed on all other screens.

• If you select logical frames for the Display Option, the library main
frame is configured as FR1, and FRx increments for each additional
drive frame added, no matter its location. The drive frames are not
numbered left to right but are instead numbered based on switch
settings in the frame. FR2 may be to the right of the main frame and FR3
to the left.

Drive Traces Collect drive traces for LTO-5 and later generation drives (see Use the
Drive Traces Button on page 438).
Note: The Drive Traces button is not supported for TS11xx technology drives.

JUNE 2025 354 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 10 - USING DRIVE LIFECYCLE MANAGEMENT



This button... Lets you...

Drive
Performance
Monitoring

Display the drive performance statistics screen (see View Drive
Performance Statistics on page 170).

Note: The Drive Performance Monitoring button only displayed if Drive
Performance Monitoring is enabled (see Enable Drive Performance Monitoring
on page 119).

Drive Firmware
Update

Use one or more firmware update (code load) tapes stored in the
partition’s entry/exit pool to update the firmware for selected drives (see
Updating Drive Firmware on page 506).

Note: This button is replaced by Staged Drive Firmware Update if a drive
firmware update is staged to one or more drives.

Staged Drive
Firmware Update

Apply an update that is already staged to the drive (see Apply the Update
on page 520) using one of the following methods:

• Autostaging (see Modify Auto Download Options on page 145)
• Manual staging (see Using Drive Update through Package Update on
page 513).

Note: This button only displays if a drive update is staged to the drives.

Remove
Replace
Add

Remove or replace a drive that is already in the library. If a DBA has an
empty drive bay, the Add button powers on a newly installed drive and
initializes it in the library (see Adding or Replacing a Drive on page 531).

Notes:

• These buttons only display on the front panel.
• The Add button only displays if a DBA location does not contain a drive.

Clean Clean the drive using a cleaning tape in an associated cleaning partition.
See Manually Cleaning a Drive on page 502.

Note: The Clean button only displays if the partition to which the drive is
assigned has an associated cleaning partition.

Detail View detailed information about the selected drive (see Viewing and
Saving a Detailed Drive Health Report on page 357).

Test Use the DLM Drive Test wizard to test a drive (see Using DLM to Test a
Drive on page 462).

Reset Reset the drive, which power cycles the drive, runs the internal drive
diagnostics, and reinitializes it in the library (see Resetting a Drive on
page 431).
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Using the Drive Health Icons

The drive health icons provide at-a-glance health status for the drives in the library. The icons
appear on the following screens, as well as in the drive health reports (see Viewing and Saving
a Detailed Drive Health Report on the next page).

The health icon on this screen... Indicates...

General Status The overall drive health for
the selected partition.

Note: The drive health icon
on the General Status screen
reflects the lowest health
score for the drives in the
partition being viewed.

Drives The overall health of each
individual drive in the
library.

Drive Details The health of the selected
drive.

The drive health icon state is based on data collected for the drive when the last cartridge was
loaded in the drive. This data consists of the code presented on the drive’s SCD or MCD, as
well as tape alerts, and errors detected at the time the tape is unloaded. See Interpreting the
SCD and MCD Codes on page 447 for detailed information about the SCD and MCD codes.
The following table describes the drive health status icons.
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Note: Not all SCD and MCD codes have an associated DLM icon.

Icon Meaning

The drive health is Good.

The drive is operating normally.

The drive requires Attention.

Use the SCD or MCD code information on the Drive Details screen
to determine the type of action required. See Interpreting the SCD
and MCD Codes on page 447 to determine what action is needed to
address the condition.

The drive health is Poor.

The drive has experienced an unrecoverable error or problem. Use
the SCD or MCD code information on the Drive Details screen to
determine the type of action required. See Interpreting the SCD and
MCD Codes on page 447 to determine what action is needed to
address the condition.

The drive health is Unknown. The status of the drive cannot be
determined.

Viewing and Saving a Detailed Drive Health Report

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > DLM to display the Drives screen.

Figure 194 Click Detail to view detailed information about
a drive.

3. Click Detail next to the drive for which you want to view more information. The Drive
Details screen displays.
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Figure 195 The Drive Details screen shows detailed
information about the selected drive.

4. Click DLM on the Drive Details screen to view a detailed Drive Lifecycle Management
report.

Note: The DLM button on the Drive Details is not present if MLM and DLM are not enabled (see
Enable and Configure MLM PreScan and PostScan on page 210).

The Drive Lifecycle Management Report screen is divided into four panes, which are
described in the following table.

This pane... Shows...

Drive health
overview

The drive identifier and any status information. The drive health icon
indicates the drive’s overall health at the time the screen was displayed.

Summary of tapes The barcode label information and health information for the last
10 cartridges loaded into the drive. The health icon indicates the cartridge
health at the time the cartridge was unloaded from the drive (Tape Health
at Unmount) and the current health status stored in the MLM database
(Current Tape Health). Refer to the table on on page 338 of Configuring
and Using Media Lifecycle Management on page 301 for descriptions of
the icons related to media health.

Note: Depending on the drive’s history, this pane may not have any entries.
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This pane... Shows...

History of tapes Detailed information about the last 50 cartridges loaded into the drive as
well as any Tape Alerts and SCD or MCD codes posted by the drive while
the tape was loaded in the drive.

Notes:

• Depending on the usage history for the drive, this pane may not have
any entries.

• For detailed information about Tape Alerts, log on to the portal (see
Accessing the Technical Support Portal on page 534), open the
Knowledge Base, and search for KBA-01769, What do the tape alert flags in
the DLM pages mean?. Refer to the tape drive documentation for
additional information

5. To save the information on the Drive Lifecycle Management screen, use the Save MLM
Database utility as described in Back Up the MLM and DLM Databases on page 345.

6. If you have corrected a condition that changed the drive’s health to yellow or red, click
Reset Health to reset the drive health to Good (Green). Click Continue to complete the
reset health process.

Notes: l If the condition was not truly corrected, the next tape load sets the drive health back to
the previous indication.

l Resetting the drive health deletes the drive’s Summary of Tapes and History of Tapes
data.
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DOWNLOADING THE DLM DATABASE

If desired, you can open and save the DLM database as an XML file. This file contains the
same information that appears on the Drive Lifecycle Management screen (see Step 4 on
page 358).

IMPORTANT

The DLM database information in the XML file cannot be used to restore the
DLM database. The information required to restore the DLM database is
backed up with the MLM database. See Back Up the MLM and DLM Databases
on page 345 for information about backing up the MLM database.

Note: The DLM Report button is only available when you access the library using the BlueScale web
interface (RLC). It is not available from the operator panel.

1. Log into the BlueScale web interface (RLC) as a user with superuser or administrator
privileges.

2. From the toolbar menu, select Maintenance > Media Lifecycle Management. The Media
Lifecycle Management Tools screen displays.

Figure 196 Click DLM Report on the Media Lifecycle
Management Tools screen to export the DLM database as
an XML file.

3. Click DLM Report. The XML file opens in the application associated with that file type on
the computer accessing the library’s BlueScale web interface.

Note: Typically, the application associated with XML files is a web browser. Depending on the
browser, the file may open in a new browser window.
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Figure 197 The DLM database XML file opened in a web
browser.

4. Use the File > Save option in the application that opened the XML file to save it to a
known location on your computer.

5. You can open the saved XML file using Microsoft Excel 2007 or later, or use another
program that supports the XML file format.
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CHAPTER 11 - CONFIGURING AND USING
AUTOSUPPORT
This chapter describes how to configure and use AutoSupport with your library. All
AutoSupport functionality is included with your library purchase.

AutoSupport Overview 363
Configuring AutoSupport 366

Configure Mail Recipients 366

Configure AutoSupport Profiles 366

Configure Alarms 371

Configure Log Set Forwarding 372

Using AutoSupport 374
Create New Support Tickets 374

Update Existing Support Tickets 378
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AUTOSUPPORT OVERVIEW

AutoSupport configures the library to automatically notify support personnel or others with
messages or when specific events occur. It can also be used to open or update a support ticket
and send it to a specified recipient or to Spectra Logic Technical Support. AutoSupport can be
used without configuring the library with email access by saving the ASL sets generated by
AutoSupport to a USB device and then manually sending an email containing the stored
information to Spectra Logic Technical Support.

Note: AutoSupport Log (ASL) information is only for troubleshooting purposes. This log information
is separate from the data path and contains no customer data.

Send Log Sets

This feature lets you manually generate a standard AutoSupport Log (ASL) set (file) and email
it to a pre-configured recipient or save it to a USB device. You can use the Send Log Sets
option to open or update a support ticket and send it to a specified recipient or to Spectra
Logic Technical Support. The ASL included in the support ticket includes the following types
of information:

• Library message logs

• Library Control Module (LCM) logs

• LCM configuration (including the current physical configuration)

• A simplified report of the MLM and DLM databases

• EC data from all components

• BlueScale version

• Contact information for data center staff

• Other library information specified in the AutoSupport user profile

Log Forwarding

This feature configures the library to send monthly ASL files to preconfigured recipients (see
Configure Log Set Forwarding on page 372).

Critical Alarms

When you enable critical alarms, the library automatically generates an ASL file whenever any
of the events in the following table occurs. If you configured one of your AutoSupport profiles
as the AutoSend Profile (see Step 4 on page 368), the library automatically sends the ASL file
to the mail recipients in the AutoSend profile.
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Note: If you select autosupport@spectralogic.com as a mail recipient in the AutoSend profile, the
library also sends the ASL file and a ticket request to Spectra Logic Technical Support.

For this event... An AutoSupport ticket request is generated...

Motion Restart Whenever motion restarts. Each motion restart is treated as a separate
event and results in generation and submission of an AutoSupport ticket
request.

Front or Side
Panel Opened or
Removed

If a library side panel or front panel is opened or removed three times
within thirty minutes. Only one AutoSupport ticket request is generated
for each 30-minute time period.

Power Supply
Failure

When a power supply fails. Each power supply is evaluated separately. Only
one AutoSupport ticket request per power supply is generated for each
24-hour time period, even if the power supply fails and then resumes
operation repeatedly. If two power supplies fail during the same 24-hour time
period, two separate AutoSupport ticket requests are generated, one per failed
power supply.

RIM Failure Whenever the library detects that a RIM is no longer present. Only RIMs that
are configured as part of a partition will generate an AutoSupport ticket
request.

The following problems can generate a RIM failure event:

• Failure of the RIM software or hardware.
• Loss of communication between the library and the RIM.
• Removal of a RIM from the library without using the BlueScale
Controller Remove or Controller Replace operation.

AutoSupport ticket requests are not generated if the RIM is removed
following a Controller Remove or a Controller Replace operation.

Each RIM is evaluated separately. Only one AutoSupport ticket request per
RIM is generated for each 24-hour time period, even if the RIM fails and then
resumes operation repeatedly. If two RIMs fail during the same 24-hour time
period, two separate AutoSupport ticket requests are generated, one per failed
RIM.

Drive Failure When the library detects a drive failure that results in the percentage of
failed drives in a partition meeting or exceeding the specified threshold
(see Configure Alarms on page 371).

The following drive problems can generate a drive failure event:

• Failure of the drive software or hardware.
• Loss of communication between the library and the drive.
• Removal of a drive from the library without using the BlueScale Drive
Remove or Drive Replace operation.
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For this event... An AutoSupport ticket request is generated...

AutoSupport ticket requests are not generated if the drive is removed
following a Drive Remove or a Drive Replace operation.

Library Controller
Fails to Initialize

If the library controller (LC) fails to properly initialize.
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CONFIGURING AUTOSUPPORT

If you have any questions about configuring AutoSupport, contact Spectra Logic Technical
Support (see Contacting Spectra Logic on page 18).

Note: To simplify entering the information required to configure and use AutoSupport, use the
BlueScale web interface or a keyboard attached to the LCM.

Network and Support Contract Requirements

Before you configure AutoSupport, Spectra Logic recommends connecting the library to an
email gateway. You will need to do the following:

• Connect an Ethernet cable to the Ethernet connector on the LCM (see Figure 10 on page 49).

• Obtain the library’s IP address, subnet, and gateway address (see Configure Network
Settings on page 124).

User Privilege Requirements

Only a user with superuser or administrator privileges can configure the AutoSupport
features.

Configure Mail Recipients

If not already completed, configure one or more mail recipients who should receive
AutoSupport information (see Configure Mail Users on page 127). At a minimum, configure
Spectra Logic Technical Support (autosupport@spectralogic.com) as a mail recipient if you want
to automatically send AutoSupport ticket requests to Spectra Logic Technical Support. If
desired, you can configure additional recipients.

Notes: l The default autosupport@spectralogic.com mail recipient can be used for any ASL or
HHM files that are generated by the library. This includes those generated manually, or
automatically in response to critical events or log forwarding.

l Do not configure the autosupport@spectralogic.com mail recipient to receive messages
that result from configuration changes or system messages generated by the library.

l AutoSupport can be used without email access by saving the information generated
by AutoSupport to a USB device and then manually sending the stored information to
Spectra Logic Technical Support.

Configure AutoSupport Profiles

Use the following steps to create or modify a profile for each person assigned to work with
Spectra Logic Technical Support to troubleshoot problems with the library or drives.

1. Log into the library as a user with superuser or administrator privileges.
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2. If not already completed, configure the mail recipients who should receive AutoSupport
information (see Configure Mail Recipients above).

3. From the toolbar menu, select Maintenance > AutoSupport. The AutoSupport screen
displays.

Note: If you have not yet configured an AutoSupport profile, the Send Log Set button is
unavailable. If you have not configured a profile for AutoSend, the Configure Alarms button
is unavailable.

Figure 198 Click Manage Profiles to create or edit an
AutoSupport profile.

4. Click Manage Profiles. The AutoSupport Profiles screen displays.

Figure 199 Use the AutoSupport Profiles screen to manage
profiles.

Create or Modify a Profile

1. Click New Profile to create a new profile or click Edit Profile to modify an existing
profile. The Company Information screen displays.
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Figure 200 Enter required information for your company.

• Complete the information in this screen. The information marked with an asterisk (*) is
required.

Note: Make sure to fill in all of the required fields in each of the following screens. You cannot
advance to the next screen if required information is missing.

• The Customer/Contract Number is no longer used. Enter any six alpha-numeric
characters.

2. Click Next. The Contact Information screen displays.

Figure 201 Enter the required information for the contact
person.

3. Enter the information for your contact person in the fields provided. This information
determines how Spectra Logic contacts this person.

4. Click Next. The System and Mail Information screen displays.
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Figure 202 Enter information about your operating
environment.

• Enter information about your library’s operating environment and storage management
software in the fields provided.

• Select AutoSend Profile to use the current profile as the recipient for critical alarm log
sets automatically sent by the library.

Note: Only one profile can be configured as the AutoSend profile.

• Select the mail recipient(s) from the Mail To choices presented. Only mail recipients that
have previously been configured are listed (see Configure Mail Users on page 127).

Note: You must select autosupport@spectralogic.com as one of the recipients if you want the library
to send an AutoSupport ticket request to Spectra Logic Technical Support.

5. Click Next. The Save Profile screen displays. Verify that all of the information shown is
correct.

If any information needs to be changed, click Previous to display the screen in which the
changes need to be made.
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Figure 203 Review the profile information.

6. When all of the information is correct, click Save.

7. The AutoSupport Profiles screen redisplays, listing the newly completed profile.

Figure 204 All of the AutoSupport profiles are listed on
the AutoSupport Profiles screen.

8. Repeat Step 1 through Step 6 if you want to create additional profiles.

Note: When you create multiple profiles, they are listed in the order in which they are created, not in
alphanumeric order.

9. Click Previous to return to the main AutoSupport screen.

If one of the profiles is configured as an AutoSend recipient, the Configure Alarms
button is active (see Figure 198 on page 367).
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Delete an AutoSupport Profile

Use the following steps to delete an existing profile.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > AutoSupport. The AutoSupport screen
displays (see Figure 198 on page 367).

3. Click Manage Profiles. The AutoSupport Profiles screen displays (see Figure 204 on
page 370).

4. Click Remove next to the contact you want to delete. The Remove Profiles screen
displays, asking you to confirm the deletion.

5. Click Remove. The AutoSupport profiles screen redisplays with the updated list of
profiles.

6. Click Previous to return to the main AutoSupport screen.

Configure Alarms

Use the steps in this section if you want the library to automatically generate an ASL file in
the event that any of the critical events listed under Critical Alarms on page 363 occurs.

1. If you have not already done so, configure one AutoSupport profile as the AutoSend
recipient (see Step 4 on page 368).

2. Click Configure Alarms from the AutoSupport screen. The AutoSupport Critical Alarm
Configuration screen displays.

Figure 205 The AutoSupport Critical Alarm Configuration
screen.
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3. Select Enable Critical AutoSupport Alarms. When enabled, the library generates an ASL
file whenever one of the critical events listed under Critical Alarms on page 363 occurs.
Any ASL file that is generated as a result of a critical event is automatically sent to all of
the recipients selected in the AutoSend profile.

Note: The autosupport@spectralogic.com address must be selected as a mail recipient in the
AutoSend profile if you want the library to send critical event ASL files to Spectra Logic
Technical Support.

4. If desired, select a value for the Partition Drive Failure Threshold from the drop-down
list. This is the only configurable critical event.

You can specify the threshold for the number of failed drives in a partition that will
cause an AutoSupport ticket request to be generated. The threshold is a percentage of
drives assigned to the partition. You can select 25% or 50%; the default is 50%. The
threshold applies to all partitions in the library.

5. Click Save to save your changes or click Previous to return to the main AutoSupport
screen without saving your changes.

After your changes are saved, the AutoSupport Critical Alarm Configuration screen
redisplays with a confirmation message.

6. Click Previous to return to the main AutoSupport screen.

Configure Log Set Forwarding

Log forwarding is enabled by default from the factory. This is a monthly log set that is
forwarded to Spectra Logic for data collection. No action is taken by Spectra Logic Technical
Support for a particular library when the log set is received, but the data is parsed and stored
in our database to better understand our field population and how the library is used and how
it can be improved.

Use the following steps to modify log set forwarding.

1. Click Log Forwarding from the main AutoSupport screen. The Configure Log
Forwarding screen displays.

JUNE 2025 372 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 11 - CONFIGURING AND USING AUTOSUPPORT



Figure 206 The Configure Log Forwarding screen.

2. Select the forwarding options you want to use.

• Allow BlueScale to automatically send log sets is selected by default. Clear the check
box if you do not want the library to automatically generate and submit monthly Auto
Support Log sets to one or more preconfigured recipients.

• The autosupport@spectralogic.com mail recipient is automatically selected. All ASL files
generated by the library are automatically sent to Spectra Logic Technical Support.

• Select any additional mail recipient(s) from the Mail To choices presented. Only mail
recipients that have previously been configured are listed (see Configure Mail Users on
page 127).

3. Click Save.

After your changes are saved, the Configure Log Forwarding screen redisplays with a
confirmation message.

4. Click Previous to return to the main AutoSupport screen.
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USING AUTOSUPPORT

This section covers the following aspects of using AutoSupport:

• Create New Support Tickets

• Update Existing Support Tickets on page 378

User Privilege Requirements

Only a user with superuser or administrator privileges can open and modify support tickets
using AutoSupport.

Create New Support Tickets

Notes: l If autosupport@spectralogic.com is included in the Mail To: field for the autosupport
profile used to submit a ticket, then Spectra Logic immediately sends a confirmation
email to the email address listed in the autosupport profile used to submit the ticket,
and a support person will contact the person submitting the ticket during normal
service contract hours.

l If it is during your service contract hours and the problems requires immediate
attention, call Spectra Logic Technical Support after submitting the AutoSupport ticket
(see Contacting Spectra Logic on page 18).

l Go to Spectra Logic’s website at: support.spectralogic.com/services-and-
contracts/support-offerings-warranty-info/ for information about the warranty and
service options for your library.

Follow these steps to open a new ticket with Spectra Logic Technical Support.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > AutoSupport. The main AutoSupport
screen displays.

Figure 207 The main AutoSupport screen.
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3. If you want to save the AutoSupport ticket information to a USB device, insert the device
into a port on the LCM or operator panel and allow time for the device to mount before
proceeding (see Figure 10 on page 49).

Note: The option to save the ticket to a USB device is only available if you connect a USB device in
before you click Send Log Set.

4. Click Send Log Set. The Select Profile To Send Log Set screen displays.

Figure 208 AutoSupport Profiles screen.

5. Click Select next to the profile for the main contact person for the issue. The Select Ticket
Type screen displays.

Figure 209 The Select Ticket Type screen.

• If you are sending additional information about an existing support ticket, select Use
existing support ticket and enter the ticket number in the Number field. See Update
Existing Support Tickets on page 378 for additional information.

• If this is a new ticket, select Create new support ticket. This option is selected by
default.
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Note: The Create new Hardware Health Monitor ticket option is not available when you use the
Send Log Set option to send an AutoSupport ticket. This option is only used to send HHM
data in response to a maintenance notification (see Respond to HHM Notifications on
page 395).

6. If you do not need to make any changes to the contact person’s information for this
support ticket, proceed to Step 7.

• If you need to temporarily change the contact person’s information for this ticket, click
Profile Data. The Profile Summary screen displays.

Make any necessary changes in the Profile Summary screen, then click Use Settings. The
Select Ticket Type screen redisplays.

Figure 210 The Profile Summary screen.

• Click Cancel to return to the Select Ticket Type screen without making any changes to
the contact person’s information.

7. In the Select Ticket Type screen (Figure 209 on page 375), type a detailed description of
the issue in the Problem Description field, including what happened just before the
failure occurred.
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Note: Supplying a detailed problem description will help support personnel to address the issue
more quickly and efficiently.

8. Click Next. The Confirm and Submit Ticket screen displays.

Figure 211 The Confirm and Submit Ticket screen.

9. Verify that all information is correct.

If... Then...

The library is not connected
to a network with an SMTP
server,

Select the check box at the top of the screen (shown in
Figure 211 on page 377) to save the ticket information to a USB
device instead of emailing it from the library.

Notes:

• The option to save the ticket to a USB device is only available
if you connected a USB device before you clicked Send Log
Set to begin the ticket process.

• After saving the ticket information to the USB device, you can
upload it to the Technical Support portal (see Accessing the
Technical Support Portal on page 534).

All of the information is
correct,

Click Submit. A progress screen indicates that the ticket request
(with log information) is being sent. When completed, the
AutoSupport Profiles screen displays.

When Spectra Logic receives the request, a ticket is opened and
an email response is sent to the user with a ticket number.

You need to change the
problem description,

1. Click Previous to return to the Select Ticket Type screen.

2. Modify the problem description as required.
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If... Then...

3. Click Next to return to the Confirm and Submit Ticket
screen.

You need to change the
contact person’s
information,

1. Click Previous to return to the Select Ticket Type screen.

2. Click Profile Data on the Select Ticket Type screen to
display the Profile Summary screen.

3. Make any necessary changes in the Profile Summary
screen.

4. Click Use Settings. The Select Ticket Type screen
reappears

5. Retype the problem description.

6. Click Next to return to the Confirm and Submit Ticket
screen.

Update Existing Support Tickets

Follow these steps to update a ticket that you have already opened with Spectra Logic
Technical Support. Updating a ticket is particularly useful for mailing new logs to Technical
Support.

Note: You must have the reference number for the existing ticket—which you receive when you
open the ticket—and the information you are sending must be related to that ticket.

If you have a new issue with your library, open a new ticket to address that issue separately.

1. If you plan to save the ticket information to a USB device, insert the device into a USB
port on the LCM (see Figure 10 on page 49) or operator panel and allow time for the
device to mount before continuing.

2. Follow the instructions in steps 1 through 5 in Create New Support Tickets on page 374
to reach the Select Ticket Type screen (see Figure 209 on page 375).

3. If you do not need to make any changes to the contact person’s information for this
ticket, proceed to Step 5.

If you need to temporarily change any of the contact person’s information, click Profile
Data. The Profile Summary screen displays (see Figure 210 on page 376).

4. Make any necessary changes in the Profile Summary screen, then click Use Settings. The
Select Ticket Type screen redisplays.

5. Select Use existing support ticket.

6. Type the six-digit ticket number in the Number field. You received this number when
you originally opened the ticket.
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7. Add any updated information in the Problem Description field.

8. Click Next. The Confirm and Submit Ticket screen displays (see Figure 211 on page 377).

9. Verify that all information is correct. If all of the information is correct, proceed to Step
10. If something needs to be changed, click Previous and make the necessary changes.

10.To save the ticket information to a USB device instead of emailing from the library, select
the check box at the top of the screen (shown in Figure 211 on page 377).

Note: The option to save the ticket to a USB device is only available if you connected a USB device
before you clicked Send Log Set to begin updating the ticket.

11.Click Submit. A progress screen indicates that the ticket request (with log information) is
being sent. When completed, the AutoSupport Profiles screen displays. When Spectra
Logic receives the request, the ticket is updated and an email response is sent to the user
with a ticket number.
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CHAPTER 12 - LIBRARY TROUBLESHOOTING
This chapter describes troubleshooting steps you can take, as appropriate, to help resolve
problems you might encounter while operating the library. Try these troubleshooting
procedures before you open a support ticket with Spectra Logic Technical Support. If you are
unable to resolve the problem yourself, open a support ticket (see Opening a Support Ticket
on page 536).

Troubleshooting Library Problems 381
Troubleshooting Library Initialization Issues 382
Troubleshooting BlueScale User Interface Issues 383
Troubleshooting MLM Issues 387
Troubleshooting Encryption Issues 388
Resolving Operational Issues 390
Interpreting External Lights 394
Using BlueScale Hardware Health Monitoring 395

Respond to HHM Notifications 395

View Hardware Health Monitoring (HHM) Data 399

Capturing Traces 401
HPT Self Test 404
Resetting the Library 406
Resetting Components 407

Reset the Power Control Module 407

Reset the LCM or RCM 407

Reset a RIM 408

Discovering and Setting the BlueScale Vision Camera IP Address 410
Configure the BlueScale Vision Camera - White 410

Configure the BlueScale Vision Camera - Black 415

Restoring the Library Configuration 420
Restore From an Auto Configuration Save File 420

Restore the Library Configuration Using a Saved Configuration 425

Restore the MLM and DLM Databases 427
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TROUBLESHOOTING LIBRARY PROBLEMS

If you have a problem with your library, use the information in this section to obtain help
with resolving the problem.

Check... To...

System
Messages

Review any System Messages that have been posted by the library (see Check
and Respond to Messages on page 167) and take any action described in the
message(s).

Error Sense
Codes

Look up the definition of an error sense code referenced in a system
message using the Spectra Tape Libraries SCSI Developer Guide

Library BlueScale
Software Version

Confirm that your library is at the latest released version of BlueScale
software (see Check the Library BlueScale Software Version on page 472).
Some problems with library components may be fixed by updating the
component firmware if the library is using a downlevel BlueScale version.

Technical Support
Portal

Find information about the most current version of BlueScale software and
additional service and support tools. You can access the Technical Support portal
at support.spectralogic.com.
Note: Accessing many of the tools available on the Technical Support portal
requires creating a user account. See Accessing the Technical Support Portal on
page 534 for instructions.

• Check the options under the Documentation and Knowledge Base
menus for additional troubleshooting information.

• Check the Service & Contracts menu to view information about the
warranty and service options available for your library as well as the
Spectra Certified Media warranty.
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TROUBLESHOOTING LIBRARY INITIALIZATION ISSUES

This section provides information about potential library initialization issues that you may
experience.

Issue Resolution

Library hangs
while gathering
initialization
tasks

The library gathers tasks at the beginning of the library initialization
process, and displays this as its first task on the Library Initialization
screen. If the library is unable to gather the required initialization tasks
within a few minutes of powering on, contact Spectra Logic technical
support for assistance (see Contacting Spectra Logic on page 18).

Library hangs
during
initialization

If the library cannot complete the initialization process, it will generate
system messages and enter maintenance mode. Contact Spectra Logic
technical support for assistance (see Contacting Spectra Logic on page 18).
Do not power off the library.
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TROUBLESHOOTING BLUESCALE USER INTERFACE ISSUES

This section provides information about potential issues that you may experience while using
the library’s BlueScale user interface, either from the operator panel or through the web
interface (RLC).

Issue Resolution

BlueScale screens
exhibit display
problems

Occasionally, the BlueScale interface may exhibit display problems (for
example, one screen displays on top of another or there are multiple
toolbars), either in the operator panel user interface or through the web
interface.

Click the refresh display button ( ) on the status bar to refresh the
screen.

IMPORTANT If you have a keyboard connected to the LCM or if you are
accessing the library through the BlueScale web interface, do not use the
keyboard to refresh the screen (for example, by pressing F5). Doing so may
cause unpredictable results.

Cannot access the
library using the
BlueScale web
interface (RLC)

• Make sure that the library is connected to the network via an Ethernet
cable connected to the LCM. For a library with BlueScale12.4.1 or later,
make sure that the Ethernet cable for web access is connected to the left-
most Ethernet port. The right-most Ethernet port on the LCM is a
dedicated EtherLib port. (see Figure 10 on page 49).

• Make sure that the web server port is correctly configured for your
environment (see Web Server Port on page 118).

• Make sure that an IP address is configured for the library (see
Configure Network Settings on page 124).

• If SSL is enabled for the library, make sure that you enter the IP address
using the form:
https://[library IP address].
See Connecting to the library remotely using the BlueScale web interface
on page 99 for additional information.

• Reset the LCM to make sure that the Ethernet port is not hung (see
Reset the LCM or RCM on page 407).

Cannot change a
configuration
setting

Before attempting to change configuration settings:

• Recommended Make sure that the drives in the partition are empty.
• Make sure that the host is not communicating with the library.
• Make sure that no background processes are running (for example,
Media Auto Discovery, PreScan, or PostScan). If a background process
is running, the library displays a message indicating what it is.
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Issue Resolution

• If the background process is Media Auto Discovery, PreScan, or
PostScan and you cannot wait for the process to complete, you can
stop or pause the operation (Stop the Discovery Process on page 324
and Pause the PostScan Process on page 334).

• For all other background processes, wait until the process is
completed and then retry the configuration change.

Cannot create a
new storage
partition

Make sure that you have:

• An active SLS key to support multiple partitions entered in the Option
Enablement panel of the System Settings screen (see Standard and
upgraded options for the library on page 112).

• Unassigned licensed chambers available for use in the new partition. If
necessary, modify an existing partition to make chambers available (see
Modifying an Existing Partition on page 232), license additional
chambers with a CoD capacity key (see Capacity-On-Demand (CoD) on
page 565), or purchase a new frame (see Hardware Expansion and
Upgrades on page 565).

• One or more drives available for use in the new partition. If necessary,
modify an existing partition to make one or more drives available or
install additional drives.

• Fewer than sixteen storage partitions configured.
Notes:

• Libraries running BlueScale software versions earlier than
BlueScale12.6.3 are limited to eight storage partitions.

• With BlueScale12.7.00 to BlueScale 12.8.01.04, the maximum number
of physical exporting devices (RIMs) supported by the library is six.

• With BlueScale12.8.07 and later, the library supports 12 RIM
exporters and 48 drive exporters.

• A single RIM can export up to eight partitions, but still only count as
one exporter; a single RIM2 can export up to 16 partitions, but still
only count as one exporter.

• If the library contains RIMs in excess of the maximum number of
exporters, the additional RIMs can be used for failover (see
Controller Failover on page 80).

• Make sure that no background processes are running (for example,
Media Auto Discovery, PreScan, or PostScan). If a background process
is running, the library displays a message indicating what it is.
• If the background process is Media Auto Discovery, PreScan, or
PostScan and you cannot wait for the process to complete, you can
stop or pause the operation (Stop the Discovery Process on page 324
and Pause the PostScan Process on page 334).
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Issue Resolution

• For all other background processes, wait until the process is
completed and then retry the partition creation.

Cannot import or
export cartridges

• Make sure that no background processes are running (for example,
Media Auto Discovery, PreScan, or PostScan). If a background process
is running, the library displays a message indicating what it is.
• If the background process is Media Auto Discovery, PreScan, or
PostScan and you cannot wait for the process to complete, you can
stop or pause the operation (Stop the Discovery Process on page 324
and Pause the PostScan Process on page 334).

• For all other background processes, wait until the process is
completed and then retry the import or export operation.

Cannot log into
the library

Log into the library using the default superuser (su). See Configuring
Library Users on page 106 for a list of the default user names and
passwords.

Forgot the user
names or
passwords

Cannot use a
Global Spare
drive to replace a
malfunctioning
drive in the
partition

• Make sure that a Global Spare drive is assigned to the partition (see
Assign Global Spare Drives on page 206).

• Make sure that no background processes are running (for example,
Media Auto Discovery, PreScan, or PostScan). If a background process
is running, the library displays a message indicating what it is.
• If the background process is Media Auto Discovery, PreScan, or
PostScan and you cannot wait for the process to complete, you can
stop or pause the operation (Stop the Discovery Process on page 324
and Pause the PostScan Process on page 334).

• For all other background processes, wait until the process is
completed and then retry activating the Global Spare.

Operator panel
touch screen
displays broken
graphics or an
error message

1. Display the soft keyboard.

2. Change the keyboard to display the number keypad.

3. Depending on what is displayed on the screen, press and hold the
specified number key for 10 seconds:

• 1—Refresh the library’s built-in web browser. Use this option if you
see a message such as “Page cannot be displayed” or if graphics on
the screen (for example, health icons) are not loading properly.

• 2—Restarts the library’s built-in web browser.
• 3—Restarts the library’s web server and the built-in web browser.
Use this option if you see a message such as “Page not found.”
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Issue Resolution

System message
states that the
BlueScale
Software Support
key has expired

A valid BlueScale Software Support key is required before you can update
BlueScale software. Renew the key as described in Renewing the BlueScale
Software Support Key on page 469.

Touch screen
buttons and text
fields are out of
alignment

Recalibrate the touch screen (see Calibrating the Touch Screen on
page 497).

USB device does
not appear as a
“save to” option

• Make sure that you plug the USB device into the LCM or operator panel
and allow time for the device to mount before you select the option that
saves data to the USB device.

• Reset the LCM to make sure that the USB port is not hung (see Reset the
LCM or RCM on page 407).

• The library only recognizes FAT-formatted, not NTFS-formatted, USB
devices. Try using a different USB device.
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TROUBLESHOOTING MLM ISSUES

This section provides information about potential issues that you may experience while using
MLM.

Issue Cause Resolution

An asterisk (*)
appears next to
the barcode on
the MLM Details
screen or an MLM
report

The cartridge has been exported from
the library.

If you do not intend to reimport
the cartridge, you can delete it
from the MLM database (see
Delete MLM Records From the
Database on page 348).

An “x” appears
next to the
barcode on the
Inventory screen

The cleaning cartridge is expired. Export the expired cartridge or
exchange it for a new one (see
Export or Exchange Expired
Cleaning Cartridges on
page 266).

The library does
not proactively
discover new
cartridges when
they are imported

The discovery process (Media Auto
Discovery or PreScan) cannot begin
while the hosts are actively loading
cartridges into or unloading cartridges
from the drives. If you import
cartridges during this time, the library
posts a failure message stating that no
drives are available to perform the
discovery process.

Either wait until the library is
idle before beginning the import
or manually start the discovery
process for imported cartridges
when the library is idle. See
Discover Cartridges Manually
on page 322 for instructions.
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TROUBLESHOOTING ENCRYPTION ISSUES

The information in this section may help resolve encryption-related problems.

Issue Cause Resolution

Library can not
access the
Spectra SKLM
server

The Spectra SKLM
server’s operating
system firewall does not
allow the library to
access the server.

If you are setting up Spectra SKLM on a
Windows server, create a firewall rule on the
server to allow the library to access the server.

Use the port setting that was assigned to the
server during the BlueScale (library) portion
of the Spectra SKLM server configuration. The
default port setting is 3801. See “Configure
the Spectra SKLM Server” in the Spectra Tape
Libraries Encryption User Guide to determine
your port setting.

System message
states that “Load
attempted while
encryption is
enabled, but no
moniker or key
list was sent to
the DCM”

If a cartridge is left in a
drive after the library
loses power or you reset
or power-cycle the
library, the drive will not
be able to receive
encryption monikers.
This can also occur if a
tape is left in a drive
while the drive is reset
or reseated.

Use the following steps to re-enable the
encryption process:

1. Move the cartridge out of the drive and
return it to its storage location (see
Exchange Magazines or Cartridges in a
Partition on page 262).

2. Reset the drive (see Resetting a Drive on
page 431).

System message
states that a tape
drive requires a
specific moniker

The cartridge was
encrypted using an
encryption key that is
not currently available
on the library.
Or, if you are using
BlueScale Professional
Edition, the required
encryption key is
available, but was not
selected as one of the
partition’s decryption
keys.

Depending on which BlueScale Encryption
edition you are using, use the following steps
to enable the cartridge to be read:
BlueScale Standard Edition

1. Log into the library as a superuser.

2. Log into the encryption feature.

3. Export and then delete the encryption
key currently listed on the Encryption
Configuration screen (see “Deleting an
Encryption Key from the Library” in the
Spectra Tape Libraries Encryption User
Guide).
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Issue Cause Resolution

4. Import the required encryption key (see
“Import the Required Key into the
Library” in the Spectra Tape Libraries
Encryption User Guide).

5. Select Configuration > Partitions.

6. Click Edit next to the partition
containing the cartridge.

7. Navigate through the BlueScale
partition wizard to the Encryption
screen.

8. Select the encryption key to be
associated with the partition.

9. Click Next to proceed to the Summary
screen of the Partition Wizard, and click
Save.

BlueScale Professional Edition

1. Log into the library as a superuser.

2. Log into the encryption feature.

3. Make sure the encryption key is listed
on the Encryption Configuration screen.
If it is not listed, add the key to the
library (see “Import the Required Key
into the Library” in the Spectra Tape
Libraries Encryption User Guide).

4. Select Configuration > Partitions.

5. Click Edit next to the partition
containing the cartridge.

6. Navigate through the BlueScale
partition wizard to the Encryption
screen.

7. Select the required encryption key as
either the primary encryption key or as
a decryption key.

8. Click Next to proceed to the Summary
screen of the Partition Wizard, and click
Save.

Note: A maximum of eight decryption keys can
be assigned to one partition.
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RESOLVING OPERATIONAL ISSUES

This section provides information about potential issues you may encounter while operating
the library.

Issue Cause Resolution

One or more
chambers
marked as
unusable

When the library is
repeatedly unable to
insert a magazine into a
chamber, it marks the
chamber as unusable
and posts a system
message.

1. Open a support ticket describing the
system message that was posted (see
Opening a Support Ticket on page 536).

2. Continue using the library, keeping the
following in mind:

• If the library has unassigned chambers,
operation is not affected. However, if you
create a new partition that uses the
unassigned chambers, you will not be able to
load magazines into all of the chambers
assigned to the partition.

• If all of the chambers in the library are
assigned to partitions, the number of
magazines that can be imported into the
partitions is reduced.

Element
addresses
change after
installing
additional
drives

Installing additional
drives into a partially
filled DBA, or removing
drives from a DBA, may
cause the library to
reassign element
addresses.

To avoid errors after adding a new drive, make
sure that you reconfigure the element addresses
your storage management software uses to
access drives when you install a new drive (refer
to your software documentation for
instructions).

Magazine is in
TAP after a
power failure

If the library loses
power while a TeraPack
magazine is in a TAP,
the library only
identifies the
magazine’s presence in
the TAP the next time
media is imported or
exported.

To recover the magazine, use the Import/Export
TeraPack Magazines screen to initiate an import
or export operation (see Importing and
Exporting Cartridges on page 238 for
instructions).
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Issue Cause Resolution

Magazine is left
in transporter
following a
move

The library was unable
to insert the magazine
into its original chamber
and no empty chambers
are available. The
library posts a system
message and moves the
TeraPorter to the service
position.

Contact Spectra Logic Technical Support for
assistance (see Contacting Spectra Logic on
page 18).

System message
indicates that
the robotics are
blocked

A blockage is
preventing the library
from moving the
robotics.

Contact Spectra Logic Technical Support for
assistance (see Contacting Spectra Logic on
page 18).

Streaming video
and camera
controls do not
work for the
library camera

The software included
with the black camera,
requires ActiveX to
view the streaming
video and controls.

Select one of the resolutions below.
• Use Internet Explorer or a plugin for your
browser that provides ActiveX support, such
as ‘IE Tab’ for Google Chrome and Mozilla
Firefox or ‘Open in Internet Explorer’ for
Safari. Consult your browser's documentation
for assistance installing a plugin.

• Use a multimedia player, such as VLC Media
Player, to view the streaming video. To
configure the camera in VLC Media Player,
launch the program and navigate to Media >
Open Network Stream, select the Network tab,
and enter rtsp://xxx.xxx.xxx.xxx/live.sdp
where xxx.xxx.xxx.xxx is the IP address of
the camera.

• Connect to the camera by entering the IP
address in your web browser. Ignore pop up
windows about missing plugins. Select the
Configuration tab, then select Advanced Mode.
Select Media > Video and in the Stream
Settings pane select Video settings for stream
1. Select JPEG and the enter the desired
settings, and then click Save. Return to the
Home page. Switch to Video Stream 2, and
then back to Video Stream 1. The video stream
should display.

Note: You will need to switch to Video Stream 2
and then back to Video Stream 1 each time you
return to the Home page.
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Issue Cause Resolution

Library has
EtherLib, but
EtherLib
options do not
display in
Package Update

The EtherLib network is
disconnected.

Navigate to Maintenance > Tools and select
EtherLib Status. If the status indicates that any
of the targets are not connected, check the
cabling between the components and then click
Refresh.

High
Performance
Transporter fails
with multiple
PAX and picker
errors.

Labels on the front of
one or more drives
interfering with
transporter position
calibration.

Remove all labels from drive faces.

Cartridge left in
a tape drive
after a library
power-cycle or
reset

If the drive is a
Global Spare,
see Cartridge
left in a Global
Spare tape drive
after a library
power-cycle or
reset on the
next page

If the library loses
power during backup
operations or you reset
or power-cycle the
library without first
unloading all of the
drives, cartridges may
remain in the drives.

CAUTION: When the Unload Drives utility runs,
cartridges are unloaded from all drives in the
selected partition(s), even if they are active. This
could cause file storage operations to fail. Do not
use the Unload Drives utility when file storage
operations are actively running.

1. From the toolbar menu, select
Maintenance > Tools. The Maintenance
Tools screen displays.

2. Select Utilities. The Utilities screen
displays.

3. Click Show Advanced. The Advanced
Utilities Confirmation screen displays.

4. Click Next. The Utilities screen refreshes
to show a list of the advanced utilities.

5. Scroll down and select Unload Drives.

6. From the Select the partition or library
drop-down list, select a partition or Total
Library.

7. Click Run Utility.

8. A progress screen displays, all drives
assigned to partitions in the full library or
the selected partition are unloaded, and
the cartridges are returned to their original
slots or the first available slot if the
original slot is not available. When the
operation is complete, a Utility Results
screen displays.
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Issue Cause Resolution

Note: This utility does not unload cartridges from
Global Spare tape drives being used for PostScan. If
there is a cartridge left in a Global Spare tape drive,
see Cartridge left in a Global Spare tape drive after a
library power-cycle or reset below.

Cartridge left in
a Global Spare
tape drive after
a library power-
cycle or reset

If the library loses
power or if you reset or
power-cycle the library
while the PostScan
process is running, the
cartridge being scanned
remains in the drive.
The library generates a
message to notify you
that the Global Spare
contains a cartridge
after it completes its
initialization process.

IMPORTANT Make sure the drive you will be
sparing is not actively running a backup or restore
operation. This could cause backups to fail.

Use the following steps to return the cartridge to
its storage location:

1. Examine the partition inventories to
determine in which partition the cartridge
belongs (see Viewing and Downloading
the Cartridge Inventory on page 281).

2. Substitute the Global Spare tape drive
containing the cartridge for another drive
in the same partition (see Use the Global
Spare Drive on page 434).

3. Move the cartridge out of the drive and
return it to its storage location (see
Moving Cartridges Within a Partition on
page 289).

4. Return the drive back to Global Spare
status. (see Undo the Global Spare Drive
on page 436).
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INTERPRETING EXTERNAL LIGHTS
This section explains the move actions and hardware issues indicated by the external lights on
the top of the TFinity frames.

Note: Move action lighting overrides all other lighting in the affected frame.

When the
external lights
are...

It means...

Not lit The library is powered off.

Blue The TeraPorters are operational.

White Indicates the locations of the TeraPorters.

Yellow A BlueScale or drive firmware update using Package Update is in
progress.

Orange A door or panel is open on the frame with the illuminated orange lights.

Red The robot on that side of the library has been moved into the service
position.
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USING BLUESCALE HARDWARE HEALTH MONITORING
Overview

BlueScale Hardware Health Monitoring (HHM) tracks maintenance thresholds for key library
components. When the library or one of its components reaches its maintenance threshold the
HHM icon appears on the status bar. As with the system message icon, the color of the icon
indicates the urgency of the notification.

When the HHM icon appears on the status bar, you can click the icon to view information
about the notification and send a Hardware Health Monitor ticket to a contact person within
your organization or to Spectra Logic Technical Support so they can review the logs and
determine if any maintenance tasks are needed.

Figure 212 The HHM icon is located on the status bar.

• To send an AutoSupport log to a contact person, see Respond to HHM Notifications,
beginning on this page.

• To view a report showing the current HHM data, see View Hardware Health Monitoring
(HHM) Data on page 399.

User Privilege Requirements

Only a user with superuser or administrator privileges can respond to HHM notifications by
creating an AutoSupport ticket and viewing HHM data.

Respond to HHM Notifications

Use the following steps to send the Hardware Health Monitoring notification and
AutoSupport Log (ASL) file to the contact person in a predefined AutoSupport profile. You
can also choose to send the ASL files to Spectra Logic Technical Support so they can review
the logs and determine if any maintenance tasks are needed to prevent future problems.

Note: AutoSupport Log (ASL) information is only for troubleshooting purposes. This log information
is separate from the data path and contains no customer data.

1. Log into the library as a user with superuser or administrator privileges.

2. If not already completed, configure the mail recipients who should receive AutoSupport
information. Also configure one or more AutoSupport profiles.
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• Mail recipients — See Configure Mail Users on page 127. At a minimum, configure
Spectra Logic Technical Support as a mail recipient if you want the library to email
AutoSupport ticket requests to Spectra Logic.

• AutoSupport profiles — See Configure AutoSupport Profiles on page 366. You can
configure one of the mail recipients to receive critical alarm log sets automatically sent
by the library.

3. Click the HHM icon on the status bar (see Figure 212 on page 395). The Hardware Health
Monitoring screen displays.

Figure 213 The Hardware Health Monitoring screen
provides information about responding to the HHM
notification.

4. If you want to save the AutoSupport ticket information to a USB device, insert the USB
device into a USB port on the LCM (see Using a USB Device on page 185) or operator
panel and allow time for the device to mount before continuing.

Note: The option to save the ticket information to a USB device is only available if you connect a
USB device before you click Send AutoSupport Ticket.

5. Click Send AutoSupport Ticket. The main AutoSupport screen displays.

Figure 214 Click Send Log Set to open a support ticket.

6. Click Send Log Set. The Select Profile to Send Log Set screen displays.
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Figure 215 Select the AutoSupport profile to use for the
support ticket.

7. Click Select next to the profile for the main contact person for HHM issues. The Select
Ticket Type screen displays.

Figure 216 Enter a problem description on the Select Ticket
Type screen.

The Create new Hardware Health Monitor ticket option is automatically selected. The
options for entering an existing support ticket number and a problem description are not
available.

8. If you do not need to make any changes to the contact person’s information for this
support ticket, skip to Step 9 on page 397.

If you need to temporarily change the contact person’s information for this ticket, click
Profile Data. The Profile Summary screen displays (see Figure 210 on page 376). Make
any necessary changes in the Profile Summary screen. Click Use Settings to save your
changes and return to the Select Ticket Type screen.

9. Click Next. The Confirm and Submit Ticket screen displays.
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Figure 217 The Confirm and Submit Ticket screen.

10.Verify that all information is correct.

• To save the ticket information to a USB device instead of emailing it from the library,
select the box at the top of the screen.

Note: The option to save the ticket information to a USB device is only available if you connected a
USB device in Step 4 on page 396.

• If all of the information is correct, proceed to Step 11.

• If something needs to be changed, click Previous to return to the Select Ticket Type
screen and make any necessary changes.

11.Click Submit to send the Hardware Health Monitor ticket to the selected recipient.

A progress screen indicates that the ticket request (and the ASL information) is being
sent. When completed, the AutoSupport Profiles screen displays.

12.After any required tasks are complete, the threshold can be reset. The HHM icon
disappears until the next threshold is reached.
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View Hardware Health Monitoring (HHM) Data

The advanced utility called HHM: View Data generates a report showing the current status of
the HHM counters. This information includes the following:

• Library serial number and name (if configured)

• Information about key library components monitored by HHM, including the type of
reminder generated when the component reaches its maintenance threshold

• TeraPorter moves: Drive To Drive Moves, Drive To Slot Moves, Slot To Slot Moves, Slot To
Drive Moves, TAP In Moves, and TAP Out Move.

CAUTION

In addition to the HHM: View Data utility, two additional HHM utilities
configure the HHM counters and thresholds for the monitored components.
Do not change the values for any counters or thresholds unless you are
specifically instructed to do so by Spectra Logic Technical Support.

Use the following steps to view the current HHM data.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

3. Select Utilities. The Utilities screen displays.

4. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

5. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

6. Scroll through the list of advanced utilities and select HHM: View Data. The screen
refreshes to show the details for the utility.

Figure 218 The HHM: View Data utility.
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7. Click Run Utility.

After a brief delay, the Utility Results screen displays the current HHM data. Scroll as
necessary to view all of the data.

Figure 219 The HHM: View Data Utility Results screen.

8. Click Previous to return to the list of advanced utilities.
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CAPTURING TRACES
Overview

Spectra Logic uses traces to help diagnose problems with the library. You only need to capture
traces when instructed to do so by Spectra Logic Technical Support. They will tell you what
type of trace you need to capture.

Emailing Trace Results

If you plan to email trace results directly from the library, make sure that you have already set
up the recipients as mail users (see Configure Mail Users on page 127).

If you are connected to the library using a web browser, you can also copy and paste the trace
results into a text file and email it to Spectra Logic Technical Support if they request it.

Saving Trace Results to a USB Device

If you plan to save trace results to a USB device, you must connect the USB device to a port on
the LCM or operator panel and allow time for it to mount before you select Traces on the
Maintenance Tools screen (see Connect a USB Device to the Library on page 186). If a USB
device is not connected, the USB option is not available. You can, however, still save trace
results to the memory card in the LCM. You can also view the results without saving them.

User Privilege Requirements

Only a user with superuser or administrator privileges can capture traces.

Procedure

Use the following steps to capture the desired trace.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Tools to display the Maintenance Tools
screen.

Figure 220 The Maintenance Tools screen.

3. If you want to save the traces to a USB device, connect the USB device to a port on the
LCM and allow time for it to mount; otherwise, skip to the next step.
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4. Select Traces. The System Traces screen displays with the trace options that were
selected the last time the screen was viewed.

5. Select the type of trace that Spectra Logic Technical Support requested.

Figure 221 Select the traces you want to capture on the
System Traces screen (Error Log trace results shown).

• LCM Trace—Captures a trace relating to a single aspect of operations related to the
LCM.

• Component Trace—Captures a trace relating to the logical library or a single aspect of
operations related to the robotics or a RIM.

Note: The RIMs in the library are listed as F-QIPs.

6. Use the check boxes to select any combination of the options for saving the generated
trace.

Option Description

Mail results to Sends the trace report to a previously configured mail recipient. Use the
drop-down list to select the recipient for the report file.

To send the email with the attached trace file to someone who is not
already listed as a library user, you must first configure that person as an
email recipient (see Configure Mail Users on page 127).

Note: Do not use the default autosupport@spectralogic.com email recipient.
Spectra Logic does not save emailed traces unless they are specifically
requested for troubleshooting.

Save results to
Compact Flash file

Saves the report to the memory card in the LCM.
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Option Description

Note: Select this option only if specifically instructed to do so by Spectra Logic
Technical Support.

Save to USB Saves the report to the USB device. The results can then be viewed from
any device that can read from USB.

Note: This option is only available if you inserted a USB device in Step 3 on
page 401.

Display Full LCM
Trace

Opens a new screen that shows the entire trace.
Note: The Display Full LCM Trace check box only applies to selections made
in the LCM Trace list, not selections made in the Component Trace list. If
Display Full LCM Trace is selected when you generate a component trace, the
selection is ignored.

7. Click Go next to either LCM Trace or Component Trace. The library retrieves the
requested trace, which may take several minutes.

If you... The trace results...

Did not select
Display Full LCM
Trace,

Display in the scrolling box on the System Traces screen (see Figure 221
on page 402).

Selected Display
Full LCM Trace,

Display in the Trace Results screen. Click Previous to return to the System
Traces screen.

8. If you chose to save the file to a USB device or mail it, a message displays showing the
filename for the trace file.
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HPT SELF TEST
The HPT Self Test runs diagnostics on the High Performance Transporters inside the library.

Use the following steps if Spectra Logic Technical Support instructs you to run the HPT Self
Test.

1. Log in to the library as an administrator or superuser privileges (see "Log Into the User
Interface" on page 97 for more detail).

2. Select Maintenance > Diagnostics. The Diagnostics screen displays.

Figure 222 The Diagnostics screen.

3. Select HPT Self Test.

4. Using the drop-down menu, select the robots you wish to test.

Figure 223 HPT Self Test screen.

5. Click Run Diagnostic. A progress bar appears.
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Figure 224 The Diagnostic Progress screen.

After the test completes, the results screen displays. If the test fails, contact Spectra Logic
Technical Support.

Figure 225 The Diagnostics Results screen.
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RESETTING THE LIBRARY
Many troubleshooting or error recovery operations only require resetting the LCM as
described in Reset the LCM or RCM on the next page. Because resetting the LCM does not
affect communication with hosts, servers, and software, backups can continue while the LCM
resets.

Performing some types of troubleshooting operations or recovering from some error
conditions will require you to reboot (power-cycle) the entire library. Power-cycling the library
resets all of the components in the library.

CAUTION
Do not reset the library unless you are specifically instructed to do so. Trace
data generated by the library may be lost when you reset the library or a
component, making diagnosing problems difficult.

Use the following steps if Spectra Logic Technical Support instructs you to reboot the entire
library by power-cycling it.

1. If possible, pause PostScan if it is running (see Pause the PostScan Process on page 334).
Any tapes currently being scanned are returned to their storage locations.

2. Discontinue all file storage operations to the library.

3. Power off the library (see Power Off the Library on page 163).

4. Wait at least 10 seconds.

5. Power on the library (see Power On the Library on page 162) and wait while the library
performs its initialization process.

6. If a cartridge is left in a drive after the reset is complete, see Resolving Operational
Issues on page 390 for information about returning the cartridge to its storage location.
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RESETTING COMPONENTS

If instructed to do so by Spectra Logic Technical Support or by error messages, you can reset
certain library components as described in this section. See Resetting the Library on the
previous page if you need to reset the entire library.

CAUTION
Do not reset a component unless you are specifically instructed to do so. Trace
data generated by the library or the component may be lost when you perform
a reset, making diagnosing problems difficult.

Reset the Power Control Module

The main frame and each drive expansion frame has a PCM. To reset the over-current circuit
that protects the power system in the event of a voltage surge, insert the tip of a toothpick or
other similar non-conductive object into the hole on the back of the PCM to press the reset
button.

CAUTION Do not use a metallic object to press the reset button. You may inadvertently
cause an electrical short inside the module.

Figure 226 Power Control Module reset button.

Reset the LCM or RCM

To reset the LCM or RCM insert the tip of a toothpick or other similar non-conductive object
into the hole on the back of the LCM or RCM to press the reset button.

CAUTION Do not use a metallic object to press the reset button. You may inadvertently
cause an electrical short inside the module.
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IMPORTANT Resetting the RCM resets the motion control for the TeraPorter(s). Any move
requests will fail until the RCM completes its initialization.

IMPORTANT

Resetting the LCM resets the front panel and the web server. Any connections
to the library through the BlueScale web interface are lost. Wait five minutes
for the reset to complete and then reconnect. Backup operations are not
affected.

Figure 227 The reset button on the Spectra LS (LCM or RCM).

Reset a RIM

Hardware Reset

To perform a hardware reset of a RIM, insert the tip of a toothpick or other similar non-
conductive object into the hole in the back panel to press the Reset button.

CAUTION Do not use a metallic object to press the reset button. You may inadvertently
cause an electrical short inside the module.

7. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

8. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

9. Scroll through the list of advanced utilities and select Reset Controller. The screen
refreshes to show the details for the utility.
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Figure 228 The Reset Controller utility for resetting a RIM.

10.Use the drop-down list to select the component identifier for the RIM that you need to
reset.

11.Click Run Utility to reset the selected RIM.

When the reset is complete, the Utility Results screen displays, showing that the RIM
was reset.

Note: When the RIM resets, the library posts system messages that the F-QIP disappeared and
reappeared.

12.The RIM is ready for use.

JUNE 2025 409 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 12 - LIBRARY TROUBLESHOOTING



DISCOVERING AND SETTING THE BLUESCALE VISION
CAMERA IP ADDRESS

If a white BlueScale vision camera is configured to use DHCP addressing, you can use the
camera’s setup wizard to find the camera on the network and determine the current IP
address. You can then enter the IP address in the BlueScale System Settings screen (see
BlueScale Vision IP Address on page 122). You can also use the camera’s setup wizard to set a
fixed IP address, if desired.

IMPORTANT

If a white camera is configured with an unknown fixed IP address, you must
reset it to use DHCP before you can discover it on the network. Resetting the
camera to use DHCP requires physically accessing the camera inside the
library. Contact Spectra Logic Technical Support for assistance (see
Contacting Spectra Logic on page 18).

For a black BlueScale Vision camera, you can use the camera’s setup wizard to find cameras
with both fixed and dynamic IP addresses.

When your library environment includes multiple cameras, the setup wizards will detect all of
the compatible cameras on the network it is accessing. When you perform the initial IP
address configuration for the camera using the wizard, you may find it helpful to connect a
computer directly to the BlueScale Vision camera connector for one camera at a time instead of
using a connection over the network.

Determine the type of BlueScale vision camera you have, and use the appropriate section to
download software and configure the camera.

• If you have the white BlueScale vision camera, use Configure the BlueScale Vision Camera
- White, below.

• If you have the black BlueScale vision camera, use Configure the BlueScale Vision Camera -
Black on page 415.

Configure the BlueScale Vision Camera - White

1. Download the BlueScale vision camera software from the support portal Downloads >
Tools page or click networkcamera.exe.

2. Open the folder and run networkcamera.exe.

3. On the wizard’s Welcome screen, click Setup Camera. The wizard searches the network
and locates any compatible network cameras currently set to use DHCP to obtain an IP
address.
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IMPORTANT
Do not click Install Utility. This option installs the Viewing/Recording utility.
It cannot be used to configure the camera.

Note: The Network Camera Setup Wizard uses the UDP broadcast to discover the camera on the
network. You may need to disable your network’s firewall if it blocks using UDP.

Figure 229 The Network Camera Setup Wizard start page.

4. If the wizard discovers multiple cameras, select the one that you want to configure, and
then click the forward arrow to continue.

Figure 230 The camera IP address shown in the Network Camera Setup
Wizard.

Notes: l The default device name for the camera is SLnnnnnn, where nnnnnn are the last 6 digits
of the camera’s 12 digit hexadecimal MAC address.
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l If you only need to determine the IP address for the camera, make a note of that
information and then click the button in the upper right-hand corner of the screen to
close the wizard. The camera will continue to use DHCP to obtain an IP address.

l If the wizard does not discover the camera, the camera must be reset to use DHCP
addressing. Contact Spectra Logic Technical Support for assistance (see Contacting
Spectra Logic on page 18).

l If the camera is configured to use DHCP and no DHCP server is available, the camera
defaults to IP address 192.168.0.99.

5. Click the forward arrow to display the login screen. Enter the Administrator Name and
Administrator Password.

The default Administrator Name is administrator (all lower case, case-sensitive); by
default, the Administrator Password is left blank.

6. Click the forward arrow to display the Camera Settings screen.

Figure 231 Enter a description for the camera and set the date and time.

a. On the Camera Settings screen, change the Device Name to something that will help
you identify the camera in your environment. The default name for the camera is
SLnnnnnn, where nnnnnn is the last six digits of the camera’s 12 digit hexadecimal
MAC address.

b. If desired, enter a Description for the camera so that you can easily identify it.

c. If necessary, set the correct Time Zone, Local Date, and Local Time.

7. Click the forward arrow to display the IP Address Settings screen.
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Figure 232 Select Fixed IP Address to configure the IP address for the
camera.

8. On the IP Address Settings screen, select Fixed IP Address or Dynamic IP Address. Click
the forward arrow.

IMPORTANT

If you select to use DHCP, and no DHCP server is available, the camera
defaults to IP address 192.168.0.99. If your network does not support using
this IP address, you must set the camera to a supported fixed IP address
before you will be able to enable and access the camera’s BlueScale Vision
viewer.
If you select to use DHCP addressing, be aware that if the DHCP-assigned IP
address changes, you will need to use the Network Configuration Wizard to
find the new IP address for the camera in order to access it.

If you select Fixed IP Address, the TCP/IP Settings screen displays. If you selected DHCP,
skip to Step 9 on page 414.

Figure 233 Configure the TCP/IP settings for the camera.
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Set the desired IP, subnet mask, and gateway addresses as required for your network
and enter DNS (Domain Name Server) information. The factory defaults are:

IP Address Subnet Mask Default Gateway

10.10.10.11 255.255.255.0 10.10.10.1

IMPORTANT

If you set the camera to use a fixed IP address, record that address for later
reference. If you do not know the camera’s IP address, you must reset the
camera to use DHCP addressing before you can connect to it. The reset
process requires physically accessing the camera. Contact Spectra Logic
Technical Support for assistance (see Contacting Spectra Logic on page 18).

Notes: l The Primary DNS address is required in order to use the email alert or dynamic DNS
features.

l The Secondary DNS is optional. If provided, it will be used if the Primary DNS is
unavailable.

9. Click the forward arrow to display the New Settings confirmation screen. Confirm that
all of the settings are correct.

Figure 234 Confirm that the new settings for the camera are correct.

10.Click the forward arrow to save the updated settings. A confirmation dialog box
displays. Click OK to confirm that you want to save the new settings.
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Figure 235 Save the updated settings for the camera.

11.After saving the new camera configuration verify the settings by attempting to access the
camera at the new IP address (see Using a Web browser on page 181).

12.If the library has multiple cameras, repeat the steps in this section for each camera. Make
a record of the IP address for each camera and the frame in which each camera is
located.

13.Other camera settings can be configured if desired. See the BlueScale Vision Camera User
Guide for information about other available settings.

14.When you have completed configuring the camera, click Exit to close the wizard.

15.If desired, edit the IP address for the BlueScale Vision camera icon on the BlueScale user
interface status bar.

a. From the library’s user interface, select Configuration > System. The System Setup
screen displays.

b. Scroll down until you see the Other Settings pane (see Figure 47 on page 111).

c. Enter the camera’s updated IP address in the BlueScale Vision IP Address field.

d. Click Save. The presence of a camera icon on the status bar indicates that the IP
address has been saved.

Configure the BlueScale Vision Camera - Black

1. Download the camera software from the support portal Downloads > Tools page or click
Vivotek_InstallWizard-v1.1.0.27.exe.

Note: The Vivotek FD8361 Fixed Dome Network Camera User’s Manual indicates that the software is
located on a CD shipped with the camera. The CD is not shipped with Spectra Logic libraries.
Download the software using the link above.

JUNE 2025 415 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 12 - LIBRARY TROUBLESHOOTING

https://support.spectralogic.com/documentation/user-guides/bluescale-camera.pdf
https://support.spectralogic.com/documentation/user-guides/bluescale-camera.pdf
https://support.spectralogic.com/python/tools/IW2_Setup-v1.1.0.27.exe
https://support.spectralogic.com/python/documents/Vivotek FD8361 Fixed Dome Network Camera User�s Manual.pdf


2. Open the folder and run IW2_Setup-v1.1.0.27.exe. The program searches the network for
any compatible network cameras.

3. When the discovery completes, a graphic of the detected setup, similar to Figure 236,
displays. Click Next.

Figure 236 Sample detected network.

4. The installation wizard displays information, such as the MAC address and IP address,
for the cameras detected. Click the row for the camera that you want to configure.

Figure 237 The camera IP address shown in the Network
Camera Installation Wizard 2.

5. The camera software should open in your default browser. If it does not, open a browser
window and type the IP address shown.

Notes: l The software included with the black camera, requires ActiveX to view the streaming
video and controls. You must use Internet Explorer or see Streaming video and camera
controls do not work for the library camera on page 391 for alternate solutions.

JUNE 2025 416 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 12 - LIBRARY TROUBLESHOOTING



l If this is the first time the program has been run on the computer an add-on will need
to be installed.

l Depending on the firmware of the black camera, you may need to log into the camera
to view live images or to configure the camera. The default username is root. The
default password is Spectra123. To change the default password or create additional
users, see “Security” in the Vivotek FD8361 Fixed Dome Network Camera User’s Manual.

6. Click Configuration to see the options for configuring the camera.

Figure 238 The viewing software home page.

7. Select System > General settings. On the System General Settings screen, enter the
following information:

• If desired, change the Host name for the camera so that you can easily identify it. This
name displays at the top of the screen.

• Select to Keep current date and time, Synchronize with computer time, set the time
manually, or set the time automatically by entering the IP address or domain name for
an NTP server.
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Figure 239 Enter a Host name and set the date if
necessary.

8. Click Save.

9. Select Network > General settings. The Network General Settings screen displays.

Figure 240 If you select Use fixed IP address, configure
the IP address for the camera.

10.On the Network General Settings screen, select Get IP address automatically (DHCP) or
Use fixed IP address.

If you select Use fixed IP address, set the desired IP, subnet mask, and gateway
addresses as required for your network and DNS (Domain Name Server) information.
The factory defaults are:

IP Address Subnet Mask Default Gateway

10.10.10.11 255.255.255.0 10.10.10.1
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Notes: l The Primary DNS address is required in order to use the email alert or dynamic DNS
features.

l The Secondary DNS is optional. If provided, it will be used if the Primary DNS is
unavailable.

Figure 241 If you select Use fixed IP address, configure
the IP address for the camera.

11.Click Save.

12.After saving the new camera configuration verify the settings by attempting to access the
camera at the new IP address (see Using a Web browser on page 181).

13.If the library has multiple cameras, repeat the steps in this section for each camera. Make
a record of the IP address for each camera and the frame in which each camera is
located.

14.Other camera settings can be configured if desired. See the Vivotek FD8361 Fixed Dome
Network Camera User’s Manual for information about other available settings.

15.When you have completed configuring the camera, close your browser to exit the camera
setup software.

16.If desired, edit the IP address for the BlueScale Vision camera icon on the BlueScale user
interface status bar.

a. From the library’s user interface, select Configuration > System. The System Setup
screen displays.

b. Scroll down until you see the Other Settings pane (see Figure 47 on page 111).

c. Enter the camera’s updated IP address in the BlueScale Vision IP Address field.

d. Click Save. The presence of a camera icon on the status bar indicates that the IP
address has been saved.
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RESTORING THE LIBRARY CONFIGURATION

Overview

If you have valid backups of the library’s configuration and the MLM database saved on a
USB device or sent as an email attachment, you can use them to restore the library in the event
of a disaster. You can also use these backups to restore the library if problems require you to
replace the LCM or the memory card in the LCM. See Backing Up the Library Configuration
on page 149 for information about backing up the library configuration.

Notes: l All backup files of the library configuration include any BlueScale encryption keys that
were stored in the library at the time the file was created.

l The backup of the MLM database also contains the DLM database.

To restore the... Using the... See...

Library configuration, the
MLM and DLM databases,
and the BlueScale encryption
keys stored in the library

Auto Configuration Save
file,

Restore From an Auto
Configuration Save File below.

Library configuration and the
BlueScale encryption keys
stored in the library

Saved configuration file, Restore the Library
Configuration Using a Saved
Configuration on page 425.

MLM and DLM databases MLM database backup file, Restore the MLM and DLM
Databases on page 427.

BlueScale encryption keys Exported key file, See the Spectra Tape Libraries
Encryption User Guide.

User Privilege Requirements

Only a user with superuser or administrator privileges can restore the library configuration
and the MLM and DLM databases. To restore BlueScale encryption keys, the user must also be
logged in as an encryption user. See Understanding User Groups and Security on page 106
and the Spectra Tape Libraries Encryption User Guide for information.

Restore From an Auto Configuration Save File

The advanced utility called “Restore Library Configuration from Auto Save” uses the
configuration backup file that the library generates automatically to restore the library
configuration, the MLM and DLM databases, and any BlueScale encryption keys that were
stored in the library when the backup file was created (see Use Automatic Backup of the
Library Configuration on page 149).
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IMPORTANT
Before restoring your system using the automatically generated backup file,
check the time stamp included in the file name to ensure that you have the
most current file.

IMPORTANT
The library does not automatically save a backup when you make changes to
any of the library configuration settings other than those for partitions. Any
changes made since the last backup will need to be entered manually.

The library automatically generates a configuration backup file whenever any of the following
events occurs:

• When you make a change to a partition, the library immediately generates a configuration
backup file and saves it to the memory card in the LCM. If you configured the option to
email the backup file, the backup file will be sent as an email attachment to the specified
recipient (see Enable Email for the Auto Configuration Save File on page 129).

• Changes to any of the library configuration settings other than those for partitions are
automatically saved in the configuration backup file that the library creates each week. The
timing for this backup is based on the first time the automatic backup file is generated.

• If you cannot restore from the configuration backup file on the LCM and you have
manually generated backups of the library configuration and the MLM database that are
more current than the available automatically generated configuration backup file that is
saved elsewhere, you may want to use those backups instead of the automatically
generated configuration backup file (see Restore the Library Configuration Using a Saved
Configuration on page 425 and Restore the MLM and DLM Databases on page 427).

Restore the Library

Use the following steps to restore the library configuration, the MLM and DLM databases, and
BlueScale encryption keys that were stored in the library, using an automatically generated
configuration backup file.

Note: If you cannot use the automatically generated configuration backup file stored in the library,
locate an Auto Configuration Save file that was saved to a USB device or sent as an email
attachment.

IMPORTANT The library cycles power after restoring the previous configuration.

1. If you plan to restore using the zip file containing the automatically generated
configuration backup file that was sent as an email attachment, use the following
instructions to copy it to a USB device; otherwise, skip to Step 2.

a. Create a folder called \autocfgsave on a USB device.
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b. Copy the zip file you received in the email to the \autocfgsave folder on the USB
device.

c. Connect the USB device to the USB port on the LCM or operator panel and allow
time for it to mount before continuing.

2. Log into the library as a user with superuser or administrator privileges.

3. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

4. Select Utilities. The Utilities screen displays.

5. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

6. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

7. Scroll through the list of advanced utilities and select Restore Library Configuration from
Auto Save. The screen refreshes to show the details for the utility.

Figure 242 The Restore Library Configuration from Auto
Save utility.

8. Use the Select a configuration time stamp drop-down list to select the configuration
backup file you want to use. The automatically generated configuration backup files are
named <date-time>cfg.zip, where <date-time> is the time stamp for when the file was
created.

Unless you have replaced the LCM or its memory card, the first file listed is the zipped
configuration backup file stored on the LCM memory card.
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Note: If available, the zipped configuration backup file stored on the LCM memory card usually
contains the most recently saved library configuration information, as well as the MLM and
DLM databases. Check the time stamp in the filename to determine whether any manually
generated backup file you have is more recent.

9. Click Run Utility.

IMPORTANT

Before the library is restored using the configuration backup file on a USB
device, the library’s current configuration is saved to the USB device with a
time stamp indicating when the file was created. The library is then restored
using the selected configuration backup file on the USB device.
The USB device now contains one additional Auto Configuration Save file.

After a brief delay, the Utility Results screen appears, showing that the configuration
was restored. The library then performs a power- cycle reset.

10.Once the library begins its power-on sequence, remove the USB device if necessary.

IMPORTANT

If you do not remove the USB device, the library power-on sequence will fail.
If the library fails to boot, power off the library as described in Power Off the
Library on page 163. Once the library is powered off, remove the USB device
and power on the library as described in Power On the Library on page 162.

Restore Other Configuration Changes

The library does not immediately generate a configuration backup file when you make
changes to any of the library configuration settings other than those for partitions. If you made
any changes to the library configuration after the automatically generated configuration
backup file you used to restore the library was generated, you will need to repeat those
changes after completing the restore.

• If you have a manual backup of the library configuration that is more current than the
automatically generated configuration backup file you used, you can use it to restore the
updated configuration (see Restore the Library Configuration Using a Saved Configuration
on page 425).

• If you do not have a manual backup available, you will need to restore the following
changes manually:

• If you made configuration changes after the creation date of the automatically generated
configuration backup file you used, you will need to use the options in the System
Setup screen to repeat those changes after the restore is complete.

• If you entered activation keys after the creation date of the automatically generated
configuration backup file you used, you will need to use the Option Enablement pane of
the System Configuration screen to re-enter those keys (see Enter Activation Keys on
page 113).
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Update the Library Inventory

When you restore the configuration, any magazines that were imported into a partition after
the configuration backup file you used was generated are not recognized as belonging to the
partition. Instead, the library notifies you that there are unused magazines in the free pool.

Use the following instructions to update the library inventory to reflect the correct number of
magazines assigned to the partition.

1. Log in as a user with superuser or administrator privileges.

2. From the toolbar menu, select Configuration > Partitions. The Shared Library Services
screen displays.

3. Click Edit for the partition to which the unassigned magazines should belong.

4. Click Next to advance through the partition configuration screens until you reach the
Chambers and Drives screen.

Figure 243 The Chambers and Drives screen.
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5. Decrease the number of storage chambers assigned to the partition by the number of
missing magazines.

6. Click Next to advance through the remainder of the screens without making any
additional changes until you reach the Save Library Configuration screen.

7. Click Save. The Share Library Services screen redisplays.

8. Repeat Step 2 on page 424 through Step 6 on page 425, this time increasing the number
of storage chambers assigned to the partition to the original number. The magazines in
the free pool will be reassigned to the partition.

IMPORTANT

If the library has multiple partitions and you imported magazines into all of
the partitions after the configuration backup file you used to restore the
library was generated, the magazines can potentially end up in the wrong
partition. Carefully examine the cartridge inventory for each partition. Export
any wrongly assigned magazines and reimport them into the correct
partition.

9. Review the information on the screen and confirm that all settings are correct for this
partition’s configuration.

• If the configuration information is correct, proceed to Step 10.

• If the configuration information is not correct:

• Click Cancel and configure the partition again from the beginning.

—OR—

• Click Previous to move backward through the configuration screens until you reach
the settings that need correction. Make any necessary corrections, then click Next to
move forward through the screens and return to the Save Partition screen.

10.Click Save. The library requires several minutes to store the configuration information,
after which the Shared Library Services screen redisplays.

Restore the Library Configuration Using a Saved Configuration

Use the following steps if you want to restore the library from a configuration backup file that
was generated manually, as described in Use Manual Backup of the Library Configuration on
page 150.

Note: The manually-generated configuration backup files do not include the MLM and DLM
databases. If you also need to restore the MLM and DLM databases, you must use a separately
generated backup of the MLM database (see Restore the MLM and DLM Databases on
page 427).

1. Log into the library as a user with superuser or administrator privileges.
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2. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

3. Select Utilities. The Utilities screen displays.

4. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

5. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

6. Scroll through the list of advanced utilities and select one of the following, as applicable
for your situation. The screen refreshes to show the details for the selected restore utility.

Note: The Advanced Utilities screen lists the utilities in alphabetical order. The following table lists
the utilities in most-frequently-used order.

Use this Restore
Option... To...

Restore Library
Configuration
from Auto Save

Restore using an automatically generated configuration backup file that is
stored on a USB device or LCM memory card (see Restore From an Auto
Configuration Save File on page 420).

Note: The automatically generated configuration backup file contains the
library configuration, as well as the MLM and DLM databases.

Restore Library
Configuration
from USB

Restore a library configuration file previously stored on a USB device.

Note: Before starting this procedure, insert the USB device into a USB port on
the LCM or operator panel.

Upload Backup
Configuration

Upload a configuration backup file to a temporary location in the library
from a computer that has network access to the library.

Note: Upload Backup Configuration is only available when you access the
library through the BlueScale web interface.

1. Click Upload Backup Configuration at the top of the screen.

2. When the upload is complete, you must then run the Restore
Library Configuration from Uploaded File utility to restore the
library configuration.

Restore Library
Configuration
from Uploaded
File

Complete the restore process after using Upload Backup Configuration to
upload a saved configuration file from a computer.

Note: This option is used in conjunction with Upload Backup Configuration,
which must be run first.

3. Click Run Utility.
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IMPORTANT

Before the library is restored using a saved configuration file on the USB
device, the current configuration is saved to the USB device with a time
stamp indicating when the file was created. The library is then restored using
the selected auto saved configuration.
The USB device now contains one additional configuration file.

After a brief delay, the Utility Results screen appears, showing that the configuration
was restored. The library then performs a power- cycle reset.

4. Once the library begins its power-on sequence, remove the USB device if necessary.

IMPORTANT

If you do not remove the USB device, the library power-on sequence will fail.
If the library fails to boot, power off the library as described in Power Off the
Library on page 163. Once the library is powered off, remove the USB device
and power on the library as described in Power On the Library on page 162.

5. If you imported magazines into empty chambers in a partition’s storage pool after you
generated the backup configuration file, see Restore Other Configuration Changes on
page 423.

6. If necessary, restore the MLM and DLM databases as described in Restore the MLM and
DLM Databases.

Restore the MLM and DLM Databases

Use the following steps to restore the MLM database from a previously saved backup that was
created using the Save MLM Database utility (see Back Up the MLM and DLM Databases on
page 345).

CAUTION The Restore MLM Database from USB utility overwrites the existing MLM and DLM
databases with the versions previously saved on the USB device.

Notes: l Restoring the MLM database also restores the DLM database.

l You can also restore the MLM and DLM databases using an automatically generated
library configuration backup file (see Restore From an Auto Configuration Save File on
page 420).

1. Use your storage management software to stop all backup or restore operations on the
library.

IMPORTANT Restoring the MLM and DLM databases requires the library to be idle.
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2. If you plan to restore using an MLM database backup file that was sent as an email
attachment, use the following instructions to copy the file to a USB device; otherwise,
skip to Step 5.

a. Create a folder called SavedMLMDB at the root of a USB device.

b. Copy the xlminfo<date-time>.db or cminfo_<date-time>.zdt file to the
SavedMLMDB folder on the USB device.

3. Log into the library as a user with superuser or administrator privileges.

4. Stop any PreScan or PostScan operations that are currently running (see Stop the
Discovery Process on page 324 and Pause the PostScan Process on page 334).

5. Plug the USB device containing the MLM database backup file into a USB port on the
LCM or operator panel and allow time for the device to mount before continuing.

6. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

7. Select Utilities. The Utilities screen displays.

8. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

9. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

10.Scroll down and select Restore MLM Database from USB. The screen refreshes to show
the details for the utility.

Figure 244 Select the Restore MLM Database from USB
utility.

11.Use the Select a restore time stamp drop-down list to select the xlminfo<date-time>.db
or cminfo_<date-time>.zdt file containing the MLM database backup you want to use
for the restore.

12.Click Run Utility.
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After a brief delay, the Utility Results screen displays, showing that the database was
restored.

Note: After an MLM database restore, the Discover Media button on the Media Lifecycle
Management Tools screen (Maintenance > Media Lifecycle Management) may be active
even if all cartridges have been discovered.
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CHAPTER 13 - DRIVE TROUBLESHOOTING
This chapter describes procedures for dealing with the most common problems encountered
with the library’s drives. Try these troubleshooting procedures before you open a support ticket
with Spectra Logic Technical Support. If you are unable to resolve the problem yourself, open
a support ticket (see Opening a Support Ticket on page 536). For additional troubleshooting
information, refer to the drive documentation (see LTO Ultrium Tape Drives on page 21 and
TS11xx Technology Drives on page 21).

Note: The library must be under warranty or have a valid service contract in order to qualify for
support (see Service Contract Extension on page 563 to learn about service contracts).
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RESETTING A DRIVE

Overview

You may occasionally need to reset a drive as part of a firmware upgrade or for
troubleshooting.

IMPORTANT

Drives can be reset using the Reset button on the Drives screen or using the
Power Drive On/Off utility. This utility should ONLY be run on a drive that is
not assigned to a partition. Do not use the advanced Power Drive on/off
utility to reset a drive that is assigned to a partition. Running this utility on a
drive assigned to a partition will disable the host interface.

User Privilege Requirements

Only a user with superuser or administrator privileges can use the BlueScale software to reset
a drive.

Perform the Reset

The following steps describe how to reset a drive using the Reset button on the Drives screen.

1. Determine the BlueScale identifier for the drive you want to reset.

Note: Drives are identified according to their physical location in the library. For example,
FR1/DBA2/DRV4 refers to the upper right drive in DBA2 of frame 1. See Drive Identifiers on
page 71 for information about identifiers.

2. Log into the library as a user with superuser or administrator privileges.

3. Select Configuration > DLM (or Drives) to display the Drives screen.

Figure 245 Click Reset on the Drives screen.

4. Identify the drive that needs to be reset and click Reset. The library power cycles the
drive.
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When the drive completes its POST and becomes ready, a status screen displays,
showing that the drive was reset.

Note: When the drive resets, the library posts system messages that the drive disappeared and
reappeared.

5. The drive is ready for use.
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USING A GLOBAL SPARE DRIVE

Overview

The Global Spare option lets you remotely replace a failed drive using a drive that is already
installed in the library. Using a Global Spare allows you to continue your backup operations
and replace the failed drive the next time you are physically present at the library.

Usage Requirements

Before you can use the Global Spare option, the following requirements must be met.

• One or more Global Spare drives must already be configured in the partition where the
failed drive is located (see Assign Global Spare Drives on page 206).

IMPORTANT

The drives that are configured as Global Spares must be connected to the
same Fibre Channel arbitrated loop or fabric (SAN) as the drives they will
replace. If they are not connected to the SAN, they will not be accessible to
the application software.
After the Global Spare is activated, you may need to reconfigure your switch
to access the spare drive.

• The failed drive must be idle, with no pending backup or restore operations. Backups to
the other drives in the partition can continue.

Note: You cannot use a Global Spare drive to replace a failed drive while the library is actively
running the Drive Firmware Update wizard in the partition.

Cartridge Inventory

If the failed drive contains a cartridge when it is replaced by the Global Spare, that cartridge is
removed from the partition’s inventory. If you are able to remove the cartridge from the failed
drive after you remove it from the library, reimport the cartridge (see Importing into a Storage
or Cleaning Partition).

PostScan Requirements

If a partition is configured to use either FullScan or QuickScan using Global Spares, keep in
mind that the PostScan process “owns” the Global Spare drive it is using until it has processed
all of the cartridges in the PostScan queue for the partition. As a result, a Global Spare drive
that is being used for PostScan is not available for use as a spare.

If all of the Global Spare drives assigned to the partition are in use by the MLM PostScan
process, you must pause PostScan to make a Global Spare drive available, as described in
Pause the PostScan Process on page 334.
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Storage Management Software Guidelines

Keep in mind the following storage management software guidelines when using a Global
Spare.

• Backup Exec™ software running on a Windows server—After sparing or unsparing a
drive, you must restart the Backup Exec Device and Media Service for the software to
function properly with the spared drive.

• General guidelines—In a few rare cases, your backup may fail if a cartridge is loaded into
any of the other drives in the partition at the same time that the library is in the process of
activating a Global Spare drive for use (as described in this section). Most applications will
retry the backup operation, but some will fail it. If your backup operation fails, wait for the
library to complete the Global Spare activation and retry the backup.

User Privilege Requirements

Only a user with superuser or administrator privileges can activate or reclaim a Global Spare
drive.

Use the Global Spare Drive

Follow these steps to use a Global Spare drive as a temporary replacement for a failed drive.

1. If necessary, use your storage management software to stop any attempts to read from or
write to the failed drive. Refer to your storage management software documentation for
instructions.

2. Log into the library as a user with superuser or administrator privileges.

3. From the toolbar menu, select Configuration > Partitions to display the Shared Library
Services screen.
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Figure 246 Click Global Spare to begin the process of
replacing a partition drive with a Global Spare drive.

4. Click Global Spare for the partition that contains the failed drive to display the Global
Spare Usage screen.

Note: The Global Spare button is not present if one or more drives are not configured as Global
Spares for the partition (see Assign Global Spare Drives on page 206).

Figure 247 Click Use Spare for the drive you want to
replace.

5. Click Use Spare next to the drive for which you want to substitute an available Global
Spare drive. Wait for the library to complete the sparing operation.

Notes: l When you select the drive to replace, the BlueScale software disables the selected drive
and configures an available Global Spare drive to report the same WWN and serial
number as the drive it is replacing. The failed drive can then be removed and replaced
the next time you are physically at the library.
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l If you have more than one available Global Spare drive, the library automatically
selects a drive in no particular order.

6. If desired, select Configuration > DLM (or Drives) to view the Drives screen. The drive
icons on the screen change to indicate the failed drive and the Global Spare that replaced
it.

Figure 248 Check the Drives screen to confirm that the failed drive was
replaced by a Global Spare drive.

7. If necessary, use your storage management software to bring the Global Spare drive that
replaced the failed drive online. Refer to your storage management software
documentation for instructions.

IMPORTANT Replace the failed drive as soon as possible and reconfigure the spare drive to
return it to a Global Spare configuration.

Note: If your storage management software cannot access the Global Spare drive, confirm that the
drive is properly connected to the same SAN as the failed drive. You may also need to
reconfigure the Fibre Channel switch.

Undo the Global Spare Drive

After you physically replace the failed drive (see Replace a Drive on page 532), use the
following steps to begin using the replacement drive and return the Global Spare to the pool
of available spare drives.

1. Log into the library as a user with superuser or administrator privileges.
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2. Use your storage management software to prepare the Global Spare drive. Refer to your
storage management software documentation for information.

a. Stop all storage management software activity to the Global Spare drive that
replaced the failed drive.

b. If necessary, use your storage management software to eject the cartridge from the
drive and return it to its slot.

c. Take the Global Spare drive offline.

3. When the Global Spare drive is empty and offline, select
Configuration > Partitions on the toolbar menu to display the Shared Library Services
screen.

4. Click Global Spare for the partition that contained the failed drive to display the Global
Spare Usage screen.

Figure 249 Click Undo Spare to begin using the
replacement drive you installed.

5. Click Undo Spare next to the drive you physically replaced.

The BlueScale software stops substituting the Global Spare for the drive it replaced and
reconfigures the replacement drive back into the partition. The Global Spare is then
available to be used again, as needed.

6. Use your storage management software to bring the newly installed drive online and
resume backup operations. Refer to your storage management software documentation
for instructions.
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RETRIEVING A DRIVE TRACE OR DRIVE DUMP FILE
Spectra Logic uses drive traces and drive dumps to help diagnose problems with a drive. A
drive trace is a set of logs collected by the library to help diagnose drive errors. A drive dump
is a file generated by the drive when it encounters an error state. You only need to retrieve a
drive trace or drive dump when instructed to do so by Spectra Logic Technical Support.

There are three tools for collecting drive traces and dumps. The best tool to use depends on
the type of file requested and the ability to download and install ITDT.

• To retrieve a drive trace from LTO-5 and later generation drives , Use the Drive Traces
Button.

• To retrieve a drive dump, if possible, Use the IBM Tape Diagnostic Tool to Retrieve a Drive
Dump on page 440.

• To retrieve a drive dump when you cannot use ITDT, Use the BlueScale Retrieve Drive
Dump Utility on page 441.

Use the Drive Traces Button

Drive traces for LTO-5 and later generation drives can be generated and retrieved using the
Drive Traces button on the Drives screen.

Note: The Drive Traces button is not supported for TS11xx technology drives.

Before You Begin

Before you begin generating a drive trace using the Drive Traces button, make sure you fulfill
the following prerequisites.

Emailing Results

If you plan to email the drive trace file directly from the library, make sure that you have
already set up the intended email recipient as a mail user (see Configure Mail Users on
page 127).

Saving Results to a USB Device

If you plan to save the drive trace file to a USB device, you must plug the USB device into one
of the USB ports on the LCM or operator panel and allow time for the device to mount before
you click Drive Traces (see Using a USB Device on page 185).

Note: If a USB device is not connected, the option to save the drive trace file to a USB device is not
available. You can, however, still email the trace file or download the file.
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User Privilege Requirements

Only a user with superuser or administrator privileges can use the BlueScale software to
retrieve a drive trace file.

Generate the Trace

1. Log into the library as a user with superuser or administrator privileges.

2. If you plan to save the drive trace file to a USB device, plug the USB device into one of
the USB ports on the LCM or operator panel and allow time for the device to mount
before proceeding.

3. Select Configuration > DLM (or Drives) to display the Drives screen.

Figure 250 Click Drive Traces on the Drives screen.

4. Click Drive Traces. The Generate Drive Traces screen displays.

Figure 251 The Generate Drive Traces screen.
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5. Select what you want to do with the drive trace file.

Option Description

Mail results to Sends the drive trace file to a previously configured email recipient. Use
the drop-down list to select the recipient for the trace file.
Only previously configured email recipients are listed. To send the email
with the attached trace file to someone who is not listed, exit the utility,
configure that person as an email recipient (see Configure Mail Users on
page 127), and then run the utility again.
Note: Do not use the default autosupport@spectralogic.com email recipient.
Spectra Logic does not save emailed drive trace files unless they are specifically
requested for troubleshooting.

Save results to
USB

Saves the drive trace file to the USB device connected to the LCM.
Note: This option is only available if you connected a USB device in Step 2 on
page 439.

Save results to
local drive

Downloads the drive trace file to your local computer. Use your web
browser’s download features to save the file.
Note: This option is only available if you are accessing the library through the
BlueScale web interface.

6. Select the drives from which you want to generate traces. The drive trace file will contain
a subdirectory for each drive.

7. Click Go. The wizard generates the traces and saves or sends the drive trace file as
selected.

Use the IBM Tape Diagnostic Tool to Retrieve a Drive Dump
Download ITDT and its related documentation directly from IBM's Fix Central website. For
information about navigating IBM's website and downloading the version of ITDT that is
appropriate for your operating system, log on to the portal (see Accessing the Technical
Support Portal on page 534), open the Knowledge Base, and search for KBA-01768,
Downloading and installing ITDT (IBM Tape Diagnostic Tool).

IMPORTANT Use the latest version of ITDT to gather a drive dump from the latest
generation of drives.

1. Log into IBM’s Fix Central website at ibm.com/support/fixcentral using your individual
IBM ID.

2. Select the following options:

• Product Group = System Storage
• Select from System Storage = Tape systems
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• Select from Tape Systems = Tape drivers and software
• Select from Tape drivers and software = IBM Tape Diagnostic Tool (ITDT)
• Platform = Select your operating system from the drop-down list and click Continue.

3. On the next page, select the version of ITDT that you want to download. If desired, you
can select multiple versions.

Note: If you are unsure which version to select, click Show Fix Details to see additional information.

4. Click Continue. Choose one of the following methods to download the selected ITDT
installation files:

• Download using your browser (HTTP)

• Download using bulk FTP

• Download using Download Director

5. Download and read the ITDT documentation for assistance in using and setting up the
program.

6. Refer to the ITDT documentation for information about using ITDT to retrieve drive
dump files. Contact Spectra Logic Technical Support if you need assistance (see
Contacting Spectra Logic on page 18).

Use the BlueScale Retrieve Drive Dump Utility

If for some reason you cannot install and use ITDT in your environment, use the BlueScale
Retrieve Drive Dump utility to collect the dump file from a drive.

Before You Begin

Before you begin the utility, make sure you fulfill the following prerequisites.

Insert USB Device

This utility saves the drive dump file to a USB device connected to the LCM or operator panel.
You must connect the USB device and allow time for it to mount before you access the Utilities
screen (see Using a USB Device on page 185).

User Privilege Requirements

Only a user with superuser or administrator privileges can use the BlueScale software to
retrieve a drive dump file.

Run the Utility

1. Determine the BlueScale identifier for the drive from which you want to retrieve the
dump file.
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Note: Drives are identified according to their physical location in the library. For example:
FR1/DBA2/DRV4 refers to the upper right drive in DBA2 of frame 1. Refer to Drive Identifiers on
page 71 for information about identifiers.

2. Log into the library as a user with superuser or administrator privileges.

3. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

4. Select Utilities. The Utilities screen displays.

5. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

6. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

7. Scroll through the list of advanced utilities and select Retrieve Drive Dump. The screen
refreshes to show the details for the utility.

Figure 252 The Retrieve Drive Dump utility.

8. Select any combination of the check boxes at the top of the screen to choose where to
send the utility results text.

Note: The check boxes indicate where to send the utility results text (pass or fail), not where to send
the drive dump file. The drive dump file is always saved to the USB device. Do not send the
utility results to the default autosupport@spectralogic.com email recipient.

9. Use the drop-down list to select the drive from which you want to retrieve the dump.

10.Click Run Utility to retrieve the dump file from the selected drive.

IMPORTANT Do not use the drive from which you are retrieving the dump file for any
other purpose while the utility runs.

When the dump is saved, the Utility Results screen displays, showing that the utility ran
successfully.
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TROUBLESHOOTING DRIVES

The following sections provide information about troubleshooting drive problems.

Identify the Problem

1. When you encounter problems with drive operation while using the library’s BlueScale
user interface, begin troubleshooting by checking the following:

Check... To...

System messages Review any system messages that have been posted by the library (see
Check and Respond to Messages on page 167) and take any action
described in the message(s).

Error sense codes Look up the definition of an error sense code referenced in a system
message using the Spectra Tape Libraries SCSI Developer Guide.

Drive
documentation

Find detailed troubleshooting information for the drive. See Additional
Publications on page 20 for information about obtaining drive
documentation.

Technical Support
Portal

Find information about the most current version of BlueScale software and
additional service and support tools. You can access the Technical Support portal
at support.spectralogic.com.
Note: Accessing many of the tools available on the Technical Support portal
requires creating a user account. See Accessing the Technical Support Portal on
page 534 for instructions.

• Check the options under the Documentation and Knowledge Base
menus for additional troubleshooting information.

• Check the Service & Contracts menu to view information about the
warranty and service options available for your library as well as the
Spectra Certified Media warranty.

2. Display the Drive Details screen for the drive you suspect is having problems and review
the information about the drive (see View Drive Status Information on page 173). Use the
following table and the information in Interpret the Detailed Drive Information on
page 445 to determine how to proceed.

Detail Field Description

POST Status Indicates whether the drive successfully completed its power-on self-tests
(POST).
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Detail Field Description

When an LTO or TS11xx technology drive is power-cycled or reset, it
automatically runs self-diagnostic tests (POST), which check the drive’s
memory and sensors, performs motor and servo tests, and tests the data
channels, to make sure that the drive is functioning within normal
parameters.

Cleaning Status Indicates whether the drive requires cleaning (see Cleaning a Drive on
page 499).

LED Status Corresponds to the status LED on the drive. See Interpreting the Status
LED Information on page 446 for detailed information.

Display Character
or Display
Message

Corresponds to the single-character display (SCD) on an LTO drive or the
display message (MCD) on a TS11xx technology drive. See Interpreting the
SCD and MCD Codes, beginning on on page 447 for detailed information.

Cartridge Status Indicates whether a cartridge is currently loaded in the drive, tape motion,
and other information related to reading and writing data.

3. If you have successfully operated the storage management software and library in the
past, but are now experiencing problems reading and writing data, check the following:

Check this... If...

Write-protect
switch setting

You are having trouble writing data to a cartridge. Make sure that the
cartridge is write-enabled (see Preparing Cartridges for Use on page 239)
before importing it into the library.

Cartridge age A tape cartridge has been in use for a long time or if it has been used
frequently, try using a new cartridge.

Drive cleaning The drive indicates that a cleaning is required. Follow the instructions in
Cleaning a Drive on page 499 to clean the drive.

Note: If the storage partition is associated with a cleaning partition and the
cleaning partition contains a usable cleaning cartridge, drives are automatically
cleaned whenever necessary.

4. If you experience problems accessing the drives in the library from the storage
management software on the host, check the following:

Check... To...

Interface
connections

Make sure that the SAS or Fibre Channel connections to the drives are
secure.
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Check... To...

IMPORTANT After you power on the library and the Fibre Channel arbitrated
loop or fabric completes its initialization, avoid disconnecting the Fibre
Channel drives from the network. If you need to disconnect a drive from
the network, use the utility provided with your switch or hub to bypass the
affected ports before breaking the connection. The bypass sets the port to
a non-participating state on the network. After you reconnect the drive to

the library, use the utility to return the port to a participating state.

Software
installation

Make sure that your host application is installed and configured correctly
(refer to your software documentation). Pay special attention to steps that
describe how to configure the software for use with the drive(s).

Drive addressing Make sure that the drive address configured in the host application is the
same one you specified when you configured the partition containing the
drive (see Creating a Storage Partition on page 199).

Host and software
requirements

Determine whether a device driver is required. Some operating
environments require you to install device drivers before the application
software can correctly communicate with the drives. When you update the
drive firmware, you may also need to update the device driver for the
drive. See Updating Drive Device Drivers on page 529 for instructions.

Interpret the Detailed Drive Information

The Drive Details screen includes information about the drive and drive sled firmware
versions, the location-based Spectra serial number, and the manufacturer’s serial number. It
also shows additional detailed status information, including the state of the status LED and
the single-character display (SCD) for an LTO drive or the display message (MCD) for a
TS11xx technology drive. See View Drive Status Information on page 173 for information
about accessing this screen.
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Figure 253 Use the information on the Drive Details screen
to help troubleshoot drive problems.

The following sections describe how to use information on the Drive Details screen to help
troubleshoot drive problems.

Responding to the Drive Cleaning Notification

Whenever a tape is loaded or unloaded, the read/write heads are physically cleaned by a
brush located within the drive. However, after reading and writing a large amount of data (the
exact amount varies by drive type and generation) or if read or write errors occur, the drive
requests to be cleaned with a cleaning cartridge. The request is made by sending a Tape Alert
message to the host, and displaying a C on the SCD for an LTO drive or CLEAN* on the MCD
for a TS11xx technology drive. The notification is also posted to the library’s Drive Details
screen (Figure 253) and the DLM drive health icon for the drive changes to yellow (see Using
the Drive Health Icons on page 356 for additional information).

If needed, clean the drive as described in Cleaning a Drive on page 499. Use only a certified
cleaning cartridge. To order cleaning cartridges, see Media and Media Accessories on
page 560.

Interpreting the Status LED Information

The Drive Details screen shows the state of the drive’s status LED. The LED states are the
same for all generations of drives. Refer to the tape drive documentation about interpreting
the LED (see LTO Ultrium Tape Drives on page 21 or TS11xx Technology Drives on page 21).
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Notes: l The LED status information shown on the Drive Details screen always indicates that the
LED is off for LTO-4 Fibre Channel drives running firmware version 8940 or later, all
firmware versions for LTO-5 and later generation Fibre Channel drives, and all firmware
versions for TS11xx technology drives. If you need to determine the state of the LED,
use the IBM Tape Diagnostic Tool (ITDT). Download and install the software as
described in Use the IBM Tape Diagnostic Tool to Retrieve a Drive Dump on page 440.

l Make sure you install ITDT on a computer that is connected to the same SAN as the
drives in the library.

l For TS11xx technology drives, use the MCD to determine the status of the drive (see
Interpreting the SCD and MCD Codes).

Contact Spectra Logic Technical Support if you need assistance (see Contacting Spectra Logic
on page 18).

Interpreting the SCD and MCD Codes

Overview

The Drive Details screen displays the state of the single-character display (SCD) on LTO drives
(see LTO SCD Codes) or the display message (MCD) on TS11xx technology drives (see TS11xx
Technology MCD Codes on page 456).

Figure 254 An LTO drive’s SCD information on the Drive
Details screen.
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Permanent Errors

If the drive detects a permanent error and displays an SCD or MCD error code other than zero
(0), it automatically performs a drive dump. If you force a drive dump, the existing drive
dump will be overwritten and data will be lost. You might also lose the dump data if you turn
off power to the drive. See Retrieving a Drive Trace or Drive Dump File on page 438 for
information about retrieving the trace data or dump from the drive.

Notes: l Some of the solutions listed in the following table include testing the drive. See Using
DLM to Test a Drive on page 462 for instructions.

l In some cases, additional tests using ITDT are required. Download and install the
software as described in Use the IBM Tape Diagnostic Tool to Retrieve a Drive Dump on
page 440. Refer to the ITDT documentation for information about using this utility.
Contact Spectra Logic Technical Support if you need assistance (see Contacting
Spectra Logic on page 18).

Multiple Errors

The SCD or MCD is blank during normal operation. If multiple errors occur, the code with
highest priority (lowest number) displays first. Once corrected, the code with the next highest
priority displays, until none remain.

Note: The drive may need to be reset in order to clear the error code.

WORM Media

The drives supported by the library support using WORM media. To learn more about WORM
media, see WORM Media on page 601.

The following conditions cause WORM media errors to occur:

• Information in the servo manufacturer’s word on the tape must match information from
the cartridge MAM. If it does not match, the drive’s SCD displays error code 7.

• Inserting a WORM tape cartridge into a drive that is not compatible with WORM media
causes the cartridge to be treated as an unsupported medium. The drive’s SCD displays
error code 7.

LTO SCD Codes

SCD Code Descriptions for LTO Drives

The following table shows the SCD codes and, where applicable the associated DLM Drive
Health icon, for LTO drives supported by the library. See the table on on page 357 for a
description of what the Drive Health icons indicate. For TS11xx technology MCD codes, see
TS11xx Technology MCD Codes on page 456.

Note: The single-character display does not use the characters B, D, G, I, O and Z to prevent
misinterpretation as the characters 8, 0, 6, 2, and 1.
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Cause and Solution

0 No error occurred. No action is required.

The power was cycled or diagnostics have finished with no errors.

1 Cooling problem.

The recommended operating temperature was exceeded. Perform one
or more of the following:

• Make sure that the cooling fan is rotating and is quiet.
• Remove any blockage that prevents air from flowing freely through
the drive.

• Make sure that the operating temperature and airflow is within the
specified range (refer to the tape drive documentation for these
specifications).

If the operating temperature is within the specified range and the
problem persists, contact Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18).

Note: The error code clears when you reset or power cycle the drive or
when you place it in maintenance mode.

2 Power problem.

The externally supplied power is approaching the specified voltage
limits (the drive is still operating) or is outside the specified voltage
limits (the drive is not operating).

If the problem is only exhibited by one drive in the library:

• Make sure that the library’s power connector is properly seated.
• If the problem persists, contact Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18).

Note: The error code clears when you reset or power cycle the drive or
when you place it in maintenance mode.
If the problem is exhibited by multiple drives in the library:

The power throughout the library needs to be checked. Contact
Spectra Logic Technical Support for assistance (see Contacting Spectra
Logic on page 18).

3 Firmware problem.

IMPORTANT Do not force a dump; one already exists.

The drive determined that a firmware error occurred. Perform the
following:
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1. If possible, use ITDT to collect the existing drive dump (see Use
the IBM Tape Diagnostic Tool to Retrieve a Drive Dump on
page 440).

If you cannot use ITDT, use the BlueScale Retrieve Drive Dump
utility (see Use the BlueScale Retrieve Drive Dump Utility on
page 441).

2. Reset the drive (see Resetting a Drive on page 431), then retry
the operation that produced the error.

3. If the problem persists, contact Spectra Logic Technical Support
and send the drive dump to them, if requested (see Contacting
Spectra Logic on page 18).

Note: The error code clears when you reset or power cycle the drive or
when you place it in maintenance mode.

4 Firmware or drive problem.

IMPORTANT Do not force a dump; one already exists.

A firmware or drive hardware failure occurred. Perform the
following:

1. If possible, use ITDT to collect the existing drive dump (see Use
the IBM Tape Diagnostic Tool to Retrieve a Drive Dump on
page 440).

If you cannot use ITDT, use the BlueScale Retrieve Drive Dump
utility (see Use the BlueScale Retrieve Drive Dump Utility on
page 441).

2. Reset the drive (see Resetting a Drive on page 431), then retry
the operation that produced the error.

3. If the problem persists, contact Spectra Logic Technical Support
and send the drive dump to them, if requested (see Contacting
Spectra Logic on page 18).

Note: The error code clears when you reset or power cycle the drive or
when you place it in maintenance mode.

5 Drive hardware problem.

IMPORTANT Do not force a dump; one already exists.

JUNE 2025 450 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 13 - DRIVE TROUBLESHOOTING



Code
DLM
Health
Icon

Cause and Solution

The drive determined that a tape path or read/write error occurred. To
prevent damage to the drive or tape cartridge, the drive does not
allow you to insert a cartridge if the current cartridge was successfully
ejected. Perform the following:

1. If possible, use ITDT to collect the existing drive dump (see Use
the IBM Tape Diagnostic Tool to Retrieve a Drive Dump on
page 440).

If you cannot use ITDT, use the BlueScale Retrieve Drive Dump
utility (see Use the BlueScale Retrieve Drive Dump Utility on
page 441).

2. Reset the drive (see Resetting a Drive on page 431), then retry
the operation that produced the error.

3. If the problem persists, contact Spectra Logic Technical Support
and send the drive dump to them, if requested (see Contacting
Spectra Logic on page 18).

Note: The error code clears when you reset or power cycle the drive or
when you place it in maintenance mode.

6 Drive or media error.

See Configuring and Using Media Lifecycle Management on page 301
for information about using MLM to determine the health of the
cartridge. See Using Drive Lifecycle Management on page 352 for
information about using DLM to determine the health of the drive.

The drive determined that an error occurred, but it cannot isolate the
cause. Ensure the tape cartridge is the correct media type:

• See LTO Read/Write Compatibility on page 600 for information
about which media is compatible with each LTO drive generation.

• Drive will not accept an expired cleaning cartridge.
• Drive will not accept a WORM cartridge when running diagnostic
tests in Maintenance Mode.

• Drive will not write over existing data sets on a WORM cartridge.
Ensure you are appending data sets on WORM media rather than
attempting to write over existing data sets.

Confirm that the cartridge is the correct media type. If it is, determine
whether the problem is associated with writing or reading data to a
single cartridge or multiple cartridges.
Problems Writing Data on a Cartridge with a Known Volume Serial
Number
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Retry the operation with a different cartridge.

• If the operation succeeds, the original cartridge was defective. If
possible, copy data from the defective cartridge and set the original
cartridge aside. If additional tests confirm that the cartridge was the
source of the error, you can discard it.

• If the operation fails and another drive is available, insert the
original cartridge into the other drive and retry the operation.
• If the operation fails, discard the defective cartridge.
• If the operation succeeds, use the Drive Health Verification
wizard to test the original drive (see Using DLM to Test a Drive
on page 462).

• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support (see Contacting Spectra Logic on page 18).

• If the drive passes the DLM drive test, the error was temporary.
• If the operation fails and another drive is not available, use the
Drive Health Verification wizard to test the drive.
• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support.

• If the drive passes the DLM drive test, retry the operation to
determine whether the error was temporary. If the operation fails
again, discard the cartridge.

6 (cont.) Problems Reading Data on a Cartridge with a Known Volume Serial
Number
Perform one of the following procedures:

• If another drive is available, insert the cartridge into the other drive
and retry the operation.
• If the operation fails, discard the defective cartridge.
• If the operation succeeds, use the Drive Health Verification
wizard to test the original drive (see Using DLM to Test a Drive
on page 462).

• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support (see Contacting Spectra Logic on page 18).

• If the diagnostics succeed, the error was temporary.
• If another drive is not available, use the Drive Health Verification
wizard to test the drive.
• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support.
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• If the drive passes the DLM drive test, retry the operation to
determine whether the error was temporary. If the operation fails
again, discard the cartridge.

Problems with One or More Cartridges with Unknown Volume Serial
Numbers
If the problem occurs with multiple tape cartridges or if you do not
know the tape cartridge’s volume serial number, use the Drive Health
Verification wizard to test the drive (see Using DLM to Test a Drive on
page 462).

• If the drive fails the DLM drive test, contact Spectra Logic Technical
Support (see Contacting Spectra Logic on page 18).

• If the drive passes the DLM drive test, the problem is not related to
the drive.

7 High probability of media error. An error occurred because of a
faulty tape cartridge.

• Ensure the tape cartridge is the correct media type:
• See LTO Read/Write Compatibility on page 600 for information
about which media is compatible with each LTO drive generation.

• Drive will not accept an expired cleaning cartridge.
• Drive will not accept a WORM cartridge when running diagnostic
tests in Maintenance Mode.

• Drive will not write over existing data sets on a WORM cartridge.
Ensure you are appending data sets on WORM media rather than
attempting to write over existing data sets.

• If another drive is available, insert the cartridge into the other drive
and retry the operation.
• If the operation fails, discard the defective cartridge.
• If the operation succeeds, use the Drive Health Verification
wizard to test the original drive (see Using DLM to Test a Drive
on page 462).

• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support (see Contacting Spectra Logic on page 18).

• If the diagnostics succeed, the error was temporary.
• If another drive is not available, use the Drive Health Verification
wizard to test the drive.
• If the drive fails the DLM drive test, contact Spectra Logic
Technical Support.
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• If the drive passes the DLM drive test, retry the operation to
determine whether the error was temporary. If the operation fails
again, discard the cartridge.

Note: The error code clears when you reset of power cycle the drive or
when you place it in maintenance mode.

8 SCSI interface or Fibre Channel failure.

A failure occurred in the drive hardware or in the SCSI bus. The error
code clears after 10 seconds if the error does not recur. If the error
persists, contact Spectra Logic Technical Support (see Contacting
Spectra Logic on page 18).

9 RS-422 error.

The drive determined that a drive interface or library interface failure
occurred. The error code clears after 10 seconds if the error does not
recur. If the error persists, contact Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18).

A Degraded operation.

The drive determined that a problem occurred that degraded the
operation of the drive, but it did not restrict continued use.

The drive is usable, though the single-character display (SCD)
continues to indicate an error and the status light flashes amber. The
error code may clear when you cycle power to the drive.

1. Reset the drive (see Resetting a Drive on page 431) to clear the
error code.

2. Confirm that the drive is using the current firmware version (see
Updating Drive Firmware on page 506) and update the firmware
if necessary.

3. Use the Drive Health Verification wizard to test the drive (see
Using DLM to Test a Drive on page 462).

4. If the problem persists, contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

C Cleaning indicator.

The drive needs to be cleaned, or is in the process of loading the
cleaning cartridge or being cleaned. The error code clears when you
clean the drive and unload the cleaning cartridge. See Cleaning a
Drive on page 499 for instructions.
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d Two drives on the Fibre Channel loop have the same Arbitrated Loop
Physical Address.

E The Fibre Channel port connection is off-line.

e The drive detected a configuration error during an encryption
operation.

1. Make sure that you are using LTO-4 or later generation data
cartridges. Encryption is only supported for LTO-4 and later
generation cartridges.

2. Retry the encryption operation with the suspect cartridge in
another encryption enabled drive.

3. Replace the cartridge if you see the same problem in multiple
drives.

F Drive Fiber Cable error.

The Fibre Channel drive does not detect light or a related diagnostic
failed to detect light through the fiber optic connection to the drive.

• Verify the fiber cables and connections between the drive and the
host are the correct type and are working properly. Verify all
equipment and devices are powered ON.

• Verify the configuration settings for the drive are set correctly and
are compatible with the topology of the network.

• Verify that the host fiber adapter and port are working properly and
are compatible with the topology of the network.

• Verify that the Fibre Channel switch ports are working properly and
are compatible with the topology of the network.

• Verify that the fiber cable is connected to Port A (0) of the drive.
• Verify that Port A (0) on the Fibre Channel drive is working
properly by using ITDT to run the “Function Code 6: Run Host
Interface Wrap Test.”

J Incompatible Media.
The drive determined that incompatible media has been loaded into
the drive.

P The cartridge in the drive is write-protected. The storage management
software cannot write data to a write-protected cartridge. The library
cannot update the cartridge MAM when the cartridge is write-
protected.
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u Firmware update is in progress.

b, c, H,
h, n, o

N/A Reserved or not actively in use, or no error or message assigned.

There may be a problem with the SCD. Reset the drive and determine
whether all segments on the SCD are lit.

• If they are all lit, confirm that the drive is using the current firmware
version (see Updating Drive Firmware on page 506) and update the
firmware if necessary.

• If the problem persists, contact Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18).

… N/A The message display has lost communication with the drive. This
message appears on Line 2 of the message display. The three dots may
occasionally display during normal processing.

TS11xx Technology MCD Codes

MCD Code Descriptions for TS11xx Technology Drives

A variety of messages that indicate the current drive status can be displayed on the drive’s 8-
character panel. In the case of an error, a Failure ID message is displayed. A Failure ID has the
format FIDx yy, where x indicates the severity of the failure and yy indicates the error code.
The following tables shows the status codes for TS11xx technology drives. The table on on
page 458 shows the Failure ID Code descriptions for these drives.

Status Code Description

<blank> The following are possible reasons for the display to be blank:

• The drive is not powered on
• The drive is ready
• There is no status
• No cartridge is mounted

<all 8 elements fully
lit>

The reset/power-on process is in progress. The diagnostic test is
verifying that all elements are working.

AJAR*
(TS1140 and some
TS1150 drives only)

A cartridge is in the opening of the drive and is not in a loadable
position, or if no cartridge or other obstruction is in the drive, the
sensor may not be functioning correctly, and the hardware may be
defective. If no cartridge or other obstruction is in the drive, contact
Spectra Logic Technical Support.
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If you cannot insert a tape cartridge in the drive, perform the following
steps:

1. Make sure that you have the proper cartridge type.

2. Inspect the tape cartridge for damage.

3. Make sure that there is no other cartridge already in the drive.

4. Try to load another cartridge into the drive. Use a scratch
cartridge to avoid possible damage to a data cartridge.

If the new cartridge can be inserted in the drive, the original
cartridge may be defective. Inspect the cartridge again for
damage.

If the cartridge is not damaged but it cannot be inserted, contact
Spectra Logic Technical Support (see Contacting Spectra Logic on
page 18).

CLEAN* Drive cleaning is in progress.

CODELOAD Microcode is being loaded. This process takes a few minutes. The drive
should not be powered off or reset during this process.

DIAGS* Diagnostics are running.

EMPTY* There is no cartridge in the opening of the drive. Alternatively, if a
cartridge is in the drive, the sensor may not be functioning correctly,
and the hardware may be defective. If a cartridge is present in the
drive, contact Spectra Logic Technical Support (see Contacting Spectra
Logic on page 18).

ERASE* Data erase is in progress.

LOAD* A load is complete. The cartridge is at the load point.

LOCATE* A locate is in progress.

MIDTAPE* The drive was reset or powered on with a tape loaded, and is in the
process of bringing the drive and tape to a recovered state. This process
may take up to 15 minutes.

NEW CODE Codeload has completed. The drive is in process of resetting to apply the
new code.

READ* A data read is in progress.

READY* The drive is in ready state. (The panel can also be blank in ready state)
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RESET* and RESET!!! The drive is in the process of resetting.

REWIND* A rewind operation is in progress.

UNLOAD* An unload has been requested, or is in progress.

@UNLOAD* An unload is complete, the cartridge is in the unloaded position.

Note: The display will go blank when the cartridge is removed.

WRITE* A data write is in progress.

The following table lists the Failure ID codes for the TS11xx technology drives.

Failure ID Code Description Action

5F A function was
attempted which is
prohibited due to the
current security settings.

This code is not related to a drive or
microcode problem. It is related to the
operating environment and requires
additional investigation. Contact Spectra
Logic Technical Support (see Contacting
Spectra Logic on page 18).

81- 85 Drive problem. Perform the following:

1. If possible, use ITDT to collect a drive
dump file (see Use the IBM Tape
Diagnostic Tool to Retrieve a Drive
Dump on page 440).

If you cannot use ITDT, use the
BlueScale user interface to collect a
drive trace file (see Use the Drive
Traces Button on page 438).

2. Reset the drive (see Resetting a Drive on
page 431), then retry the operation that
produced the error.

3. If the problem persists, contact Spectra
Logic Technical Support and send the
drive trace file to them, if requested (see
Contacting Spectra Logic on page 18).

Note: The error code clears when you reset or
power cycle the drive.
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86 Cartridge or drive
problem.

See Failure ID code FE on the next page.

87 Cartridge problem. See Failure ID code FE on the next page.

8A Drive performance
problem.

Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

90 Drive problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

9C Hardware or
configuration problem.

Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

AA, AB, AC, AD Configuration problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

AE, AF Hardware problem. Contact Spectra Logic Technical Support

(see Contacting Spectra Logic on page 18).

BF Hardware problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

C1 Drive problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

D8 Drive problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

E4 Drive problem. Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

E5, E6 Drive or microcode
problem.

Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

ED Informational message. A microcode dump exists in flash memory.
Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

F2, F4 Cartridge or Drive
problem.

Contact Spectra Logic Technical Support
(see Contacting Spectra Logic on page 18).

F5 Fibre Channel error. • Verify that the fiber cables and the
connections between the drive and the host
are the correct type and are working
properly. Verify that all equipment and
devices are powered ON.
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• Verify that the configuration settings for the
drive are set correctly and are compatible
with the Fibre Channel topology being
used.

• Verify that the host fiber adapter and port
are working properly and are compatible
with the Fibre Channel topology being
used.

• Verify that the Fibre Channel switch ports
are working properly and are compatible
with the Fibre Channel topology being
used.

• Verify that the fiber cable is connected to
Port A (0) of the drive.

F6 The drive needs to be
cleaned.

See Cleaning a Drive on page 499 for
instructions.

F7 Fibre wrap test failure. Contact Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18).

FE Cartridge or drive
problem.

Verify that the tape is the correct media type.
If the tape cartridge is the correct media type,
perform the following action:

Problems Writing Data on a Cartridge with a
Known Barcode
Retry the operation with a different cartridge.

• If the operation succeeds, the original
cartridge was defective. If possible, copy
data from the defective cartridge and set it
aside. If additional tests confirm that the
cartridge was the source of the error, you
can discard it.

• If the operation fails and another drive is
available, insert the original cartridge into
the other drive and retry the operation.
• If the operation fails, discard the
defective cartridge.

• If the operation passes, contact Spectra
Logic Technical Support.

• If the operation fails and another drive is
not available, contact Spectra Logic
Technical Support.
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Problems Reading Data on a Cartridge with a
Known Barcode
Perform one of the following procedures:

• If another drive is available, insert the
cartridge into the other drive and retry the
operation.
• If the operation fails, discard the
defective cartridge.

• If the operation succeeds, contact Spectra
Logic Technical Support.

• If another drive is not available, contact
Spectra Logic Technical Support.

Problems with One or More Cartridges with
Unknown Barcode
If the problem occurs with multiple tape
cartridges or if you do not know the tape
barcode, contact Spectra Logic Technical
Support (see Contacting Spectra Logic on
page 18).

FF Operator procedure or
host problem.

This error code is presented for an invalid or
unsupported SCSI command or parameter. It
is a SCSI application program software
problem. Sense data exists at the host.
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USING DLM TO TEST A DRIVE

Overview

BlueScale Drive Lifecycle Management (DLM) lets you monitor the DLM health information of
each drive in the library and helps you identify drives that experience a high number of errors
or other problems during operation. See Using Drive Lifecycle Management on page 352 for
detailed information about using DLM to monitor the health of drives.

If you suspect that a drive is experiencing problems or if the Drive Lifecycle Management
report indicates that a drive is experiencing repeated errors, you can use the DLM Drive
Health Verification wizard to test the drive. This test, when used in conjunction with other
DLM data and MLM data, can help you determine whether a drive or the media is the source
of the errors you are investigating.

Note: The DLM Drive Health Verification test takes approximately 15 minutes to complete.

Requirements for Using the Wizard

Before you can run the DLM Drive Health Verification wizard, the following requirements
must be met:

• The drive must not contain a cartridge.

• A scratch tape must be available in the partition’s entry/exit pool. The scratch tape must
have the following qualities:
• It must be the same media type and generation as the drive being tested.

• It must have a cartridge health of Good (green) for an MLM-enabled cartridge or Usable
for a cartridge that is not MLM-enabled.

• It must have a barcode label.

• If the scratch cartridge is encrypted with BlueScale encryption, the key must be stored
in the library

CAUTION Make sure that the scratch tape does not contain data that you need to retain.
The test process overwrites all data on the tape.

IMPORTANT The test will fail if the scratch tape does not meet the conditions listed above.

Note: If the cartridge health is unknown (that is, it is not currently listed in the library’s MLM
database), the library loads the cartridge into a drive to determine the health before
beginning the test.
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• If a cleaning partition is associated with the partition containing the drive, make sure the
cleaning partition contains a cleaning cartridge with Good (green) or Usable health. You
can use MLM to determine the health of the cleaning cartridges currently in the cleaning
partition (see Generate MLM Reports on page 336). If necessary, import a known good
cleaning cartridge into the cleaning partition (see Importing into a Storage or Cleaning
Partition on page 246).

If the partition does not use a cleaning partition, a cleaning cartridge with Good or Usable
health must be in the partition’s entry/exit pool. Import a known good cleaning cartridge
into the entry/exit pool (see Importing into a Storage or Cleaning Partition on page 246).

IMPORTANT
When importing a cleaning cartridge into the partition’s entry/exit pool, it
must be in a regular TeraPack magazine; it cannot be in a Maintenance
TeraPack magazine.

Notes: l Both the scratch tape and the cleaning cartridge can be imported into the entry/exit
pool in the same magazine.

l The test will fail if the cleaning cartridge health is not Good or Usable.

l The cleaning cartridge must have a barcode label.

l If the entry/exit pool contains only one chamber, both the cleaning cartridge and the
scratch cartridge must be in the same magazine.

• Only a user with superuser or administrator privileges can perform a DLM Drive Health
test. See Understanding User Groups and Security on page 106 for information about the
three types of user groups and what types of privileges each has.

Run the DLM Drive Health Verification Wizard

Use the following steps to launch the DLM Drive Health Verification wizard.

1. Log into the library as a user with superuser or administrative privileges.

2. If necessary, import a scratch tape and a cleaning cartridge into the library (see
Requirements for Using the Wizard on the previous page).

3. From the toolbar menu, select Configuration > DLM to display the Drives screen.

Note: The Test button is not present if DLM is not enabled.
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Figure 255 Click Test on the Drives screen to launch the
wizard.

4. Click Test next to the drive you want to test to start the DLM Drive Health Verification
wizard.

The wizard determines whether all of the requirements for the test have been met.

All Requirements Met

If all of the requirements for performing the test have been met, the Drive Health
Verification screen displays a warning about the upcoming test process. Proceed to Step
5.

Figure 256 Click Next on the Drive Health Verification
screen to begin the verification process.

Requirements Not Met

If one or more requirement needs attention, the Drive Health Verification screen displays
information about what needs to be done.

JUNE 2025 464 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 13 - DRIVE TROUBLESHOOTING



Figure 257 Address all of the requirements on the Drive
Health Verification screen.

Note: If you are accessing the library remotely using the BlueScale web interface and either the
scratch cartridge or the cleaning cartridge is not available, then Cancel is the only option
available.

Use the following steps to address the requirements listed on the Drive Health
Verification screen.

a. Click Move or Import/Export, as required, to move a cartridge out of the drive or
import a scratch cartridge and a cleaning cartridge into the partition.

b. After you complete the necessary actions, begin the entire process again, starting
with Step 3 on page 463.

c. When all of the requirements have been met, proceed to Step 5.

5. Click Next to display the DLM Select Scratch Cartridge screen.

6. On the DLM Select Scratch Cartridge screen, select the scratch cartridge you want to use
for the test.

Note: Only data cartridges located in the partition’s entry/exit pool are listed and available for
selection.

CAUTION
If the entry/exit pool contains multiple data cartridges, make sure that you
select a cartridge that does not contain data that you want to retain. The test
process overwrites all data on the tape.
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Figure 258 The DLM Select Scratch Cartridge screen.

7. Click Next to begin the automatic test process. A series of status screens lets you know
how the test is progressing. The test process requires approximately 15 minutes to
complete.

8. When the test is complete, review the DLM Test Results screen to determine the outcome
of the test and respond as required.

• If the drive passes the test, the drive health is set to Good (green). You can continue
using the drive.

Figure 259 The DLM Test Results screen (test successful).

• If the drive fails the test, the drive health is set to Poor (red). Contact Spectra Logic for
assistance (see Contacting Spectra Logic on page 18).

Figure 260 The DLM Test Results screen (test failed).

9. Click Continue to return to the Drives screen.
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CHAPTER 14 - MAINTAINING THE LIBRARY
This chapter describes the common maintenance tasks for the Spectra
TFinity library. See Maintaining the Drives on page 498 for detailed information about
maintaining the library’s drives.

IMPORTANT Contact Spectra Logic Technical Support before making any changes to your
library hardware or performing any maintenance operations.

Updating, Servicing, or Moving the Library 468
Renewing the BlueScale Software Support Key 469
Updating the BlueScale Software and Library Firmware 471

Check the Library BlueScale Software Version 472

Check Component Firmware Versions (Optional) 473

Check the Currently Released BlueScale Version 475

Download the BlueScale Package 475

Prepare for the BlueScale Package Update 476

Install the Update Package 477

Manage Update Packages 489

Replacing the Air Filter 491
Installing Cord Locks 495
Calibrating the Touch Screen 497
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UPDATING, SERVICING, OR MOVING THE LIBRARY
Contact Spectra Logic Technical Support before making any changes to your library hardware
or performing any service operations.

Installing Additional Drives

Installing an additional drive into a partially filled DBA causes the library to reassign element
addresses. To avoid errors, reconfigure your storage management software after adding a new
drive (refer to your software documentation for instructions).

Servicing the Library

In the event that it is necessary to replace a component, make sure that you have instructions
for performing the procedure and you either:

• Are instructed to do so by Spectra Logic Technical Support,

—OR—
• Have a support contract such as Assisted Self-Maintenance (ASM).

Moving the Library

The library hardware is configured to ensure proper thermal control, air flow, and dust
filtering. After the library is installed, do not move the library. Do not remove the doors from
the back of the library or any library components (except the TeraPack magazines).

IMPORTANT

Moving the library without assistance from a Spectra Certified Field Engineer
voids your service contract. Contact Spectra Logic Technical Support for
assistance if you need to relocate your library (see Contacting Spectra Logic
on page 18).
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RENEWING THE BLUESCALE SOFTWARE SUPPORT KEY

You must have a current support agreement and corresponding BlueScale Software Support
key entered in the library before you can update the library’s BlueScale software and the
component firmware. You are able to download updated BlueScale packages from the
Technical Support portal without a key; however, without a valid BlueScale Software Support
key installed on the library, you are not able to apply the updates to the library.

Notes: l Spectra Logic sends you an email notification before your current support key expires.

l The library also generates informational messages to let you know that the support key
is about to expire.

If your BlueScale Software Support key expires, you see the following screen when you
attempt to update the library.

Figure 261 The BlueScale Software Support Key Expired
screen.

You must renew the BlueScale Software Support key before you can continue. You must have
a current service contract to generate a new BlueScale Software Support key, if you do not
have a current service contract, contact Spectra Logic Technical Support (see Contacting
Spectra Logic on page 18).

If your library is covered by warranty or a service contract, and you need a BlueScale Software
Support key, follow these steps:

1. Log into your account on the Technical Support portal at
support.spectralogic.com.

Note: See Accessing the Technical Support Portal on page 534 for information about creating an
account and accessing the Technical Support portal.

2. Select Downloads > Service Key Generation.
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3. The Service Key Generation page displays with a list of the products you own. In the
Product Name column, click the product for which you want to generate a service key.

Figure 262 The Service Key Generation screen.

4. On the Software Support Keys Generator page, the Product Name, Product Type, and
Serial Number fields are populated with the information for your library. Click Generate
Key. The page refreshes to display the new Product Service Key.

Figure 263 The Software Support Key Generator page.

5. After you generate your key, enter it into the library as described in Enter Activation
Keys on page 113.
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UPDATING THE BLUESCALE SOFTWARE AND LIBRARY
FIRMWARE
Overview

The BlueScale software and library firmware are updated regularly to provide new
functionality and resolve issues. Spectra Logic recommends that you keep your library up-to-
date at all times. If your library is not using the most current BlueScale software version,
updating it to the most current version is strongly recommended.

IMPORTANT

Your library must either still be under warranty or you must have a current
service contract with Spectra Logic Technical Support before you can perform
BlueScale package updates, including firmware updates for library
components. The BlueScale Software Service key associated with your service
contract must be entered into the System Configuration screen before you
can update the library.
l For instructions on how to renew and enter your BlueScale Software

Support key, see Renewing the BlueScale Software Support Key on
page 469.

l If you have questions about your service agreement, contact Spectra
Logic Technical Support (see Contacting Spectra Logic on page 18).

New Package Availability

The most currently released version of the BlueScale package for the library is available on the
Product Software page on the Technical Support portal.

If Auto Download is configured (see Configure a Package Server on page 142), the library
checks configured package servers once a week for a library update package newer than what
the library is currently running. If a new package is available, the library downloads it, posts a
system message, and displays an icon on the status bar to indicate the update is available (see
Auto Download Icon on page 93). If the library already downloaded an update package, you
can continue with Prepare for the BlueScale Package Update on page 476.

Package Support

Packages are groupings of program code that contain the BlueScale software and firmware for
the library components. Spectra Logic provides complete support for the two most recently
released BlueScale packages. If your library is not running the most current BlueScale software
version, you may be required to update your library to resolve an issue or to verify that the
problem still exists.

The Spectra TFinity Library Release Notes and Documentation Updates, available on the Technical
Support portal, provides information about the updates in the current BlueScale package, as
well as updates to this guide and other documentation if applicable.
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User Privilege Requirements

All users can view the BlueScale software version that the library is using on the status bar at
the bottom of each screen (see Figure 264 on page 472). Only a user with superuser or
administrator privileges can update the library. See Understanding User Groups and Security
on page 106 for information about the three types of user groups and what types of privileges
each has.

Check the Library BlueScale Software Version

Use the following steps to determine the BlueScale software version currently running on the
library.

1. Log into the library as a user with superuser or administrator privileges.

2. Determine the BlueScale software version currently running on the library.

• The status bar at the bottom of each BlueScale screen shows the BlueScale version
running on the library.

Figure 264 The BlueScale version shown on the status bar.

—OR—

• Select Maintenance > Package Update from the toolbar menu to view the current
BlueScale package version on the Package Update screen.

Note: If the library notifies you that your BlueScale Software Support key expired, see Renewing the
BlueScale Software Support Key on page 469.
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Figure 265 The BlueScale version shown on the Package
Update screen.

Check Component Firmware Versions (Optional)

Note: This is typically only useful when recommended by Spectra Logic Technical Support.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

Figure 266 The Maintenance Tools screen.

3. If you want to save the information about the firmware versions to a USB device, connect
a USB device to a USB port on the LCM or operator panel and wait for the USB device to
mount.

Note: The option to save the information to a USB device is only displayed if you connect a USB
device before you select Utilities (see Using a USB Device on page 185).

4. Select Utilities. The Utilities screen displays.

5. Select Display Firmware Versions. The Utilities screen refreshes to show a description of
the Display Firmware Versions tool.

Figure 267 Select the Display Firmware Versions utility.
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6. If you want to save the output from the utility, use the check boxes at the top of the
screen to select the location; otherwise skip to Step 7.

Selecting this
location... Saves the output...

Mail results to: As an attachment to an email sent to the specified mail recipient. Use the
drop-down list to select the recipient for the report file.

To send the email with the output to someone who is not already listed as
a library user, you must first configure that person as an email recipient
(see Configure Mail Users on page 127).

Note: Do not use the default autosupport@spectralogic.com email recipient
unless Spectra Logic Technical Support specifically instructs you to do so.
Spectra Logic does not save emailed results files unless they are specifically
requested for troubleshooting.

Save results to
Compact Flash file

To the memory card in the LCM.

Note: Select this option only if specifically instructed to do so by Spectra Logic
Technical Support.

Save to USB To a USB device connected to a USB port on the LCM or the operator
panel.

Note: This option is only available if you inserted a USB device in Step 3 on
page 473.

7. Click Run Utility. The Utility Results screen displays, showing a list of the firmware
levels for all installed components.

Figure 268 The results screen for the Display Firmware
Versions utility.
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8. If requested to do so, send this information to Spectra Logic Technical Support (see
Contacting Spectra Logic on page 18) for advanced troubleshooting.

Check the Currently Released BlueScale Version

Follow these steps to check the currently recommended BlueScale version:

1. Log into your user account on the Technical Support portal at
support.spectralogic.com.

Note: See Accessing the Technical Support Portal on page 534 for information about creating an
account and accessing the Technical Support portal.

2. Select Downloads > Product Software.

3. On the Product Software page, locate your library type in the Spectra Product column.
The currently released BlueScale version is listed in the Current Version column.

Figure 269 The Product Software screen.

4. Compare the Current Version available for the library to the version installed on the
library.

Download the BlueScale Package

If Auto Download is configured (see Configure a Package Server on page 142) or your library
has Internet access and you plan to download the BlueScale package directly to the library
from the Spectra Logic package server, skip to Prepare for the BlueScale Package Update on
the next page.

If your library cannot access an outside website because of security or firewall restrictions, use
the following steps to download the BlueScale package from the Technical Support portal. You
can save the BlueScale package to a USB device or a previously configured package server.

1. Log into your account on the Technical Support portal at
support.spectralogic.com.

2. Select Downloads > Product Software. The Product Software page displays.
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Figure 270 The Product Software screen.

3. Locate your library type in the Spectra Product column. The currently released BlueScale
version is listed in the Current Version column.

4. Click the name of the BlueScale package next to your library type. The BlueScale package
begins downloading through your web browser.

Note: If you are updating a library running BlueScale12.7.04 or later, select a package ending with
the letter “s”, which indicates a digitally signed package. If you are updating a library running
a BlueScale version prior to 12.7.04, select a package ending with the letter “z”, which
indicates an unsigned zip package.

5. When the download completes, do not unzip the downloaded file. Copy the file to one of
the following locations:

• The root directory of a USB device.

Notes: l The library only recognizes FAT-formatted, not NTFS-formatted, USB devices.

l Not all USB devices are compatible with the library. If you are unable to access a USB
device from the library, remove it and use a different one.

—OR—

• A previously configured package server.

Prepare for the BlueScale Package Update

Use the following sections to prepare to update the BlueScale software and library component
firmware.

Make Sure Your BlueScale Software Support Key Is Current

Updating the BlueScale software and the firmware for the library components requires a
current service contract with Spectra Logic Technical Support. If your service contract expires,
renew it as described in Renewing the BlueScale Software Support Key on page 469.

Prepare the Library

1. Stop all library- and host-based operations.
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Notes: l If you are updating a library running BlueScale 12.7.00.05 or 12.7.00.06, at the start of
an update that includes LCM, RCM, RIM, or RIM2 updates, the library shuts down all
exporters (RIM and RIM2) so that they do not accept additional moves, and then waits
for any moves in progress to complete before starting to update the selected
components. The exporters are re-enabled to accept moves when the package update
completes.

l If you are updating a library running BlueScale 12.7.00.7 or later, at the start of a
package update that includes RCM or LCM updates, the library shuts down all
exporters (RIM and RIM2) so that they do not accept additional moves and then waits
for any moves in progress to complete before starting to update the selected
components. At the start of a package update that includes RIM or RIM2 updates only,
the library shuts down the exporters needing an update so that they do not accept
additional moves and then waits for any moves in progress to complete before starting
to update the selected components. The exporters are re-enabled to accept moves
when the package update completes.

IMPORTANT

Confirm that all of the following conditions are met before beginning the
update process:
l All backup processes are complete
l All storage management software daemons are stopped
l All drives are empty
To ensure that no commands are sent to the controllers, Spectra Logic
suggests disconnecting Fibre Channel cables to the RIMs and any tape drives
used as robotic exporters.

2. Back up your MLM database (see Back Up the MLM and DLM Databases on page 345).

Note: Backing up the MLM database also backs up the DLM database.

3. Back up all of your BlueScale encryption keys (see the Spectra Tape Libraries Encryption
User Guide).

4. Download and read the Spectra TFinity Library Release Notes and Documentation Updates for
the most current information about updated BlueScale packages.

IMPORTANT If the release notes provide special procedures or requirements for updating
the library, make sure that you follow them.

Install the Update Package

Select the BlueScale Package and Update Options

1. Log into the library as a user with superuser or administrator privileges.
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2. If you downloaded the BlueScale package to a USB device or if you plan to update the
RCM control modules or RIM2 controllers using a USB device, connect the USB device to
the USB port on the LCM and wait for the device to mount before continuing (see Using
a USB Device on page 185).

3. If you receive an error message stating that your disk is full when the library attempts to
unzip a BlueScale package, you need to delete downlevel packages before you can
continue. See Manage Update Packages on page 489.

4. Select Maintenance > Package Update. The Package Update screen displays.

Note: If the library notifies you that your BlueScale Software Support key expired, see Renewing the
BlueScale Software Support Key on page 469.

Figure 271 Click Begin Library Update to start the
process.

5. Click Begin Library Update. If the License Agreement screen displays, read the license
agreement, then click Accept.

Note: If you decline the agreement, you are not able to update the library.

6. The Select Library Package screen displays, listing the file names for the available
BlueScale packages.

Note: The file names begin with the BlueScale version number, followed by the date of release in
YYYYMMDD format.
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Figure 272 Select the BlueScale package.

7. Select the appropriate BlueScale package.

Note: If the Package does NOT display in the USB or Package server section, you may have
downloaded the package for the wrong library type or the wrong signed/unsigned package
type.

BlueScale packages may be found on the sources described in the table below.

Source Description

Spectra Logic Select and download the desired BlueScale package from Spectra Logic’s
package server to the memory card in the LCM and then install it.

Notes:

• The library must have a connection to the Internet before you can use
this option (see Configure Network Settings on page 124).

• If directed to do so by Spectra Logic Technical Support, update the IP
address and package directory for the Spectra Logic package server (see
Configure a Package Server on page 142).

Memory Card Select the desired BlueScale package from packages already stored on the
memory card in the LCM.

USB Device Select the desired BlueScale package from packages stored on a USB device.
There is a brief delay while the library accesses the USB device when you select
this option.

Notes:
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Source Description

• The USB Device option is only available if you connected a USB device
containing the BlueScale package in Step 2 on page 478.

• The BlueScale package must be stored in the root directory of the USB device.

Configured
Package Server
(server name varies)

Select the desired BlueScale package stored on a previously configured
package server, if you have one available.

Note: This option is only available if you previously configured a package
server. See Configure a Package Server on page 142 for information about
configuring a package server.

8. Click Next. The Library Package Update Options screen displays.

The Library Package Update Options screen only lists options that are applicable based
on your library configuration.

Note: Clicking Update immediately starts the update process. Spectra Logic recommends that you
select using a USB device to update RIM2 controllers (see Step 10 on page 482) and, if the
library does not have EtherLib, using a USB device to update RCM control modules (see Step 9
on page 481) before clicking Update.

Figure 273 The Library Package Update Options screen.
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9. If the library includes drive expansion frames, determine the appropriate update method
for your library’s configuration:

EtherLib

EtherLib is an Ethernet network that connects Spectra LS control modules to each other
to increase communication speed. Using EtherLib significantly reduces the time required
for RCM firmware updates.

Select the appropriate EtherLib completion option for your library’s environment. The
library uses this option if the update cannot successfully complete over EtherLib.

Figure 274 Select the appropriate EtherLib completion
strategy.

Note: EtherLib completion options are not present if the library does not detect the EtherLib
network.

If your library uses EtherLib and this option does not display, see Library has EtherLib, but
EtherLib options do not display in Package Update on page 392.

Selection Action

Automatically restart
update over the library’s
internal network

The library restarts the update, but performs it over the library’s
internal communication network. This increases the amount of
time the update requires, up to 45 minutes per RCM.

Do not automatically
restart update

If the update fails, the library does not automatically restart the
update. The BlueScale update is incomplete.

If the update fails, examine any system messages and the
package update log to determine the cause of the failure. If the
library is power-cycled, there may be a system message that
refers to an “RCM firmware mismatch”. Resolve the problems
that caused the failure and retry the update.

If the update cannot be performed using EtherLib, retry the
update using the Update RCM controllers using USB device
method.
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Update RCM Controllers Using USB Device

If your library has drive expansion frames and does not use EtherLib, you can choose to
update the RCM controllers using a USB device. This shortens the time required to
complete the update.

Note: If your library is configured to use EtherLib, performing the update using EtherLib is faster
than using the USB device option.

Select Update RCM controllers using USB device on the Library Package Update Options
screen.

Figure 275 Select Update RCM controllers using USB
device.

Note: If your library has an EtherLib network, and you select Update RCM controllers using USB
device, the library uses the USB device method to update the RCMs.

10.If the library includes RIM2 controllers, determine whether or not to update them using a USB
device. This significantly shortens the time required to complete the update, but requires
manual intervention.

Note: You can only update RIM2 controllers, not RIM controllers, using the USB option.

Figure 276 Select Update RIM2 controllers using USB
device.

Select Update RIM2 controllers using USB device on the Library Package Update Options
screen.

11.On the Library Package Update Options screen, select whether and where you want to
backup the library configuration before performing the update.

Notes: l Spectra Logic highly recommends that you save the library configuration before
updating.

l The backup of the library configuration does not include the MLM or DLM databases.
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Figure 277 Select whether and where you want to backup
the library configuration.

Choice Action

Save to USB
device

Saves a backup of the library configuration to a USB device. Using this
option is highly recommended to ensure that you can easily restore the
library if necessary.
Note: The Save to USB device option is only available if you connected a USB
device in Step 2 on page 478.

Email to... Emails a backup of the library configuration file to an already-configured
mail recipient.
Note: The Email to option is only available if you previously configured mail
recipients (see Configure Mail Users on page 127).

Do not save Updates the library without saving a backup of the library configuration.

This is not recommended unless you backed up the library configuration
right before starting the package update procedure.

12.On the Library Package Update Options screen, select whether or not an email is sent to
Spectra Logic Technical Support to update the library’s support records.

Notes: l Sending a notification to Spectra Logic Technical Support is highly recommended.

l This notification does not include the configuration backup file.

l This option is only available if you previously configured the
autosupport@spectralogic.com mail user’s SMTP IP address (see Create or Modify a
Profile on page 367).

Figure 278 Select whether or not you want to send an
update to Technical Support.

13.(Optional) To view a list of components affected by the BlueScale package, click Details
to view the Library Package Details screen. A Library Package Details screen, similar to
the one shown, displays.
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Any items that need to be upgraded or downgraded to match the BlueScale package you
chose are automatically selected. Components with auto-staged firmware are marked
with an asterisk (*).

Figure 279 The Library Package Details screen.

14.(Optional) Use the advanced firmware update procedure to limit which components get
upgraded or downgraded.

IMPORTANT Use the advanced firmware update procedure only when directed to do so by
Spectra Logic Technical Support.

a. Click Advanced on the Library Package Details screen. An Advanced Package
Update screen, similar to the one shown, displays.

b. Select or clear the check box next to the library components:

• Clear the check box to prevent the component from upgrading or downgrading.

• Select the check box to force a component to update to the firmware level supplied
by the BlueScale package. Depending on the firmware, this could be an upgrade,
downgrade, or reapplying the current firmware.
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For example, clear everything except LC Server to update just the LC Server
firmware.

Figure 280 The Library Package Advanced screen.

Notes: l Updating all of the automatically selected components is highly recommended.

l Occasionally, Spectra Logic Technical Support may instruct you to update a firmware
component even if it is already at the same level as the component in the selected
BlueScale package.

l Components with auto-staged firmware are marked with an asterisk (*).

Begin the Update

1. Click Update to begin the update process.

IMPORTANT If the library is running BlueScale12.7.00.04 or later, the external lights on the
library change to yellow during the update process.

IMPORTANT
Once the update process starts, it cannot be canceled.
Do not turn off power to the library or power-down any component being
updated during the update process.
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2. The process depends on whether you chose the Update RCM controllers using USB
device option in Step 9 on page 481 or the Update RIM2 controllers using USB device
option in Step 10 on page 482.

Note: Depending on which components you selected to update, some steps may be skipped.

Update using USB device
options selected Update Process

Both options cleared or
not applicable
(The library has an
EtherLib network or
does not have any drive
expansion frames, and
does not have any RIM2
controllers.)

The library begins the update process and displays a progress
screen, which remains for the duration of the update. Depending
on what components are updated, the process can take from
several minutes to an hour or more.

Update RCM controllers
using USB device
selected

or

Update RIM2 controllers
using USB device
selected

or

Both

The library starts the update wizard, which guides you through the
update process. Based on your selections, the wizard instructs you
to connect and remove the USB device from various components.

Notes:

• Each time you connect the USB device to a component, wait at
least 10 seconds for the USB device to mount, and then click
Continue.

• If you do not respond to the Feedback Required screen within 10
minutes, the request times out and the component update fails.

• Each component takes 5-10 minutes to update.
If you selected both Update RCM controllers using USB device and
Update RIM2 controllers using USB device, the process is as
follows:

1. On the Feedback Required screen, confirm that you connected
a USB device to a USB port on the LCM (in Step 2 on page 478).
The library copies a file containing the appropriate RCM
firmware to the USB device.

2. A Feedback Required screen prompts you to remove the USB
device from the LCM and connect it to the specified RCM.

3. When the RCM update is complete, a Feedback Required
screen prompts you to remove the USB device and connect it
to the next RCM. This is repeated until all RCM control
modules are updated.

4. When all of the RCM updates are complete, a Feedback
Required screen prompts you to move the USB device back
to the LCM. The library copies a file containing the
appropriate RIM2 firmware to the USB device.
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Update using USB device
options selected Update Process

5. A Feedback Required screen prompts you to remove the USB
device from the LCM and connect it to a RIM2. This is
repeated until all RIM2 controllers are updated.

6. When complete, the Package Update Results screen displays, showing that the update
completed successfully or that a component failed to update.

Note: If the update fails, examine any system messages and the package update log to determine
the cause of the failure. Resolve the problems and perform the update again. For further
information, see Troubleshooting below.

7. If you used a USB device during the update process, disconnect it.

8. Click Finish to complete the update. Updates do not take effect until the library
completes the update process.

IMPORTANT

Always click Finish to complete the BlueScale update process. Do not
manually reboot the LCM, power-cycle the library, or perform any other
operations on the library when you see the Package Results screen. Doing so
may cause the update process to fail.

Note: If you are using the BlueScale web interface to perform the update, the connection to the
library is lost when the LCM reboots. Allow sufficient time for the LCM to complete its
initialization, then enter the library’s IP address in your web browser to reconnect.

9. When the update completes, the library automatically sends an email to Spectra Logic
Technical Support if it is configured as a mail recipient and you selected this option in
Step 2 on page 478.

10.After the update is complete, use your storage management software to restart any
backup processes.

Troubleshooting

If you encounter problems while performing a package update, examine any system messages
and the package update log to determine the cause of the failure. Resolve the problems and
retry the update.

LCM does not automatically reboot

If the update package includes updates to software running on the LCM (LC server,
WebServer, etc.) or RCM the LCM reboots when you click Finish. Wait at least five minutes for
the LCM to complete its initialization. If the LCM does not reboot correctly, reseat the LCM
and perform the Package Update process again.
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Component failed to update

Click Finish to complete the update. When the LCM resets, reseat the component that failed to
update, and perform the Package Update process again. If the component fails to update a
second time, contact Spectra Logic Technical Support. See Contacting Spectra Logic on
page 18.

Library configuration is corrupted during the update process

Use the following steps to restore the library’s configuration if it becomes corrupted during
the package update process.

CAUTION

The Restore Configuration from Checkpoint utility should only be used
immediately after a package update is performed.
Any library configuration or inventory changes made between the time that
the package update is performed and the utility is run are lost.

Note: The library automatically saves a Checkpoint Configuration Backup file prior to beginning a
package update.

1. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

2. Select Utilities. The Utilities screen displays.

3. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

4. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

5. Scroll through the list of advanced utilities and select Restore Configuration from
Checkpoint. The screen refreshes to show the details for the utility.
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Figure 281 The Advanced Utilities screen.

6. Click Run Utility to restore the library to the Checkpoint library configuration.

7. After the library configuration restores, perform the Package Update process again.

Manage Update Packages

The BlueScale packages downloaded to the library reside on the memory card in the LCM.
Over time, the packages (one per update) accumulate on the card and the library may post an
error message notifying you that the memory card is full. You must delete downlevel
packages before you can continue; you can also choose to delete downlevel packages at other
times.

Deleting a package file does not delete the BlueScale software or component firmware already
applied to the library; it simply removes the package file from local storage on the LCM.

Note: There is no confirmation request before the selected package is deleted. Make sure that you
no longer need access to a package file before you delete it.

The following steps describe how to delete unwanted BlueScale packages from the memory
card in the LCM.

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Package Update. The Package Update
screen displays (see Figure 271 on page 478).

3. Click Manage Packages. The Manage Packages screen displays with a list of all the package
files currently stored on the memory card in the LCM.
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Figure 282 Select the BlueScale packages you want to
delete.

4. Select the package(s) that you want to delete, then click Delete Selected. The package
delete process begins.
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REPLACING THE AIR FILTER
A set of fans mounted in the lower front of each main frame, drive frame, and service frame
pull cool air into the library and circulate it to maintain the temperature within an acceptable
range. The air filters ensure that the air pulled into the library is free of contaminants. A
clogged air filter can cause operational problems due to excessive temperatures inside the
library.

You should inspect the filters at least once every three months as part of your preventive
maintenance procedures. If a filter appears to be clogged, continue with the steps in this
section.

CAUTION
Some environments may require more frequent filter inspection and
replacement. If an air filter gets clogged quickly, consider moving the library to
a more dust-free location or improve the environment where it is located.

Spectra Logic recommends keeping one or more new air filters on site to use for replacement
as often as is necessary. To purchase replacement air filters, contact your sales representative
(see Contacting Spectra Logic on page 18).

Before You Begin...

Confirm that the Filter Needs To Be Replaced

Because dust primarily collects at the bottom of the air filter, it can be rotated 180°, top to
bottom, one time before it needs to be replaced.

Gather the Following Tools and Supplies

Gather these supplies before beginning the procedure:

• A new filter from Spectra Logic

• A flat blade screwdriver (big filters)

• A #2 Phillips screwdriver (small filters)

Continue Library Operations While Replacing the Filter

It is safe to continue normal library operations, such as backups, while rotating or replacing
the air filter.
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Rotate or Replace the Filter

1. Remove the filter cover from the bottom front of each frame by first pulling outward on
the bottom center of the panel (A), then pulling outward on the handle at the top center
of the panel (B).

Note: The fans stop running when you remove the filter cover and resume running after the filter
and filter cover are replaced.

Figure 283 Remove the filter cover.

2. Set the cover aside.

3. Use the appropriate screwdriver to loosen the four captive screws on the air filter
(circled in Figure 284).
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Figure 284 Loosen the four captive screws that secure the air filter to the frame.

4. Determine whether the filter can be rotated.

• If the filter was not previously rotated, rotate it 180°, top to bottom (see Figure 284 on
page 493).

IMPORTANT
Make sure that you do not flip the filter over. Doing so places the dirty side of
the air filter toward the interior of the frame and results in the trapped
contaminates being blown into the library interior.

Note: When you rotate the filter, mark it in some way so that you can tell at a glance the next time
you inspect the filter.

• If the filter was already rotated once, you must replace it.

5. Place the air filter over the opening in the bottom front of the frame.

IMPORTANT Make sure that the tab on the filter is pressing in on the filter sensor switch.
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Figure 285 Install the filter, making sure that the tab on the filter presses the filter sensor switch.

6. Use the appropriate screwdriver to tighten the four captive screws to secure the filter to
the frame (see Figure 284 on page 493).

7. Use a dry cloth to wipe any accumulated dust off the inside of the filter cover.

8. Position the filter cover over the fan assembly and push firmly inward on the sides of the
cover to snap it onto the ball studs extending from each side of the frame. As soon as the
cover is in position, the fans restart.

9. If necessary, repeat Step 1 through Step 8 for each additional main frame, drive frame, or
service frame in the library.

JUNE 2025 494 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 14 - MAINTAINING THE LIBRARY



INSTALLING CORD LOCKS

Install the cord locks included with each frame to prevent the power cords from being
inadvertently disconnected from the dual AC input connectors.

Note: The photos in this section show installing the cord locks on a dual AC power module. The
parts and the procedure are the same for the dual AC with convenience outlet or the dual AC2
power modules.

1. Pause PostScan if it is running (see Pause the PostScan Process on page 334). Any tapes
currently being scanned are returned to their storage locations.

2. Discontinue all file storage operations to the library.

3. Power off the library (see Power Off the Library on page 163).

4. Set the AC breaker switches on the dual AC module to the “off” position.

5. If the power cords are plugged into wall plugs, unplug them. Also unplug them from the
dual AC module where you plan to install the cord locks.

6. Using a #2 Phillips screwdriver, remove the two screws securing each of the two input
plugs to the dual AC module (circled in Figure 286 and Figure 287).

Figure 286 Remove the screws securing the input plugs to the AC
power module (dual AC module shown).

Figure 287 Remove the screws on the service frame expansion power
module.
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7. Place a cord lock over the connector on the end of the power cord that connects to the
library. Orient the cord lock as shown in Figure 288.

Figure 288 Install the cord locks on the power cords.

8. Push the power cord into the input plug and reinstall the screws that secure the input
plug to the dual AC module. Make sure that the cord connector is fully seated in the
input plug.

9. Tighten the cord lock clamp screws.

10.Repeat Step 7 through Step 9 for the other power cord.

11.Plug the free end of each power cord into an appropriate power source.

12.Repeat the entire process for the power cords attached to the dual AC module in each
drive expansion frame and the expansion power module in each service frame.

13.After cord locks are installed on all of the power cords, set the AC breaker switches to
the “on” position and power on the library.
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CALIBRATING THE TOUCH SCREEN
If the touch points on the library’s touch screen do not properly align with the user interface
graphics, perform the following procedure to recalibrate the position of the touch points.

Note: You must perform this procedure while standing in front of the touch screen. The utility is not
available when accessing the library through the BlueScale web interface (RLC).

1. Log into the library as a user with superuser or administrator privileges.

2. From the toolbar menu, select Maintenance > Tools to display the Maintenance Tools
screen (Figure 266 on page 473).

3. Select Utilities. The Utilities screen displays.

4. Select Calibrate Touch Screen.

5. Click Run Utility. The touch screen displays a series of calibration target points.

6. Touch each point as it displays with either the stylus or your finger to recalibrate the
touch points on the screen.

Note: Touch each point at a straight-on angle as close to the center of the target as possible.

7. When the calibration routine is complete, the Utilities screen redisplays.
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CHAPTER 15 - MAINTAINING THE DRIVES
This chapter describes the common maintenance tasks for drives in the Spectra TFinity library.
See Maintaining the Library on page 467 for information about maintaining the library.

Cleaning a Drive 499
Determine Whether Cleaning is Required 499

Prepare the Library for Drive Cleaning 501

Determine the Cleaning Method 501

Manually Cleaning a Drive 502

Track Cleaning Cartridge Use 505

Updating Drive Firmware 506
Prepare for the Update Process 508

Update Using ITDT 510

Using Drive Update through Package Update 513

Update Using the Drive Firmware Update Wizard 521

Update Using the Update Drive Firmware Utility 525

Updating Drive Device Drivers 529
Adding or Replacing a Drive 531

Add a Drive to the Library 531

Replace a Drive 532
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CLEANING A DRIVE

Overview

Whenever a tape is loaded or unloaded, the read/write heads are physically cleaned by a
brush located within the drive. However, after reading and writing a large amount of data (the
exact amount varies by drive type and generation) or if read or write errors occur, the drive
requests to be cleaned with a cleaning cartridge. The request is made by sending a Tape Alert
message to the host, and displaying a C on the SCD for an LTO drive or CLEAN* on the MCD
for a TS11xx technology drive. The notification is also posted to the library’s Drive Details
screen (Figure 290 on page 500) and the DLM drive health icon for the drive changes to yellow
(see Using the Drive Health Icons on page 356 for additional information).

Using drives with dirty heads can reduce drive performance, decrease usable tape capacity,
and result in read/write failures which can eventually interrupt data storage.

If you have Auto Drive Clean enabled and the drive is in a partition with an associated
cleaning partition, these cleanings are performed automatically. See Creating a Cleaning
Partition on page 196 for information about configuring a cleaning partition.

It may also be possible to configure the host software to automatically clean the drives, with a
cleaning tape stored in the partition, when the software is notified that drive cleaning is
necessary.

If no automatic cleaning process is configured, you must manually clean the drive. If you
ignore a cleaning request for too long, the library generates a warning system message.

User Privilege Requirements

When Auto Drive Clean is enabled for the storage partition and a cleaning cartridge is
available in the cleaning partition, cleanings are performed automatically and do not require
user intervention.

If Auto Drive Clean is not enabled, any user with operator privileges who is assigned to the
partition and all users with superuser or administrator privileges can manually clean a drive
without an associated cleaning partition by importing a cleaning cartridge into the storage
partition’s entry/exit pool, if necessary, and using the Inventory screen to manually move the
cleaning cartridge to the drive (see No Cleaning Partition Present on page 503).

Only a user with superuser or administrator privileges can move a cleaning cartridge stored in
the partition using the BlueScale web interface (RLC).

Determine Whether Cleaning is Required

Clean the library’s drives when any of the following occurs:
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• The drive indicates that it needs cleaning (see Drive Troubleshooting on page 430) by
sending a message to the storage management software.

• The Drive Details screen indicates that the drive needs cleaning or displays a C on the SCD
for an LTO drive or CLEAN* on the MCD for a TS11xx technology drive (see Figure 290 on
page 500).

Note: In order for the library to monitor drive status, the drive must be configured in a partition.

Use the following steps to use the Drives screen to determine whether a drive requires
cleaning.

1. Log into the library as a user with superuser or administrator privileges.

2. Select Configuration > Drives or Configuration > DLM if MLM is enabled. The Drives
screen displays.

Figure 289 Click Detail on the Drives screen.

3. Click Detail next to the drive you want to check. The Drive Details screen displays.

If the Cleaning Status displays Drive Cleaning Required, clean the drive as described in
the following sections.

Figure 290 The Cleaning Status indicates that cleaning is
required.
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Prepare the Library for Drive Cleaning

Before you can clean the drive, you must address the following requirements:

Required Tools and Materials

You must have a cleaning cartridge for the type of drive(s) to be cleaned. Cleaning cartridges
can be purchased from Spectra Logic. If the cartridge has a barcode label, be sure to note the
barcode, including any leading zeros. This information helps you locate the cleaning cartridge
after it is loaded into the library.

CAUTION

Using only Spectra Certified cleaning cartridges to clean your drives is highly
recommended. For information on ordering these cartridges, see Media and
Media Accessories on page 560.
Carefully follow all instructions and recommendations provided with the
cleaning cartridge. Do not rewind and reuse the material in a cleaning
cartridge. Reusing the material may redistribute contaminants previously
removed from the tape path. If all of the cleaning material is used, discard the
cartridge and use a new cleaning cartridge.

Continuing Backups

A drive is unavailable for use while it is being cleaned. However, the library’s other drives
remain available for use.

Determine the Cleaning Method

The method you use to clean the drive depends on the following factors:

If... Then...

Auto Drive Clean is
enabled and a cleaning
partition is associated
with the storage
partition,

The library automatically cleans the drives, including any Global
Spares, as needed. See Configuring and Managing Partitions on
page 188 for information about configuring a cleaning partition
and associating it with one or more storage partitions.

You can also clean the drive manually using a cleaning cartridge in
the cleaning partition (see Cleaning Partition Present on page 503).
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If... Then...

A cleaning partition is
not associated with the
storage partition; your
software package
includes features that
allow for scheduled
drive cleanings,

Use your storage management software to perform regularly
scheduled drive cleanings. Refer to your storage management
software user manual or vendor for instructions on how to set up
scheduled automatic cleanings.

You may choose to leave a cleaning cartridge in each storage
partition, particularly if you can configure your storage
management software to perform regular automated cleanings.

CAUTION Make sure that the cleaning cartridge has a barcode label.
Your software must be able to identify the cleaning cartridge and
use it only for cleaning drives. Any attempts to use a cleaning
cartridge for data storage causes backup failures.

A cleaning partition is
not associated with the
storage partition and
your software package
does not have features
that allow for scheduled
drive cleanings,

Import a cleaning cartridge into the partition and clean the drive
manually as described in No Cleaning Partition Present on the next
page.

You may choose to leave a cleaning cartridge in each storage
partition so that it is available whenever you need it.

CAUTION Make sure that the cleaning cartridge has a barcode label.
Your software must be able to identify the cleaning cartridge and
use it only for cleaning drives. Any attempts to use a cleaning
cartridge for data storage causes backup failures.

A Global Spare drive
requires cleaning and a
cleaning partition is not
present,

Prepare and clean the drive as follows:

1. Pause the PostScan operation if it is using the Global Spare
drive that needs cleaning (see Pause the PostScan Process on
page 334).

2. Temporarily substitute the Global Spare drive for a drive in a
partition that is associated with the Global Spare drive (see
Use the Global Spare Drive on page 434).

3. Clean the drive manually (see No Cleaning Partition Present
on the next page).

4. Reclaim the Global Spare drive so that it is again available
for use as a spare (see Undo the Global Spare Drive on
page 436).

Manually Cleaning a Drive

The process for loading a cleaning cartridge into the drive depends on whether or not a
cleaning partition is associated with the storage partition containing the drive you need to
clean.
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Cleaning Partition Present

If a cleaning partition is present and contains a cleaning cartridge, you can use the Clean
feature on the Drives screen to manually clean a drive. See Creating a Cleaning Partition on
page 196 for information about configuring a cleaning partition.

1. Log into the library as a user with superuser or administrator privileges, or as an
operator assigned to the partition.

2. If necessary, import a magazine containing one or more cleaning cartridges into the
cleaning partition (see Importing into a Storage or Cleaning Partition on page 246).

3. Select Configuration > Drives or Configuration > DLM if MLM is enabled. The Drives
screen displays.

Figure 291 The Drives screen.

4. Click Clean next to the drive that needs cleaning. The library retrieves a cleaning
cartridge from the cleaning partition and inserts it into the drive. The Drive Cleaning
Progress screen displays while the cleaning is in progress.

5. When the cleaning is complete, the library returns the cleaning cartridge to the cleaning
partition and displays a status message.

6. If the cleaning cartridge is MLM-enabled, the cartridge health and Cleans Remaining are
updated in the MLM database.

No Cleaning Partition Present

If a cleaning partition is not associated with the storage partition containing the drive you
need to clean, a cleaning cartridge must be present in the storage partition's storage pool or
entry/exit pool. If you do not permanently store a cleaning cartridge in the storage pool for
each partition, you must import one in order to clean a drive.

• If you have an empty chamber in either the entry/exit pool or the storage pool for the
partition, import a TeraPack magazine containing a cleaning cartridge.

—OR—
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• If you have a TeraPack magazine with one or more empty slots in the entry/exit pool or the
storage pool for the partition, you can exchange a magazine or cartridge to import the
cleaning cartridge (see Exporting or Exchanging Magazines and Cartridges on page 257).

Use the following steps to clean the drive.

1. Log into the library.

2. If you keep a cleaning cartridge stored in the storage pool for the partition, use its
barcode label information to determine its location, as described in Locating a Specific
Cartridge on page 288.

3. If necessary, import the TeraPack magazine with the cleaning cartridge into either the
entry/exit pool or the storage pool for the partition containing the drive that needs
cleaning, as described in Importing into a Storage or Cleaning Partition on page 246.

Note: If an empty chamber is not available in either the entry/exit pool or the storage pool,
exchange the magazine containing the cleaning cartridge for a magazine in one of those
pools (see Exporting or Exchanging Magazines and Cartridges on page 257). When the
cleaning is complete, you can exchange the magazines again.

4. Move the cleaning cartridge from the magazine to the drive needing cleaning, as
described in Moving Cartridges Within a Partition on page 289.

The drive automatically performs the cleaning, which takes approximately one minute,
and ejects the cartridge when finished.

5. Move the cleaning cartridge from the drive back to the magazine from which it came.

6. Check the Drive Details screen to confirm that the cleaning was successful.

If the cleaning cartridge is expired, the drive automatically ejects the cartridge and does
not perform the cleaning. The Drive Details screen still indicates that the drive needs
cleaning. Perform the following steps before retrying:

a. Export the expired cleaning cartridge.

b. Import an unexpired cleaning cartridge.

c. Repeat Step 3 through Step 6 to clean the drive.

7. If you have additional drives to clean, repeat Step 3 through Step 6 for each drive.

8. If you do not want to store the cleaning cartridge in the library, export the magazine
containing it, as described in Exporting or Exchanging Magazines and Cartridges on
page 257.

9. Make sure that you track the number of times the cleaning cartridge was used (see Track
Cleaning Cartridge Use, below).

Note: If you used an MLM-enabled LTO cleaning cartridge, the cartridge usage is tracked in the MLM
database.
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Track Cleaning Cartridge Use

Cleaning cartridges are valid for a minimum of 50 uses. If you enabled MLM and use
MLM-enabled cleaning cartridges, the library tracks the number of cleanings remaining on the
cartridge and notifies you when a cleaning cartridge is nearing the end of its useful life. See
Configuring and Using Media Lifecycle Management on page 301 for detailed information
about using MLM-enabled cleaning cartridges.

If you are not using a Spectra certified cleaning cartridge with MLM enabled in your library,
Spectra Logic recommends marking the cleaning cartridge label after each use so that you
know when it is near the end of its life cycle.

To purchase MLM-enabled Spectra Certified cleaning cartridges, contact your sales
representative or visit the Spectra Logic website at shop.spectralogic.com.
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UPDATING DRIVE FIRMWARE

Overview

Whenever you update your library software, confirm that your drives are using the latest
firmware version (see Determine the Drive Generation and Firmware Version on page 508).
Drive firmware updates are also occasionally required to resolve drive issues. When updated
drive firmware is available, schedule a drive firmware update at your earliest convenience.

The method you use to update the drives depends on the type of drives you are updating and
your operating environment.

Notes: l If Auto Download is configured (see Configure a Package Server on page 142) and a
system message indicates that the library downloaded a new drive firmware package,
use Apply the Update on page 520 to install the firmware.

l If you cannot use any of the methods described in the following sections, contact
Spectra Logic Technical Support for assistance (see Contacting Spectra Logic on
page 18).

LTO-4 LTO-5 and Later
Generations

TS11xx
Technology

IBM Tape Diagnostic Tool (ITDT)
To use, install the ITDT utility on a
Solaris, Linux, or Windows host
connected to the drives to be
updated. The update takes 1-2
minutes per drive.

Recommended Recommended Recommended

Drive Update through Package
Update
Firmware stages in the
background (with no impact to
library operations) for up to 8
hours for LTO drives and up to 16
hours for TS11xx technology
drives; then, when initiated by the
user, the drives are updated in
parallel. The actual update takes
up to 30 minutes for all LTO-5 or
later generation and all TS11xx
technology drives.

Not
Recommended a

Available
Recommended if
you cannot use
ITDT or if the
firmware was
auto
downloaded.

Available
Recommended if
you cannot use
ITDT or if the
firmware was
auto
downloaded.

aContact Technical Support before using this wizard to update LTO-4 drives. LTO-4 drives must remain empty and idle during the
update, which may take up to 8 hours per drive.
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LTO-4 LTO-5 and Later
Generations

TS11xx
Technology

Drive Firmware Update Wizard
Requires one or more firmware
update tapes. The update takes
about 5 minutes per drive.
Multiple drives can be updated in
parallel if multiple firmware tapes
are used. One partition is
processed at a time.

Available Available Not Available

Update Drive Firmware Utility
Requires a firmware update tape.
The update takes about 5 minutes
per drive. Updates are performed
serially, one partition at a time.

Available Available Not Available

User Privilege Requirements

The user privileges required to perform a drive firmware update depend on the method used.

• ITDT—A user with appropriate permissions to use the host computer on which ITDT is
installed.

• Drive Update through Package Update—Only a library user with superuser or
administrator privileges.

• Drive Firmware Update wizard—Only a library user with superuser or administrator
privileges.

• Drive Update Firmware utility—Only a library user with superuser or administrator pr

Always download drive firmware from the Spectra Logic Technical Support portal
to ensure that the firmware was qualified by Spectra Logic.

After the drive firmware update is complete, you may need to reset the hosts
accessing the drives.

Some operating environments require you to install device drivers before the
application software can correctly communicate with the drives. When you
update the drive firmware, you may also need to update the device driver for the
drive (see Updating Drive Device Drivers on page 529 for further instructions).

DO NOT downgrade the firmware on a drive unless specifically instructed to do
so by Spectra Logic Technical Support.
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Prepare for the Update Process

Before you begin the update procedure, make sure you fulfill the prerequisites described in
this section.

Determine the Drive Generation and Firmware Version

Use the following steps to determine the generation and current firmware version for each
drive you plan to update.

1. Log into the library as a user with superuser or administrator privileges.

2. Select Configuration > DLM (or Drives) to view a list of all the drives currently installed
in the library.

Figure 292 Determine the drive type, generation, and
interface.

3. For each drive, make a note of the following information:

Note: If the library contains many drives, it may be easier to use the
drivelist.xml?action=list command to obtain this information. See the Spectra
Tape Libraries XML Command Reference for more information.

• Drive type and generation — LTO-4 and later generation drives are listed as IBM
Ultrium-TDn, where n is the generation. TS11xx technology drives are listed as IBM
3592Enn, where nn=07 indicates TS1140 technology, nn=08 indicates TS1150 technology,
nn=55 indicates TS1155 technology, nn=60 indicates TS1160 technology, and nn=70
indicates TS1170 technology.

• Interface — Fibre Channel as shown in both the Drive Type field (Fibre) and in the
Drive Identifier field (fLTO or fTS11xx)

4. For each drive, click Detail to view information about the current status of the selected
drive, including its firmware version.
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Figure 293 Locate the drive firmware version on the Drive
Details screen.

5. Make a note of the firmware version the drive is currently using.

Determine Whether an Update is Available

Use the Spectra Logic Technical Support portal to check the currently recommended firmware
version for the drives in your library and download updated firmware if it is available.

Always download drive firmware from the Spectra Logic Technical Support
portal to ensure that the firmware was qualified by Spectra Logic.

1. Log into your account on the Technical Support portal at
support.spectralogic.com.

Note: See Accessing the Technical Support Portal on page 534 for information about accessing the
Technical Support portal and setting up an account associated with your library.

2. Select Downloads > Tape Drive Firmware.

3. On the Tape Drive Firmware page, locate the appropriate drive firmware with respect to
drive type (LTO or TS11xx), generation (for example, LTO-5), interface type (for example,
SAS or Fibre Channel), and form factor (full-height or half-height).
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Figure 294 A portion of the Tape Drive Firmware page.

4. Compare the recommended drive firmware version for each of the drives in your library
with the version currently in use (see Determine the Drive Generation and Firmware
Version on page 508).

Update Using ITDT

The easiest way to update your LTO or TS11xx technology tape drive firmware is with the
IBM Tape Diagnostic Tool (ITDT).

Note: If your operating system is not supported by ITDT, or you cannot use ITDT in your
environment, choose another firmware update method:

l Using Drive Update through Package Update on page 513

l Update Using the Drive Firmware Update Wizard on page 521

l Update Using the Update Drive Firmware Utility on page 525

After you check the firmware on the Technical Support portal for the currently recommended
firmware version (see Determine Whether an Update is Available on the previous page),
follow the instructions in this section to update your drive firmware using ITDT.
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Download and Install ITDT

Download ITDT and its related documentation directly from IBM's Fix Central website. For
information about navigating IBM's website and downloading the version of ITDT that is
appropriate for your operating system, log on to the portal (see Accessing the Technical
Support Portal on page 534), open the Knowledge Base, and search for KBA-01768,
Downloading and installing ITDT (IBM Tape Diagnostic Tool).

IMPORTANT Use the latest version of ITDT to update the latest generation of drives.

Use the following steps to download and install ITDT on a computer that is connected to the
same Fibre Channel arbitrated loop or fabric as the drives in the library.

1. Log into IBM’s website (ibm.com/support/fixcentral/), using your individual IBM ID.

2. Select the Select product tab.

3. Select the following options:

• Product Group = System Storage

• Select from System Storage = Tape systems

• Select from Tape Systems = Tape drivers and software

• Select from Tape drivers and software = IBM Tape Diagnostic Tool (ITDT)

• Platform = Select your operating system from the drop-down list and click Continue.

4. On the next page, select the version of ITDT that you want to download. If desired, you
can select multiple versions.

Note: If you are unsure which version to select, click Show Fix Details to see additional information.

5. Click Continue. If you have not logged into the website yet, it will prompt you to do so
now.

6. Choose one of the following methods to download the selected ITDT installation files:

• Download using your browser (HTTP)

• Download using bulk FTP

• Download using Download Director

7. Refer to the ITDT documentation for information about using ITDT. Contact Spectra
Logic Technical Support if you need assistance (see Contacting Spectra Logic on
page 18).
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Download the Drive Firmware

1. After installing ITDT, launch the program so that it creates the Input and Output folders
required during the firmware update process.

2. Log into your account on the Spectra Logic Technical Support portal at
support.spectralogic.com.

3. Select Downloads > Tape Drive Firmware.

4. On the Tape Drive Firmware page (see Figure 294 on page 510), locate the appropriate drive
firmware with respect to drive type (LTO or TS11xx), generation (for example, LTO-5),
interface type (for example, SAS or Fibre Channel), and form factor (full-height or half-
height).

5. Click the firmware version name in the column labeled Current Firmware Version.

Note: The link in the column labeled Package File (For Staging) is for using Package Update to
update the drive firmware (see Using Drive Update through Package Update on the next
page) do not select this file if you are updating drive firmware using ITDT.

6. Use your web browser to save the file to the ITDT Input folder on the computer where
ITDT is installed.

Discontinue Background Operations

You cannot update drive firmware if the library is actively running any background
operations, including Media Auto Discovery, PreScan, and PostScan.

If you do not want to wait for a Media Auto Discovery, PreScan, or PostScan operation to
complete, you can stop the Media Auto Discovery or PreScan operation, or pause the PostScan
operation. For other background operations, you must wait for the process to complete.

• Click Stop Discovery on the Media Lifecycle Management Tools screen to stop a Media
Auto Discovery or PreScan operation (see Stop the Discovery Process on page 324).

• Click Pause PostScan on the Media Lifecycle Management Tools screen to pause the
PostScan operation for one hour (see Pause the PostScan Process on page 334).

Discontinue Backups and Empty the Drives

Before beginning the drive firmware update process, discontinue all backup operations and
remove any cartridges from the drives.
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CAUTION

Attempting to update the firmware while the library is busy or when the drives
contain tapes may result in the update failing, failed backup jobs, or permanent
damage to the drives. If you did not already do so, stop all backup operations
and remove all tapes from the drives you are updating. If the library has SlotIQ
enabled, run the Advanced Utilities Unload All Drives followed by Resolve
SlotIQ Virtualized Drive to Slot Moves.

• If possible, use your storage management software to move any cartridges that are
currently in drives back to their storage locations.

• If you cannot use your storage management software, then move the cartridges as
described in Moving Cartridges Within a Partition on page 289.

Update Drives Using ITDT

1. Follow the instructions in the ITDT documentation to update the drive firmware.

2. Reset the updated drives as described in Resetting a Drive on page 431 to restore their
configuration settings.

3. After the update is complete, use your storage management software to restart any
backup processes.

Using Drive Update through Package Update

IMPORTANT

Your library must either be under warranty or you must have a current service
contract with Spectra Logic Technical Support before you can update the
drive firmware using Package Update. The BlueScale Software Service key
associated with your service contract must be entered into the System
Configuration screen before you can use Package Update.
l If you have questions about your service agreement, contact Technical

Support (see Contacting Spectra Logic on page 18).
l For instructions on how to renew and enter your BlueScale Software

Support key, refer to Renewing the BlueScale Software Support Key on
page 469.

IMPORTANT

If Auto Download is configured (see Configure a Package Server on
page 142) and a system message indicates that the library downloaded
a new drive firmware package, use Apply the Update on page 520 to
install the firmware.
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Drive firmware is downloaded and staged to each drive as a background process. The
firmware staging process takes up to 8 hours for LTO -5 and later generations drives, and up to 16
hours for TS11xx technology drives. Backups can continue during this process. This does not
affect library operation. The update is then applied to all selected drives in parallel. This takes
between 15 and 30 minutes, during which time the drives must be empty and idle.

Requirements

• The library must be running BlueScale12.4.1 or later generation software.

• The drives must be LTO-5 and later generation drives or TS11xx technology drives.

Note: Contact Technical Support before using this wizard to update LTO-4 drives. These drives must
remain empty and idle during the entire update, which may take up to 8 hours per drive.

• The drives to update must be configured in a storage partition.
• To update the firmware of a Global Spare, first substitute the Global Spare drive for a drive
assigned to a partition. After the Global Spare drive completes the firmware update
process, it can be removed from the partition and returned to the pool of spare drives (see
Use the Global Spare Drive on page 434 for more information).

Download the Drive Firmware

If your library has Internet access, you can download the drive firmware update directly from
the Spectra Logic package server. The drive firmware package is downloaded during the
update process, and does not need to be downloaded beforehand.

—OR—

Download the recommended drive firmware from the Spectra Logic Technical Support portal,
and save it to a USB device or a package server.

1. Connect to the Spectra Logic Technical Support portal.

2. Select Downloads > Tape Drive Firmware.

3. On the Tape Drive Firmware page (see Figure 294 on page 510), locate the appropriate drive
firmware with respect to drive type (LTO or TS11xx), generation (for example, LTO-5),
interface type (for example, SAS or Fibre Channel), and form factor (full-height or half-
height).

4. Click the firmware version name in the column labeled Package File (For Staging).

Notes: l The link in the column labeled Current Firmware Version is for updating the drive
firmware using ITDT (Update Using ITDT on page 510) do not select this file if you are
updating drive firmware using Package Update.
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l If you are updating drive firmware in a library running BlueScale12.07.02 or later, select
a package ending with the letter “s”, which indicates a digitally signed package. If you
are updating drive firmware in a library running a BlueScale version prior to 12.07.02,
select a package ending with the letter “z”, which indicates an unsigned zip package.

5. Use your web browser’s download features to save the file to one of the following
locations:

• The root directory of a USB device.

Notes: l The library only recognizes FAT-formatted, not NTFS-formatted, USB devices.

l Not all USB devices are compatible with the library. If you are unable to access a USB
device from the library, remove it and use a different one.

l Do not unzip the downloaded file.

—OR—

• A previously configured package server.

Note: The package server option is only available if you previously configured a package server.
Refer to Configure a Package Server on page 142 for more information.

Stage the Firmware

1. Log into the library as a user with superuser or administrator privileges.

2. If you downloaded the drive firmware package to a USB device, connect the USB device
to a port on the LCM or the operator panel and allow time for the device to mount
before continuing.

3. Select Maintenance > Package Update to display the Package Update screen.

4. Click Begin Drive Update.

Figure 295 The Package Update screen.

JUNE 2025 515 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 15 - MAINTAINING THE DRIVES



5. If the License Agreement screen displays, read the license agreement, then click Accept.

Note: If you decline the agreement, you are not able to update the drive firmware using this
method.

6. The Select Package screen lists the filenames for the firmware update packages.

Figure 296 Select the package for the drive firmware
update.

7. Select the correct drive firmware package from the list.

Notes: l If the package does NOT display in the USB or Package server section, you may have
downloaded the wrong signed/unsigned package type.

l Update packages may be found on the sources described in the table below. Each
drive firmware package contains firmware for only one drive generation.

Source Description

Spectra Logic Select and download the desired drive firmware package from Spectra Logic’s
package server to the memory card in the LCM.
Notes:

• The library must have a connection to the Internet before you can use this
option (see Configure Network Settings on page 124 for instructions for
configuring network settings).

• If directed to do so by Spectra Logic Technical Support, update the IP address
and package directory for the Spectra Logic package server (see Configure a
Package Server on page 142 for instructions for configuring a package server).
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Source Description

Configured
Package Server
(server name varies)

Select the desired drive firmware package stored on a previously
configured package server, if you have one available.
Note: This option is only available if you previously configured a package server. (See
Configure a Package Server on page 142 for instructions for configuring a package
server).

Memory Card Select the desired drive firmware package from packages already stored
on the memory card in the LCM.

USB Device Select the desired drive firmware package from packages stored on a USB
device. There is a brief delay while the library accesses the USB device
when you select this option.
Notes:

• The USB Device option is only available if you connected a USB device
containing the update package in Step 2 on page 515.

• The update package must be stored in the root directory of the USB
device.

8. Click Next. The Drive Staging Details screen displays.

9. On the Drive Staging Details screen, each drive displays either in the Update or
Unchanged section, depending on whether the drive firmware in the update package is
different from the drive’s current firmware.

Figure 297 The Drive Staging Details screen.

Notes: l Depending on the location of the file, there may be a few minutes of delay before the
information displays.

l If no installed drives match the selected firmware, the Drive Package Details screen
displays, instead of the Drive Staging Details screen.
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Figure 298 The Drive Package Details screen.

10.Click Begin Staging. The Package Update Results screen displays.

Figure 299 The Package Update Results screen.

All drives that require an update begin staging automatically. This can take up to 8
hours for LTO drives and up to 16 hours for TS11xx technology drives.

Notes: l Staging only prepares the drive for the update process. After staging is complete, you
can choose which drives to update in Step 2 on page 520.

l There may be a few minutes of delay before the Package Update Results screen
displays.

11.Click Finished on the Package Update Results screen. The firmware staging runs in the
background, allowing the library to perform other tasks.

The Drives screen displays the staging status while the process is active.

The Drives screen displays... when...

The drive firmware is staging to the drive. The
drive icon changes to the staging drive icon, and
the staging status line displays.
Note: A Global Spare icon does not change to the Drive
Staging icon while firmware is staging to it. However,
the staging status line displays.

JUNE 2025 518 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 15 - MAINTAINING THE DRIVES



The Drives screen displays... when...

The drive firmware is finished staging to the drive,
and is available to be used to update the drive.

12.When the staging process completes, a system message displays.

Note: If there are any failures in staging the firmware to the drives, a system message informs you of
the failure. Follow the remedy instructions on the system message and then reset the drive to
restart the staging process.

Discontinue Background Operations

You cannot update drive firmware if the library is actively running any background
operations, including Media Auto Discovery, PreScan, and PostScan.

If you do not want to wait for a Media Auto Discovery, PreScan, or PostScan operation to
complete, you can stop the Media Auto Discovery or PreScan operation or pause the PostScan
operation. For other background operations, wait for the process to complete.

• Click Stop Discovery on the Media Lifecycle Management Tools screen to stop a Media
Auto Discovery or PreScan operation (see Stop the Discovery Process on page 324).

• Click Pause PostScan on the Media Lifecycle Management Tools screen to pause the
PostScan operation for one hour (see Pause the PostScan Process on page 334).

Discontinue Backups and Empty the Drives

Before applying the drive firmware update, discontinue all backup operations and remove any
cartridges from the drives.

CAUTION

Attempting to update the firmware while the library is busy or when the drives
contain tapes may result in the update failing, failed backup jobs, or permanent
damage to the drives. If you did not already do so, stop all backup operations
and remove all tapes from the drives you are updating. If the library has SlotIQ
enabled, run the Advanced Utilities Unload All Drives followed by Resolve
SlotIQ Virtualized Drive to Slot Moves.

• If possible, use your storage management software to move any cartridges that are
currently in drives back to their storage locations.

• If you cannot use your storage management software, then move the cartridges as
described in Moving Cartridges Within a Partition on page 289.
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Apply the Update

1. On the Drives screen, click Staged Drive Firmware Update. The Staged Drive Firmware
Update screen displays.

Figure 300 Click Staged Drive Firmware Update.

2. Select or clear each drive’s check box to indicate whether or not to update the drive.

Note: If a drive is not empty, it is still included in this list; however, its check box is disabled, with a
note indicating that a tape is loaded in the drive.

Figure 301 Select the drives to update.

3. Click Next. The drive firmware update process begins updating the selected drives in
parallel. A progress screen displays until the process completes, in approximately 15 to
30 minutes.

IMPORTANT If the library is running BlueScale12.07.00.04 or later, the external lights on
the library change to yellow during the update process.
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The Drives screen displays... when...

The library starts the firmware update process.
The staging status line changes to “Committing”.

The drive firmware update process is complete.
The staging drive icon changes back to the drive
icon, and the staging status line disappears.

4. After the drive firmware update completes, the Staged Firmware Update Result screen
displays the results of the update process. Click OK to return to the Drives screen

Figure 302 Click OK to return to the Drives screen.

5. After the update is complete, use your storage management software to restart any
backup processes.

Update Using the Drive Firmware Update Wizard

The Drive Firmware Update wizard lets you use one or more firmware tapes to update
multiple drives within a partition, without interrupting normal library operations in other
partitions. The updates are performed as a background operation whenever the library
determines that one of the drives selected for update is empty.

Notes: l You cannot use a Global Spare drive to replace a failed drive while the library is actively
running the Drive Firmware Update wizard in the partition.

l You cannot use the Drive Firmware Update wizard to update a TS11xx technology
drive.

Requirements

• DLM must be enabled (see Enabling DLM on page 353).

Note: Enabling MLM automatically enables DLM.

• The drives to be updated must be configured in a storage partition.
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• The drives to be updated must be offline to the host.

• The firmware update tape must be in an entry/exit slot of the partition.

Note: The partition must have entry/exit chambers configured to use this wizard.

• The drives are updated one partition at a time.

• To update the firmware of a Global Spare, first substitute the Global Spare drive for a drive
assigned to a partition. After the Global Spare drive completes the firmware update
process, it can be removed from the partition and returned to the pool of spare drives (see
Use the Global Spare Drive on page 434 for more information).

Discontinue Backups and Empty the Drives

Before beginning the drive firmware update process, you must discontinue all backup
operations and remove any cartridges from the drives you are updating.

CAUTION

Attempting to update the firmware when the drives contain tapes may result in
the upgrade failing, failed backup jobs, or permanent damage to the drives. If
you did not already do so, stop all backup operations and remove all tapes
from the drives you are updating. If the library has SlotIQ enabled, run the
Advanced Utilities Unload All Drives followed by Resolve SlotIQ Virtualized
Drive to Slot Moves.

• If possible, use your storage management software to move any cartridges that are
currently in drives back to their storage locations.

• If you cannot use your storage management software, then move the cartridges as
described in Moving Cartridges Within a Partition on page 289.

Import the Firmware Update Tapes

1. Log into the library as a user with superuser or administrator privileges.

2. Insert a firmware update tape into a TeraPack magazine (see Figure 139 on page 242).
Make a note of the barcode label on the cartridge so that you can identify it after it is
imported.

Note: If the cartridge is not labeled with a barcode, pay attention to which slot you use (as viewed
from the TAP door, slot 1 is at the back of the magazine; slot 10 is at the front).

3. Import the magazine into the library’s entry/exit pool as described in Importing into a
Storage or Cleaning Partition on page 246.

Notes: l If necessary, export a magazine from the entry/exit pool to provide an empty chamber
for the magazine containing firmware update tapes (see Exporting or Exchanging
Magazines and Cartridges on page 257).
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l Some backup software atomically moves tapes from entry/exit slots into the storage
partition. If this cannot be disabled in the software or you cannot shutdown the
software to prevent this, you cannot use this process.

Perform the Update

1. Select Configuration > DLM to display the Drives screen.

Figure 303 Click Drive Firmware Update on the Drives
screen.

2. Click Drive Firmware Update to launch the update wizard. The Drive Firmware Update
screen displays showing the information for the last partition that was viewed.

3. Select the partition containing the drives you want to update from the drop-down list,
then click Go. The Drive Firmware Update screen refreshes to show the drives assigned
to the selected partition.

Figure 304 Select the partition for the drives you want to
update.

4. Select the drives that you want to update.

IMPORTANT
If you have multiple drive generations in the same partition, make sure that
you only select one generation at a time. Each drive generation uses different
firmware.
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5. Click Next. The Drive Firmware Update Tape Selection screen displays with a list of the
cartridges currently in the entry/exit pool for this partition. Select the firmware tapes you
want to use for the update.

IMPORTANT

If you have firmware update tapes for multiple drive generations in the same
magazine, make sure that you select the firmware update tapes that
correspond to the generation of the drives you selected in Step 4 or the
update fails.

Figure 305 Select the firmware tapes you want to use for
the update.

6. Click Start Update to begin the background operation to update the selected drives. The
Drive Firmware Update screen refreshes to show that the update operation is running.

Figure 306 Drive Firmware Update screen showing an
update running.

After each drive is updated, the library posts a system message indicating whether or not
the update was successful.

Note: Once the update process begins, you cannot start any additional Drive Firmware Update
operations until the currently running process either completes or is stopped.
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7. If you need to change the library configuration, modify a partition, or make other
changes that are restricted while background operations are running, click Stop Update.
The library completes any updates that are currently in progress and then returns the
firmware tape to the magazine.

8. Export the firmware update tape from the library (see Exporting or Exchanging
Magazines and Cartridges on page 257) and store it for future use.

9. Use your storage management software to restart backup processes.

Update Using the Update Drive Firmware Utility

The Update Drive Firmware utility uses a firmware tape to update a single drive or all of the
drives in a single partition.

Note: You cannot use the Update Drive Firmware Utility to update a TS11xx technology drive.

Requirements

• The drives to be updated must be configured in a storage partition.

• The firmware update tape must be in an entry/exit slot of the partition.

Note: The partition must have entry/exit chambers configured to use this utility.

• The drives are updated one partition at a time.

• To update the firmware of a Global Spare, first substitute the Global Spare drive for a drive
assigned to a partition. After the Global Spare drive completes the firmware update
process, it can be removed from the partition and returned to the pool of spare drives (see
Use the Global Spare Drive on page 434 for more information).

Discontinue Background Operations

You cannot update drive firmware if the library is actively running any background
operations, including Media Auto Discovery, PreScan, and PostScan.

If you do not want to wait for a Media Auto Discovery, PreScan, or PostScan operation to
complete, you can stop the Media Auto Discovery or PreScan operation, or pause the PostScan
operation. For other background operations, wait for the process to complete.

• Click Stop Discovery on the Media Lifecycle Management Tools screen to stop a Media
Auto Discovery or PreScan operation (see Stop the Discovery Process on page 324).

• Click Pause PostScan on the Media Lifecycle Management Tools screen to pause the
PostScan operation for one hour (see Pause the PostScan Process on page 334).
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Discontinue Backups and Empty the Drives

Before beginning the drive firmware update process, discontinue all backup operations and
remove any cartridges from the drives.

CAUTION

Attempting to update the firmware while the library is busy or when the drives
contain tapes may result in the update failing, failed backup jobs, or permanent
damage to the drives. If you did not already do so, stop all backup operations
and remove all tapes from the drives you are updating. If the library has SlotIQ
enabled, run the Advanced Utilities Unload All Drives followed by Resolve
SlotIQ Virtualized Drive to Slot Moves.

• If possible, use your storage management software to move any cartridges that are
currently in drives back to their storage locations.

• If you cannot use your storage management software, then move the cartridges as
described in Moving Cartridges Within a Partition on page 289.

Import the Firmware Update Tapes

1. Log into the library as a user with superuser or administrator privileges.

2. Insert a firmware update tape into a TeraPack magazine (see Figure 139 on page 242).
Make a note of the barcode label on the cartridge so that you can identify it after it is
imported.

Note: If the cartridge is not labeled with a barcode, pay attention to which slot you use (as viewed
from the TAP door, slot 1 is at the back of the magazine; slot 10 is at the front).

3. Import the magazine into the library’s entry/exit pool as described in Importing into a
Storage or Cleaning Partition on page 246.

Notes: l If necessary, export a magazine from the entry/exit pool to provide an empty chamber
for the magazine containing firmware update tapes (see Exporting or Exchanging
Magazines and Cartridges on page 257).

l Some backup software atomically moves tapes from entry/exit slots into the storage
partition. If this cannot be disabled in the software or you cannot shutdown the
software to prevent this, you cannot use this process.

Perform the Update

1. From the toolbar menu, select Maintenance > Tools. The Maintenance Tools screen
displays.

2. Select Utilities. The Utilities screen displays.
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3. Click Show Advanced. The Advanced Utilities Confirmation screen displays.

4. Click Next. The Utilities screen refreshes to show a list of the advanced utilities.

5. Scroll through the list of advanced utilities and select Update Drive Firmware. The screen
refreshes to show the details for the utility.

Figure 307 Select the drive to update and the location of
the firmware tape.

6. Use the Select drive or partition to update drop-down list to select the drive(s) that you
want to update. You can choose to:

• Update all of the drives in a partition.

• Update a single drive (selected by its BlueScale identifier).

Note: Drives are identified according to their physical location in the library. For example:
FR1/DBA2/DRV4 refers to the upper right drive in DBA2 of frame 1. See Drive Identifiers on
page 71 for additional information about identifiers.

7. Use the Select EE slot of the firmware tape drop-down list to select the slot in the
magazine where the firmware update tape is located.

Note: If you use the wrong firmware tape or try to update a drive that is not compatible with the
firmware tape, the update operation fails.

8. Click Run Utility to start the update process.

IMPORTANT
l Once the firmware update process starts, it cannot be canceled.
l Do not power off the library or any component being updated during the

firmware update process.
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• The library retrieves the firmware tape and inserts it into the first drive. When the drive
completes the update, it ejects the tape. The library then either returns the tape to the
entry/exit pool or inserts it in the next drive to be updated.

• A progress screen displays for the duration of the update. When completed, a Utility
Results screen displays, showing the results of the update process.

9. Repeat the steps, as needed, for the remaining drives in the library.

10.Export the firmware update tape from the library (see Exporting or Exchanging
Magazines and Cartridges on page 257) and store it for future use. You can use the tape
to update the firmware in a replacement drive if it is at a lower firmware level.

11.Use your storage management software to restart backup processes.
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UPDATING DRIVE DEVICE DRIVERS

Overview

Some operating environments require you to install device drivers before the application
software can correctly communicate with the drives. When you update the drive firmware,
you may also need to update the device driver for the drive.

Use the following instructions to locate and download the IBM LTO drive device driver on the
IBM Support Fix Central website.

Notes: l You must have an IBM account to log in and download the drivers.

l You can connect to the Fix Central website either from the Spectra Logic Technical
Support portal or directly at
https://ibm.com/support/fixcentral. If you connect directly, skip to Step 4 in the
following instructions.

1. Log into your account on the Technical Support portal at
support.spectralogic.com

Note: See Accessing the Technical Support Portal on page 534 for information about accessing the
Technical Support portal.

2. Select Downloads > Device Drivers.

3. On the Device Drivers page, click IBM LTO-3, -4, -5, -6, -7, and -8 (IBM TotalStorage 3580
Ultrium 2, 3, 4, 5, 6, 7 and 8) to open IBM Fix Central in a new web page.

Note: The name of this link may change slightly as new drive generations are added.

4. Click the Select Product tab.

5. Select the following options:

• Product Group = System Storage

• Select from System Storage = Tape systems

• Select from Tape Systems = Tape drivers and software

• Select from Tape drivers and software = Tape device drivers
• Platform = Select your operating system from the drop-down list

Click Continue. A list of the available drivers displays on the Select fixes page.

6. Click Show Fix Details to view information about each driver.

7. Select the driver you want to download and click Continue. If required by your IT
department, select the WHQL certified driver, if available.

8. Complete the remaining screens to begin the download process.
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9. Save the file containing the driver to a known location on the server that is using the
drive.

10.Install the device driver following the instructions in the documentation for your
operating environment.
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ADDING OR REPLACING A DRIVE

Only use drives obtained from Spectra Logic in the library. When replacing a drive that is
assigned to a partition, the new drive must be the same technology and generation as the one
you replace.

Add a Drive to the Library

IMPORTANT

Adding drives to an existing partition can cause the library to reassign
element addresses. To avoid errors, make sure that when you install a new
drive, you reconfigure the element addresses your storage management
software uses to access the drives (refer to your software documentation for
instructions).

If your library has unused drive bays, you can purchase additional drives from Spectra Logic
and add them to the library.

1. Log into the library as either a superuser or administrator.

2. Select Configuration > DLM (or Drives) to view a list of all the drives currently installed
in the library.

Figure 308 The Drives screen.

3. Click Add next to a drive location that does not have a drive installed.
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4. Follow the Spectra T200, T380, T680, T950, and TFinity Drive Installation or Replacement
procedure to install the drive.

5. Connect the drive to a Fibre Channel arbitrated loop or fabric where the hosts reside.

6. After you add the drive to the library, you must create or modify a partition to assign it
to the partition or configure it as a Global Spare drive before you can use it. See
Configuring and Managing Partitions on page 188 for information about creating and
modifying partitions.

Replace a Drive

To replace a drive that failed, follow the instructions in the Spectra T200, T380, T680, T950, and
TFinity Drive Installation or Replacement procedure. Use the cable you disconnected from the
failed drive to connect the new drive to a switch on the arbitrated loop or fabric where the
hosts that use the drives reside.

Figure 309 The Drives screen.

IMPORTANT

Do not click Remove. This option removes the drive from the partition. When
the replacement drive is installed, it is not assigned to the partition from
which the malfunctioning drive was removed.
If you click Remove and the selected drive is the only drive in the partition,
the partition is deleted.

After you replace the drive, do the following to resume operation:

• If you used the Global Spare option to temporarily replace the malfunctioning drive, you
can now reclaim the Global Spare drive so that it is again available for use (see Undo the
Global Spare Drive on page 436). The library automatically switches all incoming
communications to the new drive.

• If you did not use the Global Spare option, use your storage management software to
restart any backup processes that were running to the replaced drive. This restart ensures
that the software recognizes the drive as working and available.
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CHAPTER 16 - TECHNICAL SUPPORT
Spectra Logic Technical Support provides a worldwide service and maintenance structure,
refined over many years to provide timely, professional service.

IMPORTANT A valid BlueScale Software Support key is required in order to obtain technical
support (see Service Contract Extension on page 563).

Accessing the Technical Support Portal 534
Create an Account 534

Log Into the Portal 535

Opening a Support Ticket 536
Returns 541
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ACCESSING THE TECHNICAL SUPPORT PORTAL

The Spectra Logic Technical Support portal provides access to the Knowledge Base, the
current version of BlueScale software for the library, drive firmware, drive device drivers, and
additional service and support tools. You can also open or update a support incident and
upload ASL files.

Create an Account

Access to User Guides and compatibility matrices does not require you to create an account.
You must create a user account and log in to access Release Notes or repair documents, to
download the latest version of BlueScale software, or to open a support incident.

Note: If you have multiple Spectra Logic products, the serial numbers for all products will be
associated with your account. If you do not see the serial numbers for all of your products
when you log in, contact Technical Support (see Contacting Spectra Logic on page 18).

1. Access the Technical Support portal login page at
support.spectralogic.com.

2. On the home page, click Register Now.

Figure 310 The Spectra Logic Technical Support portal home
page.

3. Enter your registration information. Your account is automatically associated with the
serial numbers of all Spectra Logic products owned by your site.

• If you have an invitation, follow the link and enter the invitation code.

JUNE 2025 534 SPECTRA TFINITY LIBRARY - USER GUIDE

CHAPTER 16 - TECHNICAL SUPPORT

https://support.spectralogic.com/


Figure 311 The Signup screen.

• If you do not have an invitation, enter the requested information to create your account.
When you are finished, click Submit.

When the account is approved, you receive an email with an initial password. Use your email
address and the password provided in the email to log in to your account. After you log in,
you can change your password if desired.

Log Into the Portal

Use your email address and password to log into the Technical Support Portal.
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OPENING A SUPPORT TICKET
You can open a support incident using the Spectra Logic Technical Support portal or
telephone.

• Use the following instructions to open a support incident hrough the portal, o

Figure 312 The Spectra Logic Technical Support portal home
page.

1. Make notes about the problem, including what happened just before the problem
occurred.

2. Gather the following information:

• Your Spectra Logic customer number

• Company name, contact name, phone number, and email address

• The library serial number (see Determine the Library Serial Number on page 115)

• Type of host system being used

• Type and version of host operating system being used

• Type and version of host storage management software being used

3. If necessary, log in to the Support Portal by clicking Login, enter your email address and
password, and click Log in.

Note: See Accessing the Technical Support Portal on page 534 if you have not previously created an
account on the Technical Support portal.

4. Submit a support incident.

• Use the following instructions to search for help before submitting a ticket, or skip to
Submit an Incident Directly on page 538.

i. From any page, select Incident>Incidents & Inventory.
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Figure 313 Select Incidents>Incidents & Inventory.

ii. Select Open or View Incidents.

Figure 314 Select Open or View Incidents.

iii. In the Search dialog box, enter a term or phrase about your problem (1) and click
Search (2).
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Figure 315 Enter a search phrase and click Search.

iv. If the search does not provide an answer, click Open a New Incident.

Figure 316 Click Open a New Incident.

v. Continue with Step 5 on page 539.

• Submit an Incident Directly

i. From any page, select Inventory>My Inventory.

ii. Locate the row of the product for which you want to submit an incident and click
Create Incident.
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Figure 317 Click Create Incident.

iii. Continue with Step 5 on page 539.

5. On the Create Incident page, enter the requested information providing as much das
possible. When you are finished, click Submit.

Figure 318 Enter information about your incident and click Submit.
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Notes: l If you have multiple libraries and need to determine the serial number of the affected
library, see Determine the Library Serial Number on page 115.

l If the serial number of the affected library is not listed, contact Technical Support (see
Contacting Spectra Logic on page 18).

• Contact Spectra Logic Technical Support by Phone

To contact Spectra Logic Technical Support by telephone, see Contacting Spectra Logic
on page 18.
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RETURNS

Your Technical Support representative may ask you to return a problem component to Spectra
Logic for analysis and servicing. After you complete a replacement procedure, return the
defective part using ALL of the packaging that the replacement part arrived in (including any
anti-static bags or foam inserts).

Severe damage can occur if the component is not packaged correctly. You may
be invoiced if it is damaged due to improper or insufficient packaging.

Use the return label and instructions that were included with the replacement part when
preparing to ship the component you are returning. If you cannot locate these, contact Spectra
Logic for another copy (see Contacting Spectra Logic on page 18). The return label and Return
Merchandise Authorization (RMA) printed on it are used to associate the returned component
with your account. To avoid being invoiced for failure to return the component, do not ship the
component back to Spectra Logic without the RMA return label.
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APPENDIX A - BEST PRACTICES
This appendix reviews best practices for using Media Lifecycle Management, protecting
library configuration data, and working with media.

MLM Best Practices 543
Implementation Guidelines 543

Usage Policy Guidelines 543

Disaster Recovery Planning 546

Back Up and Protect the Library Metadata 547
Back Up the Library Metadata 547

Verify and Protect the Metadata Backup 549

Using Cartridges 551
Labeling Cartridges 551

Handling Cartridges 551

Storing Cartridges 552

Using Cartridges in the Library 553

Cartridge Rotation 554
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MLM BEST PRACTICES

To effectively use MLM and ensure MLM and DLM data protection, plan a strategy based on
your data center needs and develop policies and procedures to support that strategy. Having
sound management policies and procedures for media rotation and management is essential
for consistent, effective implementation.

Implementation Guidelines

Consider the following best practice guidelines as you prepare to implement MLM in your
environment.

Guideline Description

Identify the people
responsible for backing up
data

The people who perform data backup at your site are typically
the ones who will be responsible for implementing and
following MLM backup procedures.

Identify the users who will
have responsibilities that
involve MLM

It may be wise to have more than a single user familiar with
policies, depending on the size of your organization, so that if
one person is not available, another can take over.

Be consistent with partition
names

Using consistent naming simplifies identifying a specific
partition. Spectra’s suggested naming practice is to list the
location, followed by the library name, followed by the storage
management software. For example, Dallas/TFinity/NetBackup.

On an organizational level,
determine the level of
management your media
requires

The level of media management depends on the requirements
for your environment. For example, you may choose to use
Spectra’s guidelines for retirement for all media, or you may
choose to retire tapes that hold financial or legal data sooner
than recommended. See the Error and Warning health scores in
Generate MLM Reports on page 336 for information on when
cartridges should be retired.

Usage Policy Guidelines

Consider the following guidelines when establishing your Media Lifecycle Management
policies.

Guideline Description

Choose a retirement
guideline

When implementing MLM, decide at the beginning on the
criteria to be used when determining when to retire a cartridge.
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Guideline Description

Spectra suggests using the Media Lifecycle Management health
icon, visible on the MLM Reports screen and on the Details
screen (Figure 182 on page 338 and Figure 183 on page 341,
respectively) for each tape, to assess the overall health of
individual tapes. See Generate MLM Reports on page 336 for
information about using the health icon to assess media health.

Only use MLM-enabled
media and cleaning
cartridges in MLM-
compatible libraries and
drives

For the most accurate tracking, do not import your MLM-
enabled media into non-Spectra Logic libraries or drive
generations earlier than LTO-4. The cartridge MAM will not be
updated with information about usage in those locations. As a
result, the information about usage in those locations will not
be recorded in the MLM database when the cartridge is
returned to your library.

Use only Spectra Certified
Media with MLM support
(both data and cleaning
cartridges) in the library

To ensure the best possible performance, use Spectra Certified
Media. Check the Spectra Logic website for the most up-to-date
media availability. Do not use any media that has not been
approved by Spectra Logic for use in the library.

The library uses information in the MLM database to monitor
the health of the media in the library. For MLM-enabled media,
the detailed health reports let you determine whether a
particular data cartridge is past its useful threshold or
determine whether a particular cartridge is experiencing high
errors rates or retries. For MLM-enabled cleaning cartridges,
you are notified when a cartridge is approaching the end of its
useful life.

Although MLM tracks the general health of media that is not
MLM-enabled, detailed health information is not available for
this media.

Always operate the library
with Media Lifecycle
Management enabled

If you disable and then re-enable Media Lifecycle Management,
any loads, reads, writes, errors, and any other tape related
events that occur while MLM is disabled are not recorded in
the MLM database.

Enable load count alerts Load count alerts, used in combination with the media health
icon, let you monitor the health of individual tapes. Tapes with
low load counts, but with a yellow or red health icon are
vulnerable to high errors rates or retries.
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Guideline Description

For higher levels of notification, configure a threshold for the
maximum number of times a data cartridge can be loaded
before an alert is generated (see Enable MLM and Configure
Settings on page 313). When the number of loads exceeds this
threshold, MLM will generate a system message listing the
barcode of the tape.

You can also enable an alert to notify you when the load count
recorded on the cartridge MAM differs from the load count
stored in the MLM database but none of the other data has
changed. This type of discrepancy can indicate that the tape has
been loaded into a non-Spectra Logic library. Use this alert as a
security feature to let you know when a tape was removed and
loaded into a drive in a different library.

Regularly back up your MLM
database

Determine how frequently to export the MLM database for
storage. You can save the MLM database to a USB device or
email it to a previously configured mail recipient. The database
can be loaded back into the library in the event of an error. See
Disaster Recovery Planning on the next page and Restore the
MLM and DLM Databases on page 427 for detailed information.

Backing up the MLM database produces a point-in-time
snapshot of the MLM database. Based on the number of tapes
you routinely import into and export from the library,
determine how frequently backups are needed to ensure that
you can easily restore the MLM database.

Enable non-MLM media
alerts

Alerts for non-MLM-enabled media notify you when a cartridge
that is not MLM-enabled is loaded into a drive.

Track exported cartridges When a cartridge is exported from the library, an asterisk (*)
next to the barcode indicates that it is currently out of the
library. However, all of the MLM data for the cartridge is still
available. Define the frequency with which you will export the
complete MLM report and make a note of all exported tapes.

Choose relevant information
for saved reports

When you save an MLM report (see Generate MLM Reports on
page 336), you can choose between saving all MLM data or just
the data from the most recently viewed report.

You can save a copy of the MLM report as a comma-separated
text file (*.rpt) to a USB device, mail the saved report to
previously configured email recipient, or both. If desired, you
can zip the file before saving it (see Save an MLM Report on
page 342).
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Disaster Recovery Planning

As a part of best disaster recovery planning and practices, Spectra Logic strongly recommends
backing up the MLM database to a USB device or emailing it to a preconfigured mail recipient
automatically after using MLM for some period of time. In the event of a disaster, you can use
the backup to restore the MLM database information for the media in your library instead of
rebuilding it by loading each cartridge into a drive (see Restore the MLM and DLM Databases
on page 427).

IMPORTANT

The automatic weekly auto-save file reflects the state of the MLM database at
the time the backup was created. If MLM-enabled media is imported into or
exported from the library during the period between the automatic weekly
auto-save operations, the backup of the MLM database may not accurately
reflect the library’s inventory.
If you plan to import or export a large number of MLM-enabled cartridges,
back up the MLM database using the procedure described in Back Up the
MLM and DLM Databases on page 345 when you are finished to ensure that
you have a backup that accurately reflects the information in the database.

Notes: l Backing up the MLM database also backs up the DLM database.

l For extra security, the library’s Auto Configuration Save feature automatically backs up
its configuration and the MLM and DLM databases to the LCM memory card once a
week and whenever a partition is created or modified (see Use Automatic Backup of
the Library Configuration on page 149).

l If email for the auto-save backup is configured, the backups are emailed to the
designated recipient (see Enable Email for the Auto Configuration Save File on
page 129).

l See Back Up and Protect the Library Metadata on the next page for additional disaster
planning information.
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BACK UP AND PROTECT THE LIBRARY METADATA

To ensure the availability of your library and encrypted data, protect library metadata by
following the procedures described in this section. Library metadata includes library
configuration data, the MLM and DLM databases, and all BlueScale encryption key-related
data.

Note: The DLM database is included in any operations that backup or restore the MLM database.

Having reliable backups of the library metadata is very important in the case of disaster
recovery and other situations where you need to restore the library.

CAUTION

Losing your library’s metadata can have catastrophic effects—as can losing keys in
any encryption key management system, especially when related to encrypted
data. If you lose all copies of all metadata:
l Your encrypted data is lost—you will be unable to decrypt encrypted data

without the encryption keys.
l You will need to completely reconfigure your library.
l You will lose stored data about your media that will be time-consuming to

recover.

Back Up the Library Metadata

Use the following methods to create backup copies of all of your library’s metadata. The
following table shows the file names and locations of the data saved during each type of
backup operation.

This backup
method... Creates...

Auto
Configuration
Save Option

A time-stamped zip file containing the library configuration, the MLM and
DLM databases, and any stored BlueScale encryption keys. The file is stored
on the memory card in the LCM and can be sent as an email attachment to a
previously configured mail recipient. The zip file is named
<date-time>cfg.zip, where <date-time> is the time stamp for when the zip file
was created.

• See Enable Email for the Auto Configuration Save File on page 129 for
information about configuring the Auto Configuration Save feature so
that the library automatically sends an email with the current Auto
Configuration Save file to a pre-configured mail recipient once a week
and whenever you create or modify a library partition.
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This backup
method... Creates...

• See Use Automatic Backup of the Library Configuration on page 149 for
information about using this method to back up the library
configuration, the MLM and DLM databases, and any stored BlueScale
encryption keys.

Note: The Auto Configuration Save feature does not automatically create a
backup when you make other configuration changes to the library.

Save MLM
Database
Advanced Utility

A time-stamped file containing the current MLM and DLM databases. The
file is saved to a USB device or emailed to a previously configured mail
recipient. The file is named cminfo_<date-time>.zdt or cminfo_
<date-time>.dat, where <date-time> is the time stamp for when the backup
file was created. The file has a .zdt extension if you zipped the file when
you created it or a .dat extension if you did not choose to zip the file. If
the backup file was saved to a USB device, it is located in a folder called
\SavedMLMDB.

Back Up the MLM and DLM Databases on page 345 provides instructions
for using the utility.

IMPORTANT To ensure that you always have a current backup of the MLM and
DLM databases, back them up regularly.

Partition Wizard
and

Save Library
Configuration
Utility

Multiple configuration files with the format cnnnnnn.cfg, where n is a
number between 0 and 9. You can choose to save the library configuration
data to a USB device or email it to a previously configured mail recipient.

• If the backup files are saved to a USB device, they are located in a folder
called SavedConfigs\<date-time>, where <date-time> is the time stamp
for when the backup was created.

• If the backup was sent as an email attachment, the files will be in a file
named <date-time>cfg.zip, where <date-time> is the time stamp for
when the zip file was created.

IMPORTANT The backup file of the library configuration does not include the
MLM and DLM databases.

IMPORTANT Backing up the library configuration also backs up any
BlueScale encryption keys that are stored in the library at the time the file is
created.

• Partition Wizard — The partition wizard prompts you to save the
library configuration whenever you create or modify a partition. See
Configuring and Managing Partitions on page 188 for detailed
information about creating and modifying partitions.
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This backup
method... Creates...

• Save Library Configuration Utility — Use the Save Library
Configuration utility to back up the updated library configuration
whenever you make a configuration change to the library. This is
especially important when you make configuration changes that do not
result in an Auto Configuration Save file. See Use Manual Backup of the
Library Configuration on page 150 for instructions.

Export Key
Option

A key file containing the exported BlueScale encryption key. The file is
named name.bsk or name.bss, where name is the moniker you assigned
to the key when you created it. You can choose to save the exported key
file to a USB device or email it to a previously configured mail recipient.

Use the BlueScale Export Key option to export BlueScale encryption keys
to a USB device as soon as you create them. The exported keys are
encrypted and password protected. See the Spectra Tape Libraries
Encryption User Guide for instructions.

CAUTION As a matter of best practice, Spectra Logic recommends exporting
BlueScale encryption keys to a USB device instead of using email.

Although emailing BlueScale encryption keys is supported by the library,
doing so presents security issues, including the following:

Copies of encryption keys may be left on the email servers used
for sending and receiving email and are thus subject to
compromise.

The difficulty in verifying where all the copies of emailed
encryption keys may be located can make security audits more
challenging.

Verify and Protect the Metadata Backup

Do the following to ensure that your metadata is protected and available when you need it:

1. As soon as you create and export the backup files, check the exported data to make sure
the correct files are present and accessible.

• Plug the USB device into a computer or laptop.

• If you emailed the metadata (the data is sent as an attachment), save the data to a USB
device, and then check the data in the email attachment and the data on the USB device.

The following figures show examples of the files you will see when you check your USB
device or the email attachment.
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Saved Data Details

BlueScale
Encryption Key
(TFinity_
SF2.bsk)

Note: The screen shown here also includes the SavedMLMDB and SavedConfigs
folders.

MLM and DLM
Data

Note: In this example the file has a .zdt extension. The file will have a .dat
extension if you did not choose to zip the file when you created it.

Configuration
Data

Note: The files are located in the \SavedConfigs\<date-time> folder, where
<date-time> in this example is 2011-08-11_11_14_06.

2. Store at least one USB device containing the backup files off-site. After you have several
weeks of backups stored off-site, rotate back through them.

3. When you run through disaster recovery exercises, test restoring the library using the
backup files from both your USB devices and your saved email attachments. See
Restoring the Library Configuration on page 420 for instructions.
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USING CARTRIDGES

The following sections describe best practices for using cartridges and for managing your
media inventory. All library user groups have privileges that allow them to use the library’s
user interface to perform the cartridge handling and media management operations described
in this appendix. Because handling cartridges requires physical interaction with the library,
much of the information in this appendix is not applicable when you are accessing the library
using the BlueScale web interface.

Note: See MLM Best Practices on page 543 for additional guidance when using Spectra Certified
Media with MLM support.

Labeling Cartridges

If you are not using pre-labeled Spectra Certified Media (both data and cleaning cartridges),
be sure to label all cartridges with the appropriate barcode labels. Position each label in the
indented area on the cartridge, as illustrated in Figure 319. See Barcode Label Specifications on
page 602 for detailed information about preparing and using barcode labels.

CAUTION Do not place labels on any surface of the cartridge except the area shown in
Figure 319. A loose label can become dislodged and damage the drive.

Figure 319 Properly barcode label all cartridges (LTO cartridge
shown).

Handling Cartridges

Incorrect handling or an incorrect environment can damage the LTO cartridge or the magnetic
tape inside it. To avoid damage to your cartridges and to ensure the continued high reliability
of your drives, use the following guidelines:
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• Do not drop the cartridge. If the cartridge drops, slide the cartridge door back and ensure
that the leader pin is properly seated in the pin-retaining spring clips. Inspect the rear of
the cartridge (the part that you load into the tape drive first) and ensure that there are no
gaps in the seam of the cartridge case.

• Do not open any part of the cartridge other than the cartridge door. Do not open any other
part of the cartridge case. The upper and lower parts of the case are held together with
screws; separating them destroys the usefulness of the cartridge.

• Do not handle tape that is outside of the cartridge. Handling the tape can damage the
tape’s surface or edges, which may interfere with read or write reliability. Pulling on tape
that is outside of the cartridge can damage the tape and the brake mechanism in the
cartridge.

• If tape is outside of the cartridge, slide the cartridge door back and turn the hub to gently
spool the tape back into the cartridge. Test the tape by using your storage management
software to write to the tape, and then run a PostScan.

• Before you use a cartridge, let it acclimate for at least 24 hours to the normal operating
environment.

• Ensure that all surfaces of a cartridge are dry before inserting it into a magazine.

• Do not stack more than six cartridges.

• Do not expose the tape cartridge to moisture or direct sunlight.

• Do not degauss a tape cartridge that you intend to use/reuse. Degaussing makes the tape
unusable.

• Do not expose recorded or blank tape cartridges to stray magnetic fields (such as terminals,
motors, video equipment, X-ray equipment, or high-current cables or power supplies). Such
exposure can cause the loss of recorded data or make the blank cartridge unusable.

• Maintain the environmental conditions specified in Tape Media Specifications on page 598.

Storing Cartridges

While in use, cartridges are stored in TeraPack magazines inside the library. When the
cartridges are outside of the library, Spectra Logic recommends storing them in magazines with
dust covers.
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Figure 320 TeraPack magazines with barcode labeled cartridges and plastic
dust cover (LTO magazines shown).

Storing and handling cartridges in magazines helps to eliminate errors resulting from
mishandling individual cartridges, which is the leading cause of cartridge damage. An
optional clear plastic dust cover snaps onto the magazine to protect the cartridges.

Whenever you remove cartridges from your library, be sure to store them properly to
maximize archival life and ensure data integrity. Follow these guidelines for proper cartridge
storage:

• Store cartridges in a suitable environment (see Tape Media Specifications on page 598).

• Keep the storage location as free of airborne particulates as possible. To eliminate obvious
sources of particulates, do not permit anyone to smoke, eat, or drink near the storage area,
and do not store cartridges near a copier or printer that may emit toner and paper dust.

• Store cartridges with the write-protect switch in the protected position (see Preparing
Cartridges for Use on page 239).

• Store cartridges as soon as possible after you remove them from the library. Immediate
storage helps avoid many of the conditions that can damage tapes, such as temperature
and humidity fluctuations, particulate contamination, and excessive handling.

• If you plan to ship a TeraPack magazine, make sure that you have a proper shipping
container and that you use adequate packing material. The TeraPack carrying cases
available from Spectra Logic are designed for safely transporting TeraPack magazines off
site and are compatible with Iron Mountain.

Using Cartridges in the Library

This section describes the best practices for using cartridges in the library.

• Use only cartridges from approved vendors in the library. See Media and Media
Accessories on page 561 for more information about Spectra Certified Media.
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• Make sure that the entry/exit pool contains one or more empty TeraPack magazines. This is
particularly important when your storage management software ejects tape cartridges from
a partition.

If the entry/exit pool does not have any empty slots available for the ejected media, then
the storage management software must wait until empty slots become available. The
simplest way to avoid this delay is to import one or more empty TeraPack magazines after
you export media from the library.

Alternatively, always make sure that you import full TeraPack magazines into the library,
then use your storage management software to move (import) all of the new media into the
storage pool for the partition. After all of the media is moved to the storage pool, you will
end up with one or more empty magazines in the entry/exit pool.

• Make the entry/exit pool large enough to accommodate all of the cartridges typically
imported or exported during a single operation. For example, if you run a nightly backup
that uses 48 cartridges which are then exported each morning, create an entry/exit pool of
50 LTO slots (5 chambers) or 54 TS11xx technology slots (6 chambers).

• After your library has been in use for a period of time, and at least one set of cartridges has
completed a round trip (exported from the library, stored off site, then re-imported), the
following rule of thumb applies: if you remove a TeraPack magazine from the entry/exit
pool, replace it with either an empty magazine to accommodate future eject operations or a
full magazine whose cartridges are then imported into the storage pool using your storage
management software.

• During an import or export operation, do not leave the library unattended for more than a
few minutes. If you do, the import or export operation times out so that the library can
continue automated backup tasks. To continue, restart the operation when you are ready.

• Enable Auto Drive Clean and configure a cleaning partition to clean drives whenever
required to help ensure optimal performance. If you do not use the Auto Drive Clean
feature, periodically check the Drives screen to determine whether the drives require
cleaning (see Cleaning a Drive on page 499).

• Confirm the quality of your media and verify data integrity by occasionally running
restores using different drives.

• Confirm the quality of both media and drives by running periodic disaster recovery drills.
These drills test the overall ability to recover all of your data using your backups.

Cartridge Rotation

During normal backup operations, tapes are rotated into and out of the library. This section
provides a simple example of the library’s media life cycle functionality to manage tape
rotation. Using a backup plan similar to the one described in the following example for a
period of time establishes a media rotation schedule for the library. The example assumes the
following:

• The library has a total of 17 licensed chambers and uses LTO media.

• 2 chambers are assigned to the entry/exit pool (20 slots, or 2 TeraPack magazines).
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• 15 chambers are assigned to the storage pool (150 slots, or 15 TeraPack magazines).

• The library contains 15 full TeraPack magazines and two empty TeraPack magazines.

• Two magazines containing 20 cartridges worth of backup data are sent off site every
Friday.

• After the data has aged two weeks, the media is returned to the library and re-used.

• The site adheres to the following best practices:

• Whenever a TeraPack magazine is exported, another magazine (either full or empty) is
imported.

• The library has enough empty TeraPack magazines to fill the entry/exit pool.

This example shows that, by Week 3, the backup plan results in a full media rotation in which
the operator has done the following:

1. Removed and stored two full TeraPack magazines of media. Full magazines were
exported from the entry/exit pool and removed through the TAP, resulting in an empty
entry/exit pool.

2. Imported two full TeraPack magazines into the entry/exit pool through the TAP and then
used the storage management software to move the media in the entry/exit pool into the
storage pool.

Moving the media to the storage pool leaves two empty magazines in the entry/exit
pools, ready to accept media as the storage management software identifies media as
ready to be ejected from the library.

The following sections describe and illustrate the rotation process .

Initial Installation of Cartridges

The library is configured with a single partition and has a total of 17 licensed chambers
assigned to either the entry/exit pool or storage pool. When the library is initially installed,
chambers are filled with TeraPack magazines as described in the following illustration.
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End of Week 1

The storage management software ejects cartridges from the storage pool. The library moves
the cartridges to empty magazine slots in the entry/exit pool, making them ready to be
removed from the library and stored off site.
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End of Week 2

The storage management software ejects cartridges from the storage pool. The library moves
the cartridges to empty magazine slots in the entry/exit pool, making them ready to be
removed from the library and stored off site.

End of Week 3

The storage management software ejects cartridges from the storage pool. The library moves
the cartridges to empty magazine slots in the entry/exit pool, making them ready to be
removed from the library and stored off site. The two full magazines stored off site in Week 1
are ready for re-use. After importing the full magazines into the entry/exit pool, the storage
management software is used to move the cartridges to the storage pool, leaving two empty
magazines in the entry/exit pool.
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APPENDIX B - MEDIA & UPGRADES
This appendix describes media, accessories, and upgrades that can be purchased for use with
the Spectra TFinity library. It also describes how to renew or extend the service contract for
the library.
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MEDIA AND MEDIA ACCESSORIES

Spectra Logic offers a variety of media and media accessories for the library.

Spectra Certified Media

Media formulations

There are two distinct formulations for LTO media: Metal Particle (MP) and Barium Ferrite
(BaFe). LTO-2 through LTO-5 media are only available in the Metal Particle formulation. LTO-
6 media can be purchased in either the Metal Particle or the Barium Ferrite formulation. LTO-6
drives are designed to run both MP and BaFe media. The two formulations can be used in the
same partition. LTO-7 and later generation media are only available in the Barium Ferrite
formulation.

TS11xx technology media (3592JC) is only available in the Barium Ferrite formulation.

Certification process

Spectra Certified Media begins with the highest quality data cartridges received directly from
the manufacturer. During certification, each cartridge is MLM-enabled. In addition, LTO data
cartridges undergo the unique CarbideClean process, which removes embedded particles and
smooths the imperfections in the tape surface that are a result of the manufacturing process.
By cleaning the tape of the debris that exists on all new media, CarbideClean reduces signal
loss and excessive tape head wear, thereby increasing the reliability, availability, and longevity
of the drives and media.

Barcode labels

For your convenience, all Spectra Certified Media is available pre-labeled with sequential
barcode labels. Optional custom barcode sequences can be ordered, if desired. Using Spectra
sequential pre-labeled media ensures that you will never have to deal with the problem of
duplicate barcodes. Spectra Logic’s barcode labels carry the same lifetime guarantee that
protects each Spectra Certified Media cartridge.

Media Storage

Spectra Logic offers both TeraPack magazines and Maintenance TeraPack magazines
pre-loaded with Spectra Certified Media data cartridges or cleaning cartridges, respectively.
The magazines are available with or without a protective dust cover to protect the cartridges
when they are not stored in the library. Empty magazines are also available.

Check the Spectra Logic website at spectralogic.com for the most up-to-date media availability.
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Media and Media Accessories

Spectra Logic offers the following media and accessories:

Media or
Accessory Description

Certified media
packs

Each pack contains one TeraPack magazine filled with Spectra Certified
Media (ten LTO data cartridges or nine TS11xx technology data cartridges)
with standard barcode labels. The media packs are available with or
without a protective dust cover.

Note: With the exception of WORM media, all Spectra Certified media is MLM-
enabled.

Certified media
pack with custom
barcode labels

Each pack contains one TeraPack magazine filled with Spectra Certified
Media (ten LTO data cartridges or nine TS11xx technology data cartridges)
with custom barcode labels. The media packs are available with or
without a protective dust cover. You must order a minimum of four
custom-labeled packs at a time.

Cleaning
cartridges

Spectra Certified cleaning cartridges are available in Maintenance
TeraPack magazines containing either five or ten LTO cleaning cartridges,
or five or nine TS11xx technology cleaning cartridges. The cleaning
cartridges have “CLN” at the beginning of the barcode sequence on their
labels.

Notes:

• All Spectra Certified LTO cleaning cartridges are MLM-enabled. The
cleaning cartridges are stored in Spectra Maintenance TeraPack
magazines, which are identified by unique labels.

• Starting with BlueScale12.7.04, TS11xx technology cleaning tapes are
always treated as MLM enabled by the BlueScale software..

Barcode labels (in
series of 300)

High-contrast, high-resolution labels for reliable operation. Labels are
available either with a standard barcode numbering sequence or with a
custom barcode numbering sequence. Barcode labels for cleaning
cartridges are also available. The barcode labels for cleaning cartridges
have “CLN” at the beginning of the barcode sequence.

TeraPack
magazines

Empty TeraPack magazines and Maintenance magazines are available.
Each magazine holds ten LTO cartridges or nine TS11xx technology
cartridges. The magazines are available with or without a protective dust
cover.

TeraPack
magazine
carrying cases

Carrying cases are designed for safely carrying TeraPack magazines off
site. Cases are compatible with Iron Mountain.
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How To Order

Check the Spectra Logic website at spectralogic.com for the most up-to-date media availability.

To purchase Spectra Certified Media and media accessories, contact your sales representative
(see Contacting Spectra Logic on page 18) or use the Spectra Logic online store at
shop.spectralogic.com.
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LIBRARY SUPPORT AND UPGRADES

The library ships with the service contract and options purchased with the library. You can
renew your service contract or purchase more capacity or additional options described in this
section at a later date.

Service Contract Extension

Your initial library purchase includes a BlueScale Software Support key that is valid for the
duration of the warranty period, or for the duration of any uplifted or extended service
contract you purchased with the library, whichever is longer. A valid BlueScale Software
Support key is required in order to update the library’s BlueScale software and the firmware
for library components, and to obtain technical support.

IMPORTANT

When you renew or extend your service contract, you must generate a new
BlueScale Software Support key and enter the new key into the library to
allow continued access to updates (see Enabling BlueScale Software Support,
Options, and Upgrades on page 112).

When the original warranty or service contract expires, a renewal contract can be purchased to
continue service. Contact Spectra Logic to purchase a renewal contract (see Contacting Spectra
Logic on page 18).

BlueScale Software Updates

Updates to the library’s BlueScale software are free of cost to customers who have a current
service contract with Spectra Logic Technical Support. When a service contract is renewed,
you must generate a new BlueScale Software Support key and enter it into the library to allow
continued access to updates. See Enabling BlueScale Software Support, Options, and Upgrades
on page 112 for information.

IMPORTANT

Updating the BlueScale software and the firmware for the library components
requires a current service contract with Spectra Logic Technical Support. The
BlueScale Software Support key associated with your service contract must
be stored in the library by entering it into the System Configuration screen.
See Enabling BlueScale Software Support, Options, and Upgrades on
page 112 for additional information.
If you have questions about your service agreement, contact Spectra Logic
Technical Support (see Contacting Spectra Logic on page 18).

See Updating the BlueScale Software and Library Firmware on page 471 for update
instructions.
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Library Upgrades

Upgrades available for purchase include BlueScale software options and library hardware
upgrades. You can purchase options and upgrades from your sales representative (see
Contacting Spectra Logic on page 18).

Options

The following table describes the BlueScale software options that are available. See Enabling
BlueScale Software Support, Options, and Upgrades on page 112 for information about
enabling these options.

Library Option Description

BlueScale
Encryption
Standard Edition

BlueScale Encryption Standard Edition, included free on the TFinity
library, provides a strong, easy to use method of encrypting data using a
single key on the library, letting you add encryption without adding
complexity.

See the Spectra Tape Libraries Encryption User Guide for more information
about BlueScale Encryption.

BlueScale
Encryption
Professional
Edition

In addition to the features of the standard edition, BlueScale Encryption
Professional Edition supports multiple keys on a library and additional
security features so that you can implement more customized data
encryption regimens.

See the Spectra Tape Libraries Encryption User Guide for more information
about BlueScale Encryption.

Spectra SKLM
Encryption Key
Management
System

Spectra Security Key Lifecycle Manager (Spectra SKLM) is a centralized
key management system that allows you to manage the lifecycle of the
encryption keys and security certificates for your library. Spectra SKLM
provides role-based access control, based on user privileges, for tasks that
range from creating and assigning encryption keys to the backup and
restoration of data.
See the Spectra Tape Libraries Encryption User Guide for more information
about the Spectra SKLM Encryption key management system.

KMIP Encryption
Kay Management
using the HP
Enterprise Secure
Key Manager
(ESKM)

The Key Management Interoperability Protocol (KMIP) using the HP
Enterprise Secure Key Manager (ESKM) is a centralized key management
system that allows you to manage the lifecycle of the encryption keys and
security certificates for your library. The library software uses the HP
ESKM server to generate, store, and retrieve security keys used by tape
drives for data encryption.
See the Spectra Tape Libraries Encryption User Guide for more information
about the KMIP Encryption key management.
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Library Option Description

Capacity-On-
Demand (CoD)

The Capacity-On-Demand (CoD) feature lets you purchase a library that
meets your current storage needs and then purchase additional capacity
later as required. CoD reduces up-front costs, because users only pay for
what they currently need. As more capacity is required, it can be added in
increments by purchasing activation codes to license additional chambers
in the library and additional TeraPack magazines to fill the added
chambers.

Note: If you purchase CoD capacity that exceeds the number of unlicensed
chambers available in the current library configuration, you must purchase
another TBA or add another frame. These upgrades and their installation by a
certified Spectra Logic field technician are priced separately from the CoD
capacity upgrade.

Rotation Manager Rotation Manager is a keyed option to simplify identifying tapes that have
been moved off site. With Rotation Manager installed, the library sends an
email containing the barcode information for every piece of media and its
off-site location to a specified email address.

See Configure Rotation Manager on page 147 for additional information
about Rotation Manager.

Shared Library
Services (SLS)

Shared Library Services (SLS) partitioning logically divides the library into
multiple virtual libraries. With SLS, one library can support multiple
media types and provide dedicated library services to multiple user
groups. The default library configuration includes support for a single
storage partition. If you need additional storage partitions, you must
purchase a Shared Library Services (SLS) activation key.

See Library Partitions on page 63 for more information about using
partitioning in the library using SLS.

Hardware Expansion and Upgrades

The Spectra TFinity library is designed to expand to meet changing storage requirements, as
well as to achieve storage consolidation goals. These expansion and upgrade options can be
purchased through a sales representative (see Contacting Spectra Logic on page 18).

The following table describes the types of hardware expansion and upgrades that are
available.
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Hardware Description

BlueScale Vision
Camera

The web-based BlueScale Vision camera lets you visually monitor the
interior of the library. In multi-frame libraries, additional BlueScale Vision
cameras can be installed in the expansion frames to provide monitoring of
the entire library. Each camera can view the interior of the frame where it
is mounted and one frame to either side. A BlueScale Vision camera is
standard in the main frame. You can purchase additional cameras when
you order your library or as an upgrade at a later date.

Note: Cameras must be installed by a certified Spectra Logic field technician.

Drive Bay
Assembly (DBA)

If all of the currently installed DBAs in the library are fully populated
with drives and your library includes one or more TeraPack Bay
Assemblies (TBAs), you can replace a TBA with a DBA.

Note: Replacing a TBA with a DBA reduces the storage capacity of your library.

TeraPack Bay
Assembly (TBA)

If all of the currently installed TBAs in the library are fully populated with
TeraPack magazines and your library includes more than one Drive Bay
Assembly (DBA), you can replace a DBA with a TBA.

Note: Replacing a DBA with a TBA can reduce data throughput.

Drives Each Drive Bay Assembly (DBA) holds up to four drives. If a DBA is not
full, additional drives can be installed to increase data throughput.

IMPORTANT Do not attempt to install drives purchased from other vendors in
the library. The drives used in the library are specifically configured for use
in the library and must be purchased from Spectra Logic.

Expansion Frames The storage capacity or performance of the library can be increased by
adding media or drive expansion frames, respectively.

See Drive, Media, and Service Frames on page 68 for information about
the number and types of expansion frames that can be added to the
library.

Power Supplies The library requires a minimum of one 5/12 VDC power supply module
per populated DBA. It also requires a minimum of six 24 VDC robotics
power supply modules (two modules in the main frame and two in each
service frame). Optionally, you can purchase an additional supply per
frame, which in combination with the dual AC power inputs, provides
redundancy and failover protection. The power supply modules needed
for the power redundancy configuration are an option you can purchase
separately or when you order the library.

Robotics Interface
Module (RIM)

A RIM can be used to provide the robotic control path to the library’s
TeraPorter(s). One RIM can support up to eight library partitions; one
RIM2 can support up to 16 partitions.
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Hardware Description

Two or more RIMs of the same type (RIM or RIM2) are required if you
want to use the BlueScale controller failover feature for enhanced
availability.

USB Device You can use a USB device for saving backups of the library configuration
and MLM database, when you are updating the library’s BlueScale
software, or as a troubleshooting tool for use as instructed by Spectra
Logic Technical Support. USB devices are available for purchase from
Spectra Logic for a nominal charge.

Note: The library only recognizes FAT-formatted, not NTFS-formatted, USB
devices.

How to Order

To purchase library upgrades, including a renewed or extended service contract, determine
your library Hardware ID (see Determine the Library Serial Number on page 115) and then
contact your sales representative (see Contacting Spectra Logic on page 18).
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REPLACEABLE COMPONENTS

Some library components are easy to remove and install. They are classified as customer-
replaceable units (CRUs) and they are available for purchase based on your service contract
with Spectra Logic Technical Support (see Technical Support on page 533). CRUs include:

• Air filters

• Drives

• RIMs

• Library Control Module (LCM)

• Robotics Control Module (RCM)

• Power supply modules

• Power Management Module (PCM)

• Service bay controller (SCM)

• Expansion power module (ECM)

• Transporter (not the entire TeraPorter)

• Power rail brushes

• Memory card in a Spectra LS

Depending on your service contract, you may also be able to replace certain additional
components that are classified as field-replaceable units (FRUs).
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APPENDIX C - SPECIFICATIONS
This appendix provides specifications for the Spectra TFinity library, as well as the drives and
media used in the library:

Library Specifications 570
Data Storage Capacity 570

Size and Weight 572

Service Access Requirements 575

Shipping and Storage Size and Weight 575

Power Specifications 576

Environmental Specifications 580

Shock and Vibration Specifications 585

Interoperability and Software Compatibility 585
Interface Specifications 586

Component Interface Connectors 586

Network Interface Cable Requirements 586

Universal Serial Bus (USB) Support 588

NDMP Support 588

Tape Drive and Media Specifications 589
LTO Tape Drive Specifications 589

TS11xx Technology Tape Drive Specifications 594

Drive-Based Encryption Highlights 598

Tape Media Specifications 598

Barcode Label Specifications 602

Note: The specifications in this chapter are subject to change without notice.
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LIBRARY SPECIFICATIONS
The following sections provide detailed specifications for the library including data storage
capacity, library size and weight, space requirements, power specifications, environmental
specifications, and shock and vibration specifications.

Data Storage Capacity
The TFinity library provides flexible storage capacity that expands from a minimum of one
media pack up to the maximum storage capacity of the library. The capacity specifications in
this section assume that only one type of drive and media is installed in the frame. Some
configurations of TFinity libraries using the High Performance Transporter and
BlueScale12.7.04, or later, support mixed media and drive types. When using mixed drives and
media, the library’s capacity depends on the number of frames in the library, the number of
drives and slots inside each frame, and the type(s) of drives and media used. See Drive,
Media, and Service Frames on page 68 for an explanation of the different types of frames that
can comprise the library.

Main Frame

The following table shows the capacity of the library’s main frame in its two basic
configurations. The information in the table assumes that only one type of tape drive and tape
media are installed in the frame.

Tape
Drives

TS11xx
Technology
TeraPack
Magazines
(Slots)

Native Capacity (TB) a

TS1140
Tech

TS1150
Tech

TS1155
Tech

TS1160
Tech

TS1170
Tech

1 - 12 78 (702) 2808 7020 10530 14040 35100

13 - 24 66 (594) 2376 5940 8910 11880 29700

aIncludes magazines stored in the entry/exit pool. The media stored in the entry/exit pool are not available for use by the
application software for writing or reading data until they are moved to the storage pool.
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Tape
Drives

LTO
TeraPack
Magazines
(Slots)

Native Capacity (TB) a

LTO-4 LTO-5 LTO-6 LTO-7
LTO-7
Type
M

LTO-8 LTO-9 LTO-
10

1 – 12 92 (920) 736 1380 2300 5520 8280 11040 16560 27600

13 - 24 80 (800) 640 1200 2000 4800 7200 9600 14400 24000

Expansion Frames

The capacity of an expansion frame depends on the type of frame and its configuration. For
each expansion frame, add the frame’s capacity to that of the main frame to calculate the
capacity of the entire library.

Tape
Drives

TS11xx
Technology
TeraPack
Magazines
(Slots)

Native Capacity (TB)

TS1140
Technology

TS1150
Technology

TS1155
Technology

TS1160
Technology

TS1170
Technology

Drive Expansion Frame

1 - 12 87 (783) 3132 7830 11745 15660 39150

13 - 24 75 (675) 2700 6750 10125 13500 33750

Media Expansion Frame

0 110 (990) 3960 9900 14850 19800 49500

aIncludes magazines stored in the entry/exit pool. The media stored in the entry/exit pool are not available for use by the
application software for writing or reading data until they are moved to the storage pool.
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Tape
Drives

LTO
TeraPack
Magazines
(Slots)

Native Capacity (TB)

LTO-4 LTO-5 LTO-6 LTO-7
Type
M

LTO-8 LTO-9
LTO-
10

Drive Expansion Frame

1 - 12 101 (1010) 808 1515 2525 6060 9090 12120 18180 30300

13 - 24 89 (890) 712 1335 2225 5340 8010 10680 16020 26700

Media Expansion Frame

0 130 (1300) 1040 1950 3250 7800 11700 15600 23400 39000

Service Frame

The service frames are located at each end of the library. The capacity for standard service
frames and bulk TAP service frames is the same. Add the capacity of each service frame to the
capacity of the other frames to calculate the capacity of the entire library.

Starting with BlueScale12.8.04, a non-isolating service frame configuration is available that replaces the
right and left service frame with media expansion frames. See Expansion Frames.

Tape
Drives

TS11xx
Technology
TeraPack
Magazines
(Slots)

Native Capacity (TB)

TS1140
Technology

TS1150
Technology

TS1155
Technology

TS1160
Technology

TS1170
Technology

0 42 (378) 1512 3780 5670 7560 18,900

Tape
Drives

LTO
TeraPack
Magazines
(Slots)

Native Capacity (TB)

LTO-4 LTO-5 LTO-6 LTO-7
Type
M

LTO-8 LTO-9 LTO-10

0 50 (500) 400 750 1250 3000 4500 6000 9000 15000

Size and Weight

The following table shows the size and weight specifications for the library frames and other
components.
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Notes: l All dimensions and weights are approximate.

l To calculate the approximate weight of a loaded library, calculate the total weight for
all of the frames and then add the weight for each drive, RIM, and power supply, plus
the weight of each TeraPack magazine full of cartridges.

l When calculating space requirements, include the service access requirements
described in Service Access Requirements on page 575.

Parameter

Specification

Main Frame
Drive
Expansion
Frame

Media
Expansion
Frame

Non-
Isolating
Service
Frame

Service
Frame

Height a 79.125 to 82 in. (201.0 to 208.3 cm)

Width 29 in. (73.7 cm) 34 in.(86.4
cm)

31 in.(78.7
cm)

Depth b 43 in. (109.2 cm)

Weight c, d 6D0T: 821 lb
(372 kg)
3D3T: 810 lb
(367 kg)

6D0T: 763 lb
(346 kg)
3D3T: 750 lb
(340 kg)

564 lb (256
kg)

564 lb (256
kg)

Standard:
737 lb (334
kg)

Bulk TAP:
824 lb (374
kg)

Each drive
(with drive
sled)

• LTO-4: 11.5 lb (5.2 kg)
• LTO-5 and LTO-6:
11.6 lb (5.3 kg)

• LTO-7 FH: 11.2 (5.1 kg),
HH: 9.5 lb (4.3 kg)

• LTO-8: FH: 11.0 (5.0 kg),
HH: 9.6 lb (4.4 kg)

• LTO-9: FH: 11.1 (5.0 kg)

N/A N/A N/A

aThe height of each frame can be adjusted to allow frame-to-frame leveling on uneven floors.

bThis dimension is for the frame with the front and back cover panels installed.

cThese weights are with no RIMs, drives, or media installed.

d6D0T means six Drive Bay Assemblies and zero TeraPack Bay Assemblies. 3D3T means three Drive Bay Assemblies and
three TeraPack Bay Assemblies or shelves.
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Parameter

Specification

Main Frame
Drive
Expansion
Frame

Media
Expansion
Frame

Non-
Isolating
Service
Frame

Service
Frame

• LTO-10: FH: 11.1 (5.0 kg)

Each
TeraPack
magazine

• with ten LTO cartridges: 5.1 lb (2.3 kg)
• with nine TS11xx technology cartridges: 5.6 lb (2.5 kg)

Each RIM 5 lb (2.3 kg) N/A N/A

Each power
supply

4 lb (1.8 kg) N/A 4 lb (1.8 kg)

The following table shows the fully loaded maximum weight of each frame type.

Frame Type a Maximum Weight for
LTO Frame

Maximum Weight for
TS11xx Technology
Frame

6D0T Main Frame 1574 lb (714 kg) 1641 lb (744 kg)

3D3T Main Frame 1461 lb (663 kg) 1578 lb (716 kg)

6D0T Drive Frame 1561 lb (708 kg) 1627 lb (738 kg)

3D3T Drive Frame 1447 lb (656 kg) 1569 lb (712 kg)

Media Frame 1227 lb (557 kg) 1180 lb (535 kg)

Service Frame 1000 lb (454 kg) 980 lb (445 kg)

Bulk TAP Service
Frame

1087 lb (493 kg) 1067 lb (484 kg)

a6D0T means six Drive Bay Assemblies and zero TeraPack Bay Assemblies. 3D3T means three Drive Bay Assemblies and
three TeraPack Bay Assemblies or shelves.
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Service Access Requirements

Minimum Access Requirements

A minimum of 2 ft (0.6 m) of clearance is required on the left and right ends of the library to
provide service access to the library. If data center equipment is on rolling racks and can be
easily moved to provide 2 ft (0.6 m) of clearance on each end of the library, then having
equipment adjacent to the ends of the library is acceptable. In addition, a minimum of 2 ft (0.6
m) of clearance at the front and back of the main frame, each drive expansion frame, and each
service or bulk TAP service frame is required for airflow and service and operator access.

Recommended Access Requirements

IMPORTANT Providing 3 feet (0.9 meters) of clearance on each side of the library is highly
recommended.

Refer to the Spectra TFinity Library Site Preparation Guide for detailed information about space
and access requirements.

Shipping and Storage Size and Weight

The following table provides the approximate dimensions and weights of the pallet and boxes
used to ship the library.

Height Width Depth Weight

Crated Frame a 7.2 ft (2.2 m) 3.5 ft (1.1 m) 4.6 ft (1.4 m) 1,200 to 1,300
lb b (544 to 590
kg)

Crated TeraPorter c 6.8 ft (2.1 m) 2.6 ft (0.8 m) 2.1 ft (0.6 m) 200 lb (91 kg)

Component Pallet d,

e

1.8 to 5 ft
(0.6 to 1.5 m)

3.5 to 14.9 ft
(1.1 to 4.6 m)

1.8 to 5 ft
(0.6 to 1.5 m)

200 to 400 lb
(91 to 181 kg)

aEach frame is shipped in a separate crate. The accessory box might ship with the main frame.

bThe weight does not include drives, media, RIMs, TeraPorter, or power supply modules.

cEach TeraPorter ships in a separate crate.

dAssumes multiple components are shipped together on a single pallet. Components may also be shipped individually.

eThe size and weight of the component pallet depends on the number and type of components shipped. To calculate the
approximate weight of all the components, add 12 lb (5.4 kg) for each drive, 5 lb (2.3 kg) for each TeraPack magazine full
of media, 5 lb (2.3 kg) for each RIM, and 4 lb (1.8 kg) for each power supply.
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Power Specifications

This section describes the power specifications for the library.

Input Power Requirements

The main frame and drive expansion frames include dual AC power modules. When using a
redundant power configuration, connect each input on the dual AC power module to a
separate branch circuit, which allows for failover in the event of a power failure in one of the
circuits.

CAUTION
If you are installing or moving the library and connecting new power cords to
it, see the Spectra TFinity Library Site Preparation Guide for important
information about testing the power cords.

Power Rating

Each library frame is rated at 200–240 VAC at 16 amps (3840 watts maximum). This power
rating is based on a main frame with 24 LTO drives and 6 RIMs, which is the configuration for
maximum power consumption by a single frame. The frames are not rated at 120 VAC due to
the high current required to supply the product.

Power Cord Specifications

The power cords included with the library are considered part of the library and are not
intended for use with any other equipment. See Supply-End Connector Types on the next page
for the different types of cords available from Spectra Logic.

Notes: l The supply-end connector is considered the disconnect for the unit. Make sure that the
socket-outlet for the AC connection is in an accessible location near the library.

l The power cord must meet the specifications for the country where the library will be
installed.

North America and Korea 200–240 VAC Power Cord

The criteria for a 200-volt to 240-volt AC power cord in North America and Korea are as
follows:

JUNE 2025 576 SPECTRA TFINITY LIBRARY - USER GUIDE

APPENDIX C - SPECIFICATIONS

https://support.spectralogic.com/documentation/user-guides/tfinity-site-prep.pdf


Parameter Specification

Power cordage SJT type, three-conductor, 14 AWG minimum a

Power input connectors • Male: Connector must be of the proper type,
rating, and safety approval (see Supply-End
Connector Types below).

• Female: IEC 60320 C19

International 200–240 VAC Power Cord

The criteria for an international 200-volt to 240-volt AC power cord are as follows:

Parameter Specification

Power cordage Flexible, HAR (harmonized) type H05VV-F,
three conductor, cord with minimum conductor
size of 1.7 square millimeters (0.0026350 square
inches).

Power input connectors • Male: Connector must be of the proper type,
rating, and safety approval for the intended
country (see Supply-End Connector Types
below).

• Female: IEC 60320 C19

Supply-End Connector Types

The supply-end connector on the cord depends on the country where the library will be
installed. The following table shows the supply-end connector types used in each country.

Part
Number Country of Use Plug Style Length Appearance

9594 North America,
Korea

NEMA L6-20P 14.8 ft (4.5 m)

7029 North America,
Korea

NEMA L6-30P 14.8 ft (4.5 m)

aPower cord must comply with local electrical code.
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Part
Number Country of Use Plug Style Length Appearance

6807 Japan NEMA L6-20P 13.9 ft (4.24 m)

8665 United
Kingdom,
Continental
Europe

IEC 60309 15 ft (4.6 m)

Grounding Requirements

Due to electromagnetic interference (EMI) filtering in each dual AC power module, the
leakage current for main frames and drive frames is such that they require a secure connection
from the chassis of the unit to an earth ground.

Use one or more of the following methods for securing a ground connection when installing a
main frame or drive frame:

Notes: l Cord lock brackets and cords with locking connectors are not compatible and cannot
be used simultaneously.

l Expansion Frame Power Modules do not require locking cords or special grounding.

• Add cord lock brackets (Spectra Logic part number 5497) to all main and drive frames. See
Installing Cord Locks on page 495 for more information.

• Use a cord with locking connectors at both ends, such as L6-20P to locking C19 (Spectra
Logic part number 9594).

Power Consumption and Cooling Requirements
The power and cooling requirements for the library depend on the number and type of drives
installed. The following table provides the maximum power consumption and heat load for
the base library and for each additional component added to the base library. Use this
information to calculate the total maximum power consumption and heat load values, which
can be used to build a power budget for the library.

All values are measured at the AC input and include power supply efficiency. The values are
averages of observed hardware. In general, the lighter the load on the power supplies, the less
efficient they are. The power supply efficiency in turn affects the power draw of all
components.
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Component
Power
Consumption
(watts)

Heat Load,
Continuous
(BTU/hour)

Minimum Library (3-frame
with service frames) a

613 2093

Minimum Library (3-frame
with right and left media
frames) b

423

Estimated

1750

Drive frame c 153 522

Media frame 30 102

Bulk TAP frame 21 72

5/12 VDC power supply 33 113

24 VDC power supply 29 99

RIM 12 41

LTO-10 Fibre Channel
Full-Height

• Read/write: 40 Read/write: 136

LTO-10 Fibre Channel or
SAS Half-Height

• Read/write: 40 Read/write: 136

LTO-9 Fibre Channel
Full-Height

• Read/write: 35 Read/write: 119

LTO-9 Fibre Channel or
SAS Half-Height

• Read/write: 35 Read/write: 119

LTO-8 Fibre Channel
Full-Height

• Read/write: 40
• Idle: 15 d

Read/write: 136

LTO-8 Fibre Channel or
SAS Half-Height

• Read/write: 43
• Idle: 14 c

Read/write: 146

aIncludes two 24 VDC and two 5/12 VDC power supplies in the main frame, and two service frames each with two 24 VDC
power supplies; no drives or RIMs installed.

bIncludes two 24 VDC and two 5/12 VDC power supplies in the main frame and right media expansion frame and left media
expansion frame in non-isolating service frame configurations.

cIncludes one 24 VDC power supply; no drives or RIMs installed.

dNo cartridge loaded.
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Component
Power
Consumption
(watts)

Heat Load,
Continuous
(BTU/hour)

LTO-7 Fibre Channel
Full-Height

• Read/write: 31
• Idle: 20 c

Read/write: 106

LTO-7 Fibre Channel or
SAS Half-Height

• Read/write: 31
• Idle: 20 c

Read/write: 106

LTO-6 Fibre Channel • Read/write: 28
• Idle: 8 c

Read/write: 95

LTO-5, Fibre Channel • Read/write: 37
• Idle: 19 c

Read/write: 126

LTO-4, Fibre Channel • Read/write: 37
• Idle: 17.5 c

Read/write: 123

TS1170 technology • Read/write: 64
• Idle: 40c

Read/write: 218

TS1160 technology • Read/write: 67
• Idle: 35 c

Read/write: 229

TS1155 technology • Read/write: 60
• Idle: 19 c

Read/write: 205

TS1150 technology • Read/write: 55
• Idle: 38 c

Read/write: 188

TS1140 technology • Read/write: 53
• Idle: 30 c

Read/write: 181

Environmental Specifications

This section describes environmental specifications for the library. Do not place the library on
a carpeted floor or anywhere else that poses risk for static discharge that could damage the
library and its drives.

CAUTION The library must be installed on a level, hard-surfaced floor such as cement or
tile. Never install it on carpeted flooring.
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The library is equipped with internal fans that operate as much as is necessary for the number
of DBAs installed. The fans keep the library’s internal temperature within specifications as
long as the data center environment is within specifications.

CAUTION
When the library is moved from a cold environment to a warm environment, it
should not be powered on for at least 24 hours. This adjustment period
prevents condensation damage.

The following tables list the general environmental specifications for the library based on
drive type.

LTO 4 - 8 Drives

Mode
Dry-bulb
Temperature

Maximum
Temperature
Rate of
Change a

Relative
Humidity
(non-
condensing)

Maximum
Humidity
Rate of
Change

Maximum
Altitude

Allowable
Environment

16° C to 32° C

(60° F to 90° F)

5° C per hour

9° F per hour

20% to 80%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

Recommended
Environment

16° C to 25° C

(60° F to 77° F)

5° C per hour

9° F per hour

20% to 50%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

aThe temperature and humidity must be allowed to stabilize in the specified ambient environment for 24 hours.
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LTO 9 & 10 Drives

Mode
Dry-bulb
Temperature

Maximum
Temperature
Rate of
Change a

Relative
Humidity
(non-
condensing)

Maximum
Humidity
Rate of
Change

Maximum
Altitude

Allowable
Environment

16° C to 35° C

(59° F to 95° F)

5° C per hour

9° F per hour

20% to 50%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

Recommended
Environment

15° C to 25° C

(59° F to 77° F)

5° C per hour

9° F per hour

20% to 50%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

aThe temperature and humidity must be allowed to stabilize in the specified ambient environment for 24 hours.
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TS1150, TS1155, and TS1160 Drives

Mode
Dry-bulb
Temperature

Maximum
Temperature
Rate of
Change a

Relative
Humidity
(non-
condensing)

Maximum
Humidity
Rate of
Change

Maximum
Altitude

Allowable
Environment

16° C to 32° C

(60° F to 90° F)

5° C per hour

9° F per hour

20% to 80%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

Recommended
Environment

16° C to 25° C

(60° F to 77° F)

5° C per hour

9° F per hour

20% to 50%

22° C dew
point max
(72° F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

TS1170 Drives

Mode
Dry-bulb
Temperature

Maximum
Temperature
Rate of
Change b

Relative
Humidity
(non-
condensing)

Maximum
Humidity
Rate of
Change

Maximum
Altitude

Allowable
Environment

16° C to 25° C

(60° F to 77° F)

5° C per hour

9° F per hour

20% to 50%

22° C dew
point max (72°
F)

5% per hour
with no
condensation

3048 m
(10,000 ft)

Storing c and Shipping (Non-Operating) Environment Specification

Humidity 10% to 95% (non-condensing)

Temperature –40° F to 149° F (–40° C to 65° C)

Altitude Sea level to 40,000 ft (12,192 m)

aThe temperature and humidity must be allowed to stabilize in the specified ambient environment for 24 hours.

bThe temperature and humidity must be allowed to stabilize in the specified ambient environment for 24 hours.

cThe library is in its original packaging. The packaging is designed to protect the library from condensation caused by
extreme temperature variations of 27° F (15° C) or more. When the library is moved from a cold storage environment to a
warm operating environment, it must be acclimated in its packaging for at least 24 hours before opening to prevent serious
condensation damage from occurring.
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Shock and Vibration Specifications

The library will operate normally after experiencing shock loads as specified in the following
table. The operating shock levels indicate how much shock the library can withstand while the
enclosed drives are reading and writing data. The non-operating and storage shock levels
indicate how much shock the library can withstand when it is not operating. After
experiencing this amount of shock, the library will operate normally.

Specification Operating Storing and Shipping
(Non-Operating Environment) a

Shock 2 g pk ½ sine wave for 10 msec
(3 axes, 2 shocks per axis, minimum)

2 g pk ½ sine wave for 10 msec
(3 axes, 2 shocks per axis, minimum)

Vibration
(Swept Sine)

5 Hz – 500 Hz – 5 Hz
5 – 22 Hz, 0.01-inch DA displacement

22 – 500 Hz, 0.25G pk @ ½ octave
(minimum three axes)

5 Hz – 500 Hz – 5 Hz
5 – 31 Hz, 0.02-inch DA displacement

31 – 500 Hz, 1G pk @ ½ octave
(minimum three axes)

Vibration
(Random)

0.5 Grms, 0 – 3000 Hz (single axis) 1 – 200 Hz @ 1.156 Grms.
Bottom face only for 60 minutes.

INTEROPERABILITY AND SOFTWARE COMPATIBILITY

You can find complete interoperability listings, as well as a list of the types of software that
have been tested and proven compatible with the library on the Spectra Logic website at
spectralogic.com/compatibility.

aSpecifications are for the library in its original packaging.
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INTERFACE SPECIFICATIONS

This section provides information about the interfaces used to connect the library and tape
drives to the host systems. It also provides information about the Ethernet interface used to
access the library’s BlueScale web interface.

The Robotics Interface Module (RIM) supports a Fibre Channel host interface. The RIM does
not provide connectivity for SCSI drives. Direct-attached tape drives have a native Fibre
Channel or SAS interface; direct-attached SCSI drives are not supported.

For information about how IBM drives support Fibre Channel and SAS communications, refer
to the tape drive documentation, available from IBM at ibm.com/support/knowledgecenter/.

Component Interface Connectors

Component Physical Interface

Drive, direct-attached Fibre Channel Two dual port multimode optical LC connectors a

RIM Fibre Channel Two dual port optical SFPs with LC connectors

Drive, direct-attached SAS (LTO-6 to LTO-
8)

One SFF-8088 connector

Drive, direct-attached SAS (LTO-9 & LTO-
10)

One SFF-8644 connector

Network Interface Cable Requirements

The type of cables required to connect the library and its drives to the network depend on the
type of interface being used.

Library Access

Provide a Category 5 (10/100BaseT connection) data-grade Ethernet cable that is compliant
with EIA/TIA 568 from an active Ethernet network to be connected to an Ethernet port on the
LCM (each Ethernet port is a pin-through-hole RJ-45 shielded connector ) to support remote
access to the library’s BlueScale web interface and to allow the library to automatically email
notifications to users and AutoSupport tickets to Spectra Logic Technical Support. During
installation, the library’s connection is set up with the library’s IP address, subnet, proxy
server, and other IP configuration settings.

aOnly one port at a time can be used to connect the drive to a Fibre Channel network. If desired, the two ports can be used to create
a failover configuration.
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CAUTION Some port scanning software can interfere with remote library sessions.

Host Access

Provide one or two optical fiber cables from the arbitrated loop or switched fabric, to Fibre
Channel port(s) on a RIM in each partition to provide the hosts with access to the partitions.
Depending on the wavelength, the cables must comply with the following specifications in the
Fibre Channel standard (FC-PI-2):

• 50-micron—400-M5-SN-I classification

• 62.5-micron—400-M6-SN-I classification (not supported for RIM2)

Tape Drive Access

• Fibre Channel

Provide one optical fiber cable from the arbitrated loop or switched fabric, to a Fibre
Channel port on each drive, to provide the hosts with access to the partitions. Depending
on the wavelength, the cables must comply with the following specifications in the Fibre
Channel standard (FC-PI-2):

• 50-micron—400-M5-SN-I classification

• 62.5 micron—400-M6-SN-I classification (not supported for LTO-6 or later generation
drives or TS11xx technology drives)

Use the following table to determine the maximum length for an M5 cable.

Data Rate / Link
Speed

M5 (OM2) cable M5E (OM3)
cable

M5F (OM4)
cable

1 Gbps 1640 ft (500 m) Not Specified Not Specified

2 Gbps 984 ft (300 m) Not Specified Not Specified

4 Gbps 492 ft (150 m) 1247 ft (380 m) 1312 ft (400 m)

8 Gbps 164 ft (50 m) 492 ft (150 m) 623 ft (190 m)

• Serial Attached SCSI (SAS)

SAS tape drives support the point-to-point Serial Attached SCSI protocol.

• LTO-7 and LTO-8 - Connecting these drives to the host network requires an SFF-8088
SAS cable rated for 6 Gb/second that does not exceed 13 feet (4 m).

• LTO-9 and LTO-10 - Connecting these drives to the host network requires an SFF-8644
SAS cable rated for 12 Gb/second that does not exceed 13 feet (4 m).
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BlueScale Vision Camera Access

One BlueScale Vision camera is included with the main frame. Additional cameras can be
installed in the expansion frames. To comply with EMC requirements, provide a shielded
Category 5 (10/100BaseT connection) data-grade cable or a similar Category 5 cable from an
active Ethernet network to each camera.

Universal Serial Bus (USB) Support

Spectra Logic supports using the USB ports on the library operator panel, the LCM, and the
RCM for the following:

• USB mass storage devices (for example, flash drives)

• Keyboards

• Pointer devices (for example, a computer mouse)

• External Drives (HD, CD, DVD, and Flash) with a USB interf

IMPORTANT The library only recognizes FAT-formatted, not NTFS-formatted, USB devices.

NDMP Support

Spectra Logic tape libraries are compatible with local, remote, and three-way NDMP (Network
Data Management Protocol) topologies, where the tape library is connected to the NDMP data
mover host over Fibre Channel.
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TAPE DRIVE AND MEDIA SPECIFICATIONS

This section provides the basic specifications for the tape drives and media supported by the
library.

Notes: l The specifications in this section are provided for convenience only. Refer to the tape
drive documentation for the most current specifications (see LTO Ultrium Tape Drives
on page 21 and TS11xx Technology Drives on page 21).

l The specifications in this section are subject to change without notice.

l For T10K Drive specifications, see Using StorageTek T10K Drives in a Spectra TFinity
Library.

LTO Tape Drive Specifications

This section provides specifications for the LTO drives supported by the library. See Tape
Media Specifications on page 598 for information about the media used in the library.

Note: LTO drives and media are also referred to as Ultrium or LTO Ultrium drives and media.

LTO-10 Drive

When connecting to a Fibre Channel network, LTO-10 Fibre Channel drives will attempt to
connect at 32 Gb/second, but will auto-negotiate down depending on the requirements of the
port to which the drive is connected.

LTO-10 SAS drives attempt to connect at 12 Gb/second, but auto-negotiate down to 6
Gb/second or 3 Gb/second, depending on the requirements of the port to which the drive is
connected.

Parameter Specification

Maximum sustained transfer ratea ,
b

400 MB/second, native
1000 MB/second, compressed SAS
1200 MB/second, compressed Fibre

Speed matching range 157 MB/second to 407 MB/second

Average space record time 45 seconds

a Assuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

b This is a per-drive value. Total sustained transfer rate for the library depends on the number of drives installed in
the library.
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Parameter Specification

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate, calculated 1 x 10 –19 bits

Power consumption Read/write: 39.8 watts typical
Idle: 27.5 watts (empty drive)

LTO-9 Drive
When connecting to a Fibre Channel network, LTO-9 Fibre Channel drives will attempt to
connect at 8 Gb/second, but will auto-negotiate down to 4 Gb/second, or 2 Gb/second,
depending on the requirements of the port to which the drive is connected.

LTO-9 SAS drives attempt to connect at 12 Gb/second, but auto-negotiate down to 6
Gb/second or 3 Gb/second, depending on the requirements of the port to which the drive is
connected.

Parameter Specification

Maximum sustained transfer rate a,
b

400 MB/second, native
900 MB/second, compressed SAS
700 MB/second, compressed Fibre

Speed matching range 177 MB/second to 400 MB/second

Average space record time TBD

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate, calculated 1 x 10 –20 bits

Power consumption Read/write: 34 watts typical
Idle: TBD

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value. Total sustained transfer rate for the library depends on the number of drives installed in
the library.
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LTO-8 Drive
When connecting to a Fibre Channel network, LTO-8 Fibre Channel drives will attempt to
connect at 8 Gb/second, but will auto-negotiate down to
4 Gb/second, or 2 Gb/second, depending on the requirements of the port to which the drive is
connected.

LTO-8 SAS drives attempt to connect at 6 Gb/second, but auto-negotiate down to 3 Gb/second
or 1.5 Gb/second, depending on the requirements of the port to which the drive is connected.

Parameter Specification

Maximum sustained transfer rate a,
b

360 MB/second, native
750 MB/second, compressed

Speed matching range 112 MB/second to 360 MB/second

Average space record time 59 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate, calculated 1 x 10 –19 bits

Power consumption Read/write: 40 watts typical
Idle: 15 watts

LTO-7 Drive
When connecting to a Fibre Channel network, LTO-7 Fibre Channel drives will attempt to
connect at 8 Gb/second, but will auto-negotiate down to
4 Gb/second, or 2 Gb/second, depending on the requirements of the port to which the drive is
connected.

LTO-7 SAS drives attempt to connect at 6 Gb/second, but auto-negotiate down to 3 Gb/second
or 1.5 Gb/second, depending on the requirements of the port to which the drive is connected

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value. Total sustained transfer rate for the library depends on the number of drives installed in the library.
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Parameter Specification

Maximum sustained transfer rate a,
b

300 MB/second, native
750 MB/second, compressed

Speed matching range 100 MB/second to 300 MB/second

Average space record time 56 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate, calculated 1 x 10 –19 bits

Power consumption Read/write: 31 watts typical
Idle: 20 watts

LTO-6 Drive
When connecting to a Fibre Channel network, LTO-6 Fibre Channel drives will attempt to
connect at 8 Gb/second, but will auto-negotiate down to
4 Gb/second, 2 Gb/second, or 1 Gb/second, depending on the requirements of the port to which the
drive is connected.

Parameter Specification

Maximum sustained transfer rate c,
d

160 MB/second, native e
400 MB/second, compressed

Speed matching range 40 MB/second to 160 MB/second

Average space record time 77 seconds

Encryption capability AES 256-bit

WORM capability Yes

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value. Total sustained transfer rate for the library depends on the number of drives installed in the library.

cAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

dThis is a per-drive value. Total sustained transfer rate for the library depends on the number of drives installed in the library.

eA 1 Gb interface speed will not stream an LTO-6 drive at 160 MB/second.
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Parameter Specification

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –17 bits

Power consumption Read/write: 28 watts typical
Idle: 8 watts

LTO-5 Drive
When connecting to a Fibre Channel network, LTO-5 Fibre Channel drives will attempt to
connect at 8 Gb/second, but will auto-negotiate down to
4 Gb/second, 2 Gb/second, or 1 Gb/second, depending on the requirements of the port to which the
drive is connected.

Parameter Specification

Maximum sustained transfer rate
a, b

140 MB/second, native c
280 MB/second, compressed

Speed matching range 30 MB/second to 140 MB/second

Average space record time 75 seconds

Encryption capability AES 256-bit

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –17 bits

Power consumption b Read/write: 27 watts typical
Idle: 7.5 watts

LTO-4 Drive

When connecting to a Fibre Channel network, LTO-4 Fibre Channel drives will attempt to
connect at 4 Gb/second, but will auto-negotiate down to
2 Gb/second or 1 Gb/second, as needed.

aAssuming a 2:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value.

cA 1 Gb interface speed will not stream an LTO-5 drive at 140 MB/second.
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Parameter Specification

Sustained transfer rate a,
b

120 MB/second native c
240 MB/second compressed

Average space record
time

70 seconds

Encryption capability AES 256-bit

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –17 bits

Power consumption b Read/write: 29.5 watts typical
Idle: 12.5 watts

TS11xx Technology Tape Drive Specifications

This section provides specifications for the TS11xx technology drives.

Note: The specifications in this section are provided for convenience only. Refer to the tape drive
documentation for the most current specifications (see TS11xx Technology Drives on
page 21).

TS1170 Technology Drive

Parameter Specification

Maximum sustained
transfer rate with JE
mediad, e

400 MB/second, native
900 MB/second, compressed

Speed matching range 112 MB/second to 365 MB/s second

aAssuming a 2:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value.

cA 1 Gb interface speed will not stream an LTO-4 drive at 120 MB/second.

dAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

eThis is a per-drive value.
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Parameter Specification

Media compatibility Only compatible with JF media. No
backwards compatibility.

Average file access time 55 seconds

Encryption capability AES 256-GCM

WORM capability No

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –21 bits

Power consumption Read/write: 64 watts maximum
Idle: 40 watts

TS1160 Technology Drive

Parameter Specification

Maximum sustained
transfer rate with JE
mediaa, b

400 MB/second, native
900 MB/second, compressed

Speed matching range JE: 112 MB/second to 365 MB/second
JD: 112 MB/second to 365 MB/second
JC (TS1150 technology format):
    99 MB/second to 303 MB/second
JC (TS1140 technology format):
    62 MB/second to 252 MB/second

Average file access time 45 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 250,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –20 bits

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value.
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Parameter Specification

Power consumption Read/write: 67 watts maximum
Idle: 35 watts

TS1155 Technology Drive

Parameter Specification

Maximum sustained
transfer rate a, b

360 MB/second, native
700 MB/second, compressed

Speed matching range JD: 112 MB/second to 365 MB/second
JC (TS1150 technology format):
    99 MB/second to 303 MB/second
JC (TS1140 technology format):
    90 MB/second to 252 MB/second

Average file access time 55 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 237,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –20 bits

Power consumption Read/write: 60 watts maximum
Idle: 19 watts

TS1150 Technology Drive

Parameter Specification

Maximum sustained
transfer rate c, d

360 MB/second, native
700 MB/second, compressed

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value.

cAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

dThis is a per-drive value.
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Parameter Specification

Speed matching range JD: 112 MB/second to 365 MB/second
JC (TS1150 technology format):
    99 MB/second to 303 MB/second
JC (TS1140 technology format):
    90 MB/second to 252 MB/second

Average file access time 55 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 237,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –20 bits

Power consumption Read/write: 46 watts maximum
Idle: 22.3 watts

TS1140 Technology Drive

Parameter Specification

Maximum sustained
transfer rate a, b

250 MB/second, native
650 MB/second, compressed

Speed matching range 76 MB/second to 251 MB/second

Average file access time 54 seconds

Encryption capability AES 256-GCM

WORM capability Yes

MTBF 237,000 hours at 100% duty cycle

Uncorrected error rate 1 x 10 –20 bits

Power consumption Read/write: 51 watts maximum
Idle: 24 watts

aAssuming a 2.5:1 compression ratio. Compression throughput depends on the type of data.

bThis is a per-drive value.
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Drive-Based Encryption Highlights
Key

AES-256 data encryption with a secret 256-bit encryption key is used to encrypt and decrypt
data. The key is not retrievable from the encryption core and is automatically erased during
the unload process; software is required to extract the key, keep it secure, and provide
management tools to track, store, use, and delete keys as appropriate.

Notes: l The encryption performed by encryption-enabled LTO-4 or later generation drives is
not compatible with the encryption performed by an encryption-enabled F-QIP.

l Spectra SKLM key management is not compatible with BlueScale Encryption key
management, because they cannot share encryption keys. Data encrypted using
Spectra SKLM key management cannot be decrypted using BlueScale Encryption key
management, and vice versa.

For more information about encryption, see the Spectra Tape Libraries Encryption User Guide.

Tape Media Specifications
This section provides specifications for the tape media supported by the library. See Media
and Media Accessories on page 560 for information about ordering media for your library.

Environmental Requirements

The following table lists the specifications for storage temperature and other environmental
requirements for tape media. Do not allow the temperature and humidity in the storage
environment to fluctuate.

Specification Recommended
Operating

LTO-9 and
LTO-10
Allowable
Operating a

LTO-8 and
Lower
Allowable
Operating a

TS11xx
Allowable
Operating a

Shipping
b

Temperature 59° F to 77° F
(15° C to 25° C)

59° F to 95° F
(15° C to 35°
C)

50° F to 113°
F
(10° C to 45°
C)

61° F to 90° F
(16° C to 32°
C)

–9° F to
120° F
(–23° C to
49° C)

Relative
humidity

20% to 50% 10% to 80% 10% to 80% 10% to 80% 5% to 80%

aThe upper limit applies to the media, not the library. Be sure there is adequate air flow around the library at all times.

bWhen media is moved from a cold shipping/storage environment to a warm operating environment, it must be acclimated
in its packaging for at least 24 hours before opening to prevent condensation damage from occurring.
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Specification Recommended
Operating

LTO-9 and
LTO-10
Allowable
Operating a

LTO-8 and
Lower
Allowable
Operating a

TS11xx
Allowable
Operating a

Shipping
b

Max dew
point

72° F (22° C) 71.6° F (22°
C)

79° F (26° C) 79° F (26° C) 79° F (26°
C)

Maximum
humidity rate
change

5% / hour with
no
condensation

5% / hour
with no
condensation

5% / hour
with no
condensation

5% / hour
with no
condensation

Maximum
Altitude

10,000 ft

3048 m

10,000 ft

3048 m

10,000 ft

3048 m

10,000 ft

3048 m

40,000 ft

12192 m

LTO Media Specifications
The following table shows the capacities of the different generations of LTO Ultrium data
cartridges.

LTO Media Generation Native Capacity (Compressed Capacity)

LTO-4 and LTO-4 WORM 800 GB (1.6 TB a)

LTO-5 and LTO-5 WORM 1.5 TB (3 TB c)

LTO-6 and LTO-6 WORM 2.5 TB (6.25 TB d)

LTO-7 and LTO-7 WORM 6 TB (15 TB b)

LTO-7 Type M 9 TB (22.5 TB b)

LTO-8 and LTO-8 WORM 12 TB (30 TB b)

LTO-9 and LTO-9 WORM 18 TB (45 TB b)

LTO-10 and LTO-10 WORM 30 TB (75 TB b)

aThe upper limit applies to the media, not the library. Be sure there is adequate air flow around the library at all times.

bWhen media is moved from a cold shipping/storage environment to a warm operating environment, it must be acclimated
in its packaging for at least 24 hours before opening to prevent condensation damage from occurring.

cAssuming a 2:1 compression ratio. The compressed capacity depends on the type of data.

dAssuming a 2.5:1 compression ratio. The compressed capacity depends on the type of data.
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LTO Read/Write Compatibility

The following table shows the media read/write compatibility for each LTO drive generation
supported by the library.

Driv
e
Gen

LTO-4
Media

LTO-5
Media

LTO-6
Media

LTO-7
Media

M8
Media

LTO-8
Media

LTO-9
Media

LTO-10

LT
O-4

Read/wr
ite

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

LT
O-5

Read/wr
ite

Read/wr
ite

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

LT
O-6

Read only Read/wr
ite

Read/wr
ite

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

LT
O-7

Not
supporte
d

Read only Read/wr
ite

Read/wr
ite

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

LT
O-8

Not
supporte
d

Not
supporte
d

Not
supporte
d

Read/wr
ite

Read/wr
ite

Read/wr
ite

Not
supporte
d

Not
supporte
d

LT
O-9

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Read/wr
ite

Read/wr
ite

Not
supporte
d

LT
O-10

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Not
supporte
d

Read/wr
ite

TS11xx Technology Media Specifications

The following table shows the capacities of TS11xx technology data cartridges.
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Media type
Native Capacity
(Compressed Capacity ab  )

JC / JY (WORM) (TS1140 technology format): 4 TB (10 TB)
(TS1150 technology format): 7 TB (17.5 TB)

JD / JZ (WORM) (TS1150 technology format): 10 TB (25 TB)
(TS1155/60 technology format): 15 TB (37.5 TB)

JE / JV (WORM) (TS1160 technology format): 20 TB (50 TB)

JF (TS1170 technology format): 50 TB (150 TB)

TS11xx Technology Read/Write Compatibility

The following table shows the media read/write compatibility for each TS11xx technology
drive generation supported by the library.

Drive
Generation JC Media JD Media JE Media JE Media

TS1140 Read/write Not supported Not supported Not supported

TS1150 Read/write Read/write Not supported Not supported

TS1155 Read/write Read/write Not supported Not supported

TS1160 Read only Read/write Read/write Not supported

TS1170 Not supported Not supported Not supported Read/write

WORM Media

Certain records retention and data security applications require a Write Once, Read Many
(WORM) method for storing data on tape. LTO-4 and later generation drives and TS11xx
technology drives enable WORM support when a WORM tape cartridge is loaded into the
drive.

aAssuming a 2.5:1 compression ratio for TS1140, TS1150, and TS1155. The compressed capacity depends on the type of
data.

bAssuming a 3:1 compression ratio for TS1160, and TS1170. The compressed capacity depends on the type of data.
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WORM Media Requirements

Because standard read/write media are incompatible with the WORM feature, a specially
formatted WORM tape cartridge is required. Each WORM cartridge has a unique, worldwide
cartridge identifier (WWCID), which comprises the unique CM chip serial number and the
unique tape media serial number.

Data Security on WORM Media

Certain built-in security measures help ensure that the data written on a WORM cartridge
does not become compromised, for example:

• The format of a WORM tape cartridge is unlike that of standard read/write media. This
unique format prevents a drive that lacks WORM-capable firmware from writing on a
WORM tape cartridge.

• When the drive senses a WORM cartridge, the firmware prohibits the changing or altering
of user data already written on the tape. The firmware keeps track of the last appendable
point on the tape.

Cleaning Cartridges

Cleaning cartridges are valid for 50 uses. Do not rewind and reuse the material in a cleaning
cartridge. Reusing the material may redistribute contaminants previously removed from the
tape path. If all of the cleaning material has been used, discard the cartridge and use a new
cleaning cartridge.

Barcode Label Specifications

Symbology

The barcode labeling scheme used on Spectra Logic certified media uses the barcode
symbology of USS-39. You can obtain a complete description and definition of this symbology
from the Automatic Identification Manufacturers (AIM) specification, the Uniform Symbol
Specification (USS-39), and the ANSI MH10.8M-1993 ANSI Barcode specification.

Application and Orientation

The barcode label must be applied to the cartridge so that it fits within the label recess on the edge
of the cartridge without curling up on the sides or ends. The label must be oriented so that the
barcode characters are along the edge closest to the hub side of the cartridge.
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Printed Characters

The label can have human-readable alphanumeric characters printed along the top or bottom
edge of the label provided there is no conflict or interference with the automation code. This
text must include the barcode data, but can also include additional text. The format and colors
of the human readable characters is up to the customer and label vendor. For location
restrictions, see Detailed Specifications for LTO Cartridge Barcodes on the next page and
Detailed Specifications for TS11xx Technology Cartridge Barcodes on page 605.

Note: When using barcode labels with alphanumeric characters along the bottom edge, the label
must be positioned so that barcode is at least 13.72 mm below the top edge of the cartridge
to ensure that the barcode reader can read the label.

Barcode Data

The library supports barcode data strings consisting of from 1 to 16 characters, including an
optional checksum character. Quiet zones precede and follow the start and stop characters.

The barcode data string on standard Spectra Logic barcode labels consists of a start character, eight
alphanumeric characters, a checksum character, and the stop character. Quiet zones precede and
follow the start and stop characters.

• The first six (6) characters following the start character can be any combination of upper
case A-Z or 0-9 (for example, ABC123) to identify the cartridge Volume Serial Number. The
use of “CLN” and “DG{space}” at the beginning of the volume identifier is reserved.
• The volume identifier “CLNvnn” is reserved for cleaning cartridges. When a drive
requires cleaning, it requests a specific type of cleaning cartridge.
• The “v” field is an alphanumeric field to identify cleaning cartridge applications,
“U” for Universal Cleaning Cartridges or a drive unique identifier.

• The “nn” alphanumeric field is used to track individual cleaning cartridge activity
(that is, usage and life).

• The volume identifier “DG{space}vnn” is reserved for diagnostic and service
cartridges.

• The last two (2) characters are the media identifier and indicate the cartridge Media Type
(for example, “L” for LTO and “4” for an LTO-4 cartridge or JC for a TS11xx technology
cartridge). In IBM LTO tape drives, the value of the media identifier on cleaning cartridges
is ignored, although a valid value must be present.

• The barcode string can be printed in either direction on the label and must begin and end
with a valid start/stop character ( * ).

• The label must be printed so that barcode data is positioned along the edge of the label that
will be closest to the hub side of the cartridge.
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The AIM Uniform Symbol USS-39 specification provides detailed information about the format of the
start character, the series of characters that make up the barcode data, the optional checksum
character, and the stop character.

Detailed Specifications for LTO Cartridge Barcodes

Figure 321 shows the dimensional specifications for LTO labels with the alphanumeric
characters above the barcode.

Figure 321 Barcode specifications for LTO media; alphanumeric characters on top.

Note: When using barcode labels with alphanumeric characters along the bottom edge, the label
must be positioned so that barcode is at least 13.72 mm below the top edge of the cartridge
to ensure that the barcode reader can read the label.

LTO Barcode Element Specifications

For the official IBM barcode label specification, see ibm.com/support/pages/node/651699. Unless
otherwise specified, tolerances are X.XXX ± 0.127 mm, X.XXX ± 0.762 mm.

• Minimum symbol height is 11.1 mm, measured to the inside of the label’s edge.
• The wide-to-narrow ratio is 2.75.
• The narrow element width is 0.432 mm +0.03 mm or –0.076 mm.
• The nominal width of the wide spaces and bars is 1.188 mm.
• The inter-character gap is 0.432 mm +0.03/–0.076 mm.
• The minimum quiet zone at the beginning and end of a printed barcode string is 4.32 mm
(10 times the narrow element width).

• The total nominal barcode string length (including quiet zones) is 74.088 mm.
• The edge of the barcode is the edge of the printed area associated with the bar. The edge
roughness is the transition encountered as a horizontal line is moved vertically from all
black to all white. The edge roughness maximum is 0.038 mm.
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• Variation between all bars, white and black, must be less than ±0.0381 mm.

LTO Physical Label Specifications

• Label stock must fit within the label recess on the face of the cartridge without curling up
on the sides or ends (79 mm X 17 mm +0/–0.8).

• Minimum length sufficient for the quiet zones, start-stop, and data characters (nominal
74.088 mm).

• Minimum width no less than 1.5 mm narrower than the cartridge label recess width.
Corners are cut with a 1.5 mm radius.

• Maximum label thickness, including the RFID tag, if present, together with any associated
layers and adhesives cannot exceed 0.40 mm.

• The label and adhesive must have an environmental performance to match or exceed the
environmental specifications of the cartridge to which it is applied.

Detailed Specifications for TS11xx Technology Cartridge Barcodes

Figure 322 shows the dimensional specifications for TS11xx technology labels with the
alphanumeric characters above the barcode.

Figure 322 Barcode specifications for TS11xx technology media; alphanumeric characters
on top. All measurements are in millimeters.

Note: When using barcode labels with alphanumeric characters along the bottom edge, the label
must be positioned so that barcode is at least 13.72 mm below the top edge of the cartridge
to ensure that the barcode reader can read the label.

TS11xx Technology Barcode Element Specifications

For the official IBM barcode label specification, see ibm.com/support/pages/node/651747. Unless
otherwise specified, tolerances are X.XXX ± 0.127 mm, X.XX ± 0.76 mm.

• Minimum symbol height is 7.1 mm, measured to the inside of the label’s edge.

• The wide-to-narrow ratio is 2.75.
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• The narrow element width is 0.500 mm + 0.03/- 0.07 mm.

• The nominal width of the wide spaces and bars is 1.375 mm.

• The inter-character gap is 0.500 mm + 0.03/- 0.07 mm.

• The minimum quiet zone at the beginning and end of a printed barcode string is 5.0 mm
(10 times the narrow element width).

• The total nominal barcode string length (including quiet zones) is 85.75 mm.

• The edge of the barcode is the edge of the printed area attached to the bar. The edge
roughness is the transition encountered as a horizontal line is moved vertically from all
black to all white. The edge roughness maximum is 0.04 mm.

• Variation between all bars, white and black, must be less than ±0.04 mm.

TS11xx Technology Physical Label Specifications

• Label stock must fit within the label recess on the face of the cartridge without curling up
on the sides or ends (88.5 mm X 11.9 mm +0/–0.4).

• Minimum length sufficient for the quiet zones, start-stop, and data characters (nominal
85.75 mm).

• Minimum width no less than 1.5 mm narrower than the cartridge label recess width.
Corners are cut with a 1.5 mm radius.

• Maximum label thickness, including the RFID tag, if present, together with any associated
layers and adhesives cannot exceed 0.75 mm.

• The label and adhesive must have an environmental performance to match or exceed the
environmental specifications of the cartridge to which it is applied.
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APPENDIX D - REGULATORY & SAFETY
STANDARDS
The Spectra TFinity library complies with the safety and regulatory agency standards listed
below when installed by a Spectra Logic certified engineer or third-party provider.

EU Declaration of Conformity 608
Emission Standards 609
Safety Standards and Compliance 610
Nemko Accreditation 611
Environmental Regulations 612
Conflict Minerals Policy 614

JUNE 2025 607 SPECTRA TFINITY LIBRARY - USER GUIDE

APPENDIX D - REGULATORY & SAFETY STANDARDS



EU DECLARATION OF CONFORMITY

 

6101 Lookout Road  www.SpectraLogic.com 
Boulder, CO 80301  +1 303-449-6400 Worldwide 
  +1 800-833-1132 US/Canada 

 

Document # 99100001 V7.0 

DECLARATION OF CONFORMITY 
According to ISO/IEC 17050-1:2004 

 

 

Manufacturer’s Name: Spectra Logic Corporation 

Manufacturer’s Address: 6101 Lookout Road, Boulder CO,80301 

Declares under sole responsibility that the product as delivered 

Product Name: TFinity 

Model Number: TFinity, T950, T950e. T950V 

Product options: This declaration covers all options of the above product(s) 

Complies with the essentials of the following European Directives, and carries the CE 
marking accordingly: 

Safety 
Directive: 2014/35/EU IEC 62368-1:2018 (Third Edition) 
EN 60950-1:2006 +A11:2009 +A1:2010 +A12:2011 +A2:2013 
EN 62479:2010  

 

Electromagnetic Compatibility 
Directive 2014/30/EU EN55032: 2012, Class A  
EN55024: 2010 EN 61000 3-2:2014 
EN 61000 3-3:2013 

 

Restriction of the use of certain hazardous substances 
IEC 63000 / EN 50581-2012 EN 62321 
(EC)1907/2006 REACH 2011/65/EU RoHS 
2012/19/EU  WEEE 

 

 

Mike Beaty 
Sr. Director Operations 
September 20, 2023 
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EMISSION STANDARDS
The Spectra TFinity library complies with the following domestic and international emission
standards.

Country Standard

United States - FCC CFR Title 47, FCC Part 15 (see FCC Notice)

Australia/New Zealand AS/NZS CISPR 32: 2015

Canada ICES-003

Japan VCCI

Korea KN 22

Taiwan CNS 13438

FCC Notice

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to CFR 47, Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency
energy, and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference, in which case the user will be required to correct
the interference at the user’s own expense.

Korean Notice
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SAFETY STANDARDS AND COMPLIANCE

Product Safety Standards

The Spectra TFinity library complies with the following domestic and international product
safety standards.

• Directive: 2014/35/EU

• EN 60950-1:2006 +A11:2009 +A1:2010 +A12:2011 +A2:2013

• EN 62479:2010

• CAN/CSA C22.2 No. 60950-1-03 (Canada: cNemko Mark)

Laser Warning

IBM Tape Drives

A Class 1 laser assembly, in the optical transceiver, is mounted on each IBM tape drive Fibre
Channel electronics card. This laser assembly is registered with the DHHS and is in
compliance with IEC825.

These products contain components that comply with performance standards that are set by
the U.S. Food and Drug administration. This means that these products belong to a class of
laser products that do not emit hazardous laser radiation. This classification was accomplished
by providing the necessary protective housings and scanning safeguards to ensure that laser
radiation is inaccessible during operation or is within Class 1 limits. External safety agencies
have reviewed these products and have obtained approvals to the latest standards as they
apply to this product type.

Spectra Logic QIP and RIM Controllers

The optical transceiver is a Class 1 Laser Product as defined by the international standard IEC
60825-1:1993+A1:1997+A2:2001 and by USA regulations for Class 1 products per CDRH 21 CFR
1040.10 and 1040.11. Laser emissions from Class 1 laser products are not considered hazardous
when operated according to product specifications. Operating the product with a power
supply voltage exceeding 4.0 volts may compromise the reliability of the product, and could
result in laser emissions exceeding Class 1 limits.
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NEMKO ACCREDITATION

The safety issues of this information technology equipment type have been evaluated by a
government-accredited European third-party organization, such as Nemko.

This Mass Storage Device has been evaluated and determined to comply with the Safety
Requirements of the International Standard for Information Technology Equipment, IEC/EN
60950-1, Second Edition. The evaluation was conducted by Nemko. Nemko participates in the
CB Scheme as a National Certification Body certified by the IECEE.
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ENVIRONMENTAL REGULATIONS

The Spectra TFinity library complies with the following domestic and international
environmental regulations and directives.

Waste of Electronic and Electrical Equipment (WEEE) Directive

Note: For information on recycling your Spectra library, please check the Spectra Logic website.
European Union users should contact their local waste administration for WEEE collection
instructions for this product.

The WEEE symbol on the back of this product indicates that this product meets
the European Directive 2012/19/EU on Waste Electrical and Electronic Equipment,
known as the WEEE directive. This directive, only applicable in European Union
countries, indicates that this product should not be disposed of with normal
unsorted municipal waste.

Within participating European Union countries, special collection, recycling, and
disposal arrangement have been established for this product. At the end of life, the product
user should dispose of this product using special WEEE collection systems. These special
systems mitigate the potential affects on the environment and human health that can result
from hazardous substances that may be contained in this product.

Restriction of Hazardous Substances in Electrical and Electronic
Equipment (RoHS)

The RoHS marking indicates that this product is in compliance with European
Council Directive 2011/65/EU RoHS, on the restriction of the use of certain
hazardous substances in electrical and electronic equipment.
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Measures for the Administration of the Control of
Pollution by Electronic Information Products (China)

Recycling Your Library

For information on recycling your Spectra library, check the Spectra Logic website at:
spectralogic.com/environment.
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CONFLICT MINERALS POLICY

Spectra Logic is committed to complying with the OECD Due Diligence Guidance for
Responsible Supply Chains of Minerals from Conflict-Affected and High-Risk Areas, as well as
the applicable requirements of Section 1502 of the Dodd-Frank Act, which aims to prevent the
use of minerals that directly or indirectly finance or benefit armed groups in the Democratic
Republic of the Congo (DRC) or in adjoining countries (“conflict minerals”).

Affected suppliers to Spectra Logic will be required to commit to being or becoming “conflict-
free” (which means that such supplier does not source conflict minerals) and sourcing, where
possible, only from conflict-free smelters. Each affected supplier to Spectra Logic will be
required to provide completed EICC-GeSI declarations evidencing such supplier's commitment
to becoming conflict-free and documenting countries of origin for the tin, tantalum, tungsten,
and gold that it purchases.

For more information on Spectra Logic's conflict minerals program contact
conflictminerals@spectralogic.com.
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